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Document Revisions 

Version Section Document Changes 

11.2  
Track Mortgage Call 
Report 

A new screen is available for the Mortgage 
Call Report. 

Report Templates A new report template is available for NMLS 
Call Report. 

Employment/Self 
Employment 

An Aliases button ins available to add 
employment aliases. 

Buydown Mortgage The Paid By dropdown menu is available for 
a Buydown Mortgage. 

Certificate of Eligibility 
Request 

The Previous VA Loans section is updated to 
accommodate the updated VA Request of 
the Certificate of Eligibility 
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Chapter 1: PREFACE 

Product Assistance 

Table 1: Product Assistance 

Type Description 

Help for Point Screens Press F1 or select Help from the toolbar on any Help 
screen. 

User Guide Access the online Knowledge Base Articles in Point: 
Help > Point User Guide or from the Calyx Documents 
page.  

Knowledge Base 
Access the online Knowledge Base Articles two ways: 

• In Point: Help > Support Online > Knowledge Base 

• Visit: Training | Calyx Customer Portal | Calyx Software 

Product Information General product information and links to product 
support pages and the user guide are available at 
Calyx Support. 

Training • Attend online classes delivered by Certified Calyx trainers 

• Go to the Calyx Customer Portal 

• Email: training@calyxsoftware.com 

• Toll Free: 800-362-2599 

• Fax: 214-252-5650 

  

https://customers.calyxsoftware.com/bloglist/list/00p00000000001D00bz?kw=QM&retUrl=%2Faspx%2FHomeCustomer
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Product Support 

Table 2: Product Support 

Contact Supported Products 

Email: sales@calyxsoftware.com 

Call: 800-36-CALYX (800-362-2599) 

Press 1 

Point, PointCentral, WebCaster account 
subscription, Website activation 

Dedicated Customer Service 

Email: customerservice@calyxsoftware.com 

Call 800-34-CALYX (800-342-2599) 

Email Technical Support 

Inside Point, select Help > Email Technical Support to email technical support issues with a 
loan file. If enabled, the user can attach a loan file. A Save As button was added to save the 
loan file to the user’s desktop. 

 
Figure 1: Email Support 

Note: Auto sending the loan file automatically removes sensitive information (SSN, Account 
Numbers, etc…). 

  

mailto:sales@calyxsoftware.com


   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
29 

Chapter 2: ABOUT POINT 
The following sections contain important Point application information. 

Point File Encryption Levels 

The following list contains Point File encryption details: 

• Borrower and prospect files are compressed in a proprietary format but are not 
encrypted. 

• Emailed Point compressed files (.PCF) are encrypted with AES 256-bit. 

•  Emailed Point PDF files are encrypted with a 128-bit encryption level when 
password protected. 

• Most service interface vendors use 128-bit Secure Socket Layer for electronic 
document requests. 

Conventional Data Folder Storage 

The following list contains the conventional data folder storage details: 

• Data folders can contain approximately 1500 Borrower or prospect files. 

• Data folders should contain only two sub folders. 

• A Borrower sub-folder housing all Borrower file data. 

• A prospect sub-folder housing all prospect file data. 

Note: Data folders should contain only necessary configuration settings and index files, 
such as: Borrower.index (*.index, *.idx) (*.ini, *.usr, *.sec). 

Installation 

The following information applies only to users upgrading from Point version 7.2 or earlier. 

Point contains several fields that may cause data discrepancies if files are shared between 
versions. 

Data from fields in earlier versions transition to the new fields in the updated version when 
an existing loan file is opened for the first time. Problems can occur when an earlier Point 
version opens a file after the data was modified in a later version. 

Example: The calculations in some Point screens may not match if 9.6 loan file is opened 
after modified in 9.2. 

Note: All Point user in the organization should update to the latest version of Point as soon 
as possible after release to avoid confusion. 
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Operating Requirements 

Point is designed for use with standard computing systems (laptop and desktop 
computers). Calyx does not support Point installation on a tablet or convertible device 
(Surface, Chrome Book, and others), but some Point functionality is available on the devices. 

System Requirements 

The following system requirements are needed to install and use Point: 

Table 3: System Requirements 

Component Version 

Processor Speed 800 MHz (or higher) 

Memory (RAM) 2 GB minimum 

Disk space 

Point application: 300MB 

Microsoft .NET Framework®: up to 4.5 GB 

Electronic document storage: 20 MB per loan file (on 
average) 

Point software does not support multi-functional printers. Calyx provides limited customer 
support for multi-functional printer issues when used with Point. 

Software Requirements 

The following software is required for Point installation and use. 

Table 4: Software Requirements 

Component Version 

Operating System 

One of the following operating systems is required: 

• Microsoft Windows 10 

• Microsoft Server 2012 or higher 

Web browser Microsoft Edge® 

Microsoft .NET Framework Version 4.8 

Modem/Internet Connectivity 
Active Internet connection is required to install Point 
and access Internet enabled services in Point 
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Component Version 

Other 

Adobe Acrobat Reader© version 11, DC or later is 
required to open PDF files 

Microsoft Office® 2016 or 2019 

Note: Refer to the System Requirements on the Calyx Point Product page for more 
information about third-party product support. 

Install Point 

An email notification containing a link and instructions for installing Point is mailed to the 
end-user assigned a Point seat. The installation is completed per the settings in the 
assigned installation group. 

Note: The Point Administrator is installed, and the default templates and data folders are 
created If an installation group is not specified. 

1. Open the confirmation email from MyCalyx. 

2. Click the Installation link. 

3. Review and accept the Calyx Software License Agreement to proceed. 

4. Click the Install button. 
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Chapter 3: USER INTERFACE 
It is recommended that the User Interface (UI) section of this guide is reviewed prior to 
processing loans to obtain familiarity with the UI options. 

Loan Search Screen Overview 

Double-click the Point desktop icon to open the Loan Search screen. The Loan Search 
screen contains limited options until a loan is created or opened. 

 

Figure 2: Loan Search Screen 

  

D 

A 
B 
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The following sections provide an overview of the Loan Search screen options. 

Table 5: Loan Search Screen 

Screen Option Description 

A. Menu Bar Appears at the top of all Point screens. Menu bar 
options include: 

• File Menu: Provides options for opening and interacting with 
loan files. 

• Edit Menu: Provides basic editing options. 

• Utilities Menu: Provides utilities for interacting with Point and 
loan files. 

• Window Menu: Provides options for moving between Point 
windows. 

• Help Menu: Provides Help options. 

Note: Additional Menu options are available after 
creating or opening a loan. The additional menu 
options are specific to loan interaction. The options 
are discussed when relevant throughout the 
document. 

B. Tool Bar Limited to the following on the Loan Search screen: 

• File Icon: Provides options for opening a new loan. 

• Calculator Icon: Opens the desktop Calculator. 

• Cardex Database Icon: Opens the Cardex Database dialog. 

• Help File Icon: Opens the Help Files dialog. 

Note: Additional Tool bar options are available after 
creating or opening a loan. 

C. Navigation Panel Provides access to additional Point tabs, including: 

• Loans Tab 

• Pipelines Tab 

• Tasks Tab 

• Reports & Marketing Tab 

• Templates Tab 

Note: See Navigation Panel for additional information about the 
tabs. 

D. Loan Search Results Displays the currently selected item or search results 
after performing a search 

Navigation Panel 

The Navigation Panel is available on all Point screens. 
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1. Click the Navigation X to collapse the Navigation panel. 

 

Figure 3: Collapse Navigation Panel 

2. Click any tab to expand the collapsed Navigation Panel. 

 

Figure 4: Expand Navigation Panel 
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Loans Tab 

Use the Loans tab to access prospect and Borrower loan files in Point and import loan 
applications from Zip or WebCaster. 

The Loans tab provides access to Borrower and Loan screens after a loan is opened. The 
listed screen order changes as screens are selected. Point shuffles the order according to 
the most frequently used. Many of the screens are also accessible from the Forms menu 
and typically easier to find because the Forms menu is static. 

 

Figure 5: Loans Tab 

Note: Proceed to Create Loans to create new loans and work with existing loans. 

Data Folders 

Use the Data Folder dropdown list to select where to perform the search. The Primary Data 
Folder is the default data folder and is available immediately after installation. (See Manage 
Data Folders for additional details.) 

Standard Loan Search 

Set the loan search criteria to locate an existing loan. At least on criteria field must be 
completed to perform the loan search. 

1. Click the Loans tab. 

2. Select the Data Folder to be searched from the dropdown. (See Figure 5.) 

Note: The Primary Data Folder is the default data folder created during installation. See 
Manage Data Folders for creating additional folders. 

3. Select the Prospect or Borrower radio button to indicate the loan type to search. 

4. Use the Search By dropdowns to further refine the search criteria. 

5. Enter additional search criteria in the final field when required. 
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6. Click Search to view the Loan Search Results. 

 

Figure 6: Loan Search Results 

Advanced Loan Search 

Use the Advanced Search dialog to refine the search criteria and search in multiple data 
folders. 

1. Click the Loans tab. 

2. Click Advanced Search. (See Figure 5.) 
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3. Select the Data Folders to search. 

 

Figure 7: Advanced Search Dialog 

Note: Ctrl+Click multiple folders to include in the search. Click Select All to search all data 
folders. 

4. Select one or both radio buttons for loan type to search. 

5. Select the Search By criteria. 

6. Click Search to view the Loan Search Results. (See Figure 6.) 

List Co-Borrowers 

Use List Co-Borrowers option to search by Co-Borrowers in the selected data folder. 

1. Click the Loans tab. 

2. Select the appropriate Data Folder. (See Figure 5.) 
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3. Click List Co-Borrowers to retrieve the Co-Borrowers search results. 

 

Figure 8: Co-Borrowers Search Results 

Import from Zip/Webcaster 

See Import From for details on importing or copying and moving files. 

Loan Files 

The following sections provide information for moving and deleting existing loan files. 

Table 6: Loan File Options 

Option Description 

Add to Pipeline Click to add the selected loan to the 
pipeline 

New See Create Loans for details 

Open Click to open the selected loan 

Copy See Copy Loan Files for details 

Move See  

Move Loan Files for details 

Delete Click to delete the selected file. 
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Move Loan Files 

Manage loan files more efficiently by moving prospect and borrower files into data folders 
to create groupings. Lists do not have to be rebuilt when files are copied or moved. 

Note: See Copy Loan Files for details on copying external files to Point. 

1. Select the Loans tab from the Navigation panel. 

2. Perform a loan search. 

3. Select the file to move. 

4. Click the Move button. 

5. Select the Data Folder on the Move Borrower dialog. 

 

Figure 9: Move Borrower Dialog 

6. Select the appropriate As A radio button. 

7.  Select the Filename option. 

8. Click OK to complete the move process. 

9. Click Yes on the Move Confirmation. 
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Pipeline Tab 

Use the following steps to open a loan file from the Pipeline tab. 

Note:  The Pipeline options can be modified to change active loans displayed in the Pipeline 
List. 

1. Select the Pipeline tab. 

2. Click Refresh to update the Pipeline List. 

 

Figure 10: Pipeline List 

3. Select the appropriate loan from the list. 

4. Click Open to open the loan. 

Note: See Pipeline Management for pipeline details. 

Tasks Tab 

Use the Task tab to view and update tasks associated with a loan. 

Note: See Task Management to create and manage loan tasks. Associate tasks to a loan file 
to archive a permanent task record with the loan file. 

Use the following steps to locate and view a task. 

1. Select the Tasks tab. 
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2. Select the task status to search from the Search For dropdown. 

 

Figure 11: Task Search 

3. Select the folder to search from the In dropdown. 

4. Click Search. 

5. Double-click a task in the Search Results to open. 

 

Figure 12: Task Details Dialog 
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6. Update the Status if applicable. 

7. Enter Comments if applicable. 

8. Click Print to print the task. 

9. Click Save to save the updates. 

Note: See Create Tasks to open a new task. 

Reports & Marketing Tab 

The Reports & Marketing tab contains options for generating: 

• Reports 

• Mailing labels 

• Marketing material 

See Reports Management and Marketing Management for details. 

Templates Tab 

The Templates tab provides access to pre-created templates. 

1. Select the Templates tab. 

2. Select the appropriate Template Category radio button. 

 

Figure 13: Point Templates 

3. Double-click a template in the Template List to open a read only template copy. 

Note: See Template Management for details. 
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Shortcut Toolbar 

The Shortcut toolbar displays in the Navigation panel when a loan file is opened. The 
Shortcut toolbar contains quick access to select forms listed in other Point menus. 

The Shortcut toolbar is not available when a master template is created. The forms must be 
selected from the Forms menu to include in the template. Use the First Mtg and Second 
Mtg buttons to toggle between linked first and second mortgage files. These buttons are 
visible only after a second mortgage is linked to the first mortgage file. 

 

Figure 14: Shortcut Toolbar 
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Information Bar 

The Information bar is visible from any screen in an open loan file. The Information bar is 
divided into two sections: 

• Current Status 

• Loan Checklist 

 

Figure 15: Information Bar 

Minimize the information bar by clicking the X button at the top of the bar.  

Current Status 

The Current Status section includes important loan data such as: 

• Qualified Mortgage (QM) finding 
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• Loan status 

• First or second loan 

• Amount 

• Property address 

• Type and purpose 

• Payment 

• Note and Qual rates 

• Payment 

The Update Status button opens the Update Status dialog that imports loan information 
from the Status and Checklist screen. (See Figure 330.) 

Loan Checklist 

The Loan Checklist shows the status of document deliverables required for the loan. 

 This checklist tracks the following dates for each item: 

• Order Date 

• Due Date 

• Received Date 

• The first two checkboxes indicate if the item was ordered and received. 

Hover the mouse over a selected checkbox to display the date the item was completed. 

Double-click an item or click the Open Detail button to open an information dialog for the 
selected item. Use this dialog to update the item status. 

Information added or updated in this dialog automatically updates the corresponding 
tracking screen. 
 

 

Figure 16: Loan Checklist 

Note: See Track Loan Status for information about adding and updating items listed on the 
loan checklist and for information about the Status and Checklist screen. 
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Chapter 4: LOAN APPLICATIONS 
Point provides a set of files for prospects and a set of files for Borrowers. Use prospect files 
for potential customers and Borrower files for actual loans being processed. 

Prospect files contain most of the marketing tools, preliminary disclosures, and processing 
forms required. A prospect file is easily converted to a Borrower file after the prospect signs 
a Loan Application. Borrower files contain the forms required to process the loan from 
origination through to submission to the underwriter. 

Note: Point does not provide closing documents. Point does interface with vendors that 
provide the closing documents. 

Borrower files include the following not included in prospect files: 

• Verification Forms 

• Submission Forms 

• Transmittal Forms 

• Access to the Banker Screens 

• Additional tracking functions 

Entered data in one Point screen automatically populates the same field in other screens 
and forms.  

Create Loans 

Point offers multiple options for creating application loan files. The options include: 

Table 7: Loan Creation Options 

Create Loan Option Description 

Create from Blank File Create loan file from an empty Point screen 

Convert Prospect to Borrower File Create loan file from an existing prospect file 

Create from Template Create loan file from a Point loan template 

 
Duplicate Existing File Duplicate an existing loan file 

Rename Existing File Rename an existing loan file 

Create Co-Borrower File 
Create a Co-Borrower file from and existing 
prospect or loan application 

Note: Select a link in the above table to begin loan application creation. 
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Create from Blank File 

Use the following steps to create a prospect or borrower loan application. 

1. Select the Loans tab. 

2. Click New. (See Figure 5.) 

3. Select the New Blank File radio button. 

 

Figure 17: Create New Loan File Dialog 

4. Click OK. 

5. Proceed to Borrower Information Screen. 

Convert Prospect to Borrower File 

Use the following steps to convert a prospect file to a borrower file. 

Note: Classic URLA loan files cannot be converted to the New URLA format. 

1. Select the Loans tab. 

2. Click New. (See Figure 5.) 

3. Select the New File from Prospect radio button. (See Figure 17.) 

  



   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
48 

4. Click Search on the Search Loans dialog to locate the prospect file to convert. 

 

Figure 18: Search Loans Dialog 

5. Double-click loan from the Search Results to select. 

6. Click OK. 

7. Proceed to Borrower Information Screen. 

Create from Template 

Use the following steps to create the prospect or Borrower loan files. 

1. Follow Steps 1 – 2 in Create from Blank File to access the Create New Loan File dialog. 

2. Select the New File from Master Template radio button. (See Figure 17.) 

3. Click OK. 

4. Proceed to Borrower Information Screen. 
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Duplicate Existing File 

Three file naming conventions are available when duplicating an existing file: 

• Preserve: Retains the original file name 

• Auto Filename: Use the automatic file naming convention specified for the selected 
data folder 

• Manual Naming: Manually rename the file when prompted  

Use the following steps to duplicate an existing loan file. The duplicate file will remain in the 
save format as the original file. 

1. Click the Loans tab. 

2. Perform a search for the loan file to copy. (See Standard Loan Search.) 

3. Select the loan file to copy. 

 

Figure 19: Copy Loan File 

4. Click Copy. 

5. Select the appropriate Data Folder to store the copied loan file. 

 

Figure 20: Copy Borrower 
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6. Select the appropriate As a radio button. 

7. Select the appropriate Filename radio button: 

8. Select the Copy only 1003 data to start a new loan including Co-Borrowers to copy 
the loan file plus the following documents: 

• User-defined document requests 

• Due date calculations defined in the Document Requests section of the Status 
and Checklist screen. 

• The originator identified in the Borrower Information screen. 

• The processor identified in the Borrower Information screen. 

Note: The audit trail log is not copied with the loan data when the checkbox is selected. 
(See Audit Trail for details.) 

9. Click Yes on the Copy Confirmation dialog. 

Rename Existing File 

Use the steps in Duplicate Existing File to copy and rename an existing file. This option 
reuses existing information for repeat loans or second mortgages. 

Create Co-Borrower File 

Co-Borrower files are used for applicants who are not married to each other. A maximum of 
five Co-Borrowers are allowed per loan. Co-Borrower applications are saved under the 
primary Borrower file name with the .cb[X] extension. The X in the extension denotes the 
Co-Borrower number. 

Example: The extension for the first Co-Borrower on a loan is cb1, the second Co-Borrower, 
cb2, etc. 

1. Click the Loans tab. 

2. Perform a search for the loan file to copy. (See Standard Loan Search.) 
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3. Select Bor/Co-Bor menu. 

 

Figure 21: Bor/Co-Bor Menu 

4. Select the appropriate Co-Borrower Number. 

Note: See Add/Swap/Delete Borrowers & Co-Borrowers for additional information. 

Save Loan Files 

Use the following methods to save loan files. 

Opened Loan File 

Click Save to save open loan files. 

 

Figure 22: Save Open Files 

Files are saved in the following formats: 

Prospect Extension: .prs Location: c:\PNTDATA\Prospect\pointfile.prs 

Borrower Extension: .brw Location: c:\PNTDATA\Borrower\pointfile.brw 

Co-Borrower Extension: .cbx Location: c:\PNTDATA\Borrower\pointfile.cbx 
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Save File as a Point Compressed File 

Save data files in Point Compressed File (pcf) format to email as an attachment when the 
company email program does not communicate with Point (such as a web-based email 
account). 

1. Open the loan file to save. 

2. Select E-mail from the File menu. 

3. Select Point Data File. 

4. Enter the Email Password. 

 

Figure 23: Email Point Data File Dialog 

5. Click Save as PCF. 

6. Set the save location on the Save As dialog. 

7. Enter the filename. 

8. Click Save. 

Note: Send the file as an attachment from the email application. (See Email Data File for 
additional details.) 

Open Multiple Files 

Select the Keep Open checkbox in the workspace before opening another file to allow 
multiple loan files to be opened. 
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The new file opens to the Borrower Information screen without closing the open file. Switch 
between open files by selecting the file name from the list of open files in the Window 
menu. 

 

Figure 24: Keep File Open 

Borrower Information Screen 

The Borrower Information screen captures initial Borrower/Co-Borrower information and 
subject property details. 

Borrower/Co-Borrower Information 

Use the following steps to complete the Borrower/Bo-Borrower Information fields. 

1. Select Borrower Information from the Forms menu. 

2. Enter Borrower Name. 

 

Figure 25: Borrower/Co-Borrower Information 

3. Enter Borrower Social Security Number (SSN). 

4. Select Borrower Best contact method from the dropdown. 
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5. Enter Borrower Nickname if applicable. 

6. Complete Borrower Contact fields. 

7. Select the appropriate Borrower current address checkbox. 

8. Enter Borrower number of years at current location in the No of field. 

9. Enter Borrower Present Address information. 

If renting, select the Positive Rental History checkbox if applicable. The checkbox auto-
fills the same checkbox in the Loan Application section 1 screen. 

10. Select Copy from Borrower to copy the Borrower information to the Co-Borrower if 
applicable. 

11. Complete the remaining Co-Borrower fields if applicable. 

Subject Property Information 

Use the following steps to complete the Subject Property Information. 

1. Click Copy From Present Address when subject property is the Borrower current 
address. 

 

Figure 26: Subject Property Information 

Note:  Proceed to Credit Scores when subject property is Borrower current address. 

2. Complete the address information when subject property is not Borrower current 
address. 

3. Select the Unit option. 

4. Select the Mixed-Use Property option. 

5. Select the Manufactured Home option. 

6. Enter the subject property number of units. 

7. Select the Property Type. 
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Credit Scores 

 Use the following steps enter Borrower credit scores. 

1. Enter the Borrower Experian/FICO score. 

 

Figure 27: Credit Scores 

2. Enter the Borrower TransUnion/Emprica score. 

3. Enter the Borrower Equifax/BEACON score. 

4. Enter the Minimum FICO score required. 

5. Repeat Steps 1 – 4 for Co-Borrower if applicable. 

Loan Summary 

Complete the following Loan Summary information. 

Loan Program & Closing Costs 

Use the following steps to complete the loan program, closing costs, and loan originator 
information. 

1. Click Loan Program. 

 

Figure 28: Loan Summary 
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2. Select the Loan Program from the Loan Programs dialog. 

  

Figure 29: Loan Programs Dialog 

3. Click OK. 

4. Select CC Scenario. 

Note: The CC Scenario dialog displays the options for which entity is responsible to pay the 
property closing costs. 

5. Select the appropriate Closing Cost Scenario on the CC Scenario dialog. 

 

 Figure 30: CC Scenario Dialog 

6. Click OK. 

7. Select loan Originator from the dropdown. (See Figure 28.) 

8. Select loan Processor from the dropdown. 
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Property Details 

Complete the following property details. The Purchase option is selected by default. (See 
Figure 28.) 

1. Select the Construction checkbox if the loan is for construction costs.  

2. Select the Refinance checkbox if applicable. 

Note: The Purchase checkbox is unselected when Refinance is selected. 

3. Select the appropriate Cash-Out radio button when selecting Refinance. 

4. Enter Descriptions when selecting Other purchase option. 

Loan Details 

Use the following steps to enter loan summary information. (See Figure 28.) 

1. Select the appropriate Loan Type checkbox. 

2. Select the appropriate loan Primary, Secondary, or Investment option. 

3. Enter Gross Rent when Investment is selected. 

4. Enter the occupancy percentage in the in the Occ Rate field when Investment is 
selected. 

5. Select the appropriate Mortgage option. 

Loan Terms 

Use the following steps to enter loan terms information. (See Figure 28.) 

1. Enter the loan interest rate in the Note Rate field. 

2. Complete the Terms/Due fields. 

3. Enter the property appraisal value in the Appr Value field. 

4. Click the LTV link to calculate the loan to value percentage. 

5. Enter the property Sales Price. 

6. Click the CLTV link to calculate the combined loan to value percentage. 

7. Enter the down payment percentage in the Down Pmt field. 

8. Click the Top link to calculate the top payment-to-income ratio. 

9. Click the Bottom link to calculate the bottom debt-to-income ratio. 

10. Click the FHA Max Loan button to determine the maximum FHA loan amount. 
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Income Details 

Enter Borrower/Co-Borrower income information. 

Note: The fields populate automatically from Loan Application Section 1. 

1. Click Base Inc. 

 

Figure 31: Income Details 

2. Select the Borrower Period from the dropdown. 

 

Figure 32: Monthly Income Calculator Dialog 

3. Enter the income Amount. 

4. Repeat Steps 2 – 3 for the Co-Borrower. 

5. Click OK to populate the Income Details Base Income fields. 

6. Complete remaining Income fields for Borrower/Co-Borrower. (See Figure 31.) 
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Other Obligations 

Use the Other Obligations fields to enter Borrower/Co-Borrower liabilities not listed on the 
Liabilities screen. 

1. List the Obligations. 

 

Figure 33: Other Obligations 

2. Enter the obligation Cost. 

3. Select the Neg Cash Flow checkbox when the Borrower/Co-Borrower has a negative 
cash flow. 

4. Enter the payment amount for Subj Prop. 

5. Enter the payment amount for Other Prop. 

Monthly Payments for Present Housing 

Complete the Monthly Payments for Present Housing details. 

Add Monthly Payments 

Use the following steps to add monthly payments. 

1. Click the Monthly Payments for Present Housing Add button. 

 

Figure 34: Monthly Payments for Present Housing 
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2. Select the payment Description on the Present Housing Monthly Payment dialog. 

 

Figure 35: Present Housing Monthly Payment 

3. Enter the amount for the Monthly Payment. 

4. Click Save & Close. 

Note: Click Save & New to add another monthly payment. 

Edit Monthly Payments 

Use the following steps to edit a listed monthly payment. 

1. Select the monthly payment to edit. (See Figure 34.) 

2. Click Edit. 

3. Update the information on the Present Housing Monthly Payment dialog. (See Figure 
35.) 

4. Click Save & Close. 

Delete Monthly Payments 

Use the following steps to delete monthly payments. 

1. Select the monthly payment to delete. (See Figure 34.) 

2. Click Delete. 

Proposed Monthly Payment for Property 

Complete the Proposed Monthly Payments for Property. 

Add Proposed Monthly Payment 

Use the following steps to add proposed monthly payments. 

1. Click the Monthly Payments for Present Housing Add button. (See Figure 34.) 
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2. Select the payment Description on the Proposed Monthly Payment dialog. 

 

Figure 36: Proposed Monthly Payment Dialog 

3. Enter the amount for the Monthly Payment. 

4. Click Save & Close. 

Note: Click Save & New to add another monthly payment. 

Edit Proposed Monthly Payment 

Use the following steps to edit listed proposed monthly payments. 

1. Select the monthly payment to edit. (See Figure 34.) 

2. Click Edit. 

3. Update the information on the Proposed Monthly Payment dialog. (See Figure 36.) 

4. Click Save & Close. 

Delete Proposed Monthly Payment 

Use the following steps to delete proposed monthly payments. 

1. Select the monthly payment to delete. (See Figure 34.) 

2. Click Delete. 

Borrower Information Screen Buttons 

The Borrower Information screen contains buttons for additional Borrower/Co-Borrower 
information. 

Personal Information 

Use the Personal Information button to capture personal information for the Borrower. 

1. Select the Personal Info button. 
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2. Enter Borrower Interests. 

 

Figure 37: Personal Information Dialog 

3. Enter Co-Borrower Interests. 

4. Enter Borrower/Co-Borrower Children’s Information. 

5. Select the Parent(s) from the dropdown. 

6. Click OK. 

Contact Info 

Use the Contact Info button to access the Contact Information dialog for capturing 
Borrower conversations or potential leads. 

1. Select the Contact Info button. 
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2. Select the appropriate Rating radio button to rate the conversation. 

 

Figure 38:Contact Information Dialog 

3. Enter the Contact Date. 

4. Enter the Contact Time. 

5. Enter a Memo about the contact. 

6. Click Done. 

7. Complete the Referral Source field to track referrals. 

8. Complete the Lead ID field to track the lead. 

9. Enter applicable Comments. 

10. Click OK. 

Mtg Insurance 

Enter mortgage insurance information on the Mtg Insurance tab if not completed on the 
Borrower Information screen. The information is populated into the Mortgage Insurance 
fields in the forms throughout the loan file. 

1. Click the Mtg Insurance button. 
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2. Complete the Up-From Mortgage Insurance Premium information if the mortgage 
insurance policy requires payment to the escrow account in advance. 

 

Figure 39: PMI/MIP/FF/USDA Dialog 

3. Complete the Up-Front Mortgage Insurance Premium Funding Fee section if the 
mortgage insurance policy requires payment to the escrow account in advance. 

Note: The Base Loan Amount field is automatically populated if previously entered in the 
Borrower Information screen or Loan Application. 

4. Click the FHA Max Ln button to calculate the maximum loan amount that is allowed. 

5. Click Yes in response to the prompt to copy the maximum loan amount to the Loan 
Amount field in the Borrower Information screen. 

Note: The FHA Max Ln button is enabled only when both the FHA and Purchase 
checkboxes are selected in the Loan Type and Purpose of Loan sections on the Borrower 
Information screen. 

6. Enter the mortgage insurance premium in the MIP, FF, PMI, USDA field or select a 
predefined value from the dropdown. 
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7. Press the Tab key to populate the calculated fields. 

8. Enter the cash amount in the Amount Paid in Cash field if part or all of the fee will be 
paid in cash. 

Note: The Up-Front MIP/Funding Fee Financed and Loan Amount with Up-Front 
MIP/Funding Fee fields are automatically populated. 

9. Select an option from the Refundable Type dropdown to if the mortgage insurance is 
refundable. 

10. Select the mortgage insurance rate for the initial period from the PMI/MIP/VA/USDA 
dropdown. 

Note: Click the Lock to enable the Monthly Amount field to manually enter the value. 

11. Enter the number of months that the initial rate is effective in the mths field. 

Note: The amount is calculated and automatically populated in the following areas: 

• Proposed Monthly Housing Expenses section on page 2 of the Loan Application. 

• Mortgage Insurance field on the Truth-in-Lending Disclosure. 

• Line 1002 of the Good Faith Estimate 

12. Select the renewal rate from the PMI Renewal 1 the PMI Renewal 2 (if applicable) 
dropdowns if the mortgage insurance rate changes after the initial period. 

13. Enter the number of months that the renewal rate is effective in the mths field. 

Note: The resulting amount populates the second Mortgage Insurance field on the Truth-
in-Lending Disclosure. 

14. Select the appropriate option from the Calculate Based On dropdown: 

• Select Appraisal Val to calculate the premium based on the appraised value of the 
property. 

• Select Loan Amount to calculate the premium based on the loan amount. 

• Select Sales Price to calculate the premium based on the sale price of the property. 

15. Enter 78% in the Cancel at ___% field for monthly mortgage insurance. 

Note: The mortgage insurance amount is removed from the payment schedule after the 
loan-to-value ratio reaches 78% and the borrower has paid the annual mortgage premium 
for at least five years when the Calculate button is clicked in the Truth-in-Lending 
Disclosure. 

16. Select the Calculate based on remaining balance checkbox to calculate the 
insurance based on the balance of the loan. 

Note: The calculation averages the loan balance every 12 months and averages the 
mortgage insurance premium in the Truth-in-Lending payment schedule. 
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17. Select the Midpoint payment cancellation checkbox to cancel the insurance halfway 
through the mortgage term. 

18. Click OK. 

Sub Financing 

Use the Sub Financing button to capture the subordinate financing information. 

Note: See Subordinate Financing for additional information. 

Construction 

Use the Construction button to capture construction information if applicable. 

1. Click Construction. 

2. Enter the construction Period in months or days. 

 

Figure 40: Construction Dialog 

3. Click the Calendar button to enter the construction dates if known. 

 

Figure 41: Construction Calendar  

4. Click Ok. 

QM Button 

The QM tab opens the Qualified Mortgage Reporting interface. This function sends data from 
the current loan to Loan Scorecard to evaluate the loan according to QM standards and 
returns a report. 
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Loan Application Screens 

The Point User Guide discusses the New URLA loan application screens. 

The New Loan Application screens follow the New 1003 Loan Application sections. 

Loan Application Section 1 

Complete the Loan Application Section 1 details. Use the bottom tabs to move through the 
remaining loan application sections. 

Personal Information 

Use the following steps to complete Borrower/Co-Borrower Personal Information. 

1. Enter the Lender Case No. 

 

Figure 42: Section 1 Personal Info 

2. Enter the Agency Case No. 

3. Enter the Legal Entity Identifier (LEI). 
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4. Enter the Universal Loan Identifier (ULI). 

Note: The Universal Loan Identifier (ULI) is a combination of the LEI along with a unique 23-
digit number identifying a particular loan that is auto populated. If needed, click on the 
lockbox icon to enable editing for the Universal Loan Identifier (ULI) field. Leaving the 
lockbox unselected will allow the field to auto-calculate. 

5. Review the Borrower Personal Information. 

6. Select the Borrower Citizenship status from the dropdown. 

7. Repeat Steps 5 – 6 for Co-Borrower. 

Alternative Names and Contact Information 

Enter alternate names and contact information for the Borrower/Co-Borrower. 

Add Alternate Names 

Use the following steps to add Borrower alternate names. 

1. Click Add. (See Figure 42.) 

2. Enter Borrower Alternate Name information. 

 

Figure 43: Edit Alternate Names Dialog 

3. Click Save & Close. 

Note: Click Save & New to add another alternate name. 

4. Repeat Steps 1 – 3 for additional Borrower alternate names.  

5. Repeat Steps 1 – 4 Co-Borrower. 

6. Enter Borrower Work Phone if applicable. 

7. Enter Borrower E-mail. 

8. Repeat Steps 6 – 7 for Co-Borrower 

9. Click the Total Number of Borrowers Lock and add the total number of Borrowers 
when greater than 2. 
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Edit Alternate Names 

Use the following steps to edit alternate names. 

1. Select the Alternate Name to edit. 

 

Figure 44: Edit Alternate Name 

2. Click Edit. 

3. Update the alternate name on the Edit Alternate Names dialog. (See Figure 43.) 

4. Click OK. 

Insert Alternate Name 

Use the following steps to insert an alternate name at a selected table location. 

1. Select the location to insert the name. (See Figure 44.) 

2. Click Insert. 

3. Enter the Alternate Name information on the Edit Alternate Names dialog. (See 
Figure 43.) 

4. Click OK. 

Delete Alternate Name 

Use the following steps to delete an alternate name. 

1. Select the Alternate Name to delete. (See Figure 44.) 

2. Click Delete. 
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Marital Status & Current Address 

Complete the Marital Status fields for Borrower/Co-Borrower. 

1. Select the appropriate Borrower Marital Status checkbox. 

 

Figure 45: Section 1 Marital Status 

2. Enter number of Dependents. 

3. Enter the Dependents Age(s). 

4. Select the appropriate Unmarried checkboxes. 

5. Repeat Steps 1 – 4 for Co-Borrower. 

6. Verify Borrower Current Address information. 

If renting, select the Positive Rental History checkbox if applicable. The checkbox 
auto-fills if the same checkbox is selected in the Borrower information screen. 

7. Verify Co-Borrower Current Address information. 

Former Addresses 

Seven years of former addresses for all borrowers are required. 
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Add Former Address 

Use the following steps to add former address information. 

1. Click Add. 

 

Figure 46: Section 1 Former Addresses 

2. Select the Address Type from the dropdown on the Edit Address dialog. 

 

Figure 47: Edit Address Dialog 

3. Enter Address Details. 

4. Select the No primary housing exp checkbox if applicable. 

5. Select the Rent or Own checkbox. 

6. Enter Number of Years and Months. 

7. Enter Rent/Mortgage Amount. 
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8. Click Save & Close. 

Note: Click Save & New to add another address. 

9. Repeat Steps 1 – 8 for Co-Borrower. 

10. Complete the Mailing Address if different from Current Address. (See Figure 46.) 

11. Select the appropriate Borrower/Co-Borrower Language Preferences. 

Edit Former Address 

Use the following steps to edit a former address. 

1. Select the Former Address to edit. 

 

Figure 48: Edit Former Address 

2. Click Edit. 

3. Update the former address on the Edit Address dialog. (See Figure 47.) 

4. Click Save and New. 

Insert Former Address 

Use the following steps to insert Former Address at a selected table location. 

1. Select the location to insert the name. (See Figure 48.) 

2. Click Insert. 

3. Enter the Former Address information on the Edit Address dialog. (See Figure 47.) 

4. Click OK. 

Delete Former Address 

Use the following steps to delete a former address. 

1. Select the Former Address to delete. (See Figure 48.) 

2. Click Delete. 
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Employment/Self Employment 

Complete the Borrower/Co-Borrower Employment/Self Employment fields. The 
information populates the VOE form. (See Verification of Employment (VOE). 

Point imports the employment information from the received Verification of Employment 
when Populate Employment is selected on the Verification of Employment screen. 

Note: Leave this section blank to allow the Verification of Employment results to 
automatically populate the fields. 

Current Employer 

Use the following steps to enter current employment. 

1. Select the Borrower Employment Status Type from the dropdown. 

 

Figure 49: Section 1 Employment 

2. Select the Primary checkbox if listed employment is primary employment. 

3. Enter Employer Name. 

4. If an Employer has any aliases, select the Aliases button. 

5. Enter aliases. 

 
Figure 50: Aliases 
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6. Click OK in the Aliases dialog. 

7. Enter employer Address Information. 

8. Enter Borrower Position. 

9. Enter employer Phone. 

10. Enter employment Start date. 

11. Enter employment End date if applicable. 

12. Enter Years/Months for length of time in line of work. 

13. Enter Years at current employer. 

14. Select the appropriate Income Type from the dropdown. 

 

Figure 51: Edit Employment Income Dialog 

15. Enter Monthly Income. 

16. Click Save & Close. 

Note: Click Save & New to add another Income Type. 

17. Select the appropriate Income checkboxes. (See Figure 49.) 

 
Figure 52: Income Type Options 

Former Employers 

Use the following steps to complete the former employer details. 
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1. Click New to add another employer. 

2. Repeat Steps 1 – 13 above to cover two-years work history. 

Insert Employer 

Use the following steps to insert an employer at a specific table location. 

1. Click Show All (See Figure 49). 

2. Select the location to insert the employer. 

 

Figure 53: List of Employers Dialog 

3. Click OK. 

4. Repeat Steps 1 – 2 in Former Employers. 

Delete Employer 

Use the following steps to remove a former employer. 

1. Click Show All. (See Figure 54.) 

2. Select the employer to delete. (See Figure 53.) 

3. Click OK. 

4. Click Delete. (See Figure 54.) 

Enter Income Type 

Use the following steps to enter a new income type for a selected employer. 

1. Click Show All. (See Figure 54.) 

2. Select the employer to add income. (See Figure 53.) 

3. Click New. (See Figure 54.) 
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4. Complete the Edit Employment dialog information. (See Figure 51.) 

5. Click Save & Close. 

Edit Income Type 

Use the following steps to edit income type for a selected employer. 

1. Click Show All. (See Figure 54.) 

2. Select the employer to edit income. (See Figure 53.) 

3. Click OK. 

4. Click Edit. (See Figure 54.) 

5. Complete the Edit Employment dialog information. (See Figure 51.) 

6. Click Save & Close. 

Delete Income Type 

Use the following steps to delete income type for a selected employer. 

1. Click Show All. (See Figure 54.) 

2. Select the employer to delete income. (See Figure 53.) 

3. Click OK. 

4. Click Delete. (See Figure 54.) 

1e. Income from Other Sources 

Complete the Income from Other Sources information if applicable. 

Add Income from Other Sources 

1. Click the Add button. 

 

Figure 54: Income from Other Sources 
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2. Select the appropriate Income Type from the dropdown. 

 

Figure 55: Edit Other Income 

3. Enter the Monthly Income. 

4. Click Save & Close. 

Note: Click Save & New to add another Income Type. 

5. Repeat Steps 1 – 4 for Co-Borrower. 

Edit Other Income 

Use the following steps to edit a former address. 

1. Select which Income Type to edit. 

 

Figure 56: Add Income Sources 

2. Click Add. 

3. Update the Income Information on the Edit Other Income dialog. (See Figure 55.) 

4. Click Save and New. 
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Insert Other Income 

Use the following steps to insert Other Income at a selected table location. 

1. Select the location to insert the Other Income. (See Figure 56.) 

2. Click Insert. 

3. Enter the Income Information on the Edit Other Income dialog. (See Figure 55.) 

4. Click OK. 

Delete Other Income 

Use the following steps to delete a listed Other Income. 

1. Select the Income to delete. (See Figure 56.) 

2. Click Delete. 

Loan Application Section 2 & 3 

Complete the Loan Application Section 2 & 3 details. 

VOA Buttons 

Use the Verification of Assets (VOA) buttons to verify and import assets to the 2a. Assets 
table. 

• View VOA: Click to view the Verification of Assets Report 

• Update VOA: Click to import the Verification of Assets Report information into the 2a. 
Assets table. 

Note: The VOA import overwrites the table contents when results are different than listed 
Values. 

• Retrieve VOA: Click to retrieve the Verification of Assets Report after entering the 2a. 
Assets table account information. 

• Remove VOA: Click to remove the imported Verification of Assets Report results. 

2a. Assets 

Enter bank accounts, retirement accounts, and other similar accounts in the 2a. Assets 
table. 
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Add Assets 

Use the following steps to add assets to the 2a. Assets table. 

1. Click the New button. 

 

Figure 57: Add Assets 

2. Enter the company information. 

Note: Click the folder icon inside the Company field to use the Cardex Database. 

 

Figure 58: Edit Asset Dialog 

3. Select the Account Type. 

4. Enter the Account Number. 

5. Enter the Account Funds. 

6. Click Save & Close. 

Note: Click Save & New to add an additional account. 

Edit Assets 

Use the following steps to edit assets listed in the 2a. Assets table. 

1. Select the Account to edit. (See Figure 57.) 
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2. Update the information appropriate on the Edit Asset dialog. (See Figure 58.) 

3. Click Save & Close. 

Insert Assets 

Use the following steps to enter an asset at a specific 2a. Assets table location. 

1. Select the table row to add the asset. (See Figure 57.) 

2. Click Insert. 

3. Update the information appropriate on the Edit Asset dialog. (See Figure 58.) 

4. Click Save & Close. 

Delete Assets 

Use the following steps to remove an asset from the 2a. Assets table. 

1. Select the Account to delete. (See Figure 57.) 

2. Click Delete. 

2b. Other Assets 

Enter other asset types in the 2b. Other Assets table. 

Add Other Assets 

Use the following steps to add Other Assets on the 2b. Other Assets table. 

1. Click the New button. 

 

Figure 59: Add Other Assets 
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2. Select the Account Type. 

 

Figure 60: Edit Asset Dialog 

3. Enter the Account Funds. 

4. Select the applicable Liquid Asset checkbox. 

5. Click Save & Close. 

Note: Click Save & New to add an additional asset. 

Edit Other Assets 

Use the following steps to edit assets listed in the 2b. Other Assets table. 

1. Select the Account to edit. (See Figure 59.) 

2. Update the information appropriate on the Edit Asset dialog. (See Figure 60.) 

3. Click Save & Close. 

Insert Other Assets 

Use the following steps to enter an asset at a specific 2b. Other Assets table location. 

1. Select the table row to add the asset. (See Figure 59.) 

2. Click Insert. 

3. Update the information appropriate on the Edit Asset dialog. (See Figure 60.) 

4. Click Save & Close. 

Delete Assets 

Use the following steps to remove an asset from the 2b. Other Assets table. 

3. Select the Account to delete. (See Figure 59.) 

4. Click Delete. 

2b. Other Assets - Credits 

Enter other asset types in the 2b. Other Assets - Credits table. 
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Add Other Assets - Credits 

Use the following steps to add Other Assets on the 2b. Other Assets - Credits table. 

1. Click the New button. 

 

Figure 61: Add Other Assets - Credits 

2. Select the Account Type. 

 

Figure 62: Edit Other Credits Dialog 

3. Select the Source. 

4. Enter the Amount. 

5. Click Save & Close. 

Note: Click Save & New to add an additional asset. 

Edit Other Assets - Credits 

Use the following steps to edit assets listed in the 2b. Other Assets - Credits table. 

1. Select the Account to edit. (See Figure 61.) 

2. Update the information appropriate on the Edit Asset dialog. (See Figure 62.) 

3. Click Save & Close. 

Insert Other Assets 

Use the following steps to enter an asset at a specific 2b. Other Assets - Credits table 
location. 
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1. Select the table row to add the asset. (See Figure 61.) 

2. Click Insert. 

3. Update the information appropriate on the Edit Asset dialog. (See Figure 62.) 

4. Click Save & Close. 

Delete Other Assets 

Use the following steps to remove an asset from the 2b. Other Assets - Credits table. 

1. Select the Account to delete. (See Figure 61.) 

2. Click Delete. 

Request Credit 

Click the Request Credit button to submit a Credit Report request. (See Credit Reports for 
details.) 

View Credit 

Click View Credit to view the returned Credit Report. 

Populate Liabilities 

Click Populate Liabilities to populate the 2c. Liabilities table with the Credit Report 
information. 

Note: Enter information on 2c. Liabilities table is overwritten with imported Credit Report 
information. 

2c. Liabilities Table 

Enter additional liabilities into the 2c. Liabilities table. Include other property mortgages in 
the 2c. Liabilities table. 

Note: Other Obligations from the Borrower Information screen are automatically pre-filled. 
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Add Liabilities 

Use the following steps to add liabilities to the 2c. Liabilities table. 

1. Click the New button. 

 

Figure 63: Add Liabilities 

2. Enter the company information. 

Note: Click on the folder icon in the Company field to use the Cardex Database. 

 

Figure 64: Edit Liability Dialog 

3. Enter account information. 

4. Select Mortgage Type if applicable. 

5. Enter Credit Limit if applicable. 

6. Enter Balance and Months Left. 

7. Enter Payoff Amount. 

8. Select the appropriate checkboxes. 
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9. Click Save & Close. 

Note: Click Save & New to add another account. 

Edit Liabilities 

Use the following steps to edit assets listed in the 2c. Liabilities table. 

1. Select the Liability to edit. (See Figure 63.) 

2. Update the information appropriate on the Edit Liability dialog. (See Figure 64.) 

3. Click Save & Close. 

Insert Other Assets 

Use the following steps to enter an asset at a specific 2c. Liabilities table location. 

5. Select the table row to add the asset. (See Figure 63.) 

6. Click Insert. 

7. Update the information appropriate on the Edit Asset dialog. (See Figure 64.) 

8. Click Save & Close. 

Delete Assets 

Use the following steps to remove an asset from the 2c. Liabilities table. 

1. Select the Account to delete. (See Figure 63.) 

2. Click Delete. 

2d. Other Liabilities 

1. Enter other liabilities in the Table 2d Other Liabilities table. 

2. Click the New button  

3. Select the Borrower. 

 

Figure 65: Edit Other Liability Dialog 
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4. Select the Account Type. 

5. Enter the Payment amount. 

6. Enter Months Left. 

7. Click Omitted to omit from the liabilities. 

8. Click Save & Close. 

Note: Click Save & New to add another account. 

Table 3a Property You Own 

Enter owned properties in the 3a Property You Own table. 

Note: Owned properties are listed in table 2c Liabilities. 

1. Enter Occupancy Rate. 

 

Figure 66: Loan Section 2 & 3 Additional Property 

2. Click New. 

 

Figure 67: Edit REO Dialog 

3. Select the Subject Property checkbox if the entry is the property being bought. 

4. Enter property address. 

5. Enter No of Units if applicable. 

6. Enter Property Value. 

7. Select Status. 
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8. Select Intended Occupancy. 

9. Enter Ins/Tax/Assoc Fees. 

10. Select the Omitted checkbox if applicable. 

11. Select Current Occupancy. 

12. Select the appropriate Condominium/Cooperative checkbox if applicable. 

13. Enter Rental Income. 

14. Click Save & Close. 

Note: Click Save & New to add additional REO. 

Match with Liability 

Match properties list on the 3a Property You Own table with the applicable mortgage listed 
in the 2c. Liabilities table. 

1. Click Match with Liabilities. 

2. Select the matching liability. 

 

Figure 68: Match Liabilities and REO Dialog 

3. Click Match. 
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Loan Application Section 4 

Complete the Loan Application Section 4 details. 

Loan and Property Information/Subject Property 

Complete the non-populated loan and property information fields as applicable. 

Note: Some fields are already populated from other screens. 

1. Review the populated information and enter missing details if applicable. 

 

Figure 69: Loan Section 4 Subject Property 

2. Click Copy From Present Address to populate the Subject Property fields with 
current address information if applicable. 

3. Select the appropriate Mixed-Use Property option if applicable. 

4. Select the appropriate Manufactured Home option if applicable. 

5. Enter the property Legal Description. 

4b. Other New Mortgage Loans 

Complete the 4b. Other New Mortgage Loans table with other new mortgages taken out 
on the property. 
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Add Other New Mortgage 

1. Click the Add button. 

 

Figure 70: Other New Mortgages 

2. Enter the Creditor. 

 

Figure 71: Edit Other New Mortgage Loans Dialog 

3. Enter Loan Amount. 

4. Select the appropriate Lien. 

5. Enter Note Rate. 

6. Enter Credit Limit. 

7. Enter Term/Date. 

8. Select the appropriate checkbox. 

9. Select the Source of Funds. 

10. Enter a Qual Rate (Qualifying Rate). 

11. Check the Qualify Ratios checkbox if needed. 

12. Enter Interest Only Mths (Months). 

13. Click Save & Close. 

Note: Click Save & New to add another account. 
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Edit Other New Mortgage 

Use the following steps to edit assets listed in the 4b. Other New Mortgage Loans table. 

1. Select the Mortgage to edit. (See Figure 70.) 

2. Update the information appropriate on the Edit Other Mortgage Loans dialog. (See 
Figure 71.) 

3. Click Save & Close. 

Insert Other New Mortgage 

Use the following steps to enter an asset at a specific 4b. Other New Mortgage Loans table 
location. 

1. Select the table row to add the mortgage. (See Figure 70.) 

2. Click Insert. 

3. Update the information appropriate on the Edit Other Mortgage Loans dialog. (See 
Figure 71.) 

4. Click Save & Close. 

Delete Other New Mortgage 

Use the following steps to remove an asset from the 4b. Other New Mortgage Loans table. 

1. Select the Mortgage to delete. (See Figure 70.) 

2. Click Delete. 

Property Rental Income 

Complete the Rental Income for the property if applicable. 

1. Enter the average occupancy rate in the Occ Rate field. (See Figure 70.) 

 

Figure 72: Property Rental Income 

2. Enter the Rental Income. 

Note: Point calculates the Net Rent after saving the loan file. 
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Gifts and Grants 

Complete the 4d. Gifts or Grants table with gifts or grants being applied to the purchase. 

Add Gifts/Grants 

 Use the following steps to add Gifts or Grants. 

1. Click the Add button. 

 

Figure 73: Gifts/Grants 

2. Select the Type of Gift. 

 

Figure 74: Edit Gift or Grants Dialog 

3. Select the Source. 

4. Enter the Cash Value. 

5. Select the appropriate Deposited checkbox. 

6. Click Save & Close. 

Note: Click Save & New to add another account. 

Edit Gift/Grant 

Use the following steps to edit gifts or grants listed on 4d. Gifts or Grants table. 

1. Select the Gift/Grant to edit. (See Figure 73.) 
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2. Update the information appropriate on the Edit Gift or Grants dialog. (See Figure 74.) 

3. Click Save & Close. 

Insert Gift/Grant 

Use the following steps to enter gifts or grants at a specific 4d. Gifts or Grants table 
location. 

1. Select the table row to add the gift/grant. (See Figure 73.) 

2. Click Insert. 

3. Update the information appropriate on the Edit Gift or Grants dialog. (See Figure 74.) 

4. Click Save & Close. 

Delete Gift/Grant 

Use the following steps to remove gifts or grants from the 4d. Gifts or Grants table. 

1. Select the Gift/Grant to delete. (See Figure 73.) 

2. Click Delete. 

Loan Application Section 5 

1. Complete the questionnaire displayed on the Loan Application Section 5 screen. 

2. Proceed to Loan Application Section 7 & 8. 

Loan Application Section 7 & 8 

Complete Section 7 and Section 8 fields. 

1. Complete the Borrower Military Service Information if applicable. 

 

Figure 75: Military Service 
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2. Complete the Borrower Demographic Information. 

 

Figure 76: Demographic Information 

3. Complete the Borrower Information was Taken in Person fields. 

4. Answer the remaining questions. 

5. Repeat Steps 1 – 4 for the Co-Borrower. 

Loan Application Section 9 

Use the following steps to enter Loan Originator information. 

1. Select Originator from the dropdown. 

 

Figure 77: Loan Originator Information 

2. Enter Loan Originator NMLS # if required. 

3. Enter Loan Originator License # if required. 

4. Enter the Loan Originator contact information. 
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5. Enter the Borrower/Co-Borrower Interview Date. 

6. Enter the Borrower/Co-Borrower Signature Date(s). 

7. Click Continuation Sheet and enter additional loan or Borrower/Co-Borrower 
information when required. 

8. Click QM to open the Qualified Mortgage Reporting interface. (See QM Button.) 

Lender Loan Information – 1 

The Lender Loan Information – 1 screen contains a summary of information captured while 
completing the Loan Application Section screens. Review the screen and verify all required 
information is completed. 

1. Review the L1 Property and Loan Information section. 

2. Update existing information or add missing information as required. 

3. Review the L2 Title Information section. 

4. Update existing information or add missing information as required. 

5. Review the L3 Mortgage Loan Information section. 

6. Update existing information or add missing information as required. 
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Lender Loan Information – 2 

The Lender Loan Information – 2 screen contains a summary of information captured while 
completing the Loan Application Section screens. Review the screen and verify all required 
information is completed. 

 
Figure 78: Lender Loan Information - 2 

1. Review Due From Borrowers section. 

2. Update existing information or add missing information as required. 

3. Review the Total Credits section. 

4. If needed, click on the L. Seller Credits button to edit the amount of seller credits. 

 
Figure 79: Seller Credits 
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5. If needed, click on the Lender Credits button. 

6. Select the Copy as Lender Credit to 1003 checkbox if applicable. 

 
Figure 80: Lender Credits 

7. Click Ok. 

8. Update existing information or add missing information as required. 

9. Update Homeownership Education and Housing Counseling section. 

10. Update existing information or add missing information as required. 

Add/Swap/Delete Borrowers & Co-Borrowers 

Point provides functions for adding and deleting non-married borrowers and co-borrowers. 
The functions include adding and deleting borrower sets. 

Add Non-Married Co-Borrower 

Use the following steps to add a non-married co-borrower to the loan. 

1. Select Co-Borrower 1 from the Bor/Co-Bor menu. 

 

Figure 81: Add Non-Married Co-Borrower 

2. Complete the loan screens for the co-borrower. 
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Swap Married Borrower & Co-Borrower 

Only borrower and co-borrower in the primary borrower set can be swapped. This swap 
moves the loan information that is specific to each applicant during the swap. 

Note: Only borrower and co-borrower in the primary set can be swapped. 

1. Select Swap or Delete from the Bor/Co-Bor menu. 

2. Click the first Swap button. 

 

Figure 82: Swap Married Borrower & Co-Borrower 

Swap Borrower & Co-Borrower File 

Use the following steps to swap loan files between the unmarried borrowers and co-
borrowers. This swap moves the complete loan file during the swap. 

1. Select Swap or Delete from the Bor/Co-Bor menu. 
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2. Select the Borrower File to swap from the first dropdown. 

 

Figure 83: Swap Borrower & Co-Borrower File 

3. Select the Co-Borrower File to swap from the second dropdown. 

4. Click Swap. 

Merge Borrower into Co-Borrower Position 

Use the Merge option to move a borrower from one borrower set to a co-borrower position 
in another borrower set when the loan the borrower is moved from also has a co-borrower. 

1. Select Swap or Delete from the Bor/Co-Bor menu. 
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2. Select the co-borrower position to move the borrower on the To dropdown. 

 

Figure 84: Merge Borrower to Co-Borrower 

3. Select the borrower being moved on the From dropdown. 

4. Click Merge. 

Note: Use the Swap Married Borrower & Co-Borrower option to move the co-borrower into 
the empty borrower position created by the Merge. 

Delete Married Co-Borrower 

1. Select Swap or Delete from the Bor/Co-Bor menu. 

2. Click the first Delete button to remove a co-borrower from the loan file. 

Delete Co-Borrower File 

1. Select Swap or Delete from the Bor/Co-Bor menu. 

2. Click the second Delete button to remove a co-borrower from the loan file. 
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Chapter 5: MARKETING MENU 
The Marketing menu provides access to loan marketing screens. 

Amortization Schedule 

The Amortization Schedule produces a projected payment schedule for the entered loan 
program. Use the amortization schedule option to show prospects and borrowers the 
proposed monthly payments for following loan types: 

• Fixed rate 

• ARM 

• Bi-weekly 

• GPM 

• Negative amortization 

• Construction 

Use loan program templates to run amortization schedules for prospects under various loan 
programs. Start the Amortization Schedule by selecting a preset loan program after creating 
the templates. Manually enter the data when a template is not available. 

Access Amortization Schedule 

Use the following steps to access the Amortization Schedule. 

1. Open the applicable loan. 

2. Select Amortization Schedule from the Marketing menu. 

3. Select a link for assistance with creating the associated Amortization Schedule: 

Fixed Rate Loan Amortization Schedule 

ARM Amortization Schedule 

Negative ARM Amortization Schedule 
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Fixed Rate Loan Amortization Schedule 

Use the following steps to create a fixed rate loan amortization schedule. 

1. Click Loan Prog to select a custom loan program template if applicable. 

 

Figure 85: Amortization & Payment Schedule 

2. Click Loan Prog. 

3. Select the loan program from the Loan Programs dialog. (See Figure 29.) 

4. Click OK. 

5. Enter the Date Prepared. 

6. Enter 1st Pmt Date. 

7. Enter the Loan Amt. 

8. Enter Note Rate. 

9. Enter Term. 

10. Enter the loan length in the Due field. 

Note: 30-year amortized loan with a balloon payment after five years should is Term/Due 
In: 360/60. 

11. Click the Calculate button to run the payment schedule. 
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12. Click Monthly Sch button to display the Detailed Payment Schedule. 

 

Figure 86: Detailed Payment Schedule 

13. Click OK to close the Detailed Payment Schedule. 

14. Click Save to save the screen information. 

ARM Amortization Schedule 

Use the following steps to create an ARM loan Amortization Schedule. 

1. Click Loan Prog. (See Figure 85.) 

2. Select the loan program from the Loan Programs dialog. (See Figure 29.) 

3. Click OK. 

4. Enter the Date Prepared. (See Figure 85.) 

5. Enter 1st Pmt Date. 

6. Enter the Loan Amt. 

7. Enter Note Rate. 
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8. Complete the 1st Adj Cap field. 

Note: The first adjustment cap is the percent the loan changes for the first adjustment. 

 

Figure 87: Amortization Adjustments & Insurance 

9. Enter the number of months between each rate adjustment for the remainder of 
the loan in the Adj Period field. 

10. Enter the percent the loan changes each period in the Adj Cap field. 

11. Enter the difference between the starting note rate and the ceiling to which the 
note rate can adjust in the Life Cap field. 

12. Enter those values based on the loan program of the lender in the Margin and 
Index fields. 

Note: Leave the Index field blank to display worst-case results. 

13. Enter the Floor rate to indicate the minimum interest rate if applicable. 

14. Click Calculate to run the payment schedule. 

15. Click Monthly Sch to display the Detailed Payment Schedule. 

16. Click OK to close the Detailed Payment Schedule. (See Figure 86.) 

17. Click Save to save the screen information. 
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Negative ARM Amortization Schedule 

Use the following steps to create an ARM loan with a Negative Amortization Schedule. 

1. Complete Steps 1 – 13 in ARM Amortization Schedule. 

2. Select the Payment Adjustments Initial Pmt Rate option. (See Figure 87.) 

3. Enter the Percentage. 

4. Enter the Initial Pmt Rate Period. 

5. Select the Interest Only During Initial Pmt Rate Period checkbox to set the initiate 
payment rate as interest only.  

6. Enter the percent that payment increases for a certain amount of time In the Adj 
Cap field. 

7. Enter the number of months the payment changes in the Adj Period field. 

8. Enter the number of months until the loan is re-amortized to pay off the loan In the 
Recast Pd/Stop fields. 

9. Enter when the negative amortization ends. 

10. Enter the percentage rate of the original balance the principal balance can reach In 
the Max Ba field. 

11. Select the Calculate Qual Ratios at the Max Adjusted Loan Balance checkbox if 
applicable. 

12. Click Calculate to run the payment schedule. 

13. Click Monthly Sch to display the Detailed Payment Schedule. 

14. Click OK to close the Detailed Payment Schedule. 

15. Click Save to save the screen information. 

Amortization Buttons 

The following buttons are available on the Amortization Schedule. 

Calculate 

Click to calculate screen values. 

Monthly Schedule 

Click to review the monthly payment schedule. (See Figure 86.) 
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Prepared For 

Use the following steps to complete the Prepared For dialog to personalize the Amortization 
Schedule. 

1. Click Prepared For. 

 

Figure 88: Prepared For Dialog 

2. Enter the Company Name. 

3. Enter Attention Name. 

Note: Click Cardex to look up the address information in the Cardex database. 

4. Enter Address Information. 

5. Enter Contact Information. 

6. Click OK. 

Cash-To-Close 

The Cash-to-Close screen indicates the amount of cash required to close a loan. 

1. Select Cash-to-Close from the Marketing menu. 
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2. Enter the Purchase Price. 

 

Figure 89: Cash-to-Close 

3. Enter estimated Alterations cost. 

4. Enter Land cost if applicable. 

5. Enter the Subordinate Financing. 

6. Enter Lender Credits. 

7. Click CC Adjustments for FHA. 

8. Complete the FHA: Additional Itemized Closing Costs in the dialog. 

 

Figure 90: FHA: Additional Itemized Closing Costs 
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9. Click Close. 

10. Enter Closing Costs from New Second Mortgage if applicable. 

11. Complete the unlocked fields as required. 

12. Click Save to save the information. 

Prepared For Button 

Use the Prepared For button to create the printed form information. (See Prepared For.) 

Debt Consolidation Worksheet 

The Debt Consolidation Worksheet consolidates consumer debt for a refinance. The 
worksheet is most beneficial when used in conjunction with a credit interface provider or a 
credit service in Point. Use the Debt Consolidation Worksheet to save the step of manually 
entering liabilities. 

Debts entered on the Loan Application Page 3 or from an ordered Credit Report populate the 
Debt Consolidation Worksheet. 

Note: Change the current monthly mortgage payment to reflect only the principal and 
interest when it includes taxes and insurance. 

Review Worksheet 

Review the worksheet information and adjust as required. 

1. Select Debt Consolidation Worksheet from the Marketing menu. 
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2. Verify populated field information. 

 

Figure 91: Debt Consolidation Worksheet 

3. Enter Borrower cash in the Cash Out field if applicable. 

4. Click CC Scenario to update the closing cost scenario. 

  



   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
109 

5. Select the Scenario from the CC Scenario List dialog. 

 

Figure 92: CC Scenario List Dialog 

6. Click OK. 

7. Click Loan Pg to select a different loan program. 

8. Select the Loan Program from the Loan Program dialog. 

9. Click OK. 

10. Enter Terms when not populated. 

11. Enter Interest Rate when not populated. 

12. Click Calculate New Loan after making changes to view the new loan amount. 

13. Click Save. 

Enter New Debt 

Enter new debt information when not included in the Debt Table. 

1. Click the New button. (See Figure 91.) 

2. Enter the Debtor Company. 

 

Figure 93: Liability Dialog 



   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
110 

3. Enter the Account Number. 

4. Enter the Account Type. 

5. Enter the debt Balance. 

6. Enter the Payment Amount. 

7. Enter Months Left. 

8. Enter Payoff Amount. 

9. Select Will be paid off if debt will be gone prior to closing. 

10. Click OK. 

11. Click Calculate New Loan after making changes to view the new loan amount. 

12. Click Save. 

Modify Debt 

Use the following sections to modify a Debt Table entry. 

Paid Off 

1. Select the Debt in the table. (See Figure 91.) 

2. Click Paid Off to place an X next to the debt. 

3. Click Calculate New Loan after making changes to view the new loan amount. 

4. Click Save. 

Edit Debt Amount 

1. Select the Debt in the table. (See Figure 91.) 

2. Click Edit. 

3. Make appropriate changes in the Liability dialog. 

4. Click OK. 

5. Click Calculate New Loan after making changes to view the new loan amount. 

6. Click Save. 

Debt Consolidation Buttons 

The following buttons are available on the Debt Consolidation Worksheet. 
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Income 

Use the Income button open to enter Borrower/Co-Borrower sources of income. 

1. Click Income. 

2. Enter income details as appropriate in the Income Information dialog. 

 

Figure 94: Income Information Dialog 

3. Click OK. 

4. Click Calculate New Loan after making changes to view the new loan amount. 

5. Click Save. 
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HE & Oblig 

Use the HE & Oblig button to modify housing expenses and other obligations. 

1. Click HE & Oblig. 

2. Update the dialog fields appropriately. 

 

Figure 95: Housing Exp & Other Obligations 

3. Click OK. 

4. Click Calculate New Loan after making changes to view the new loan amount. 

5. Click Save. 
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2nd Mtg 

Use the 2nd Mtg button to enter second, third, and fourth mortgage information for the 
subject property and link the loan files. 

1. Click 2nd Mtg. 

2. Enter 2nd Mortgage amount. 

 

Figure 96: Subordinate Financing Information 

3. Click 2nd Mtg on the Subordinate Financing Information dialog. 

4. Complete the Second Mortgage Payment dialog. 

 

Figure 97: Second Mortgage Payment Dialog 

5. Click OK on the Second Mortgage Payment dialog. 

6. Enter All Other Existing Mortgages amount. 
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7. Click Create Second Mortgage File. 

8. Select the appropriate option.p  

 

Figure 98: Create Second Mortgage File Options 

9. Complete the prompts. 

10. Click OK on the Subordinate Financing Information dialog. 

11. Click Calculate New Loan after making changes to view the new loan amount. 

12. Click Save. 

Invest 

Use the Invest button to enter Investment Information about owned investment property. 

1. Click the Invest. 

2. Enter Investment Information. 

 

Figure 99: Investment Information Dialog 

3. Click OK. 

4. Click Calculate New Loan after making changes to view the new loan amount. 

5. Click Save.  
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Credit Scr 

Click Credit Scr to review the Borrower/Co-Borrower credit scores. 

 

Figure 100: Credit Score Dialog 

Status 

Click Status button to review or add tasks. 

 

Figure 101: Status Dialog 
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Calc Bal 

Use the Calc Bal button to calculate the loan balance. 

 

Figure 102: Balance Calculation Dialog 

Cntct Info 

Click Cntct Info to access the Contact Information dialog for contact information about the 
Borrowers. 

 

Figure 103: Contact Information Dialog 
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Cur Ratio 

Click the Cur Ratio button to display the debt-to-income ratio totals for information 
contained in the Debt Consolidation Worksheet. 

 

Figure 104: Current Ratio Dialog 

Loan Comparison 

Point provides tools to compare loans that contain the benefits, costs, requirements, and 
other information used to determine which loan type of loan required for successful 
financing. Use the Loan Comparison screen to compare three loan scenarios side-by-side. 
The Loan Comparison screen provides immediate answers to questions about loan choices 
when used with the Loan Program Templates and the Closing Cost Scenario Templates. 

The tools enable the following loan comparisons: 

• Compare three different loan scenarios 

• Comparing a sample FHA versus a conventional loan 

Note: It is important to be consistent among the scenarios. Include taxes, insurance etc. in 
all scenarios when used. 

Perform Loan Comparison 

Existing loan data from the loan file automatically populates in the Loan Comparison fields 
in the Prospect Program column. The Anti-Steering Disclosure Scenario 1 and Scenario 2 
data populates the Loan Comparison Scenario 1 and 2 columns. 

Note: Only the current loan file data can be edits. Use the Anti-Steering Disclosure screen to 
edit the scenario data. 

1. Select Loan Comparison from the Marketing menu. 
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2. Click Loan Prg. 

 

Figure 105: Loan Comparison 

3. Select a loan program template from the Loan Programs dialog. (See Figure 29.) 

Note:  Enter the name of a custom template to use the template instead of a loan program 
template. PointCentral users with Calyx Pricer enabled do not use loan program templates. 
Clicking the Loan Program button provides direct access to Calyx Pricer without populating 
a loan program template. 

4. Click CC Scen to select a closing cost scenario from the CC Scenario List dialog. 
(See Figure 92.) 

5. Enter the Sales Price. 

6. Enter the Down Payment. 

Note: Enter only a loan amount for refinance alternatives. 

7. Enter or edit the data in the remaining fields as needed for the comparison. 
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8. Click the Mth Pmt button to open the Monthly Payment dialog. 

 

Figure 106: Monthly Payment Dialog 

9. Enter or edit the following as applicable: 

• Hazard Insurance 

• Property Taxes 

• Mortgage Insurance 

• Homeowner Association (HOA) Fee 

10. Click OK to close the Monthly Payment dialog. 

11. Click the ARM button to open the ARM dialog. 

 

Figure 107: ARM Dialog 
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12. Enter or edit the adjustable-rate information. 

13. Click OK to close the ARM dialog. 

14. Click Notes to open a dialog to enter notes about the loan comparison. 

15. Click Prepared For to include the contact information of the party for whom the 
comparison was created. (See Figure 88.) 

16. Click Open House to access the Open House Picture File dialog. 

 

Figure 108: Open House Picture File Dialog 

17. Browse to the Image File Location and attach. 

18. Click OK to close the dialog. 

19. Click Calculate New Loan after making changes to view the new loan amount. 

20. Click Save. 

Loan Comparison Buttons 

The following buttons are available on the Loan Comparison screen. 

Edit Scenarios 

Click to select a closing cost scenario from the CC Scenario List dialog. (See Figure 92.) 

Compare 

Click to open the Months to Compare dialog. 

 

Figure 109: Months to Compare Dialog 
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Mth Pmt 

Click to open the Monthly Payment dialog. (See Figure 106.) 

ARM 

Click to open the ARM dialog. (See Figure 107.) 

Notes 

Click to open the Loan Comparison Notes dialog. 

 

Figure 110: Loan Comparison Notes Dialog 

Prepared For 

Click to open the Prepared For dialog. (See Figure 88.) 

Open House 

Click to open the Open House Picture File dialog. Use the dialog to upload property pictures 
for open house showings. (See Figure 108.) 

Prequalification 

The Prequalification screen is used to determine the prospect ability to qualify for a 
mortgage. Use the Prequalification screen in to qualify the prospect by the property 
information or by prospect personal information. 

1. Select Prequalification from the Marketing menu. 
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2. Click Loan Prog. 

 

Figure 111: Prequalification 

 

3. Select a loan program template from the Loan Programs dialog. (See Figure 29.) 

Note: Select the appropriate Loan Program checkboxes when not using a loan program 
template. 

4. Click CC Scenario. 

5. Select the closing cost template from the CC Scenario List dialog. 

6. Select a link to continue: 

Prequalify by Property 

Prequalify by Prospect 

Prequalify by Property 

Use the following steps to prequalify a prospect by property. 

1. Enter the Purchase Price. 

2. Enter Down Payment. 

3. Enter Equity. 
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4. Enter Note Rate. 

5. Enter Term. 

6. Click the Mth Pmt button to adjust monthly payments on the Monthly Payment 
Settings dialog. 

 

Figure 112: Monthly Payment Settings Dialog 

7. Click the HE & Oblig button to enter housing expenses and other obligations on 
the Housing Exp & Other Obligations dialog. (See Figure 95.) 

8. Click the Present HE button to access the Present Housing Expense dialog. 

9. Enter current housing expenses. 

 

Figure 113: Present Housing Expense Dialog 

10. Clock OK to close the Present Housing Expense dialog. 
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11. Use lender guidelines to enter data for the Top and Bottom Debt Ratios. (See 
Figure 111.) 

12. Complete the LTV and CLTV fields. 

Note: Select Ratios from the Utilities menu to display the ratios at any time. 

13. Complete the remaining fields as required. 

14.  Verify the amounts in the following fields to check the Prequalification for 
accuracy: 

• Max Loan Amount 

• Down Pmt 

• Max Prop Value 

• Max Loan Limit 

• Min Income Req’d 

• Max Debt Allowable 

15. Click Save. 

Prequalify by Prospect 

Use the following steps to prequalify a prospect based on prospect qualifications.  

1. Select Prequalification from the Marketing menu. 

2. Enter the Note Rate. (See Figure 111.) 

3. Enter the Term. 

4. Click the Income button. 

5. Enter income details in the Income Information dialog. (See Figure 94.) 

6. Click OK to close the dialog. 

7. Click the HE & Oblig button to enter housing expenses and other obligations on 
the Housing Exp & Other Obligations dialog. (See Figure 95.) 

8. Use lender guidelines to enter data for the Top and Bottom Debt Ratios. (See 
Figure 111.) 

9. Click the Calc button to calculate the maximum property value for which the 
Borrower qualifies. 

10. Click Copy from Max Prop Value to populate the purchase price and loan amount. 

11. Click Save. 
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Prequalification Buttons 

Notes 

Click the Notes button to display a dialog where you can enter additional notes about the 
prequalification. 

 

Figure 114: Prequalification Notes Dialog 

Mtg Insurance 

Click Mtg Insurance to open the PMI/MIP/FF/USDA dialog which is used to calculate 
mortgage insurance fees for conventional and government loans. (See Mtg Insurance for 
details.) 

Sub Financing 

Click Sub Financing to access the Subordinate Financing Information dialog, which is used 
to create second, third, and fourth mortgage information for the subject property, and link 
the loan files. (See Sub Financing for details.) 

Investment 

Click Investment to access the Investment Information dialog. (See Invest for details.) 

Prepared For 

Click Prepared For to enter the contact information for an individual. (See Prepared For 
details.) 

Rent vs. Own 

The Rent vs. Own screen produces a comparison showing the advantages of owning a home 
versus renting. 

1. Select Rent vs. Own from the Marketing menu. 
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2. Enter the number of months to compute the benefit in the Compare for field. 

 

Figure 115: Rent vs. Own 

3. Select the Loan Type. 

4. Enter the Sales Price. 

5. Enter the Down Payment. 

6. Enter the Note Rate. 

7. Enter the Term. 

8. Click the Mth Pmt button to access the Monthly Payment Settings dialog. (See 
Figure 112.) 

9. Make the necessary adjustments on the dialog. 

10. Click OK. 

11. Enter the monthly rent and likely annual increase in the rent payment in the Rent 
section. 

12. Enter the annual percentage rate for the subject property estimated appreciation in 
the Home Appreciation (Compounded Yearly) field. 

13. Enter the Investment Interest (Compounded Monthly) field for investment loans. 

14. Click Housing Expenses & Obligations to open the Housing Exp & Other Obligations 
dialog. (See Figure 95.) 

15. Enter the information and click OK. 

16. Enter the Borrower tax bracket percentage in the Income Tax Bracket field. 
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17. Click Calculate to calculate the following information: 

• Monthly Benefit of Purchase (first column) 

• Total Benefit of Purchase (second column) 

Rent vs. Own Buttons 

Calculate 

Click Calculate to calculate the financial data showing the benefits of buying over renting. 

Mtg Insurance 

Click Mtg Insurance to opens the PMI/MIP/FF/USDA dialog which is used to calculate 
mortgage insurance fees for conventional and government loans. (See Mtg Insurance for 
details.) 

Prepared For 

Click Prepared For to enter the contact information for an individual. (See Prepared For 
details.) 

Fees Worksheet 

Click Fees Worksheet to access the Fees Worksheet. (See Fees Worksheet.) 

The Loan Estimate screen has buttons for additional screens or tools to assist with form 
completion. 
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Chapter 6: FORMS MENU 
The Forms menu is an alternative to selecting screens from the Navigation Panel. 
Frequently used screens move to the top of the Navigation Panel list providing quick 
access. The Form menus are static. The list order does not move with frequent use. This 
document explains the screens as accessed from the Forms menus for consistent access 
steps. 

The following sections provide information about the available Forms. Details include: 

• Form locations 

• Form completion 

• Form interactions with other screens 

Complete form fields to display on the printed forms. See Print Options for form printing 
details. 

Note: See Borrower Information Screen and Loan Application Screens for details about 
those forms. 

Truth-In-Lending (Reg Z) 

Regulation Z (Reg. Z) is the Federal Reserve Board regulation that implemented the Truth in 
Lending Act (TILA) of 1968. Use the Reg Z screen to populate the form. 

Note: The Truth-in-Lending Reg. Z screen contains links to tools web-based tools to assist 
with form completion. 

Loan Program and Dates 

Use the following steps as a guide for completing the Reg Z fields. 

1. Select Truth-in-Lending Reg. Z from the Forms menu. 
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2. Click Loan Program. 

 

Figure 116: Reg Z Loan Program Details 

3. Select the appropriate Loan Program from the Loan Programs dialog. (See Figure 
29.) 

4. Select the Date Prepared. 

5. Select the Disclosed Date. 

6. Enter the Disclosed APR. 

7. Select the Disclosed Method. 

8. Select the First Payment Date. 

9. Select the Re-disclosed Date if applicable. 

10. Enter the Re-disclosed APR if applicable. 

11. Select the Re-disclosed Method. 

Higher Priced Mortgage Loan 

Complete the fields to determine the Higher Priced Mortgage Loan (HPML). 

1. Select the Average Prime Offer Rate (APOR) Date. (See Figure 116.) 

2. Click the Average Prime Offer Rate link to obtain the latest Percentage. 
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Loan Information 

Complete the non-populated Loan Information fields. 

1. Enter the Note Rate. 

 

Figure 117: Reg Z. Loan Information 

2. Enter the Qualifying (Qual) Rate. 

3. Enter the loan Term Months. 

4. Enter the loan Due Months. 

5. Enter Interest Only Months if applicable. 

6. Select the Calculate Qual Rations checkbox if applicable. 

7. Select the Bi-Weekly Pmt Schedule checkbox to indicate the loan payments are 
bi-weekly. 
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Payment Schedule 

Complete the Payment Schedule section when customizing a payment schedule. 

1. Select the Customized Payment Schedule checkbox. 

 

Figure 118: Payment Schedule 

2. Enter the APR if applicable. 

3. Complete the Customized Payment Schedule. 

4. Click the Prepaid Fin Chg link for assistance with entering the prepaid finance 
charge if applicable. 

5. Complete the Finance Charge and TIP Percent fields if applicable. 

6. Enter the Extra Payment information if applicable. 
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ARM Rounding & Rate Adjustments 

Complete the Arm Rounding Options and Rate Adjustments for an ARM loan. 

1. Enter the ARM Rate Percent. 

 

Figure 119: ARM Rounding & Rate Adjustments 

2. Select the Up or Dn checkbox as applicable. 

3. Click the Rate Adjustments link to assist with completing the Rate Adjustments. 

Payment Adjustments 

Use the Payment Adjustments link to assist with payment adjustments. 

1. Select the Initial Payment (Pmt) Rate option. 

 

Figure 120: Reg Z Payment Adjustments 

2. Enter the Initial Pmt Rate Percent. 

3. Enter the Initial Pmt Rate Period. 
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4. Enter the Adjustment (Adj) Cap Percent. 

5. Enter the Adj Period. 

6. Enter the Recast Period/Stop (PD/Stop) information for a negative amortization 
loan. 

7. Enter the Max Balance Percent. 

8. Select the Calculate Qual Ratio checkbox if applicable. 

Buydown Mortgage 

Complete the Buydown Mortgage fields if applicable. 

1. Select the applicable Buydown Mortgage from the dropdown. 

 

Figure 121: Reg Z Buydown Mortgage 

2. Complete the Term Months (Mths) for each listed Rate. 

3. Select the Disclose LE/CD Product. 

4. Select an option for the Paid By dropdown menu. 

5. Select the Buydown Rate checkbox if applicable. 

Note: The Temporary Buydown Fee will auto-populate as an Origination Charge in the Fees 
Worksheet by selecting the Temporary Buydown/Admin Fee option from the fee type 
dropdown menu. 
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Extra Features & Graduated Payment Mtg 

Complete the Extra Loan Features and Graduated Payment Mortgage fields if applicable. 

1. Select the Simple Interest checkbox if applicable. 

 

Figure 122: Features & Graduated Payment 

2. Select the DPA checkbox if applicable. 

3. Complete the Principal Forgive fields when selecting the DPA checkbox. 

4. Enter the Years and Rate details for the Graduated Payment Mtg if applicable. 

Mortgage Insurance & Demands 

Use the Mortgage Insurance link to assist with field completion when the Borrower must 
carry mortgage insurance. 

1. Select the PMI/MIP/VA/USDA MI Factor. 

 

Figure 123: Mortgage Insurance 

2. Enter the PMI/MIP/VA/USDA Monthly Amount. 

3. Enter the number of required PMI/MIP/VA/USDA Months. 

4. Select the PMI Renewal 1 MI Factor. 

5. Enter the number of required Months for the first renewal. 

6. Select the PMI Renewal 2 MI Factor. 
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7. Enter the number of required Months for the second renewal. 

8. Enter the Cancel at Percent. 

9. Select the applicable Calculate Based On option. 

10. Select the Calculate Based on Remaining Balance checkbox if applicable. 

11. Select the Midpoint Cancellation checkbox if applicable. 

12. Select the Required Deposit checkbox if applicable. 

13. Select the Demand Feature if applicable. 

14. Select the Variable Rate Feature if applicable. 

15. Enter a description for the selected checkboxes in the blank field. 

Additional Reg Z Information 

Complete the following fields as required for the TIL Reg Z form. 

1. Enter additional Insurance requirements. 

 

Figure 124: Additional Reg Z Information 

2. Select the applicable Additional Insurance checkboxes. 

3. Enter Premium Insurance details if applicable. 

4. Complete the Security details. 

5. Enter required Filing Fees. 
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6. Enter Late Charges that apply. 

7. Enter Prepayment Penalties if applicable. 

8. Enter Optional Payment details. 

9. Select the applicable Assumption option. 

10. Complete the applicable Escrow Account Information. 

 

Figure 125: Remaining Reg Z Fields 

11. Enter Prepayment details. 

12. Enter Optional Payment information. 

13. Select the appropriate Assumption. 

14. Enter the appropriate Escrow Account Information. 

15. Select the appropriate Servicing checkbox. 

16. Select the final two checkboxes if applicable. 

17. Click Save. 

Reg Z Buttons 

The Reg Z screen has buttons to additional screens or tools to assist with form completion. 

Calculate 

Click the Calculate button to run a Reg Z form calculation. 
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Monthly Schedule 

Click to view the Detailed Payment Scheduled dialog. (See Figure 86.) 

Pmt Summary 

Use the Pmt Summary button to review the Payment Summary. 

1. Click the Pmt Summary button. 

 

Figure 126: Payment Summary Dialog 

2. Click Close to close the dialog. 

Form 1098 

Use the Form 1098 button to complete the 1098 form fields not populated. (See Tax 
Information (1098).) 

Section 32 

Click the Section 32 button to access the Truth-in-Lending Section 32 form if required. (See 
Section 32 Form.) 

ARM Disclosure 

Click the ARM Disclosure button to complete the ARM Disclosure form. (See ARM Disclosure 
(Initial). 
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QM Button 

The QM tab opens the Qualified Mortgage Reporting interface. (See QM Button for details.) 

Section 32 Form 

The Section 32 form establishes TIL requirements for certain loans with high rates and/or 
high fees by setting Federal guidelines that limit closing costs and set APR restrictions. Use 
the Section 32 screen to complete the form fields. 

1. Select the applicable Optional Credit Insurance option. 

 

Figure 127: TILA Section 32 

2. Select the applicable Regular Payment option. 

3. Select the appropriate remaining checkbox(es). 

4. Click Save. 

Note: Use the Calculate button to run the calculation. 

Fees Worksheet 

The Fees Worksheet form is created from the Closing Cost Scenario template. Complete 
the Fees Worksheet to itemize fees that populate the aggregate charges on the Loan 
Estimate form. (See Loan Estimate Form.) Print the Fees Worksheet Fee Details and Fees 
Worksheet Summary of Transaction Details forms for details and a summary of the 
estimated fees. 

Note: Review the form fields to verify completeness before printing. 
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Loan Information 

Use the following steps to complete the non-populated Loan Information fields. 

1. Select Fees Worksheet from the Forms menu. 

 

Figure 128: Fees Worksheet 

2. Select the Freeze checkbox if ready to freeze the Loan Estimate fees. 

Note: The Disclosed Loan Amount fields auto populate after selecting the Freeze checkbox. 

3. Select the Disclosure Type. 

4. Select the Date Prepared. 

5. Verify the applicable Loan Estimate form option is selected. 

6. Select the Yes checkbox to receive a Confirmation Message. 

7. Enter the Interest Rate Percent. 

8. Enter the Term/Due values. 

9. Click Loan Program to select a program from the Loan Programs dialog if 
applicable. (See Figure 29.) 

10. Click CC Scenario to select a closing cost template from the CC Scenario dialog if 
applicable. (See Figure 30.) 

11. Select the Intent to Proceed date. 

12. Select the applicable Intent to Proceed option from the dropdown. 

13. Select the Estimated Closing Date. 

14. Select the 1st Payment Date. 
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Rate Lock 

Complete the Rate Lock fields when freezing the fees. 

1. Enter the Rate Lock Period in Days. 

 

Figure 129: Fees Worksheet Rate Lock 

2. Select the Lock Expiration Date. 

3. Enter the Rate Lock Time. 

4. Select the Rate Lock Time Zone. 

5. Select the Cost Expiration Date. 

6. Enter the Cost Expiration Time. 

7. Select the Cost Expiration Time Zone. 

Origination Charges 

Use the following steps to complete the Origination Charges fields not populated. 

Enter the applicable companies used for closing. 

1. Select the Use checkbox for each listed company if Company must be used. 

 

Figure 130: Fees Worksheet Company Names 

2. Enter the Paid To Broker. 

3. Enter the Paid To Lender. 

4. Enter the Paid to Investor. 

5. Click the Check All Financed button to include the listed fee amounts in the loan 
financing. 

Note: The FIN option is selected for all fees listed on the Fees Worksheet when Check All 
Financed is selected. 



   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
141 

Use the following table to assist with selecting the Discount Fees checkboxes when Check 
All Financed is not selected. 

Table 8: Discount Types 

Checkbox Name Discount Type Description 

PFC Prepared Finance Charge Fees are included in the calculation 
of the Annual Percentage Rate (APR) 
and the total amount is populated in 
the Truth-In-Lending Disclosure. 

F FHA Allowable FHA-allowable closing cost and 
affects what can be charged to the 
borrower or financed in the loan. 

POC Paid Outside of Closing Fees not included in the total 
estimated settlement charges 
calculation 

FIN Financed Fees included in the total loan 
amount. 

Applicable to the Good Faith 
Estimate. 

QM Qualified Mortgage Fees included in the QM total points 
and fees calculation. 

GFE Section 2 

The Company Name fields auto populate with the entered Company Names when the Paid 
To option matches a name entered in the tables in Figure 130. 

1. Select Loan Discount recipient from the Paid To dropdown. 

 

Figure 131: Fees Worksheet GFE Section 2 
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2. Enter the company name of the payment recipient in the Company Name field if 
not populated. 

3. Enter the fee as a loan percentage, dollar value, or both in the applicable fields to 
populate the Amount field. 

4. Click the Borrower button to complete the Fee Distribution Worksheet dialog to 
distribute the fee among multiple payers. 

 

Figure 132: Fees Distribution Worksheet Dialog 

5. Update the dialog fields to indicate the fee distribution. 

Note: An (L) prefix prints on the Closing Disclosure form next to the fees 100% paid by the 
lender when a fee is entered for the Lender. 

6. Click OK to close the dialog. 

7. Select the applicable Discount Type checkbox when Check All Financed is not 
selected. (See Table 8 for details.) 

8. Select the State Bona Fide checkbox and enter the Percentage when the QM 
discount is selected. 

9. Enter the Starting Adjusted Rate Percentage when the QM discount is selected. 

10. Enter the Discount/Rebate for Starting Rate Percentage when the QM discount is 
selected. 

11. Complete the Credits information when the QM discount is selected. 

12. Select the Copy as a Lender Credit to Line 1003 Line M checkbox if applicable. 

Note: If the Copy as Lender Credit to Line 1003 Line M checkbox is selected, credits that are 
entered will appear in the second Lender Credits field. See  
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13. Select the first Loan Level Pricing Adjustment if applicable. 

14. Select the first Loan Level Pricing Adjustment Paid To if applicable. 

15. Enter the first Loan Level Pricing Adjustment Company Name if applicable and 
not populated. 

16. Enter the first Loan Level Pricing Adjustment Amount. 

17. Select the first Loan Level Pricing Adjustment Borrower button to distribute the 
fees. (See Figure 132.) 

18. Select the applicable Discount Type checkbox when Check All Financed is not 
selected. (See Table 8 for details.) 

19. Repeat Steps 13 – 18 for the second Loan Level Pricing Adjustment if applicable. 

GFE Section 1 

Use the following steps to set loan-level pricing adjustments in GFE Section 1. 

1. Select the Loan Origination Fee Paid To if applicable. 

 

Figure 133: Fees Worksheet GFE Section 1 

2. Enter the Company name if not populated. 

3. Enter the fee as a loan percentage, dollar value, or both in the applicable fields to 
populate the Amount field. 
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4. Click the Borrower button to add to the Fee Distribution Worksheet dialog if 
applicable. (See Figure 132.) 

5. Select the appropriate Discount Type checkbox. (See Table 8.) 

6. Repeat Steps 1 – 5 to complete the remaining GFE Section 1 fees as applicable. 

7. Select the Include Lender-Paid Compensation to Broker in the Total Settlement 
Charges checkbox to include the lender paid compensation to the broker. 

Note: It is not required to disclose lender-paid broker compensation on the Loan Estimate 
form, but it is required on the Closing Disclosure form. It is not necessary to select this 
checkbox when disclosing the Loan estimate, but the value is not included in the QM 
calculation when checkbox is not selected. 

8. Select the applicable Fee from the dropdown. 

9. Repeat Steps 1 – 4. 

10. Select the applicable Discount Type checkbox. 

Services You Cannot Shop For 

Use the following steps to complete the Services You Cannot Shop For fields. 

1. Complete the fees for Services You Cannot Shop For section as described above. 

 

Figure 134: Services the Borrower Cannot Shop 

2. Enter user-defined fees in the provided empty spaces. 

3. Select the appropriate Discount Type checkbox when Check All Financed is not 
selected. (See Table 8 for details.) 

Services You Can Shop For 

Use the following steps to complete the Services You Can Shop for fields. 
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1. Complete the fees for Services You Can Shop For section as described above. 

 

Figure 135: Services You Can Shop For 

2. Select the Shopped checkbox for each selection. 

3. Click Closing/Escrow Fee to access the Escrow Tables dialog to select a provider 
from the Escrow table setup on the Utilities menu. (See Escrow Tables for details.) 

Note: The Lock must be selected to access the Escrow Tables dialog. 

4. Select the appropriate provider from the Escrow Tables dialog. 

 

Figure 136: Escrow Tables Dialog 

5. Click Auto Re-calculate to initiate a fees recalculation. 

6. Click OK. 

7. Select the appropriate Discount Type checkbox when Check All Financed is not 
selected. (See Table 8 for details.) 

8. Click the Lenders Title Insurance button to access the Title Tables dialog to select 
a provider from the Title table setup on the Utilities menu. (See Title Tables for 
details.) 

Note: The Lock must be selected to access the Title Tables dialog. 
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9. Select the provider from the Title Tables dialog.  

 

Figure 137: Title Tables Dialog 

10. Select the appropriate provider from the Title Tables dialog. 

11. Click Auto Re-calculate to initiate a fees recalculation. 

12. Click OK. 

13. Select the appropriate Discount Type checkbox when Check All Financed is not 
selected. (See Table 8 for details.) 

14. Select the Single Provider checkbox if the Borrower selects a single provider not 
from the list of providers for all services in the section. 

Note: The single selection is used with the Good Faith Estimate form. 

GFE Section 6 

Use the following steps to complete the GFE Section 6 fields. 

1. Complete the fees for GFE Section 6 as described above. 

 

Figure 138: Services You Can Shop For 

2. Select the Print Additional Fees checkbox to print the GFE Section 6 fees on the 
addendum. 
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Taxes and Other Government Fees 

Use the following steps to complete the Taxes and Other Government Fees section. 

GFE Section 7 

Enter the tax information manually or calculate it by using the tax tables set up in the 
dropdown lists. 

1. Select the Recording Fee - Mortgage fees Paid To. 

 

Figure 139: GFE Section 7 

2. Enter the Company name if not populated. 

3. Enter a Fee Description if applicable. 

4. Enter the fee as a loan percentage, dollar value, or both in the applicable fields to 
populate the Amount field. 

5. Click the Borrower button to add to the Fee Distribution Worksheet dialog if 
applicable. (See Figure 132.) 

6. Select the appropriate Discount Type checkbox when Check All Financed is not 
selected. (See Table 8 for details.) 

7. Enter a second fee and repeat Steps 1 – 6 if applicable. 

8. Select the Exclude from Mortgage checkbox to itemize the fee separate from the 
mortgage total value. 

9.  Enter the Recording Fee - Deed fees. 

10. Repeat Steps 1 – 8 as applicable. 

11. Select the Exclude from Deed checkbox to itemize the fee separate from the deed 
total value. 
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GFE Section 8 

Click the Section 8 locks to access the buttons to use the Rates Calculations dialogs set up 
on the Utilities menu. Mortgage (Mtg) and Deed values must be entered manually when the 
Rates Calculation dialog is not used. 

Note: The Mortgage and Deed values entered in the Amount column, will populate the total 
fee amounts of the Lender Loan Pg. 2, Closing Disclosure Pg. 2, Closing Disclosure Pg.3, Good 
Faith Estimate, and Cash-To-Close screens. 

1. Select the City/County Tax/Stamps lock to access the button.  

 

Figure 140: GFE Section 8 

Note: Use the above steps if not using the Rates Calculations dialog. 

2. Click the City/County Tax/Stamps button to access open the City Tax Rates 
Calculation dialog. 

3. Select the applicable Tax Description. 

 

Figure 141: Rate Calculation: City Tax 
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4. Select the Auto Re-calculate to initiate a recalculation. 

5. Click OK to exit the dialog and repeat for additional taxes. 

6. Enter a Tax Description if applicable. 

7. Enter the Tax Amount. 

8. Click the Borrower button to open the Fee Distribution Worksheet dialog if 
applicable. (See Figure 132.) 

9. Select the appropriate Discount Type checkbox when Check All Financed is not 
selected. (See Table 8 for details.) 

10. Repeat Steps 1 – 9 for additional taxes. 

Prepaids 

Use the following steps to complete the Prepaids section. Note: Interest is paid for the 
remainder of the current month for prepaid interest. The amount is calculated based on the 
number of days per year set. 

1. Select the applicable Paid To. 

 

Figure 142: Prepaids 

2. Enter the Company if not auto populated. 

3. Select the number of days from the Days/Year dropdown list. 

4. Enter how many days of interest must be paid in advance in the Days field. 

5. Select the Date Range using the two calendars. 

6. Enter the Amount. 

7. Click the Borrower button to add to the Fee Distribution Worksheet dialog if 
applicable. (See Figure 132.) 
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8. Select the appropriate Discount Type checkbox when Check All Financed is not 
selected. (See Table 8 for details.) 

9. Select the appropriate Source of Service Provider (LEF) form the dropdown to 
report fee information in Regulator Connect Licensee Examination File (LEF) format. 

GFE Section 11 

The Hazard Insurance Premium button is only available if more than one hazard insurance 
company if available. Enter the hazard insurance premium manually when the Hazard 
Insurance Premium button is unavailable. 

1. Select the applicable Hazard Insurance Paid To option. 

 

Figure 143: GFE Section 11 

2. Enter the Company if not auto populated. 

3. Enter the Total months. 

4. Enter the Amount if not auto calculated. 

5. Click the Borrower button to add to the Fee Distribution Worksheet dialog if 
applicable. (See Figure 132.) 

6. Select the appropriate Discount Type checkbox when Check All Financed is not 
selected. (See Table 8 for details.) 

7. Select the applicable Source of Service Provider (LEF). 

8. Repeat Steps 1 – 7 for additional GFE Section 11 fees. 
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Initial Escrow Payment at Closing 

Use the following steps to complete the Initial Escrow Payment at Closing section. This 
section contains the monies required at closing for the escrow account. 

1. Click Hazard Insurance/Reserves to calculate the hazard insurance. 

 

Figure 144: Escrow at Closing 

2. Select the applicable Hazard Insurance/Reserves Paid To option. 

3. Enter the Company if not auto populated. 

4. Enter the Total months. 

5. Enter the Amount if not auto calculated. 

6. Click the Borrower button to add to the Fee Distribution Worksheet dialog if 
applicable. (See Figure 132.) 

7. Select the appropriate Discount Type checkbox when Check All Financed is not 
selected. (See Table 8 for details.) 

8. Select the applicable Source of Service Provider (LEF). 

9. Repeat Steps 1 – 7 for remaining escrow fees. 
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Other Section 

Use the Steps 1 – 7 in GFE Section 11 to complete remaining Fees Worksheet fees as 
applicable. The remaining fields populate based upon the fees information added to the 
worksheet. 

 
Figure 145: Other 

Closing Costs & Credits 

Review this section and make any adjustments if needed. Click on the lockbox icon to edit 
the fields. Enter an amount for a New First Mortgage and Closing Costs from New First 
Mortgage if applicable. 

 
Figure 146: Closing Costs & Items Summary 

Lender & Seller Credits 

For the Lenders & Seller credits fields: 

1. If needed, enter an amount for Cash Deposit. 
The Cash Deposit field will synch with Earnest Money in Table 2b. Other Assets – 
Credits in the Loan Application. 
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2. If needed, enter an amount for Lender Credits. 

 
Figure 147: Credits & Cash to Close 

Note: The second Lender Credit field auto populates additional credits if the Copy as Lender 
Credit to 1003 Line M checkbox is selected. 

3. If needed, enter the desired amount in the Seller Credits field. 

Calculating Cash to Close 

Calculating Cash to Close fields will auto populate from the Lender Loan Information page 
2 screen. 

Fees Worksheet Buttons 

The Fees Worksheet has buttons to additional screens or tools to assist with worksheet 
completion. 

Loan Estimate 

Use the Loan Estimate button for quick access to the Loan Estimate form. (See Loan 
Estimate Form.) 

SVC Providers List 

Use the Svc Providers List button for quick access to one of the following: 

Written List of Service Providers 

Service Providers List 

Note: Click the appropriate link to for more details. 
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Payoffs & Adjustments 

Use the Payoffs & Adjustments form to calculate adjustments and other credits to populate 
the Cash-to-Close on the Loan Estimate form. (See Payoffs & Adjustments Screen for 
details.) 

Post Consummation Fees 

Use the Post Consummation Fees button to enter construction and inspection fees. 

1. Click the Post Consummation Fees button. 

2. Enter the fee Description. 

 

Figure 148: Post Consummation Fees Dialog 

3. Enter the fee Amount. 

4. Repeat Steps 2 – 3 for additional fees. 

5. Click OK. 

GFE Button 

Use the GFE tab to access to the Good Faith Estimate form. (See Good Faith Estimate.) 
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Mtg Insurance 

Use the Fees Worksheet Mtg Insurance button to access the Mortgage Insurance dialog. 
(See Mtg Insurance for details.) 

QM Button 

Use the QM button to open the QM interface. (See QM for details.) 

Loan Estimate Form 

The Loan Estimate form satisfies the compliance requirements for fee disclosures. The form 
contains different disclosure information depending on the selected loan types. Most Loan 
Estimate fields are read-only and populated from other screens. 

Note: Open the Loan Estimate screen before printing the form to populate the fields on the 
form. An addendum page prints when multiple Co-Borrowers are on the loan and the Print 
additional fees Borrower can shop for checkbox is selected on the Fees Worksheet. 

1. Select Loan Estimate from the Forms menu. 

2. Select the Application Date. 

 

Figure 149: Loan Estimate Fields 

3. Select the Date Issued. 

4. Select the First Payment Date. 

5. Select a different Purpose if applicable. 
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6. Verify populated fields. 

Note: The Loan ID field is automatically populated from the loan file name when the 
Company Information is set to Lender. (See Company Default Information for setting 
company defaults.) 

7. Enter a Loan ID if required. 

8. Enter Rate Lock Period. 

9. Enter Lock Expires information. 

10. Enter Cost Expires information. 

11. Select the applicable Form checkbox in Calculating Cash to Close section. 

 

Figure 150: Cash to Close Forms 

12. Select the appropriate Assumptions checkbox. 

 

Figure 151: Other Considerations 

13. Enter the Late Payment details. 

14. Select the appropriate Servicing checkbox. 

15. Select the Confirm Receipt checkbox to include a signature line on the printed 
form. 
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16. Click Save to save form. 

Note: Refer to Appendix B – Loan Estimate Fields for field-to-field mapping information. 

Loan Estimate Buttons 

The Loan Estimate screen has buttons for additional screens or tools to assist with form 
completion. 

Fees Worksheet 

Use the Fees Worksheet button to access the Fees Worksheet. (See Fees Worksheet for 
details.) 

Changed Circumstance 

Use the Changed Circumstance button to change previously recorded fees. 

1. Click Changed Circumstance. 

2. Select the Change Date. 

 

Figure 152: Changed Circumstance Dialog 
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3. Select the Re-disclosed Date. 

4. Select the Reason. 

5. Enter information about the change in the Details of Change field. 

6. Complete the Fees Associated with Changed Circumstance fields. 

7. Click OK. 

Payoffs & Adjustments 

Use the Payoffs & Adjustments button to access the Payoffs and Adjustments screen used 
to populate the Cash-to-Close section on the Loan Estimate form. 

Payoffs & Adjustments Screen 

Manually enter the values on this screen from the Paid by Broker and Paid by Other fields 
in the Closing Costs & Prepaids Items Summary section on the Fees Worksheet to include 
them in the adjustments. 

1. Select Loan Estimate from the Forms menu. 

2. Select Payoffs Adjustments. 

3. Enter the Cash Deposit amount. 

 

Figure 153: Payoffs & Adjustments 

4. Enter the Lender Credits. 

Note: The second Lender Credits field auto-populates credits if the Copy as a Lender Credit 
to 1003 Line M checkbox is selected (See GFE Section 2). 

5. Enter the Seller Credits. 
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6. Enter the closing costs paid by the lender in the CC paid by Lender field. 

7. Enter the closing costs paid by the seller in the CC paid by Seller field. 

8. Enter the Existing Loans Value. 

9. Click the Copy from Liabilities button to populate the fields from the Loan 
Estimate Liabilities and Adjustments. 

10. Enter additional liabilities in the To column. 

11. Select the appropriate Liabilities and Adjustments option for each liability. 

12. Enter Amounts for each liability. 

13. Enter Adjustments and Other Credits. 

 

Figure 154: Adjustments & Other Credits 

14. Enter Due From Borrower Payment Descriptions. 

 

Figure 155: Due from Borrower 

15. Select the appropriate Cash to Close options for each description. 

16. Enter Amounts for each description. 

17. Click Save to save form. 

Payoff and Adjustments Buttons 

The following buttons are available on the Payoff and Adjustments screen: 
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Calculate Button: Click to total the entered values. 

Loan Estimates: Click to access the Loan Estimates screen (See Loan Estimate Form.) 

Fees Worksheet: Click to access the Fees Worksheet (See Fees Worksheet.) 

Written List of Service Providers 

The Written List of Service Providers form is used to comply with the Consumer Financial 
Protection Bureau (CFPB) requirements for disclosing the loan services and fees. 

1. Select Written List of Service Providers from the Forms menu. 

2. Enter the Date Prepared. 

 

Figure 156: Add Service Providers 

3. Select the Print the Written List of Service Providers without fee checkbox to 
omit the fees from the printed form. 

Add Service Providers 

Use the following steps to add service providers to the Service Providers table. 

1. Click the Service Provider Add button. (See Figure 156.) 
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2. Enter Company Name. 

 

Figure 157: Edit Service Provider Dialog 

3. Enter the Contact. 

Note: Click the Cardex Lookup to select the service provider from Cardex. 

4. Enter the Address. 

5. Enter the Contact Site/State/Zip. 

6. Enter the Email. 

7. Enter the Phone. 

8. Click Save & Close to close the dialog. 

Note: Click Save & New to add another service provider. 

Edit Service Providers 

Use the following steps to edit a listed Service Provider. 

1. Select the listed Service Provider to edit. 

 

Figure 158: Edit Listed Service Providers 

2. Click Edit. 
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3. Update the provider information on the Edit Service Provider dialog. (See Figure 
157.) 

4. Click Save & Close to close the dialog.  

Delete Service Providers 

Use the following steps to delete a listed Service Provider. 

1. Select the Service Provider to delete. (See Figure 158.) 

2. Click Delete. 

Add Services 

Use the following steps to add services to the Services table. 

1. Click the Services Add button. 

 

Figure 159: Add Services 

2. Enter the Service. 

 

Figure 160: Edit Service Dialog 

3. Select the Cannot Shop For checkbox if the Borrower is not allowed to shop for 
the service. 

4. Enter the service dollar Estimate. 

5. Select the service Provider. 

6. Click Save & Close. 

Note: Click Save & New to add another Service. 
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Edit Services 

Use the following steps to edit a listed Service. 

1. Select the Service to edit. (See Figure 159.) 

2. Click Edit. 

3. Update the service details on the Edit Service dialog. (See Figure 160.) 

4. Click Save & Close. 

Delete Services 

Use the following steps to delete a listed Service. 

1. Select the Service to delete. (See Figure 159.) 

2. Click Delete. 

Closing Costs Worksheet 

Use the Closing Costs Worksheet to compare any fees that changed from the Loan Estimate 
to Closing Disclosure. Complete non-populated fields. 

1. Select Closing Costs Worksheet from the Forms menu. 

2. Select the Confirm Receipt – Closing Disclosure Yes checkbox to receive a 
receipt confirmation. 

 

Figure 161: Closing Cost Worksheet 
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3. Click Copy from Fees Worksheet to populate the fields with current fees (See 
Fees Worksheet). 

4. Follow prompts if applicable. 

5. Enter the MIC #. 

6. Click Loan Program to select the loan program from the Loans Program dialog. 
(See Figure 29.) 

7. Click CC Scenario to select the closing cost scenario from the CC Scenario dialog. 
(See  Figure 30.) 

8. Select the Estimated Closing Date. 

9. Select the Closing Date. 

10. Select the Disbursement Date. 

Note: Edit the dates populated from the Fees Worksheet if applicable. 

11. Complete the remaining fields as required. 

12. Use Table 8 for discount type selection. 

13. Select the Source of Service Provider (LEF) in the Prepaids Section for entered 
prepaids. 

14. Enter Notes if applicable. 

15. Click Save to save form. 

Note: An (L) prefix prints on the Closing Costs Worksheet next to the fees 100% paid by the 
lender. 

Closing Costs Worksheet Buttons 

Use the Closing Costs Worksheet buttons to access additional screens and tools to assist 
with form completion. 

Closing Disclosure 

Click Closing Disclosure to open the Closing Disclosure form. (See Closing Disclosure for 
details.) 

Aggr Escrow 

Click Aggr Escrow to open the Escrow Account Disclosure form. (See Escrow Account 
Disclosure for details.) 

Post Consummation Fees 

Click Post Consummation Fees to open the Post Consummation Fees dialog. (See Post 
Consummation Fees for details.) 
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Closing Disclosure 

The Closing Disclosure form is used to satisfy the TRID compliance requirements for 
disclosure of fees. Much of the data on this screen is populated from the corresponding 
fields and calculations on the Closing Costs Worksheet and Truth-In-Lending screens. 
Additional information is collected on the Payoffs and Payments screen. The Closing 
Disclosure form consists of 5 pages. An addendum page also prints when the loan has 
multiple Co-Borrowers and sellers. 

Note: Refer to Appendix C – Closing Disclosure Field Mapping Table for data sources when 
changes are required to populated fields. 

Closing Disclosure Page 1 

Review and update the Closing Disclosure Page 1 screen. 

1. Select the Date Issued. 

 

Figure 162: Closing Disclosure Page 1 

2. Select the Closing Date. 

3. Select the Disbursement Date. 

4. Verify the Loan Purpose. 

5. Review the remaining fields to ensure accuracy. 

6. Review the remaining pages and edit the data as needed. 

7. Click Pg 2 and proceed to Closing Disclosure Page 2. 
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Closing Disclosure Page 2 

Review and update the Closing Disclosure Page 2 screen. 

Note: Refer to Appendix C- Closing Disclosure Field Mapping Tables for data sources when 
changes are required to populated fields. 

1. Review the Page 2 information. 

2. Select the Includes Closing Costs Increase above the legal Limit checkbox if 
applicable. 

 

Figure 163: Includes Closing Costs Increase 

3. Click Pg 3 and proceed to Closing Disclosure Page 3. 

Closing Disclosure Page 3 

The following fields at the bottom of page 3 are calculated based on the data entered from 
other screens: 

• Due From Borrower at Closing 

• Sale Price of Property 

• Closing Costs Paid at Closing 

Review and update the Closing Disclosure Page 3 screen. 

Note: Refer to Appendix C- Closing Disclosure Field Mapping Tables for data sources when 
changes are required to populated fields. 

Borrower Transactions 

Use the following steps to complete the Borrower Transactions. 

1. Select the Calculating Cash to Close checkboxes if applicable. 
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2. Click Copy From Loan Estimate to populate fields. 

 

Figure 164: Closing Disclosure Trans Summary 

3. Click Copy From Loan Estimate to populate the Cash to Close column. 

4. Enter the amount the borrower paid for personal property purchased from the 
seller in the Sale Price of Any Personal Property Included In Sale field. 

5. Select the appropriate Paid By option. 

6. Select the POC checkbox if applicable. 

7. Select an option from the Closing Costs Paid at Closing to select an additional 
closing cost if applicable. 

8. Select the appropriate Cash to Close option. 

9. Select the appropriate Paid By option. 

10. Enter the Amount. 

11. Select the POC checkbox if applicable. 

12. Enter the UCD Paid To. 

13. Enter adjustment details in the Adjustments fields. 

14. Enter Adjustments for Items Paid by Seller in Advance in the Payoffs and 
Payments section. 

15. Enter additional Paid Already by or on Behalf of Borrower at Closing information. 

16. Enter other Seller Credits and Adjustments. 

17. Enter Adjustments for Items Unpaid by Seller. 
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Sellers Transactions 

Use the following steps to complete the Sellers Transactions fields. (See Figure 164.) 

1. Select the Exclude from Printed Form checkbox if applicable. 

2. Complete the Personal Property Included in Sale fields. 

3. Complete the Due from Seller at Closing fields. 

4. Complete the Seller Credit fields. 

5. Click Pg 4 and proceed to Closing Disclosure Page 4. 

Closing Disclosure Page 4 

Review and update the Closing Disclosure Page 4 screen. 

Note: Refer to Appendix C- Closing Disclosure Field Mapping Tables for data sources when 
changes are required to populated fields. 

1. Select the appropriate Assumptions checkbox. 

 

Figure 165: Closing Disclosure Page 4 

2. Select the Demand Feature checkbox if applicable. 

3. Enter the Late Payment information. 

4. Select the appropriate Amortization checkbox if applicable. 

5. Select the appropriate Partial Payments checkbox. 

6. Complete the Escrow account selections. 

7. Click Pg 5 and proceed to Closing Disclosure Page 5. 
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Closing Disclosure Page 5 

Review and update the Closing Disclosure Page 5 screen. 

Note: refer to Appendix C- Closing Disclosure Field Mapping Tables for data sources when 
changes are required to populated fields. 

1. Select the Liability after Foreclosure checkbox if applicable. 

2. Select the Confirm Receipt checkbox to receive a receipt confirmation. 

Closing Disclosure Buttons 

The Closing Disclosure screen has buttons to access additional screens and tools to assist 
with form completion. 

Calculate 

Click Calculate to calculate the values entered on the screen. 

Payoffs & Payments 

The Payoffs & Payments button opens the Closing Disclosure–Payoffs and Payments 
screen. 

1. Click the Payoffs & Payments button. 

2. Click Copy from Loan Estimate to bring information from Loan Estimate. 

 

Figure 166: Payoffs & Payments 

3. Update as required. 
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Tolerance 

The Tolerance button opens the Tolerance screen that displays all the individual fees and 
the calculations used to determine tolerance. 

The Tolerance screen contains two comparison tables: 

Fees that cannot Change Table 

The Fees that cannot change table contains zero tolerance fees. Zero tolerance indicates 
the fees cannot increase from those originally disclosed on the Loan Estimate. Lenders are 
not permitted to charge more than the amounts for fees disclosed unless there is a change 
of circumstance that would trigger the need for a revised disclosure. Fees that fall in this 
category are typically for services the lender has control over or access to the actual fee 
amounts. 

 

Figure 167: Fees that cannot Change Table 

Fees that fall under this category include: 

• Fees paid to the Lender, Mortgage Broker, or Affiliate of either. 

• Fees paid to an unaffiliated third-party also apply if the Lender did not permit the 
Borrower to shop for a third-party service provider for any settlement service. 

• Transfer Taxes 

• Origination Fees 

• The Zero Tolerance fees are in the following sections: 

• Origination Charges. 

• Services You Cannot Shop For, and some of those in section. 

• Services you Can Shop For. 
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Aggregate of fees that cannot change more than 10% 

 

Figure 168: Aggregate of Fees 

The Aggregate of fees that cannot change more than 10% table list the description of: 

• Fee(s) that have a 10% tolerance. 

• Current fee amount. 

• Baseline the fee is being compared to. 

• Tolerance coverage 

The Total fields at the bottom of the table total: 

• Overages for the current fees 

• Fee baselines 

• Amount exceeding the 10% cap. 

Any fees that change between the Loan Estimate and the Closing Disclosure are listed in the 
table but not looked at on an individual level. The tolerance is calculated by the total sum of 
the amount increases. There is only a need to cure if total sum has increased by over 10%. 

Fees that fall under this category are: 

• Recording Fees 

• Third-party services not paid to the Lender or Lender Affiliates. 

• Services the Borrower can shop for: If the Borrower is allowed to shop for a service, 
but shops off the Written List of Service Providers, the item will change to the 
Cannot Shop section on the Closing Disclosure. 

The 10% tolerance fees are in the following sections: 

• Services You Cannot Shop For 

• Services You Can Shop For 

• Taxes and Other Government Fees 
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Reset the Baseline 

The fees in the Baseline column are listed in either table and are based on the fees from 
the Loan Estimate or the last saved fees from the Loan Estimate or Closing Disclosure after 
the baseline has been reset. 

Reset the Baseline to match the current fees and recalculate the tolerance when the 
following occurs: 

• There is a change of circumstance. 

• When the fees change from the disclosure to disclosure. 

Note: Resetting Baseline overwrites the fees in the Baseline column with the current fees 
from the Loan Estimate or Closing Disclosure. 

1. Click Tolerance. 

2. Select the appropriate option from the Reset Tolerance dropdown. 

 

Figure 169: Reset Baseline 

3. Click Reset Baseline to overwrite the fees in the Baseline column. 

Closing Costs Worksheet 

The Closing Costs Worksheet tab opens the Closing Costs Worksheet used to itemize 
closing costs on the loan. (See Closing Costs Worksheet for details.) 

Post Consummation Fees 

The Post Consummation Fees tab opens the Post Consummation Fees dialog for 
construction costs. (See Post Consummation Fees for details.) 

Good Faith Estimate 

The Good Faith Estimate (GFE) includes an itemized list of fees and costs associated with 
personal loan. The form is provided within three business days of the loan application. 
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Many of the fields on the GFE are calculated fields containing the total of a group of fees 
documented on the Fees Worksheet. The GFE field is automatically updated when a fee 
field is initially populated or changed on the Fees Worksheet. 

Edit individual Fees Worksheet values on the to modify the aggregate value. 

The values in the following fields on the GFE form are calculated from values entered on 
the Fees Worksheet: 

• Origination Charge 

• Title Services and Lender’s Title Insurance 

• Government Recording Charges 

• Transfer Taxes 

• Initial Deposit in Escrow Account 

Fees marked as paid outside of closing are included in the total calculation if the POC 
checkbox is selected on the Fees Worksheet. 

Note: Fields that have a one-to-one correlation with fields on the Fees Worksheet are 
identified when discussed below. 

Disclosures and Dates 

Use the following steps to complete the Disclosures and Dates information. 

1. Select Good Faith Estimate from the Forms menu. 

2. Enter the Disclosed Date. 

 

Figure 170: GFE Disclosures and Dates 

3. Enter the Re-disclosed Date. 

4. Select Disclosed Method. 

5. Select the Re-Disclosed Method. 
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6. Enter current date in the Date Prepared field. 

7. Enter the Interest Rate Available Through date and time information. 

8. Enter the Estimate Available Through date and time information. 

9. Enter the number of days the loan must close before the rate guarantee expires in 
the Rate Lock Period field. 

10. Enter the minimum number of days the interest rate must be locked before the 
loan can close in the Days Before Settlement Interest Rate Must Be Locked field 
if applicable. 

Summary of Loan 

Use the following steps to complete the non-populated Summary of Loan fields. 

1. Enter the Base Loan Amount if not prepopulated. 

2. Click the Monthly Payment button. 

3. Make the necessary adjustments on the Monthly Payment Settings dialog and click 
OK. (See Figure 112.) 

4. Select the Can the interest rate rise? checkbox for an ARM mortgage. 

Note: The It can rise to a maximum of and First change will occur in fields are populated 
based on information entered in the Truth-In-Lending form, Amortization screens, and the 
Monthly Payment Settings dialog. 

5. Select the Even if payments are made on time, can the Loan Balance rise? 
checkbox if the loan has product features that could cause the loan balance to 
increase even if the payments are made on time. 

Note: The checkbox selection is not required when escrow items paid through the loan are 
the only cause of the loan balance increasing. 

6. Select the Even if payments are made on time, can the Monthly Principal, 
Interest, and any MI rise? checkbox if an increase in the following can occur and 
increase the monthly payment (even when payments are made on time: 

• Principal 

• Interest 

• Mortgage insurance 

Note: The First Increase Can Be In, Monthly Amount Owed Can Rise To, and Maximum Amount 
Can Ever Rise To fields are calculated based on information entered in the Truth-In-Lending 
form, Amortization screen, Monthly Payment Settings dialog, and PMI/MIP/FF/USDA 
selections. 
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7. Select the Loan has a Prepayment Penalty checkbox and enter the maximum 
amount of the penalty in the Maximum Penalty field if the loan has a prepayment 
penalty. 

8. Select the Loan has a Balloon Payment checkbox if the loan has a balloon 
payment. 

Note: The Balloon Payment of and Due In years fields are calculated based on information 
entered in the Term/Due fields or on the Mortgage Loan Disclosure Statement (MLDS.) 

Adjusted Origination Charges 

1. Select the This Good Faith Estimate is being provided by Broker checkbox if not 
selected. 

 

Figure 171: adjusted Origination Charges 

Note: The checkbox is selected if setup in the If you completed the Company Information 
defaults. (See Display Ratios for details.) 

2. Verify and correct any fees on the Fees Worksheet that comprise the total 
origination charges. 

Note: The Origination Charge field is a calculated field and always disabled. The field 
reflects the total fees the lender is charging to provide the loan to the Borrower. It also 
includes the charges for the mortgage Broker, if applicable. The charge does not include 
the charges for third-party services. The field is populated with the sum of the following 
fees itemized in the Our Origination Charge section on the Fees Worksheet: 

• Lender’s Inspection Fee 

• Mortgage Broker Fee 

• Processing Fee 

• Underwriting Fee 

• Wire Transfer 

• User-defined fees 
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3. Select the appropriate option for Credits or Charge Points for the specific interest 
rate chosen. 

Note: The Adjusted Origination Charges field is populated in the Summary of Settlement 
Charges section. Use the Tradeoff table at the screen bottom to create scenarios that show 
how the settlement fees are affected with a higher or lower interest rate. 

All Other Settlement Services Charges 

Use this section to itemize fees for services for which the provider is selected and required 
by the lender or the originator. 

1. Enter the estimated charges for required third-party services in Required Services 
empty fields. 

 

Figure 172: GFE Charges for Settlement Services 

Note: The Up-Front Mortgage Insurance/USDA Guarantee Fee and VA Funding Fee fields 
are disabled calculated values. These fields are populated with information entered in the 
PMI/MIP/FF/USDA dialog. 

2. Verify and correct any fees on the Fees Worksheet that comprise the Total Title 
Services and Lenders Title Insurance Fees, including the following fields: 

• Closing/Escrow Fee 

• Document Preparation Fees 

• Notary Fees 

• Attorney Fees 

• Lender’s Title Insurance 

• User-defined fees 

3. Click the TOTAL Lock and manually enter the value. 
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4. Click the Title Services Lock and manually enter the value. 

5. Click the Lenders Title Insurance Fees Lock manually enter the value. 

6. Click the Owner’s Title Insurance Lock and manually enter the value. 

Note: The Owner’s Title Insurance is not included in the finance charge or APR. 

Services Borrower Can Shop For 

Use the following steps to complete the itemized fees for required services for which the 
Borrower can select the provider. List the name of suggested companies and estimated 
fees. 

1. Enter the estimated charges for the pest inspection, if applicable. 

 

Figure 173: Services that Can be Shopped 

2. Enter any user-defined services and estimated charges in the empty fields. 

Remaining Fees 

Use the following steps to complete the remaining fees. 
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1. Verify and correct fees on the Fees Worksheet that comprise the Government 
Recording Charges. 

 

Figure 174: GFE Remaining Fee Fields 

Note: Charges are populated with the recording fees in the Government Recording 
Charges section on the Fees Worksheet. 

2. Click the Government Recording Charges Lock and manually enter the fee. 

3. Verify and correct fees on the Fees Worksheet that comprise the Transfer Taxes. 

Note: Taxes are calculated from the Transfer Taxes section on the Fees Worksheet. 

4. Click the Transfer Taxes Lock and manually enter the fees. 

5. Verify and correct fees that comprise the total initial escrow deposit on the Fees 
Worksheet. 

Note: The Initial Deposit in Escrow Account field is populated with the sum of the 
following fees itemized in the Initial Deposit for Your Escrow Account section on the Fees 
Worksheet: 

• Hazard Insurance Reserves 

• Mortgage Insurance Reserves 

• County Property Tax Reserves 

• School Taxes 

• Flood Insurance Reserves 

• User-defined fees 

• Aggregate adjustment 

6. Select the Includes all property taxes checkbox if the initial escrow deposit 
includes payments for all property taxes. 



   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
179 

7. Select the Includes all insurance checkbox if initial escrow deposit includes all 
insurance. 

8. Select the Other checkbox if initial escrow deposit includes payments for some, 
but not all fees. 

9. Enter the included fees in the Other field. 

10. Enter the number of days that interest is being charged based on the estimated 
settlement date. 

11. Enter the estimated settlement date in the If Settlement field. 

Note: These fields are populated from the Fees Worksheet if the interest information in the 
Daily Interest Charges section is completed. 

12. Enter the estimated insurance charges the Borrower is required to pay before the 
loan closes. 

Note: The Hazard Insurance field is automatically populated from the fields in the Hazard 
Insurance Premium section on the Fees Worksheet. 

13. Enter the flood insurance premium in the Flood Insurance field. 

14. Enter or select an insurance type and enter the estimated fees if required. 

Tradeoff Table 

Use the following steps to complete the Tradeoff table. 

Select the Display Tradeoff Scenarios checkbox to include alternate scenarios on the 
printed GFE. 

 

Figure 175: Good Faith Estimate Tradeoff Table 

Note: The loan in this GFE column shows the total settlement charges based on the terms 
of the current loan being processed. 

Perform on of the following: 

Show Borrower accepting a higher interest rate will lower settlement costs: 
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1. Enter an interest rate lower than the proposed loan rate in the Initial Interest Rate 
field in the Same loan with lower interest rate column. 

2. Enter the credit (as a percentage) the lender pays for the higher interest rate in 
the Change in Amount Paid at Settlement field in the Same loan with lower 
settlement charges column. 

Show the Borrower that paying higher settlement charges can lower their interest rate: 

3. Enter an interest rate lower than the proposed loan rate in the Initial Interest Rate 
field in the Same loan with lower interest rate column. 

4. Enter the discount (as a percentage) the lender charges the Borrower to buy 
down the interest rate in the Change in Amount Paid at Settlement field in the 
Same loan with a lower interest rate column. 

5. Click Calculate to calculate the totals. 

6. Click Save to save form. 

Good Faith Estimate Buttons 

Use the Good Faith Estimate screen buttons to access additional screens and tools to assist 
with form completion. 

Calculate 

Click Calculate to run the calculation. 

Mtg Insurance 

Use the Mtg Insurance button to access the Mortgage Insurance dialog. (See Mtg Insurance 
for details.) 

Fees Worksheet 

Use the Fees Worksheet button to access the Fees Worksheet. (See Fees Worksheet for 
details.) 

Svc Providers List 

Use the Svc Providers List button to access the Service Providers List. (See Service 
Providers List for details.) 



   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
181 

Changed Circumstance 

Use the Changed Circumstance button to access the Changed Circumstance dialog. (See 
Changed Circumstance for details. 

QM Button 

Use the QM button to access the QM screen for details.) 

Service Providers List 

The Service Providers List provides Borrowers with a list of services and providers for the 
required lender services. The form contains only providers of services for which the 
Borrower can shop. 

Note: The screen is divided into blocks corresponding to the blocks on the Good Faith 
Estimate. 

1. Select Service Providers List from the Forms menu. 

2. Select the Date Prepared. 

GFE Block 4 

The providers selected in GFE Block 4 display on the Title Services and Lender’s Title 
Insurance Help Screen when the link is selected on the GFE. 

GFE Block 4 provides two checkboxes with options for presenting the available service 
providers: 

• Display as one provider that can perform all services in Block 4: Select this option 
to indicate one provider can perform all the services in Block 4 

• Display separate providers for each component service Select this option to 
indicate different providers will perform the services in Block 4: Select this option 
to list multiple providers for a service. 

  



   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
182 

1. Select the appropriate checkbox. 

 

Figure 176: GFE Block 4 

2. Select the Shopping Allowed checkbox for the Add Provider button for the 
Display as one provider checkbox. 

Note: Proceed to Step 9 when the second checkbox is selected. 

3. Click Add Provider. 

4. Enter the Company Name in the Edit Service Provider dialog. (See Figure 157.) 

Note: Use the Cardex Lookup button to locate a company listed in Cardex. 

5. Enter company representative in the Name fields. 

6. Complete the remaining company information. 

7. Click Save & Close to close the dialog. 

Note: Click Save & New to add another company. 

8. Select checkbox for the required service. 

9. Enter the Fee Amount if the field is enabled. 

10. Repeat Steps 4 – 8. 

11. Repeat Steps 9 – 11 for remaining enabled services. 

GFE Block 5 

Use the following steps if GFE Block 5 is not populated. 
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1. Enter a value in the Title Insurance (Owner’s) Fee Amount field. 

 

Figure 177: GFE Blocks 5 & 6 

2. Follow Steps 4 – 8 above for remaining fields. 

GFE Block 6 

Services previously entered on the Fees Worksheet are displayed. Values in parentheses 
represent fees to be paid outside of escrow or fees not being paid by the Borrower. 

1. Enter additional services and fees as required. (See Figure 177.) 

2. Select the Shopping Allowed checkbox for services for which the Borrower can 
shop. 

3. Click Save to save form. 

Service Providers 

The Service Providers list is built as Providers are added in the GFE sections on the form. 
Edit or delete the listed providers as required. 
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Edit Provider 

Use the following steps to edit a listed provider. 

1. Select the Provider to edit. 

 

Figure 178: Service Providers List 

2. Click Edit. 

3. Update the Company if applicable. 

 

Figure 179: Edit Service Provider Dialog 

Note: Use the Cardex Lookup icon to update the Company using the Cardex database. 

4. Enter the Contact Name. 

5. Enter the Company Address. 

6. Enter the Contact Email. 

7. Enter the Company Website. 

8. Click Save & Close. 
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Delete Provider 

Use the following steps to delete a listed provider. 

1. Select the Provider to delete. (See Figure 178.) 

2. Click Delete. 

Service Providers List Buttons 

Use the Service Providers List buttons to access additional screens and tools to assist with 
form completion. 

GFE Button 

Click GFE to access the GFE screen. (See Good Faith Estimate for details.) 

Fees Worksheet 

Click Fees Worksheet button to access the Fees Worksheet. (See Fees Worksheet for 
details.) 

Transmittal Summary (1008) 

The Transmittal Summary form communicates the foundational loan information. The form 
is required when submitting a loan to underwriting. 

IMPORTANT! Complete all other forms prior to the Transmittal Summary to enable 
appropriate data import. 

Point has three Transmittal Summaries: 

• Transmittal Summary: Used for a single Borrower set. 

• Combined Transmittal Summary: Used for multiple Borrower sets. 

• Combined Transmittal Summary – New: Used for multiple Borrower sets in the new 
format. 

Note: The select Transmittal Summary impacts information included and the form layout. 

Transmittal/Combined Transmittal 

Many Transmittal Summary fields are not enabled when using the Combined Transmittal 
Summary. The non-enabled values are populated from the primary Borrower/Co-Borrower 
Transmittal Summaries. Modify the individual Transmittal Summary to add or change an 
option. 
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Use the Transmittal Summary for a single Borrower set, or the first Borrower set on a loan. 

1. Select Transmittal Summary from the Forms menu. 

2. Select Transmittal Summary from the sub-menu. 

Borrower and Property Information 

Complete the non-populated Borrower and Property Information fields. 

1. Select the Property Type from the dropdown. 

 

Figure 180: Borrower and Property Information 

2. Verify populated fields and update if applicable. 

3. Select the appropriate Project Classification checkboxes if applicable. 

Note: Project Classification options are available only for investment properties. 

4. Complete other unpopulated fields. 

Mortgage Information 

Complete the non-populated Mortgage Information fields. 

1. Verify the populated fields and update if applicable. 
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2. Enter the amount of subordinate financing in the Sub. Financing field First is 
selected for the Lien Position. (Skip to Step 3 if Second is selected for the Lien 
Position.) 

 

Figure 181: Trans Summary Mortgage Info 

Note: Enter the actual balance and the credit limit in Sub Financing if the loan is a Home 
Equity Line of Credit (HELOC). 

3. Select the Purpose of Refi when loan is for refinance. 

4. Select the applicable Mortgage Originator checkbox(es). 

5. Enter the Broker/Correspondent Name and Company Name if applicable. 

6. Select the owner of the first mortgage from the If Second Mortgage Owner of 
First Mtg option. 

7. Enter the original loan amount in the If Second Mortgage column. 

Note: The Init P & I is different from the Loan Application when the Note Rate is different 
than the Qualifying Rate.  The P & I on the Loan Application is the Note Rate. The P & I on 
the 1008 is the Qualifying Rate. 

Underwriting Information 

Income data in the Stable Monthly Income section is populated from Loan Application page 
2. 

The total for the Proposed Monthly Payments/Borrower’s Primary Residence section 
reflects the Borrowers current housing expenses if the subject property is an investment or 
secondary residence. 

The total for the Proposed Monthly Payments/Borrower’s Primary Residence section 
reflects the Borrowers proposed housing expenses if the subject property is for a primary 
residence. 

The Other Obligations section populates liabilities and properties the borrower owns from 
the Loan Application sections 2-3. 
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Use the following steps to complete the unpopulated Underwriting Information section. 

1. Select the Underwriter’s Name from the dropdown. 

 

Figure 182: Transmittal Summary Underwriting 

2. Enter the Appraiser’s Name. 

3. Enter Appraiser’s License #. 

4. Enter the Appraiser’s Company Name. 

5. Review and update any remaining fields as appropriate. 

Qualifying Ratios and Risks 

The POS (Positive) Cash Flow (Subj Prop) from Underwriting Information and the Other 
Obligations from the Qualifying Rations section are automatically populated from the 
Schedule of Real Estate Owned section. 
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1. Click the Other Obligations Lock and enter the new positive or negative cash flow 
from the Pos Cash Flow (Subj Prop) or Neg Cash Flow (Subj Prop) that results 
from the purchase or refinance re-finance of a non-owner-occupied property. 

Note: The P & I on the Loan Application is the Note Rate. The P & I on the 1008 is the 
Qualifying Rate. 

 

Figure 183: Qualifying Ratios & Risks 

2. Verify the following fields are correct to adjust the Top and Bottom Debt-to-
Income ratios: 

• All income fields 

• Housing Expenses 

3. Use Mortgage Payments fields to adjust the loan-to-value (LTV) and combined 
loan-to-value (CLTV) ratios in the Borrower or Prospect Information screen. 

Note: Display the Ratios dialog for the current loan file by selecting Display Ratios from the 
Utilities menu. 

4. Select the appropriate checkbox to indicate if the value is above or below Note 
Rate, Bought Dn Rate, or Other.  

Note: The Qual Rate field is automatically populated from the Loan Application.  

5. Enter the HCLTV/HLTV if applicable. 

Note: The HLTV is the combined LTV based on the maximum credit limit of the equity line. 
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6. Complete the Risk Assessment section. (See Figure 183.) 

Note: Risks are typically not required to be completed by the Broker. The Debt-to-Housing 
Gap Ratio (Freddie) field, required for Freddie Mac loans, is the difference between the 
monthly debt-to -income ratio and the monthly expense -to -income ratio. 

7. Enter Underwriter Comments if applicable. 

8. Complete the Seller, Contract, And Contact Information section. 

9. Click Save to save form. 

Transmittal Screen Buttons 

Use the Transmittal screen buttons to access additional screens and tools to assist with 
form completion. 

Credit Scores 

Click Credit Scores to access the Credit Scores dialog. (See Figure 100.) 

QM Button 

Use the QM button to open the QM interface. (See QM for details.) 

Combined Transmittal Summary – New 

Use the Combined Transmittal Summary – New for loans created in the new 1008 format. 

Use the steps provided in Transmittal to complete the Combined Transmittal Summary. 

 
Figure 184: Combined Transmitted Summary - New 
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HELOC 

The Home Equity Line of Credit (HELOC) screen discloses the costs and fees associated with 
a home equity line of credit loan. 

Select HELOC to: 

• Uncheck the Loan Type option on screens. 

• Check the Other. 

• Populate the Description field with HELOC. 

Note: The Initial Period field corresponds to the 1st Change field. The Margin, Index, and 
the Floor fields correspond to the respective fields on the Truth-In-Lending screen, 
Amortization Schedule, and Monthly Payment Settings dialog. Changes made to the fields on 
any screen updates the respective fields in all locations. 

Loan Information 

Use the following steps to complete the Loan Information. 

1. Select HELOC from the Forms menu. 

2. Select the HELOC checkbox. 

 

Figure 185: HELOC Loan Information 

3. Enter the Line of Credit. 

4. Enter the amount the Borrower will take for the first draw in the Initial Advance 
Amount field. 

Note: The Initial Advance Amount field corresponds to the Initial HELOC Draw field on the 
Underwriting screen. (See Underwriting details.) 

5. Enter the minimum amount the Borrower must initially withdraw from the credit 
line in the Minimum Initial Advance field. 

6. Enter the minimum amount the Borrower must withdraw from the credit line in 
subsequent draws in the Minimum Draw Amount field. 
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7. Enter the Minimum Balance the Borrower must maintain in the line of credit. 

8. Enter the months before the first-rate change is to occur in the Initial Period field. 

9. Enter the years the funds are available to the Borrower to draw in the Draw Period 
field. 

10. Enter the years of the repayment period in the Repayment Period field. 

Note: The Term (Draw + Repay), Initial Monthly Payment, and Draw Monthly Payment 
fields are automatically calculated. 

11. Enter the Initial Rate %. 

12.  Enter the Margin %. 

13. Enter the Index %. 

14. Enter the Max Rate %.  

15. Enter the Floor %. 

Note: The APR is calculated by adding the Floor and the Index fields. 

Penalty Fees 

Use the following steps to complete the Penalty Fees. 

1. Enter the Fee Values. 

 

Figure 186: HELOC Penalty Fees 

2. Enter the percentage of minimum payment for Late Payment Fee if applicable. 

3. Enter the Transaction Fee if applicable. 

4. Enter the percentage of credit limit for Early Termination Fee. 

5. Click Save to save form. 
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Anti-Steering Disclosure 

Loan originators are required to present an Anti-Steering Disclosure to borrowers to comply 
with the Federal Truth-In-Lending Act (TILA) and Regulation Z (Reg Z). The disclosure 
includes the available options for each loan type in which the borrower has expressed an 
interest. 

Scenarios 

Use the Scenario section to create loan scenarios to include in the Anti-Steering Disclosure. 

The first column shows the current loan information from the Borrower file. Create 
additional scenarios to display Borrower loan options. 

1. Select Anti-Steering Disclosure from Forms menu. 

 

Figure 187: Anti-Steering Disclosure Scenarios 

2. Select an appropriate link to continue: 

Create Scenario 

Edit Scenario 

Create Scenario 

Use the following steps to create a scenario. 

1. Click Create to add a scenario. (See Figure 187.) 

2. Proceed to Edit Scenario. 
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Edit Scenario 

The loan comparison scenarios on the Loan Comparison screen are also updated when you 
make changes. 

1. Click Edit for the scenario to edit. 

2. Make scenario changes to the Borrower Information screen. 

 

Figure 188: Borrower Information Scenario 

3. Repeat Steps 1 – 2 for additional scenarios. 

4. Use the Scenario dropdown on the Borrower Information screen to switch 
between scenarios. 

5. Click Swap to swap the listed scenario with the original loan. 

 

Figure 189: Swap Scenarios 

Note: Click Clear to delete the data from an existing scenario. 

Anti-Steering Disclosure Selection 

Use the following steps to complete the Anti-Disclosure Steering section. 

1. Select the Fixed Lowest Interest Rate. (See Figure 187.) 

 

Figure 190: Anti-Steering Disclosure Selection 
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2. Select the Fixed Lowest Interest Rate without Risky Features. 

3. Select the Fixed Lowest Origination Cost. 

4. Select the ARM Lowest Interest Rate. 

5. Select the ARM Lowest Interest Rate without Risky Features. 

6. Select the ARM Lowest Interest Origination Cost. 

7. Select the Certification checkbox if applicable. 

8. Click Save to save form. 

Affiliated Business Arrangement Disclosure 

The Affiliated Business Arrangement Disclosure provides the names of the settlement service 
providers and the charges for the provided services. 

Use the following steps to complete the Affiliated Business Arrangement Disclosure. 

1. Select Affiliated Business Disclosure from Forms menu. 

 

Figure 191: Affiliated Business Arrangement 

2. Enter Business Relationship. 

3. Enter Nature of the Relationship. 

4. Select Section A checkbox and complete fields if applicable. 

5. Select Section B checkbox and complete fields if applicable. 
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ARM Disclosure (Initial) 

The Initial ARM Disclosure statement contains information about the terms of the ARM the 
Borrower is considering. This form explains to the Borrower: 

• How the interest rate is calculated and adjusted. 

• How the payments are determined. 

• How and when the payments can change over the life of the loan. 

1. Select ARM Disclosure (Initial) from the Forms menu. 

 

Figure 192: ARM Disclosure (Initial) 

2. Verify Lenders Name. 

3. Enter Loan Program. 

4. Select Index Base. 

5. Complete the Index Information fields if not populated from the Truth-in-Lending 
screen. 
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Rate Adjustments 

Use the following steps to complete the Rate Adjustment fields. 

1. Click the Rate Adjustments Link for Point Calculation Help to assist with rate 
Adjustment information. 

2. Enter the maximum percentage the rate will increase in the First Adj Cap % field. 

 

Figure 193: ARM Disclosure Rate Adjustments 

Note: Leave the 1st Adj Cap and Adj Cap fields blank for negative amortization loans. 

3. Enter the number of months until the first rate adjustment in the 1st Change mths 
field. 

4. Enter the maximum percentage the rate will increase for each period in the Adj 
Cap % field. 

5. Enter the number of months between each rate adjustment for the remainder of 
the loan in Adj Period mths field. 

6. Enter the maximum percentage the note rate may rise to in the Life Cap % field. 

7. Enter the amount added to the index to establish the adjusted rate in the Margin % 
field. 

8. Enter the published interest rate used to measure the ARM against in the Index % 
field. 

9. Enter the minimum interest rate for the loan in the Floor % field. 

Note: The Floor field is optional. 

Payment Adjustments 

The Payment Adjustment fields are populated from the Truth-in-Lending screen. Use the 
following steps to modify the fields. 

Note: Changes made to the Payment Adjustment fields update the Truth-In-Lending 
screen. 
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1. Click the Payment Adjustments Link for Point Calculation Help to assist with rate 
Adjustment information. 

 

Figure 194: Payment Adjustments 

2. Select the Initial Pmt Rate. 

3. Enter the rate Percent. 

4. Enter the number of months the Borrower is eligible to make the initial payment 
rate in the Initial Pmt Rate Period field. 

5. Check the Interest Only During Initial Pmt Rate Period checkbox to specify 
interest-only payments during the initial payment rate period. 

Note: The initial interest-only payments expire at the end of the term specified in the Initial 
Pmt Rate field and default to the period Interest Only ___ mths field when selected. The 
debt-to -income ratio is still calculated based on the qualifying rate even though the 
payment adjustment is lower than the full amortization amount during the initial payment 
rate period, 

6. Enter the Adj Cap % to specify the payment adjustment. 

7. Enter the Adj Period to specify the term in which the payments can adjust. 

8. Enter the Re-Amortization rate and the number of months rate is effective in the 
Recast Pd/Stop fields. 

9. Enter the Max Balance %. 

Rounding Options & Important Information 

The fields are automatically populated with information from the Truth-in-Lending screen. 
Use the following steps to complete the remaining ARM fields. 

1. Enter the amount the rate is to be rounded to in the Rate field. 

 

Figure 195: Rounding and Important Info 
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2. Select the applicable Up or Dn checkbox. 

3. Select the applicable Important Loan Information checkbox. 

New Interest Rate, Payment, and Balance 

Complete the fields if applicable. 

1. Enter the New Interest Rate. 

 

Figure 196: New Interest, Payment, & Balance 

2. Enter the New Payment. 

3. Enter the New Balance. 

4. Enter the PrePayment Date. 

5. Click the Calculate button to populate the Worst-Case Scenario fields. 

Note: The worst-case scenario assumes a loan amount of $10,000 and is based on 
information you entered in the Rate Adjustments section. The fields are automatically 
calculated before the form is printed when printing the form before clicking Calculate. 

ARM Disclosure Buttons 

Use the ARM Disclosure screen buttons to access additional screens and tools to assist with 
form completion. 

Calculate 

Click the Calculate button to populate the Worst-Case Scenario fields. 

Monthly Sch 

Click Monthly Sch to view the Detailed Payment Schedule. (See Figure 86.) 

Truth-in-Lending 

Click Truth-in-Lending to access the Truth-in-Lending screen. (See Truth-In-Lending (Reg 
Z).) 
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Brokerage Business Contract (Generic) 

The Brokerage Contract contains the agreement being entered into by the broker and the 
Borrower. The contract explains the rights and obligations of the Borrower and the 
mortgage Brokerage acting on behalf of the Borrower to ensure a loan commitment. Most 
of the data is automatically populated from other screens. 

Use the following steps to create a generic Brokerage Business Contract. 

1. Select the Brokerage Business Contract (Generic) from the Forms menu. 

 

Figure 197: Brokerage Business Contract 

2. Enter Contract Period. 

3. Enter Estimated Market Value. 

4. Enter Estimated Balance. 

5. Complete the Percentage fields. 

6. Enter the Application Fee. 

7. Select the appropriate Fee Type from the checkbox. 

8. Enter License Number. 

Cash Flow Analysis (1084) 

The Cash Flow Analysis is comprised of three pages that apply to self-employed Borrowers. 
Point use the Schedule Analysis Method and AGI (Adjusted Gross Income) to calculate the 
monthly income for self-employed Borrowers acceptable to underwriters. 
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Complete the field values and Point performs all necessary calculations and totals. 

1. Select Cash Flow Analysis Page 1 from the Forms menu. 

2. Enter the IRS 1040 – Individual Tax Return Years on Page 1. 

 

Figure 198: IRS 1040 – Individual Tax Return 

3. Enter the values for each row. 

4. Click Page 2. 
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5. Enter the IRS Form 1065 – Partnership Years on Page 2. 

 

Figure 199: IRS Form 1065 – Partnership 

Note: Skip Steps 4 – 6 when the Borrower is not part of a partnership. 

6. Enter the values for each row. 

7. Click Page 3. 
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8. Enter the IRS Form 1120 - Regular Years on Page 3. 

 

Figure 200: IRS Form 1120 - Regular 

9. Enter the values for each row. 

Credit Score Information Disclosure 

The Credit Score Information Disclosure informs Borrowers and Co-Borrowers of the 
following information: 

• Credit score distributed by the credit bureau in connection with the loan. 

• Range of possible credit scores for the agency. 

• Score ranks compared to other U.S. consumers. 

• Key factors affected the score. 
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1. Select Credit Score Disclosure from the Forms menu. 

 

Figure 201: Credit Score Information Disclosure 

2. Review displayed information for accuracy. 

3. Select the Credit Score to disclose from the dropdown. 

4. Select the Credit Score Provided on Behalf of Lender checkbox if applicable. 

5. Complete the Factors fields if applicable. 

6. Click Credit Scores to review Borrower credit scores. (See Figure 100.) 

Note: Skip Steps 2 – 3 when the disclosure fields are populated. 

7. Click OK on the Credit Scores dialog. 

Escrow Account Disclosure 

Use the Aggregate Escrow Account Disclosure dialog to calculate: 

• Ongoing escrow payments 

• Escrow data for taxes 

• Hazard insurance 

• Homeowners’ association fees 

• Mortgage insurance 
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• Flood insurance 

• School taxes 

• User-defined escrow expenses 

The Initial Escrow Account Setup dialog tracks the monthly escrow fees for the first year of 
the loan. The company defaults specified in the utility function are prepopulated on the 
screen. 

Point calculates the adjustment to impounds from the aggregate analysis and enters the 
adjustment on the Closing Costs Worksheet. 

1. Select the Escrow Account Disclosure from the Form menu. 

2. Verify the Servicer. 

 

Figure 202: Escrow Account Disclosure 

3. Enter Servicer Contact Information. 

4. Enter Payment Date. 

5. Enter any user-defined fees in the Blank fields. 

Note: The user-defined fields are inn Section G. Initial Escrow Payment at Closing on the 
Closing Costs Worksheet. Enter the information for these funds in the Closing Costs 
Worksheet to include amounts for the user-defined fields in the aggregate total. 
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6. Click Calculate to open the Initial Escrow Account Setup dialog. 

 

Figure 203: Initial Escrow Account Setup 

7. Enter the number of months the Borrower must pay in the Cushion row to specify 
the advanced reserve. 

8. Enter the number of months being paid in the field for the month the payment is 
due to add additional escrow charges. 

Example: Enter 6 in the April and December rows in the Tax Disb column if property taxes 
are paid in April and December for a six-month period. Enter 12 in the field for the month the 
if the payments are made annually. 

Note: Do not enter values in the fields unless the fees are to be included in the ongoing 
monthly escrow payments. Delete any default values, or replace them with zeros, not 
included in the ongoing monthly payments. Do not remove the cushion value if the fees are 
to be paid at the close of escrow. 

9. Select the entry to change and enter the new value to change a default setting. 

Note: Select the cell containing the fee and press Delete to remove a value. 

10. Select the Exclude checkbox at the bottom of a disbursement to exclude a fee 
from the aggregate accounting. 

11. Click OK to calculate and close the dialog. 

12. Click Save to save form. 

Note: Click Company Defaults to reset the fees to company defaults. 
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Flood Certification Work Order 

Use the Flood Certification Work Order to order Borrower flood insurance when property is 
listed in a flood zone. 

Automated Flood Report 

Use the following steps to request a Flood Report using the Request Certification Request 
dialog when the Flood Provider is available from the Services menu. 

1. Select Flood Certification Work Order from the Form menu. 

2. Click Request Flood to request flood certification. (See Flood Certification for 
requesting flood certification.) 

 

Figure 204: Flood Certification Work Order 

Note: View Flood is available after the receiving the Flood Certification. 

Manual Flood Request 

Complete the information to manually request flood certification. 

1. Enter the FFCC Customer Number. 

2. Enter the Branch Location if applicable. 

3. Enter the Legal Description. 

4. Enter the Assessor’s Parcel. 
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5. Select Flood Policy in Force checkbox after receiving policy information. 

Note: Track the status of the flood request on the Track Status and Checklist screen. 

6. Select the appropriate Property Type checkbox. 

7. Select the Escrow Account Established for Loan if applicable. 

8. Select the appropriate The Loan Is checkbox. 

9. Complete the Flood Ins Req’d field. 

10. The FEMA Information populates after the report is complete. 

 

Figure 205: FEMA Information 

11. Click Save to save form. 

Flood Hazard Determination 

The Flood Hazard Determination is the standard Flood Hazard Form created by FEMA. 

1. Select Flood Hazard Determination from the Form menu. 

2. Click Request Flood to request flood certification. (See Flood Certification for 
requesting flood certification.) 

 

Figure 206: NFIP Fields 

Note: View Flood is available after the receiving the Flood Certification. 
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3. Enter Lender ID Number. 

4. Verify the Loan Identifier. 

5. Enter the Amount of Flood Insurance. 

6. Enter the NFIP Community name. 

7. Enter the NFIP Community Number. 

8. Complete the National Flood Insurance Program (NFIP) Data Affecting 
Building/Mobile Home fields. 

9. Complete the Federal Flood Insurance fields. 

 

Figure 207: Remaining Fields 

10. Select the Determination Yes checkbox. 

11. Enter Comments. 

12. Enter Preparers Information. 

13. Enter Date of Determination. 

14. Click Save to save form. 

Flood Hazard Notice 

The Flood Hazard Notice notifies potential buyers of special flood hazards in the area and of 
the availability of federal disaster relief assistance. 
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1. Select Flood Hazard Notice from the Forms menu. 

2. Click Request Flood to request flood certification. (See Flood Certification for 
requesting flood certification.) 

 

Figure 208: Flood Hazard Notice 

Note: View Flood is available after the receiving the Flood Certification. 

3. Select the appropriate Notice 1 checkboxes. 

4. Verify the Flood Hazard Bound Map Community. 

5. Select the appropriate Notice 2 checkbox. 

6. Click Save to save form. 

HOEPA Homeownership Counseling 

The HOEPA Homeownership Counseling screen is used to document information to comply 
with the HOEPA disclosure and management of home ownership counseling. 

Note: Complete the top portion of the screen after the Borrower(s) have completed the 
homeownership counseling. 

The following disclosures are completed with this screen: 

• Homeownership Counseling Notice—Not High-Cost Mortgage 

• Homeownership Counseling Notice—High Cost Mortgage 

• Acknowledgment of Receipt of Homeownership Counseling Notice 

• Acknowledgment of Certification of Counseling 

• Counseling for First-Time Borrowers Acknowledgment 

• Homeownership Counseling List 
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1. Select HOEPA Homeownership Counseling from the Forms menu. 

2. Click the CFPB Tool to Generate Homeownership Counselors List link to search 
for a list of local counseling organizations on the CFPB website. 

 

Figure 209: HOEPA Homeownership Counseling 

3. Enter the name and contact information of local organizations in the 
Homeownership Counselors List field. 

Note: Copy and paste all or a portion of the list or enter the information manually. 

4. Generate the HOEPA Disclosures applicable to this loan. 

5. Complete the following fields after the Borrower(s) completes the counseling: 

• Date Prepared 

• Counselor Name 

• Counselor Address 

• Borrower Completed Date 

• Co-Borrower Completed Date 

6. Click Save to save form. 

Loan Submission Sheet 

The Loan Submission Sheet is a summary of the loan information. Use the Loan Submission 
as a cover page when submitting a loan manually for underwriting. 



   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
212 

Complete the Loan Submission Sheet last to ensure all required fields are populated. 

Review Populated Information 

Verify with the lender the form is accepted prior to submission. 

1. Select Loan Submission Sheet from the Forms menu. 

2. Review the Lender section. 

 

Figure 210: Loan Submission Sheet 

3. Complete any missing information in the Loan Summary and Terms section. 
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Vendor Details 

1. Verify Submitting Broker/Lender information. 

 

Figure 211: Vendor Details 

2. Verify Appraisal Company information. 

3. Complete Escrow Company fields. 

4. Complete Title Company fields. 
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Loan Demands 

The Demand section is used to record certain loan related fees. 

1. Click the Loan Demands button. 

 

Figure 212: Loan Related Fees Dialog 

2. Select the Lender radio button. 

3. Enter the amount the lender must pay. 

Note: Dialog information may be populated from the Fees Worksheet. 

4. Select the Borrower button. 

5. Enter the amount the borrower must pay. 

6. Click OK to close the dialog. 

7. Enter additional fees due to the lender in the Lender column. 

 

Figure 213: Other Demands 

Note: Additional fees may include Appraisal Fee, or Credit Reporting Fee, etc. 
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8. Enter fees already paid by the Borrower to the Broker in the open fields left of the 
Broker column. 

Note: Leave the field blank if the lender is due the entire fee paid by the Borrower. The fees 
automatically total. The Borrower Total Owed equals the sum of the Amount Due to the 
lender plus the amount Paid/Due to the Broker. 

9. Enter Comments/Other Instructions if applicable. 

10. Click Save to save form. 

Mortgage Loan Origination Agreement 

The Mortgage Loan Origination Agreement states the nature of the relationship being 
entered into between the broker or lender and the Borrower. 

1. Select Mortgage Loan Origination Agreement from the Forms menu. 

2. Review the populated fields. 

 

Figure 214: Loan Origination Agreement 

3. Enter Name of Law if applicable. 

4. Click Save to save form. 
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Mortgage Loan Commitment 

The Mortgage Loan Commitment form communicates the rate lock and loan lock status to 
the Borrower. 

1. Select Mortgage Loan Commitment from the Forms menu. 

2. Verify the populated fields. 

 

Figure 215: Mortgage Loan Commitment 

3. Enter the date the Borrowers Rate Lock and Commitment expire in the Cmt Expires 
field. 

4. Enter the terms of repayment according to the loan program in the Repayment 
Terms field. 

5. Enter the type of title insurance required in the Evidence of Title field. 

6. Select the appropriate Return to Lender checkbox(es) at the form bottom. 

7. Enter the Within Days value. 

8. Enter the Alternate Lender Address information if applicable. 

9. Click Save to save form. 
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Notice of Action Taken 

The Notice of Action Taken informs Borrowers of the following information: 

• Reason(s) their credit request was denied. 

• Reason loan application was terminated. 

• Other action is taken with the loan application. 

The following buttons, located at the bottom of the workspace, provide additional 
functionality. 

Actions Taken 

Use the following steps to complete the Action Taken fields. 

1. Select Notice of Action from the Forms menu. 

2. Verify the populated fields. 

 

Figure 216: Action Taken 

3. Enter the Description of the account, Transaction, or Requested Credit description. 

4. Select the Action Notice. 

5. Select the HMDA Action Taken. 

6. Enter the Action Date. 

7. Enter the action information in the Notice Detail field. 
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8. Enter the date the offer expires, or the completed application is required if you 
selected Notice of Counter Offer or Notice of Incomplete Application. 

9. Select the If checked, our principal reasons for denying your original request are 
indicated below checkbox if Counter Offer was selected for Action Taken. 

10. Enter the Date Denied if Notice of Credit Denial was selected for Action Taken. 

Principal Reasons 

Use the following steps to select the reason for actions taken. 

1. Select the reasons for the action taken from the Part 1 list. 

 

Figure 217: Principal Reasons 

2. Enter any user-defined reasons in the Blank fields. 
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Disclosures 

Use the following steps to complete the Disclosure fields. 

1. Click Copy from Credit Score Disclosure. 

 

Figure 218: Credit Score Disclosure 

2. Select the Credit Reporting Agency used to provide the credit report information 
for the Borrower/ Co-Borrower. 

 

Figure 219: Select Credit Score for Disclosure 

3. Click OK to close the dialog. 

4. Select the Information obtained in a report from a consumer reporting agency 
checkbox if the information Disclosures section was obtained from a consumer 
reporting agency. 

Note: The selections on the Select Credit Score for Disclosure dialog populate the Date 
Created, Factors, and the Credit Scores fields. 

5. Complete the Borrower fields. 
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6. Enter the number of recent credit inquiries for the Borrower in the Number of 
recent inquiries on credit report fields. 

7. Repeat Steps 5 – 6 for Co-Borrower. 

8. Select the applicable checkbox if information was obtained from a source other 
than a consumer reporting agency. 

9. Select the Additional Statement checkbox to provide additional information. 

10. Enter the Additional Statement. 

11. Enter provider of document in the Completion of letter by field. 

12. Select the Delivery Method. 

13. Enter the notice delivery Date. 

14. Click Save to save form. 

Notice of Action Taken Buttons 

Use the Notice of Action Taken buttons for HMDA reporting. 

HMDA Reporting (2017) 

Click to access the HMDA Reporting (2017) screen. See HMDA Reporting (2017) for details. 

HMDA Reporting (2018) 

Click to access the HMDA Reporting (2018) screen. See HMDA Reporting (2018) for details. 

Patriot Act Disclosures 

Patriot Act Disclosures must be completed by all financial institutions to comply with the 
USA Patriot Act. 

Borrower Identification 

Use the following steps to complete the Borrower Identification Patriot Act Disclosure. 

1. Select Patriot Act Disclosures from the Forms menu. 

2. Select Borrower Identification. 
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3. Enter the Date. 

 

Figure 220: Patriot Act: Borrower Identification 

4. Review the populated fields. 

5. Select the Primary Identification Document Type. 

6. Enter Other Document Type if the required selection is not available. 

7. Enter the Document Number. 

8. Enter the Issue Date. 

9. Enter the Expiration Date. 

10. Enter the Issued by. 

11. Repeat Steps 5 – 10 for Secondary Identification Documentation. 

12. Enter Discrepancies and Resolution details if applicable. 

13. Enter Completed by Name. 
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Co-Borrower Identification 

Use the following steps to complete the Co-Borrower Identification Patriot Act Disclosure. 

1. Select Patriot Act Disclosures from the Forms menu. 

2. Select Co-Borrower Identification. 

3. Use the steps in Borrower Identification to complete the Co-Borrower 
Identification disclosure. (See Borrower Identification.) 

Organization Identification 

Use the following steps to complete the Organization Identification Patriot Act Disclosure. 

Note: The Organization Identification Patriot Act Disclosure is required for companies. 

1. Select Patriot Act Disclosures from the Forms menu. 

2. Select Organization Identification. 

3. Enter the Date. 

 

Figure 221: Patriot Act: Organization ID 

4. Enter the Organization or Entity Information. 

5. Click Copy From Subject Property to auto populate the Org or Entity Address. 

Note: Manually enter the field information if applicable. 
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6. Click Copy From Mailing Address to auto populate Mailing Address. 

Note: Manually enter the field information if applicable. 

7. Select the Organization or Entity Identification Doc Type. 

8. Enter Other Document Type if the required selection is not available. 

9. Enter the Document Number. 

10. Enter the Tax ID. 

11. Enter the Issue Date. 

12. Enter the Expiration Date. 

13. Enter the Issued by. 

14. Enter Discrepancies and Resolution details if applicable. 

15. Enter Completed by Name. 

Request for Appraisal 

Use the Request for Appraisal form to request the AVM for the subject property. Manually 
enter the information if the appraiser fields are blank. 

Note: The View AVM button is available if an appraisal has been completed. 

Select Request for Appraisal from the Forms menu. 
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Automated Requests 

Click Request AVM to request the appraisal using the AVM Request dialog if the appraiser is 
listed as a provider in the Services menu. (See AVM Reports for requesting AVM details.) 

 

Figure 222: Request for Appraisal 

Note: View AVM is available after appraisal receipt. 

Manual Requests 

Use the following steps to manually request AVM. 

1. Enter the From Information. (See Figure 222.) 

2. Enter the Date. 

3. Enter/verify the Appraiser Information. 

4. Enter the Order Number. 

5. Enter the FHA Case # if applicable. 
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6. Verify the Property Information. 

 

Figure 223: Appraisal Property & Mortgage Info 

7. Enter a Legal Description if required. 

8. Enter the Escrow Company information. 

9. Enter the Title Company information. 

10. Enter the Listing Agent information. 

11. Enter the Selling Agent information. 

12. Select the requested Appraisal Information. 

13. Enter the Due Date. 

14. Enter the E-Mail Appraisal to information. 

15. Enter Appraisal Cost. 

16. Enter Contact for Entry. 

17. Select the appropriate Payment Method. 

18. Enter Bill or Other field information if applicable. 

19. Enter Comments if required. 
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Request for Evidence of Insurance 

Use the following steps to request a Hazard Insurance Quote. 

1. Select Request for Evidence of Insurance from the Forms menu. 

2. Enter the Annual Premium. 

 

Figure 224: Request Hazard Insurance Quote 

3. Enter/verify the Insurance Company Agent Information. 

4. Enter the From Information if applicable. 

5. Enter Legal Description if required. 

6. Enter the Insurance Agent Address if required. 

7. Enter Estimated Closing Date. 

8. Select the Type of Insurance. 

9. Enter Comments if required. 
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Request for Payoff 

Use the Request for Payoff form to request a payoff amount from the lien holder. 

1. Select Request for Payoff from the Forms menu. 

2. Enter the Date. 

 

Figure 225: Request Payoff 

3. Enter the Account Number. 

4. Select the New Request checkbox when requesting the pay off the first time. 

Note: Select Revision Request and enter the Original Request Date when requesting an 
updated payoff amount. 

5. Enter the request recipient information in the To fields. 

6. Click Copy Brw to copy the Borrower screen information. 
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7. Click Copy Co-Brw to copy the Borrower screen information 

 

Figure 226: Request for Payoff Details 

8. Repeat Steps 6 – 7 for Borrower 2 if applicable. 

9. Select the appropriate Response Options. 

10. Enter Response details. 

11. Enter Special Instructions if required. 

Request for Survey 

Use the following steps to request a survey. 

1. Select Request for Survey from the Forms menu. 

  



   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
229 

2. Enter the Surveyor information in the To fields. 

 

Figure 227: Request for Survey 

3. Select the appropriate Attachments. 

4. Enter the Due Date. 

5. Enter Comments if required. 

6. Click Save to save form. 

Request for Tax Return 

Use the Request for Tax Return form to provide the Borrower authorization to verify tax 
information with the Internal Revenue Service. 

Form 4506 orders copies of tax returns. 

Form 4506-T orders transcripts of tax returns. 

Form 4506-C enables Income Verification Express Service (IVES) participants to order tax 
transcript records electronically for a third-party. 

A single screen is used in Point to complete the 4506, 4506-T, and 4506-C forms. 

The Send Return Transcript To section from the 4506-T screen is used to print the IVES 
Participant Name and SOR number in Section 5a of the 4506-C form. 

A separate print package must be created for the 4506-C form because the 4506-T and 
4506-C use the same fields to print the Return Address on the 4506 form as opposed to the 
IVES Participant Name and SOR number for the 4506-C form. 

Note: The IRS instructions to complete and submit the 4506 and 4506-T are provided on 
page 2 of each form. Select Print Preview with the form open to view the IRS instructions. 
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Name of Tax Return 

The initial tax return fields are populated from other screens. 

1. Select Request for Tax Return (4506/4506-T/4506-C) from the Forms menu. 

Note: The Borrower and Co-Borrower fields are automatically populated and disabled for 
changes. 

2. Select the Borrower Name, Phone, SSN on Tax Return, if Not Name of Borrower 
checkbox if applicable. 

 

Figure 228: Request for Tax Return 

3. Enter the Borrower EIN if applicable. 

Note: No additional entries or clarification is required in the Name on Tax Return section if 
the Borrower and Co-Borrower are married, filing jointly, and the Borrower is named first on 
the tax return. 

4. Repeat Steps 2 – 3 for the Co-Borrower if required. 

5. Complete the Present Address section. 

6. Select the Previous Address on Last Return, if Different from Present Address 
checkbox and enter the address if applicable. 
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IVES Information 

Complete the IVES fields to order tax transcript records for a third-party. 

1. Enter the specific information received from the vendor in the Name field. 

 
Figure 229: IVES Information 

Note: See the IRS instructions to complete and submit the 4506-C on page 2 of the form. 

2. Enter Vendor address information. 

3. Enter SOR Mailbox. 

4. Enter Customer #. 

5. Enter IVES ID #. 

6. Enter the Unique ID. 

Client Information 

The Client Information section allows the user to specify the company that requests the tax 
transcripts from the IVES participant. 

Note: Due to IRS compliance, this section CAN NOT be blank or Not Available (NA). 

  



   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
232 

1. If the client information is the same as the IVES Information section, select the 
Same as IVES Information checkbox to copy over values. 

 
Figure 230: Client Information 

2. Enter the Name. 

3. Enter the address (Street, Unit, Number, City, St, ZIP). 

4. Enter Phone number. 

Send Return Transcript 

Complete the Send Return Transcript to fields for 4506 and 4506-T if not populated. 

1. Enter the transcript recipient Name. 

 

Figure 231: Return Transcript Fields 

2. Enter the transcript recipient Address. 

3. Enter the transcript recipient Phone. 

Fee 

Using the following steps to complete the Fee section. 
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1. Enter a Cost amount. 

 
Figure 232: Fee 

2. Enter # of Returns. 

3. If needed, select the Return Refund to 3rd Party Listed on Line 5 checkbox. 

Type of Transcript 

Use the following steps to complete the remaining fields. 

1. Select the Transcript Form #. 

 

Figure 233: Remaining Fields 

2. Select Certified Copy if required. 

3. Select the Transcript Type(s). 

4. Enter the Request Period Ending Dates. 

Wages & Income 

Use the dropdown menus to choose which forms to request to verify the borrower’s wages 
and Income. 

Note: The IRS only allows the user to request three (3) forms. 

  



   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
234 

1. In the form dropdown menus, select the desired forms. 

 
Figure 234: Wages & Income 

2. Select the Request for Borrower checkbox. 

3. If needed, select the Request for Co-Borrower checkbox. 

4. Click Save to save the form. 

Request for Title Commitment 

Use the following steps to request the title/escrow from the title company. 

Note: The View Title/Escrow button is available when the title/escrow has been received. 

Select Request for Title Commitment from the Forms menu 

Automated Request 

Click Request Title/Escrow to request the title using the Title/Escrow Request dialog when 
available from the Services menu. 
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Manual Request 

Use the following steps to complete the request manually. 

1. Enter the Title/Escrow Officer Name. 

 

Figure 235: Request for Title Commitment 

1. Enter the Title/Escrow Officer Contact Information. 

2. Enter the Title/Escrow Officer Company. 

3. Enter the Title/Escrow Officer Company Address. 

4. Enter the From information. 

5. Verify the Property and Mortgage Information. 

6. Enter a Legal Description if required. 

7. Verify Property Address. 

8. Verify/enter Owner’s Name & Phone. 

9. Select/verify Property Type. 

10. Enter Seller details. 
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11. Enter the Insured Lender/Mortgage Contact information. 

12. Complete the Request for Title Commitment fields. 

13. Enter Special Instructions if required. 

Self-Employed Income Analysis 

The Self-Employed Income Analysis is comprised of two forms. 

Form A 

Use the following steps to complete the Self Employed Income Analysis Form A. 

Note: Point performs the calculations automatically. 

1. Select Self-Employed Income Analysis from the Forms menu. 

2. Select Form A. 

3. Verify the Borrower Information. 

 

Figure 236: Self Employed Income Analysis A 
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4. Enter Schedule Analysis Method(s). 

5. Enter Individual Tax Return information. 

6. Enter Corporate Tax Return information if applicable. 

7. Enter S Corporate/Partnership Tax Return information if applicable. 

8. Enter Year-to-Date Profit and Loss information if applicable. 

9. Click Save. 

10. Click Frm B. 

11. Enter the Form B information. 

Form B 

Use the following steps to complete the Self Employed Income Analysis Form B. 

Note: Point performs the calculations automatically. 

1. Verify the Borrower Information. 

2. Enter Adjusted Gross Income Method(s). 

3. Enter Individual Tax Return Adjusted Gross Income. 

 

Figure 237: Self Employed Income Analysis B 
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4. Enter Individual Tax Return information. 

5. Enter Adjustment Section details if applicable. 

6. Enter Additional Schedules if applicable. 

7. Enter Corporate Tax Return information if applicable. 

8. Enter S Corporate/Partnership Tax Return information if applicable. 

9. Enter Year-to-Date Profit and Loss information if applicable. 

10. Click Save. 

Social Security Number Verification 

Use the Social Security Number Verification (SSA-89) form to collect the data required to 
complete the Authorization for the SSA to release the Social Security Number (SSN) 
Verification form. The Borrower signature on the form authorizes the Consent Based Social 
Security Number Verification Service (CBSV) to verify the SSN and Borrower name are a 
match according to the SSAs records. 

The information is submitted on the CBSV website for verification. CBSV returns the 
verification or indication there is an issue with the SSN. 

1. Social Security Number Verification (SSA-89) from the Forms menu. 

2. Enter the type of transaction being conducted. 

 

Figure 238: Social Security Number Verification 

3. Select the Reasons for using CBSV. 

4. Complete the Return to fields. 

5. Click Save to save form. 
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Tax Information (1098) 

The Tax Information (1098) form contains origination and discount fees along with the first 
year of interest for the loan. 

1. Select Tax Information (1098) from the Forms menu. 

2. Verify the populated information. 

 

Figure 239: Tax Information (1098) Form 

3. Enter the Recipient’s Federal ID. 

4. Enter the 1st Payment Date. 

5. Enter the Account Number. 

6. Enter the Date Last Payment was Received. 

7. Complete remaining fields if applicable. 

8. Click Save to save form. 

State Disclosures 

The following states have Borrower disclosure that must be completed. 
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Lender Disclosure (FL) 

Florida requires the Lender Disclosure be provided to the Borrower. 

1. Select State Disclosures from the Forms menu. 

2. Select Lender Disclosure (FL). 

3. Enter the Date Prepared. 

 

Figure 240: Florida Lender Disclosure 

4. Select the appropriate Fees Collected at Application checkbox. 

5. Enter the Amount Received for the selected checkbox. 

6. Enter Check made payable to. 

Note: Select N/A if no fees are collected. 

7. Complete the Estimated number of days required by lender fields. 

Application Log (NY) 

New York requires the Application Log be provided to the Borrower. 

1. Select State Disclosures from the Forms menu. 

2. Select Application Log (NY). 
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3. Verify the populated information. 

 

Figure 241: New York Application Log 

4. Enter Application Date. 

5. Complete Fees Received Table. 

6. Add Referral Source Details. 

7. Add Broker Fee Details. 

8. Click Save to save form. 

Pre-Application Disclosure (NY) 

New York requires the Pre-Application Disclosure be provided to the Borrower. 

1. Select State Disclosures from the Forms menu. 
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2. Select Pre-Application Disclosure (NY). 

3. Enter the Assistance in processing the loan application, and in meeting conditions 
of the loan commitment, such as field. 

 

Figure 242: Pre-Application Acknowledgement 

4. Enter the Acknowledgement(s). 

Broker Fees 

Use the following steps to complete the Broker Fee and Mortgage Broker Fee 
acknowledgments. 

1. Complete the required Broker Fees. 

   

Figure 243: Broker Fee Acknowledgements 

2. Enter the Application Fee. 

3. Enter the Property Appraisal fee. 

4. Enter the Credit Report Fee. 

5. Enter the application fee refundable details if applicable. 
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Remaining Fields 

Use the following steps to complete the remaining fields. 

1. Enter the Processing Fee. 

 

Figure 244: NY Pre-App Disclosure Remaining Fields 

2. Complete the Application Questions statement as applicable. 

3. Enter the applicable Designated Lenders. 

4. Complete the Division of Fees fields. 

Mortgage Disclosures (TX) 

Texas requires the Mortgage Disclosures be provided to the Borrower. 

1. Select State Disclosures from the Forms menu. 

2. Select Mortgage Disclosures (TX). 
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3. Verify Originator. 

 

Figure 245: Texas Mortgage Disclosures 

4. Complete Texas Mortgage Company Disclosure fields. 

5. Complete How we will be compensated fields. 

6. Complete Texas Mortgage Banker Disclosure fields. 

Federal Housing Administration (FHA) 

FHA requires additional forms and information to process loans.  

Underwriting & Transmittal Summary 

The FHA Loan Underwriting and Transmittal Summary (HUD-92900-LT) contains detailed 
information about the loan to simplify the disclosure of loan-level information. The form is 
required to submit an FHA loan to underwriting for both purchases and refinanced loans. 

Most summary fields are automatically populated from the Borrower Information screen, 
Loan Application, and Truth-in-Lending screen. 

Note: Use the Underwriting & Transmittal Combined form when unmarried Co-Borrowers 
are applying jointly for the loan. 
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FHA Identification Information 

1. Select Federal Housing Administration (FHA) from the Forms menu. 

2. Select FHA Loan Underwriting and Transmittal Summary (HUD-92900-LT). 

3. Verify the populated fields. 

 

Figure 246: FHA Identification Information 

4. Enter the FHA Case Number. 

5. Select Section of Housing Act. 

6. Select FHA Assign Date. 

7. Enter the Appraisal Reviewer CHUMS ID. 

8. Enter the Underwriter CHUMS ID. 

9. Select the appropriate Risk Class checkbox. 

10. Click the Run FHA Total Scorecard button to retrieve the LoanScorecard. 

11. Verify Borrower and Property Information. 

12. Enter Sales Price if applicable. 

13. Select the applicable Construction checkbox when property is construction. 
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Mortgage Information 

Complete the applicable Mortgage Information fields. 

1. Verify the populated Mortgage Information. 

 

Figure 247: Mortgage Information 

2. Enter Secondary Financing details if applicable. 

3. Select the applicable Amortization Type. 
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Underwriting Information 

Complete the applicable Underwriting Information. 

1. Click Base Income to edit income information. 

 

Figure 248: Underwriting Information 

2. Complete the Monthly Income Calculator dialog. (See Figure 32.) 

3. Click OK on the dialog. 

4. Complete the Proposed Monthly Payment fields if applicable. 

5. Complete the Debts and Obligations fields if applicable. 

6. Enter the Borrower Funds to Close information as applicable. 

7. Modify Borrower Funds to Close if applicable. 

8. Enter Underwriter details. 

Transmittal Summary Buttons 

Mtg Insurance 

Use the Mtg Insurance button to access the Mortgage Insurance dialog. (See Mtg Insurance 
for details.) 

FHA Stat Req 

Click the FHA Stat Req button to access the FHA Statutory Requirements Worksheet. (See 
Statutory Requirements Worksheet.) 
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Underwriting & Transmittal Combined 

Complete the FHA Loan Underwriting and Transmittal Summary Combined form for multiple 
Borrower sets. The fields are the same as the FHA Loan Underwriting and Transmittal 
Summary (HUD-92900-LT) form. (See Underwriting & Transmittal Summary.) 

Statutory Requirements Worksheet 

Use the FHA Statutory Requirements Worksheet to maintain compliance with FHA guidelines 
requiring the statutory required calculations be documented in the FHA loan file. 

Most of the fields in the FHA Statutory Requirements Worksheet are populated with data 
previously entered in the Borrower Information screen, the Loan Application, and the Fees 
Worksheet. 

1. Select Federal Housing Administration (FHA) from the Forms menu. 

2. Select FHA Statutory Requirements Worksheet. 

3. Verify the populated fields. 

 

Figure 249: FHA Statutory Requirements 
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4. Click Minimum Down Payment Required Lock to change the listed percentage or 
value. 

5. Enter Required Adjustments if applicable. 

6. Enter the Maximum Mortgage Amount w/o UFMIP if applicable. 

7. Click CC Adjustments for FHA Additional Itemized Closing Costs. 

Note: Itemized Costs (Ex: Energy Efficient Mortgage) entered in the Total Credits table on 
the Lender Loan Pg. 2 screen will auto-populate in the FHA: Additional Itemized Closing 
Costs. 

8. Update the Mortgage Insurance Premium Refund on the FHA: Additional Itemized 
Closing Costs dialog. 

 

Figure 250: FHA: Additional Closing Costs 

9. Enter the Required Cash Investment if required. 

10. Enter Repairs/Improvements. 

11. Enter Energy Efficient Mortgage. 

12. Click Close. 

13. Enter Upfront MIP Paid in Cash if applicable. 

Statutory Requirements Worksheet Buttons 

FHA Trans Sum 

Click to open the FHA Transmittal Summary Worksheet. (See Underwriting & Transmittal 
Summary.) 
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Mtg Insurance 

Use the Mtg Insurance button to access the Mortgage Insurance dialog. (See Mtg Insurance 
for details.) 

203(k) Worksheet 

The HUD-92700 Maximum Mortgage Worksheet calculates the maximum mortgage 
amount allowed for Streamlined (k) loans for purchases and refinances. 

Note: Fields not enabled are calculated based on the input from other screens and will 
auto-populate. 

Commitment Stage and Property Information 

Use the following steps to complete the Commitment Stage and Property Information 
fields. 

1. Select Federal Housing Administration (FHA) from the Forms menu. 

2. Select FHA 203(k) Worksheet (HUD-92700). 

3. Verify populated fields. 

 

Figure 251: FHA 203(k) Worksheet 

4. Enter the FHA Case Number. 

5. Enter the Number of Units if appliable. 

6. Select the HUD-REO Property checkbox if applicable. 

7. Select the Commitment Stage. 
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8. Select the Streamline (K) checkbox if applicable. 

9. Enter the Purchase Date if selecting the checkbox. 

10. Enter the Contract Sales Price. 

11. Enter the As Is Value. 

12. Enter the Allowable Energy Improvements amount. 

Rehab & Other Costs 

Complete the Rehabilitation and Other Allowable Costs section for repair loans. 

1. Enter the Total Cost of Allowable Repairs. 

 

Figure 252: Rehab & Other Costs 

2. Enter the Contingency Reserves if applicable. 

3. Enter the Inspection Fees values. 

4. Enter the Title Update Fees values. 

5. Enter the Mortgage Payments Escrowed values. 

6. Enter Architectural and Engineering Fees. 

7. Enter Consultant Fees if applicable. 

8. Enter Permits fees. 

9. Enter Other Fees. 

10. Enter the Discount Points. 
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Mortgage Calculation for Purchase Transaction 

Use the following steps to complete the Mortgage Calculation for Purchase Transaction 
when applicable. 

1. Enter the Base Mortgage Amount Required Adjustment. 

 

Figure 253: Mortgage Calculation for Purchase 

2. Enter the HUD-Owned Property value if applicable. 

3. Click to the Lock to enter the value. 

Mortgage Calculation for Refinance Transaction 

Use the following steps to complete the Mortgage Calculation for Refinance Transaction 
if applicable. 

1. Enter the Existing Debt Sum. 

 

Figure 254: Mortgage Calculation for Refinance 

2. Click the Lock to enter the value. 

3. Enter the Lesser of Sum value. 

4. Enter the Owner-Occupant value. 

5. Click the Lock to enter the Base Mortgage Amount. 
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Remaining Fields 

1. Select the Calculation for Energy Efficient Mortgage Lock to enter a value. 

 

Figure 255: HUD-92700 Remaining Fields 

2. Enter Total Escrowed Funds. 

3. Update the Interest Rate if applicable. 

4. Enter the Discount Points. 

5. Click the Lock to manually enter the Total Mortgage Amount with UFMIP. 

6. Select the appropriate Borrower’s Acknowledgement checkbox. 

7. Enter Remarks if required. 

Addendum to URLA 

The FHA Addendum to URLA (HUD-92900-A/26-1802a) is a supplemental form to 
accompany the Uniform Residential Loan Application. 

Borrower & Property Info 

Verify Borrower and Property Information. 

1. Select Federal Housing Administration (FHA) from the Forms menu. 

2. Select FHA Addendum to URLA (HUD-92900-A/26-1802a). 
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3. Select Application Type checkbox. 

 

Figure 256: FHA Addendum to URLA 

4. Select the appropriate Section of the Act. 

5. Verify the populated fields. 

6. Enter the Legal Description if required. 

7. Enter the Discount Amount if applicable. 

8. Enter Lender’s ID Code. 

9. Enter the Sponsor/Agent ID Code. 
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Lines 15 – 19 

Use the following steps to complete Lines 15 – 19. 

1. Complete the Lender Contact Information. 

 

Figure 257: Lines 15 - 19 

2. Complete the Sponsor/Agent Contact Information. 

3. Select the Sponsored Originations checkbox if applicable. 

4. Select the appropriate First-Time Homebuyer checkbox. 

5. Select the VA Only checkbox if applicable. 

  



   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
256 

Loan Purpose & Duty Agents 

Use the following steps to complete the Loan Purpose & Duty Agents fields. 

1. Select the appropriate Purpose of Loan checkbox. 

 

Figure 258: Loan Purpose & Duty Agents 

2. Complete Duty Agents fields if applicable. 

3. Complete the Function fields if applicable. 
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Borrower’s Certification 

Use the following steps to complete the Borrower’s Certification fields. 

1. Select the appropriate 22a checkbox(es). 

 

Figure 259: Borrower’s Certification 

2. Enter the Sales Price. 

3. Enter Original Mortgage Amount. 

4. Enter Property Address. 

5. Select the applicable 22e – 23 checkboxes. 

6. Select the applicable 25 checkbox if a VA loan. 
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Approved or Modified & Approved 

Complete either Approved or Modified & Approved. 

Note: Skip to Step 4 if Modified & Approved. 

1. Select Approved if applicable. 

 

Figure 260: Approved or Modified & Approved 

2. Select the Current Date. 

3. Select Approval Expiration Date. 

4. Select Modified & Approved if applicable. 

5. Enter the Loan Amount. 

6. Enter the Interest Rate. 

7. Enter the Proposed Maturity. 

8. Enter the Monthly Payment. 

9. Enter the Amount of UFP. 

10. Enter the Monthly Premium. 

11. Enter the Term. 

12. Select the applicable checkboxes. 
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Mortgagee Certification 

Use the following steps to complete the Mortgagee Certification. 

1. Enter the Company Contact Name. 

 

Figure 261: Mortgagee Certification 

2. Enter the Company Phone. 

3. Enter the Company Contact Title. 

4. Enter the Certification Code Number. 

5. Enter the Certification Type. 

Application for Property Improvement 

The FHA Application for Property Improvement form is used to apply for credit to complete 
improvements to a home or other property. 

Borrower Information 

Used the following steps to complete the Borrower Information. 

1. Select Federal Housing Administration (FHA) from the Forms menu. 

2. Select FHA Application for Property Improvement (HUD-56001). 
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3. Select the appropriate checkbox. 

 

Figure 262: FHA Property Improvement App 

4. Complete associated checkbox fields as applicable. 

5. Verify the populated fields. 

6. Enter Borrower’s Bank Account details. 

7. Enter Co-Borrower’s Bank Account details if applicable. 
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Debts 

Complete the applicable Debt fields. 

1. Enter Automotive Lienholder(s) information. 

 

Figure 263: Debts 

2. Complete the Automotive fields. 

3. Enter the Real Estate Lienholder(s). 

4. Complete the Real Estate fields. 

5. Enter other Lienholders as applicable. 
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Property & Lease Information 

Use the following steps to complete the remaining Property Improvement fields. 

1. Select the Property to be Improved checkboxes. 

 

Figure 264: Property & Lease Information 

2. Complete the Describe Improvements field. 

3. Select the New Residential checkbox if applicable. 

4. Complete the Dealer/Contractor information. 

DE Analysis of Appraisal 

The Direct Endorsement (DE) Analysis of Appraisal Report (HUD-54114) provides an honest 
assessment of the property appraisal to ensure a valid property description. 

1. Select Federal Housing Administration (FHA) from the Forms menu. 

2. Select FHA DE Analysis of Appraisal (HUD-54114). 
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3. Complete the form fields. 

 

Figure 265: FHA DE Analysis of Appraisal 

DE Statement of Appraised Value 

The FHA DE Statement Of Appraised Value (HUD-928005b) establishes the terms upon 
which a commitment or direct endorsement statement of appraised value is made. The 
statement includes specific conditions that must be met before HUD can endorse a firm 
commitment for mortgage insurance. 

Commitment Terms 

Use the following steps to complete the Commitment Terms fields. 

1. Select Federal Housing Administration (FHA) from the Forms menu. 

2. Select FHA DE Statement of Appraised Value (HUD-928005b). 
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3. Select the appropriate Commitment Terms checkbox(es). 

 

Figure 266: Commitment Terms 

Note: Proceed to Commitment Details if not selecting the See Below checkbox. 

4. Enter the Lender in the By field. 

5. Enter the Action Date. 

6. Enter Lender ID. 

7. Enter Sponsor/Agent. 

8. Enter INST Case Reference Number. 

9. Verify the populated Borrower and Co-Borrower fields. 

Commitment Details 

Use the following steps to complete the Commitment Details. 

1. Select the Existing checkbox. 
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2. Enter the Commitment Issued Date if applicable. 

 

Figure 267: Commitment Details 

3. Enter the Commitment Expires Date if applicable. 

4. Enter the Improved Living Area if applicable. 

5. Select the Proposed checkbox. 

6. Complete the Monthly Expense Estimate fields. 

7. Enter Monthly Expenses information. 

8. Click Other to enter additional monthly expenses. 

9. Complete the Specific Commitment Conditions fields. 

10. Enter other Conditions information if applicable. 

Refi of Borrowers Neg Equity 

The FHA Refi of Borrowers in Neg Equity (HUD-92918) form discloses the states where a 
Borrower and Co-Borrower have previously resided. The form lists aliases they have used. 
This information is used to verify eligibility for the refinance. 

1. Select Federal Housing Administration (FHA) from the Forms menu. 

2. Select FHA Refi of Borrowers Neg Equity (HUD-92918). 
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3. Select the states in which the Borrower has resided in the past 10 years. 

 

Figure 268: FHA Refi of Borrowers Neg Equity 

4. Repeat Step 3 for Co-Borrower. 

Add Borrower Aliases 

Use the following steps to add Borrower Aliases. 

1. Click the Borrower Aliases Add button. 

 

Figure 269: Borrowers Aliases 
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2. Select the Borrower Name on the Edit Alias dialog. 

 

Figure 270: Edit Alias Dialog 

3. Select Alias Type. 

4. Complete the Name fields. 

5. Click Save & Close. 

Note: Click Save & New to add additional aliases. 

6. Repeat steps for other aliases. 

Edit Borrower Alias 

Use the following steps to edit a listed alias. 

1. Select the Alias to edit. (See Figure 269.) 

2. Click Edit. 

3. Update information on the Edit Alias dialog. (See Figure 270.) 

4. Click Save & Close. 

Insert Borrower Alias 

Use the following steps to insert an alias at a selected table position. 

1. Select the position to enter the Alias. (See Figure 269.) 

2. Click Insert. 

3. Enter the information on the Edit Alias dialog. (See Figure 270.) 

4. Click Save & Close. 
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Delete Borrower Alias 

Use the following steps to delete a listed alias. 

1. Select the Alias to delete. (See Figure 269.) 

2. Click Delete. 

Veterans Administration (VA) 

The VA requires additional forms and information to process loans. 

Addendum to URLA 

The FHA/VA Addendum to the URLA (HUD-92900-A/26-1802a) is a supplemental form to 
accompany the Uniform Residential Loan Application. See Addendum to URLA for details on 
completing this form. 

Loan Disbursement Certification 

The VA Certification of Loan Disbursement (26-1820) must be signed at loan closing. The form 
includes a binding occupancy statement. The veteran Borrower is committed to the terms 
of the form once signed. 

1. Select Veterans Administration (VA) from the Forms menu. 

2. Select VA Certification of Loan Disbursement (26-1820). 

3. Enter the Lender’s Loan #. 

 

Figure 271: VA Loan Disbursement Certification 

4. Enter Date of Report. 
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5. Enter the Lender VA ID. 

6. If needed, click on the lockbox icon to change the Property Type. 

7. Complete Nearest Relative Not Living with Veteran fields. 

8. Select the appropriate Request issuance of evidence of checkbox. 

9. Complete the Date fields. 

10. Select the applicable Lien. 

11. Select the applicable Estate in Property. 

12. Enter the Title of Property Is Vested In fields. 

13. Enter Insurance Information. 

14. Enter the Authorized Agents. 

 

Figure 272: Authorized Agents 

15. Select the Construction checkbox if applicable. 

Loan Analysis 

Complete the required VA Loan Analysis (26-6393). 

Personal & Financial Status 

Use the following steps to complete the Personal & Financial Status fields. 

1. Select Veterans Administration (VA) from the Forms menu. 
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2. Select VA Loan Analysis (26-6393). 

3. Click the From Loan App button to import screen data from the Loan Application. 

 

Figure 273: VA Loan Analysis 

4. Verify populated fields. 

5. Click Mtg Insurance to add the mortgage insurance information. (See Mtg 
Insurance.) 

6. Enter Cash Down Payment. 

7. Select the appropriate Utility Included checkbox. 

8. Enter Occupation. 

9. Enter Spouse Occupation. 

10. Enter Age of Dependents if applicable. 

Estimated Monthly Shelter Expenses 

Use the following steps to complete the Estimated Monthly Shelter Expenses fields. 

1. Enter the Mortgage Payment information. 

 

Figure 274: Estimated Monthly Shelter Expenses 
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2. Enter the Realty Taxes. 

3. Enter the Hazard Insurance. 

4. Enter the Special Assessments. 

5. Enter the Maintenance & Utilities. 

6. Enter Other if applicable. 

Debts and Obligations 

Complete the Debts and Obligations Unpaid Balance fields. 

Monthly Income and Deductions 

Use the following steps to complete the Monthly Income and Deductions fields.  

1. Enter the Spouse Gross Salary or Earnings from Employment. 

 

Figure 275: Monthly Income and Deductions 

2. Enter the Spouse Federal Income Tax. 

3. Enter the Spouse State Income Tax. 

4. Enter the Spouse Retirement Social Security. 

5. Repeat Steps 1 – 4 for Borrower. 

6. Enter the Balance Available for Family Support amount. 
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7. Select the appropriate Past Credit Record checkbox. 

8. Select the appropriate Does Loan Meet VA Credit Standards? checkbox. 

9. Enter Remarks if applicable. 

Loan Comparison 

Complete the VA Loan Comparison form for Borrowers refinancing VA loans. 

Refinance Loan Comparison 

Use the following steps to complete the Refinance Loan Comparison fields. 

1. Select Veterans Administration (VA) from the Forms menu. 

2. Select VA Loan Comparison. 

3. Select the Disclosure Form type. 

 

Figure 276: VA Loan Comparison 

4. Enter Date Closed. 

5. Select the IRRL checkbox if applicable. 

6. Complete the Existing Loan fields. 

7. Complete the Proposed Loan fields. 

8. Complete the Estimated Impact of Refinance fields. 

9. Complete the Borrowers fields. 
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 Net Tangible Benefits 

Use the following steps to complete the Net Tangible Benefits for Refinance Loan fields. 

1. Enter the Company Name. 

 

Figure 277: Net Tangible Benefits 

2. Select the applicable Net Tangible checkboxes. 

Remaining Fields 

Complete the remaining screen fields. 

1. Enter the Amount of Cash Directly Disbursed. 

 

Figure 278: Refinance Closing Summary 

2. Enter the Total for payoffs, disbursed, excluding mortgages on behalf of 
borrowers. 

3. Enter the Amount of Increase Over Total of Loan. 

4. Select the Total Closing Costs Lock to manually enter the value. 
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5. Select the Lender Certification checkbox if applicable. 

Loan Summary 

The VA Loan Summary (26-0286) form contains basic loan facts, including information about: 

• Applicant 

• Property 

• Financing 

• Loan and purpose 

All closed loan packages submitted to the VA for a loan guaranty must include the VA Loan 
Summary (26-0286) form. 

Veteran Information 

Use the followings steps to complete the Veteran Information fields. 

1. Select Veterans Administration (VA) from the Forms menu. 

2. Select VA Loan Summary (26-0286). 

3. Enter the VA Agency Case Number. 

 

Figure 279: Veteran Information 

4. Select the appropriate Submittal checkbox. 

5. Verify the populated fields. 

6. Select the appropriate Ethnicity and Race checkboxes. 

7. Enter the Entitlement Code. 
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8. Enter the Entitlement Amount. 

9. Select Branch of Service. 

10. Select Military Status. 

Loan Details 

Complete the loan details. 

1. Select the Purpose of Loan. 

 

Figure 280: VA Loan Summary Loan Details 

2. Select Loan Code. 

3. Select Prior Loan Type if applicable. 

4. Select Type of Mortgage. 

5. Select Type of Ownership. 

6. Enter Lender VA ID. 

7. Enter Agent VA ID. 

8. Select the First-Time Homebuyer checkbox if applicable. 

9. Enter Initial Rate. 

10. Enter the Terms. 

11. Enter the Reasonable Value. 
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12. Enter Closing Date. 

13. Select the appropriate Energy Improvements options. 

Property Details 

Complete the property details. 

1. Select the Appraisal Type. 

 

Figure 281: Property Details 

2. Select the Type of Structure. 

3. Select the Property Type. 

4. Select the Manufactured Home option if applicable. 

5. Select the Property Designation. 

6. Complete the LAPP fields if applicable. 
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Income Information 

Use the following steps to complete the Income Information. 

1. Select the Loan Processed Under Automated Underwriting checkbox if applicable. 

 

Figure 282: Income Information 

2. Select the System Used. 

3. Select the Risk Classification. 

4. Enter the Median Credit Score. 

5. Enter the Residual Income Guideline. 

6. Complete the Discount Information fields. 

7. Complete the IRRRLS Only fields if applicable. 

Refinance Worksheet – IRRL 

Use the VA Refinance Worksheet – IRRL (26-8923) to calculate the maximum loan amount for 
a VA refinance. 

1. Select Veterans Administration (VA) from the Forms menu. 

2. Select VA Refinance Worksheet – IRRL (26-8923). 
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3. Enter the Existing VA Loan Balance. 

 

Figure 283: VA Refinance Worksheet – IRRL 

4. Enter the Subtract Cash Payment Value. 

5. Enter Preliminary Loan Amount Values. 

6. Enter Other Allowable Closing Costs and Prepaids. 

7. Complete the Final Computation fields. 

8. Click Save to save form. 

Req/Cert of Reasonable Value 

The VA Request for Certificate of Reasonable Value (CRV) (26-1805/26-1849) is created from 
an appraiser property value estimate. 

Some of the data for this certificate is populated from the Loan Application. 

Initial Fields 

Use the following steps to complete the initials fields. 

1. Select Veterans Administration (VA) from the Forms menu. 

2. Select VA Request for Certificate of Reasonable Value (CRV) (26-1805/26-1849). 
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3. Enter the Case Number. 

 

Figure 284: VA Reasonable Value Request 

4. Enter HUD Sec of Act. 

5. Verify the Property Address information. 

6. Complete the property Legal Description. 

7. Enter known Title Limitations. 

Note: Include easements, special assessments, mandatory homeowner association 
memberships, etc. Enter None if there are no known limitations. 

8. Select the Condominium or Planned Unit Development checkboxes if applicable. 

9. Complete the Name and Address of Firm Making Request field. 

10. Complete the Lot Dimensions fields. 

11. Enter the e-mail address of the person to be notified when the appraisal is 
uploaded in the Email Address field. 

12. Select whether the appropriate Utilities options. 

13. Select the removable Equipments included in the value of the property. 

14. Use the Blank field for user-defined equipment. 
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Building Details 

Use the following steps to complete the building details where applicable. 

1. Select the Building Status. 

 

Figure 285: Building Details 

2. Select the Building Type. 

3. Select the appropriate Factory Fabricated option. 

4. Enter the Number of Buildings and complete the Number of Living Unit. 

5. Select the Street Access and Street Maint. options. 

6. Enter the Construction Warranty Included details. 

7. Complete the Owner Name. 

8. Select the appropriate Property Occupancy option. 

9. Enter the Rental Information. 

10. Enter Name of Occupant if applicable. 

11. Enter Occupant Telephone. 

12. Enter Broker Information. 

13. Enter Broker Telephone. 

14. Enter Keys At details. 

15. Enter Originator’s Identification Number. 

16. Enter the Sponsor’s Identification Number. 

17. Enter the Institution’s Case Number. 
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Remaining Fields 

Complete the remaining VA Req/Cert of Reasonable Value fields as applicable. 

1. Complete the Purchaser details. 

2. Complete the New or Proposed Construction details. 

3. Enter the Applicable Point of Contact Information. 

4. Enter Annual Real Estate Taxes. 

5. Enter the Mineral Rights Reserved details. 

6. Enter Leasehold Cases details. 

7. Enter the Sales Price of Property. 

8. Select the appropriate Buyer Purchasing Lot checkbox. 

9. Enter the Refinance Amount of Proposed Loan. 

10. Select the appropriate Sales Contact Attached checkbox. 

11. Enter the Person Authorizing This Request details. 

12. Enter Date of Assignment. 

13. Enter Appraiser details. 

14. Click Save to save form. 

Certificate of Eligibility Request 

Use the VA Request for Certificate of Eligibility (26-1880) to determine whether a veteran is 
eligible for a loan and the amount of available entitlement. Veterans or lenders may submit 
the form. The subsequent Certificate of Eligibility must be received prior to loan closing to 
ensure a veteran is eligible and possesses sufficient entitlement for a VA loan. 

1. Select Veterans Administration (VA) from the Forms menu. 

2. Select VA Request for Certificate of Eligibility (26-1880). 
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3. Verify the populated information. 

 

Figure 286: VA Certificate of Eligibility Request 

4. Select Served under a different name if applicable and complete the field. 

5. Enter Borrower Contact Information. 

6. Click Copy From Mailing Address to populate the Certificate Mailing fields if 
applicable. 

7. Select the Discharged/I have any service-related disabilities checkbox if 
applicable. 

8. Enter VA Claim Number. 

9. Select the Currently on Active Duty checkbox if applicable. 

10. Select the Purple Heart recipient? Checkbox if applicable. 

11. Complete the Active Service or Reserve/National Guard Information if 
applicable. 
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12. Complete the Previous VA Loans section if applicable. 

 

Figure 287: Previous VA Loans 

13. Click on the Add button to add previous LA loan addresses. 

Add Previous VA Loan Addresses 

Use the Edit Previous VA Loans dialog to add addresses for previous VA Loans. 

To add a Previous VA Loan Address: 

1. Select the VA Req/Cert of Eligibility. 

2. Click on the Add button in the 14-16 Previous VA Loan Addresses table. 

 
Figure 288: Previous VA Loan Addresses 
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3. Enter property information. 

 
Figure 289: Edit Previous VA Loans 

4. Select an Entitlement from the dropdown menu. 

5. Enter the Loan Number. 

6. Use the Calendar icon or enter the Loan Date. 

7. If the 17a Damaged/Destroyed…Disaster checkbox is selected, enter the Loss Date. 

8. Click Save & Close or Save & New. 

9. Add any Remarks if needed. 

Certificate of Veterans Status Request 

Complete the VA Request for Certificate of Veterans Status (26-8261a) form to request 
veteran status certification. 

1. Select Veterans Administration (VA) from the Forms menu. 

2. Select VA Request for Certificate of Veterans Status (26-8261a). 

3. Verify the populated fields. 
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Figure 290: Veterans Status Certificate Request 

4. Enter the Borrower Address. 

5. Enter Military Service Data. 

6. Enter the VA Claim Number. 

7. Select the appropriate Duty checkbox. 

Verification of VA Benefits 

Complete the VA Verification of VA Benefits (26-8937) to provide to the Lender with the Loan 
Application. 

1. Select Veterans Administration (VA) from the Forms menu. 

2. Select VA Request for Certificate of Veterans Status (26-8261a). 

3. Enter the Lender Name and Address information. 
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Figure 291: Verification of VA Benefits 

4. Complete the Veteran’s Information. 

5. Complete the Certification Questions. 

Custom Screens/Fields 

The Custom Screens/Fields Form menu option is available when user-defined screens are 
created. (See Custom Screen Settings for details.) 

Chapter 7: ELOANFILE MENU 
Point includes a group of screens in the eLoanFile menu that compile loan information for 
electronic submission to vendors or borrowers. The screen fields automatically populate 
with information from other screens. Remaining fields are manually completed. 

Use eLoanFile Document Management option to select the documents for submittal to 
vendors or borrowers and the stacking order the documents are printed. 

See Print Forms for form printing details. 
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eLoan Document Management 

Access the Document Management System from the eLoanFile menu. Use the Repository 
(with the Document Management System) to electronically manage the loan documents 
generated inside and outside of Point. External documents may include: 

• Bank statements 

• Pay stubs 

• Identification documents, etc. 

Each loan file has a separate document repository used to store and manage electronic 
documents associated with that file. Use the document repository to retain an electronic file 
of all information associated with the loan. 

The document repository facilitates the movement of documents throughout the loan 
process. Select all the documents from the repository and create a package to send. The 
Document Management system records the package date and time stamp while printing or 
emailing. 

The document repository is used to send documents to and request documents from 
borrowers through Zip or WebCaster. 

The flow of documents through the document repository is recorded in the audit trail file if 
your site runs PointCentral and the audit trail is enabled in PointCentral. See Audit Trail for 
details. 

Note: The audit trail is not available when Point is not connected to PointCentral. 

The document repository stores the following types of documents: 

• Electronic documents created outside of Point. 
• Point-generated forms accessible from the Borrower Forms dialog. 
• Documents generated using the Point services or interfaces. 

A copy of a document requested using one of the Point services is automatically stored in 
the document repository when received if the Automatic Document Storage option is set in 
the Utilities menu. See Set Automatic Document Storage for details. 

Note: The name of the user who is logged in is automatically populated in the Stored by 
field. When Point is not running in a secure mode, you can change the name that displays 
by selecting Change Name from the File menu while in the Loans tab. 

Add Documents 

Use the following sections to add documents to the Repository and assign document 
properties. 
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Add Borrower Forms 

Selected forms may be converted to a single PDF document or stored as individual files. 
Individual files retain the form name. Multiple files stored as a single PDF are named during 
storage. 

1. Open the borrower or prospect file with information to store. 

2. Select Document Management from the eLoanFile menu. 

3. Click Add. 

 

Figure 292: Document Management Dialog 

4. Select Add Point Form on the Add Selection dialog. 

 

Figure 293: Add Selection Dialog 

5. Click OK. 

6. Select the forms to store from the Borrower Forms dialog. 
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Figure 294: Document Storage 

7. Verify Output Option is Store. 

8. Select the appropriate Print Option. 

9. Select the Store as one file checkbox to combine the selected documents as one 
PDF file. 

10. Click Store. 

11. Enter a document name for a combined file in the Document Name dialog. 

 

Figure 295: Document Name Dialog 

12. Click OK. 
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Add Zip & WebCaster Documents 

10. Click Send/Retrieve documents with no document selected to automatically 
retrieve documents uploaded to the Zip & WebCaster sites. (See Figure 292.) 

Non-Point Document Supported Formats 

The category must be Closing, and the document type must be one of the following to 
enable export to UCD XML for this document: 

• Closing Disclosure: Standard 

• Closing Disclosure: Alternative 

• Closing Disclosure: Borrower Only 

Default category and type lists are provided. Add and change the lists from Document 
Categories/Types on the Utilities menu. 

Add documents in the following supported formats: 

• PDF (pdf) 

• Images (jpeg, jpg, gif, bmp, tif, tiff) 

• Microsoft Word (doc, docx) 

• Text (txt) 

• Rich text (rtf) 

• HTML (html, htm) 

• UAD XML and non-UAD appraisal XML files only (xml) 

Drag and Drop Documents 

Drag and drop an existing document or Outlook email attachment to the document 
repository. Documents in a supported format are converted to PDF during storage. 

1. Open a loan file. 

2. Select Document Management from the eLoanFile menu. 

3. Locate the document on the computer or in an email. 

4. Drag the file to Document Management dialog. 
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5. Respond Yes Add Confirmation prompt to confirm the addition. 

 

Figure 296: Add Confirmation Dialog 

6. Select the Category. 

 

Figure 297: Document Information Preview 

Note: The category must be Closing, and type must be Closing Disclosure: Standard, 
Closing Disclosure: Alternative, or Closing Disclosure: Borrower Only to enable export to 
UCD XML for this document. 

7. Enter the Received From. 

8. Select the Active checkbox if the document is active. 
9. Click the Restrict to Secondary Marketing checkbox to enable only users who are 

granted access to the Secondary Marketing screen in PointCentral access to the 
document. 

10. Select the Borrower from the dropdown list and select Signature Type of signature 
after the closing documents are signed. 

11. Enter the Date signed if applicable. 

12. Repeat Steps 10 – 11 for Co-borrower if applicable. 

13. Select the Category. 

14. Select the Type. 

Note: Manually enter the document type if the appropriate option is not available in the 
dropdown. 

15. Select the package to include the document from the Package dropdown list. 

16. Enter who is to receive the package in the To field and specify a Date and Time. 
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17. Review the document. 

18. Click Add to add it to the repository. New and extracted documents are 
highlighted. 

19. Close the Document Information Preview dialog. 

Browse and Add Documents 

Documents in a supported format are converted to PDF during storage. Use the following 
steps to browse for a document to add to the Repository. 

1. Open the borrower or prospect file containing the information to store. 

2. Select Document Management from eLoanFile menu. 

3. Click Add. 

4. Select Add File from Computer on the Add Selection dialog. (See Figure 293.) 

5. Click OK. 

6. Browse to the stored file. 

7. Select the file. 

8. Click Open. 

9. Use Steps 5 – 18 in Drag and Drop Documents to assign document properties. 

View Documents 

Use the controls above the document preview to scroll through the pages or to enlarge the 
view.  

Note: The Extract icon and the thumbnails are disabled for users without access to secured 
areas. 

Use the following steps to open and view Repository Documents. 

1. Select Document Management from the eLoanFile menu. 

2. Select the document to view. (See Figure 292.) 

3. Double-click to view in the Document Viewer. 
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4. Review the document information in Document Details pane. 

 

Figure 298: Document Viewer 

5. Click the Show Thumb Nails to view additional document pages if applicable. 

6. Click View to open the PDF. 

7. Close the PDF when complete. 

8. Close the dialog. 

Edit Document Properties 

Document properties are assigned when the documents are added to the Repository. 

1. Use the Steps 1 - 3 in View Documents to access the document. 

2. Click Edit to access the Document Information Preview dialog. (See Figure 298.) 

3. Edit the document properties as required. 

4. Click Save. 

5. Close the dialog. 
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Delete Documents 

Use the following steps to delete documents from the Repository. 

1. Use the Steps 1 - 3 in View Documents to access the document. 

2. Select the document. 

3. Click Delete. 

Extract Document Pages 

The extract function copies the selected document pages in the Document Information 
Preview dialog to a separate document and stores it in the repository. 

None of the icons are enabled in the Document Extraction Preview dialog unless multiple 
pages were extracted, and a page is selected when the Show Thumbs is selected. 

The Delete and Undo icons are enabled if the user has access to secured areas in Point or 
is granted Edit access in PointCentral. 

1. Use the Steps 1 - 3 in View Documents to access the document. 

2. Click Edit. 

3. Select the Show Thumbs checkbox to display the document thumbnails. 

4. Click the Extract icon. 

Note: The extract icon is disabled if the PDF file is secured. Refer to your Adobe® Acrobat® 
documentation for information about applying or removing security for PDF documents. 

5. Click the page numbers you want to extract from the document. 

6. Click Add to move the to the right column. 

7. Click OK. 

Outcome: The selected pages are copied and are displayed in the Document Extraction 
Preview dialog. 

8. Use Steps 5 – 18 in Drag and Drop Documents to assign document properties. 

Note: The Stored, By, and Received From fields are populated automatically appropriately. 

9. Click OK to add the extracted document to the repository. 

10. Click OK to save the original document. 

Note: The extracted pages remain in the original document. 
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Save Documents to New Location 

Multiple documents are merged and saved in one PDF file in the order they appear in 
document storage. 

Note: XML files must be saved one at a time. 

Use the following steps to save a document stored in the Repository to a new location. 

1. Open the borrower or prospect file containing the documents to save to a different 
location. 

2. Select Document Management from the eLoanFile menu. 

3. Select the document(s) to save to another location. 

4. Click Save As. 

5. The UAD Appraisal Report Save As Type dialog displays the option to save the file in 
PDF format or in XML format with the PDF image embedded in the file. 

6. Select the file format option. 

7. Click OK. 

8. Select the appropriate Password Protection option on the Set PDF Password 
dialog. 

9. Enter the Password if applicable. 

10. Click OK. 

11. Use the Save As dialog to navigate to the appropriate location and save the 
document. 

Print Documents 

Use the following steps to print a document in the Repository. 

1. Open the borrower or prospect file containing the documents to save to a different 
location. 

2. Select Document Management from the eLoanFile menu. 

3. Select the documents to print. 

4. Click Print. 

5. Select Print from the PDF File menu. 

6. Click OK. 
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Email Files 

Use the following steps to email files from the Repository. 

1. Open the borrower or prospect file containing the documents to save to a different 
location. 

2. Select Document Management from the eLoanFile menu. 

3. Select the files to email. 

4. Click Email. 

5. Edit the file name in the Email Document dialog. 

6. Click OK. 

7. Select the appropriate Password Protection option on the Set PDF Password 
dialog. 

8. Enter the Password if applicable. 

9. Click OK. 

10. Complete and send the email. 

Repository Search 

Use the Search field to Search for documents in the Repository. 

1. Open the borrower or prospect file containing the documents to save to a different 
location. 

2. Select Document Management from the eLoanFile menu. 

3. Enter the document description of the document in the Search field. 

4. Click Search. 

Compare Documents 

Use the Compare button to compare documents in the document repository. 

1. Open the borrower or prospect file containing the documents to save to a different 
location. 

2. Select Document Management from the eLoanFile menu. 

3. Select up to four documents. 

4.  Click Compare. 

5. Select a displayed document to zoom in and out. 

6. See Edit Document Properties to update the selected document properties. 
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Set Stacking Options 

Use the following steps to set the stacking options. 

1. Select Document Management from the eLoanFile menu. 

2. Select the Stack option from the Stacking Order dropdown. (See Stacking Orders 
for details on creating document stacks.) 

 

Figure 299: eLoanFile Document Management 

3. Select the Inactive checkbox to include inactive documents in the stack. 

4. Select the Package Type to create. 

5. Click Conversation Log to review the loan conversation history. 

 

Figure 300: Conversation Log Dialog 

6. Click Add to add additional conversation history. 

Note: Click Open to review a conversation. Select and click Delete to remove a 
conversation. 

7. Click Close to close the dialog. 
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Add Files 

Use the following steps to add files to the stack. 

Note: Use the other eLoanFile options to review documents prior to stacking. 

1. Click Add. 

2. Select the Add Point Form radio button on the Add Selection dialog. (See Figure 
293.) 

3. Click OK. 

4. Select the Form to include in the stack. 

 

Figure 301: Select Stack Forms 

5. Select the Store Output Option. 

6. Select the Store as one file checkbox to combines selected documents into one 
file. 

7. Select the Print in order of paper size checkbox to print according to paper size. 

8. Click Store. 

9. Name the document on the Document Name dialog. (See Figure 295.) 

10. Click OK. 
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Build Stack 

Use the following steps to review documents and create the stack. 

1. Select the Category for the displayed document. 

 

Figure 302: Build Stack 

2. Select the Type. 

3. Select Borrower. 

4. Select Signature Type. 

5. Select the Date signature is required. 

6. Select the Package type. 

7. Enter the To field if applicable. 

8. Select Co-Borrower Information if applicable. 

9. Select the Show Thumbs checkbox to show the page thumb files to manipulate 
the file. 

10. Click View to review full-page. 

11. Click Add to add the document to the stack. 

12. Return to Add Files to select the next document. 

13. Proceed to Print Forms for details on package delivery options. 

eLoanFile Borrower 

The eLoanFile Borrower screen contain Borrower-specific information from various Point 
screens. 

1. Select Borrower from the eLoanFile menu. 
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2. Review screen information. 

 

Figure 303: eLoanFile Borrower 

3. Update missing or inaccurate information. 

eLoanFile Property 

The eLoanFile Property screen contains property-specific information. 

1. Select Property from the eLoanFile menu. 
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2. Review screen information. 

 

Figure 304: eLoanFile Property 

3. Update missing or inaccurate information. 

eLoanFile Product 

The eLoanFile Loan Product screen contains document-specific information about the loan 
and products. It is also possible to request and view disclosures from this screen. 

Update Product 

Use the following steps to update a loan product. 

1. Select Loan Product from the eLoanFile menu. 

2. Click Select Product on the Loan Product screen. 

 

Figure 305: Select Product 
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3. Click Update Protocols on the Select Product dialog. 

 

Figure 306: Select Product Dialog 

4. Select the Documents Provider on the Investors and Products Login dialog. 

 

Figure 307: Investors and Products Login. 

5. Enter Login Information. 

6. Click Submit to access the product updates. 
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Request Disclosures 

Use the following steps to request initial disclosures. 

Note: The View Disclosures and View Analysis buttons are available after the requested 
Disclosure have arrived. 

1. Click Request Disclosures on the Loan Product screen. (See Figure 305.) 

2. Select the Document Provider on the Initial Disclosures Request dialog. 

 

Figure 308:Initial Disclosures Request 

3. Select the Disclosure Package Type. 

4. Select the appropriate Request Type radio button. 

5. Enter the Order Reference Number if applicable. 

6. Click Submit. 

  



   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
304 

Loan Product Remaining Fields 

Use the following steps to complete the remaining Loan Product fields. 

1. Select the appropriate Riders checkbox(es). 

 

Figure 309: Riders and Prepayment Penalty 

2. Enter/update the Prepayment Penalty details if applicable. 

3. Enter/update the Adjustable Rate Mortgage details if applicable. 

 

Figure 310: ARM and Buydown 

4. Enter/update the Buydown details if applicable. 

5. Select the Repayment Type. 

 

Figure 311: Repayment Type & Note Details 

6. Enter the Loan Maturity Date. 
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7. Elect the Day of the Month Loan Payments is to be option. 

8. Select the Eligible for Timely Payment Rewards checkbox if applicable and enter 
the percentage. 

9. Enter the Late Charge Minimum Amount. 

10. Enter the Late Charge Maximum Amount. 

11. Enter the Late Charge Amount. 

12. Enter the Note Pay To details. 

eLoanFile Government (FHA/VA) 

Use the Government (FHA/VA) screen to document information required for FHA and VA 
loans. 

Loan Details 

Use the following steps to complete the initial eLoan Government fields. 

1. Select Government (FHA/VA) from the eLoanFile menu. 

2. Select Refinance Type if applicable. 

 

Figure 312: Loan Details 

3. Select the Section of the Act. 

4. Enter the Lender’s I.D. Code. 

5. Enter Sponsor/Agent I.D. Code. 

6. Enter the FHA/VA Originator ID. 

7. Select the appropriate First Time Homebuyer checkbox. 

8. Enter the Discount Amount. 
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9. Review the populated fields. 

Borrower Certification 

Use the following steps to complete the Borrower Certification. 

1. Enter Borrower Certification Information. 

 

Figure 313: Borrower Certification 

2. Enter Occupancy selections if the loan is VA. 

3. Select the four remaining checkboxes as applicable. 

4. Complete the FHA section if applicable. 

 

Figure 314: FHV & VA Fields 
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5. Complete the VA section if applicable. 

eLoanFile Additional Loan Data 

Use the Additional Loan Data screen to document miscellaneous loan information. 

1. Select Additional Loan Data from the eLoanFile menu. 

2. Select the appropriate Transmittal Summary Information options. 

  

Figure 315: Additional Loan Data 

3. Complete the appropriate HMDA information. 

4. Complete the appropriate QM information. 

Note: The Short Reset ARM % is used for the Uniform Closing Dataset (UCD) 

5. Complete the appropriate Loan Underwriting information. 

6. Complete the appropriate Mortgage Insurance information. 

7. Complete the appropriate Fannie Mae – Community Lending information. 

8. Complete the appropriate Freddie Mac information. 
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Chapter 8: VERIFICATIONS MENU 
Verifications are requested to verify information provided by the Borrower. Customer 
authorization is required prior to requesting verification. The Customer Authorization forms 
are available on the Print menu. 

Note: See Print Forms for form printing details. 

Verification of Benefits (VOB) 

Use the Verification of Benefits (VOB) for to verify claimed benefits. 

Note: The Borrower Certification and Authorization signature is required before requesting 
VOB. 

1. Select Verification of Benefits (VOB) from the Verifs menu. 

2. Enter the From Lender Number. 

 

Figure 316: Verification of Benefits (VOB) 

3. Enter the From Title. 

4. Enter the request Date. 
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Add VOB Administrator 

Use the following steps to add an Administrator of Benefits. 

1. Click New. (See Figure 316.) 

2. Enter the Attention To. 

3. Enter the verifier Name. 

4. Enter the verifier Address. 

5. Click New to add another Administrator of Benefits. 

Insert VOB Administrator 

Use the following steps to insert an Administrator of Benefits at a selected table location. 

1. Click Show All. (See Figure 316.) 

 

Figure 317: List of Items Dialog 

2. Select the location at which to add the new Administrator of Benefits. 

3. Click OK to close the List of Items dialog. 

4. Enter the Administrator of Benefits details. (See Add VOB Administrator.) 
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Delete VOB Administrator 

Use the following steps to remove an Administrator of Benefits from the list. 

1. Click Show All. (See Figure 316.) 

2. Select the Administrator of Benefits to delete. (See Figure 317.) 

3. Click OK to close the List of Items dialog. 

4. Click Delete to delete from the list. 

Assign Accounts 

Use the following steps to assign accounts to the Borrower. 

1. Select the Borrower checkbox. 

 

Figure 318: Assign VOB Accounts 

2. Enter the Account Information for the Borrower. 

3. Repeat Steps 1 – 2 for additional Borrower Accounts. 

4. Select the Co-Borrower checkbox if applicable. 

5. Repeat Steps 1 – 2 for Co-Borrower Accounts. 

6. Select the Print ’SEE ATTACHMENT’ in this signature box checkbox if applicable. 

Verification of Deposit (VOD) 

Use the Verification of Deposit (VOD) for to verify deposits. 

Note: The Borrower Certification and Authorization signature is required before requesting 
verification of deposit. 

1. Select Verification of Deposit (VOD) from the Verifs menu. 
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2. Click From Loan App (Assets) to import assets from the Loan Application. 

 

Figure 319: Verification of Deposit (VOD) 

3. Enter the From Attention Name. 

4. Enter the From Title. 

5. Enter the From Date. 

6. Enter the From Lender Number. 

Add VOD Administrator 

Use the following steps to add VOD accounts. 

Note: Use the From Loan App (Assets) option to import prior to adding manually if 
importing and adding additional accounts manually. 

1. Click New. (See Figure 319.) 

2. See Steps 2 – 5 in Verification of Benefits (VOB) to add administrators. 

Insert VOD Administrator 

Use the following steps to insert an Administrator of Benefits at a selected table location. 

1. Click Show All. (See Figure 319.) 

2. Select the location at which to add the new Administrator of Benefits. (See Figure 
317.) 

3. Click OK to close the List of Items dialog. 
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4. Enter the Administrator of Benefits details. (See Add VOD Administrator.) 

Delete VOD Administrator 

Use the following steps to remove an Administrator of Benefits from the list. 

1. Click Show All. (See Figure 319.) 

2. Select the Administrator of Benefits to delete. (See Figure 317.) 

3. Click OK to close the List of Items dialog. 

4. Click Delete to delete from the list. 

Enter Accounts 

Use the following steps to enter information for accounts to verify. 

1. Enter the Type of Account. 

 

Figure 320: Enter VOD Accounts 

2. Enter the Account Information for the Borrower. 

3. Enter Name of Account. 

4. Enter Account Number. 

5. Enter a Reference if applicable. 

3. Select the Print ’SEE ATTACHMENT’ in this signature box checkbox if applicable. 

Verification of Employment (VOE) 

Use the Verification Employment (VOE) to verify employment. 

Note: The signed Signature Authorization form is required before requesting verification of 
employment. 
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Request VOE 

Use the following steps to request VOE. 

Note: View Report is available after receiving the VOE results. 

1. Select Verification of Employment (VOE) from the Verifs menu. 

2. Click Request Verification. 

 

Figure 321: Verification of Employment (VOE) 

3. Select the Verification Services Provider from the dropdown. 

 

Figure 322: Request Verifications Dialog 

Note: The Work Number is selected by default. 

4. Select the appropriate Order radio button. 



   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
314 

5. Enter the Primary Borrower Order Reference Number if selecting Upgrade or 
Check Status radio button for the Borrower VOE. 

Note: Enter the Co-borrower Order Reference Number if selecting Upgrade or Check 
Status radio button for the Co-borrower VOE. 

6. Select the Borrower radio button. 

7. Select Verification Type(s). 

8. Select the Authorization Method. 

9. Click Browse to attach the document. 

10. Select Pay by credit card if applicable. 

11. Enter Credit Card information if prompted. 

12. Click Submit. 

13. Repeat Steps 3 – 12 for Co-Borrower. 

Populate Employment 

The Populate Employment button is available after receiving the VOE results. 

The top portion of the Populate Employment dialog contains the VOE results. The button 
portion contains the Employment Information from the Loan Application - Section 1 screen 
and/or the manually entered Employer Information on the VOE screen. 

 

Figure 323: Populate Employment 
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Point displays the Replace Employer(s) dialog if similar employer information is detected in 
the Employment Record’s table. Replace the desired Employers or click on the Close 
button to add the values to the VOE 

 

Figure 324: Replace Employment 

1. Click Populate Employment. (See Figure 321.) 

2. Select the Employment Records Received to add to the Employment Records to 
Populate. (See Figure 323.) 

3. Click Add. 

Note: Click Add All when applicable. 

4. Select the Employment Information to replace. (See Figure 324: Replace 
Employment) 

5. Click OK. 

Note: Click Close to add the employment information to the VOE. 

Add Employment 

Use the followings steps to manually add employment to verify. 

1. Enter the From Attention. 

 

Figure 325: Add Employment 
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2. Enter the From Title. 

3. Enter the From Lender Number. 

4. Enter the From Date. 

5. Select the Borrower. 

6. Select the Standard VOE radio button when submitting VOE electronically. 

Note: Select the Telephone VOE when performing VOE by phone. 

7. Click New. 

8. Click From Loan App (Employer) to import the employers listed on the loan 
application. 

Note: Point imports the information from the Loan Application – Section 1 screen 
Employment/Self Employment and Income fields. 

9. Enter the Employer Name. 

10. Enter the Employer Attention. 

11. Enter the Employer Address. 

12. Enter the Employer City/State/Zip. 

13. Click New and repeat Steps 5 – 12 for the Borrower. 

14. Select the Co-Borrower radio button and repeat Steps 5 -12 for Co-Borrower if 
applicable. 

15. Select the Print the Words See Attachment in the Signature Box if applicable. 

Insert VOE 

Use the following steps to insert an Employer at a selected table location. 

1. Click Show All. (See Figure 325.) 

2. Select the location at which to add the new Employer. (See Figure 317.) 

3. Click OK to close the List of Items dialog. 

4. Enter the Administrator of Benefits details. (See Add Employment starting with 
Step 5.) 

Delete VOE 

Use the following steps to remove an Employer from the list. 

1. Click Show All. (See Figure 325.) 

2. Select the Employer to delete. (See Figure 317.) 
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3. Click OK to close the List of Items dialog. 

4. Click Delete to delete from the list. 

Certify VOE 

Complete the Certification fields after completing the VOE. 

Verification of Loan (VOL) 

Use the Verification of Loan (VOL) for to verify liabilities. 

Note: The Borrower Certification and Authorization signature is required before requesting 
verification of liabilities. 

1. Select Verification of Loan (VOL) from the Verifs menu. 

2. Click From Loan App (Liab) to import liabilities from the Loan Application. 

 

Figure 326: Verification of Loan (VOL) 

3. Enter the From Attention. 

4. Enter the From Title. 

5. Enter the From Date. 

6. Enter the From Lender Number. 
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Add VOL Administrator 

Use the following steps to add VOL accounts. 

Note: Use the From Loan App (Liab) option to import prior to adding manually if importing 
and adding additional accounts manually. 

1. Click New. (See Figure 326.) 

2. See Steps 2 – 5 in Verification of Benefits (VOB) to add administrators. 

Insert VOL Administrator 

Use the following steps to insert an Administrator of Loans at a selected table location. 

1. Click Show All. (See Figure 319.) 

2. Select the location at which to add the new Administrator of Loans. (See Figure 
326.) 

3. Click OK to close the List of Items dialog. 

4. Enter the Administrator of Loans details. (See Add VOL Administrator.) 

Delete VOD Administrator 

Use the following steps to remove an Administrator of Benefits from the list. 

1. Click Show All. (See Figure 319.) 

2. Select the Administrator of Benefits to delete. (See Figure 326.) 

3. Click OK to close the List of Items dialog. 

4. Click Delete to delete from the list. 

Enter Accounts 

Use the following steps to enter information for accounts to verify. 

1. Enter the Type of Loan. 

 

Figure 327: Enter VOL Accounts 
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2. Enter the Loan in Name of. 

3. Enter the Loan Number. 

4. Enter the Balance. 

5. Select the Print the Words See Attachment in the Signature Box if applicable. 

Verification of Mortgage/Rent (VOM/R) 

Use the Verification of Mortgage/Rent (VOM/R) for to verify mortgage/rent. 

Note: The Borrower Certification and Authorization signature is required before requesting 
verification of mortgage/rent. 

1. Select Verification of Mortgage/Rent (VOM/R) from the Verifs menu. 

2. Click the appropriate button to import information from the Loan Application. 

 

Figure 328: Verification of Mortgage/Rent 

3. Enter the From Attention. 

4. Enter the From Title. 

5. Enter the From Date. 

6. Enter the From Lender Number. 
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Add VOM/R 

Use the following steps to add VOM/R accounts. 

1. Click New. (See Figure 330.) 

2. See Steps 2 – 5 in Verification of Benefits (VOB) to add VOM/R. 

Insert VOM/R 

Use the following steps to insert VOM/R at a selected table location. 

1. Click Show All. (See Figure 319.) 

2. Select the location at which to add the new VOM/R. (See Figure 330.) 

3. Click OK to close the List of Items dialog. 

4. Enter the VOM/R details. (See Add VOM/R.) 

Delete VOM/R 

Use the following steps to remove VOM/R from the list. 

1. Click Show All. (See Figure 319.) 

2. Select the VOM/R to delete. (See Figure 330.) 

3. Click OK to close the List of Items dialog. 

4. Click Delete to delete from the list. 

Enter Accounts 

Use the following steps to enter information for accounts to verify. 

1. Select the applicable checkbox. 

 

Figure 329: Enter VOL Accounts 
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2. Enter the Account Name. 

3. Enter the Property Address. 

4. Enter the Account Number. 

7. Select the Print the Words See Attachment in the Signature Box if applicable. 
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Chapter 9: TRACK MENU 
Point creates a tracking file when a prospect or Borrower file is created. The information 
entered on the forms populates the tracking screens. 

Note: Enter date information in all tracking fields to determine the status of ordered 
documents. 

Print the reports from the Tracking tab in the Borrower Forms dialog. 

Verify the date and time settings on the computer are correct before printing to ensure the 
reports are accurate.   

Track Loan Status 

The Status and Checklist screen supplies synchronized data to the Information bar. The 
screen opens with the Current Status displayed. 

Update Disclosure Information 

1. Select Status from the Track menu. 

2. Enter the Estimated Close date when known. 

 

Figure 330: Track Status and Checklist 

3. Enter Comments if applicable. 

4. Select the GFE Disclosed Date. 

5. Select the GFE Disclosed Method. 

6. Select the GFE Re-disclosed Date if applicable. 

7. Select the GFE Re-disclosed Method if applicable. 

8. Select the TIL Disclosed Date. 

9. Enter the TIL Disclosed APR. 
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10. Select the TIL Disclosed Method. 

11. Select the TIL Disclosure Receipt Date. 

12. Select the TIL Re-disclosed Date if applicable. 

13. Enter the TIL Re-disclosed APR. 

14. Select the TIL Re-disclosed Method if applicable. 

Update Loan Progress 

The current date auto populates when selecting an item in to Loan Progress table. 

1. Select a listed item in the Loan Progress list. 

2. Click Edit. 

 

Figure 331: Track Loan Progress 

3. Enter the progress update Date. 

 

Figure 332: Loan Progress Dialog 

4. Enter appropriate Comments. 

Note: Select the checkbox to enter the current date in the Date field. 
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5. Repeat Steps 1 – 4 to update other list items. 

Note: Select a blank field to enter a user-defined item. 

Update Third-Party Document Status 

Use the following steps to update status for documents requested from a third-party. 

1. Select a listed item in the Third-Party Documents list. 

 

Figure 333: Third-Party Document Status 

2. Click Edit. 

 

Figure 334: Third-Party Documents 

3. Click the Required checkbox if applicable. 

4. Select the Due Date. 

5. Select the Ordered Date. 

6. Select the Received Date. 

7. Enter Comments if applicable. 

8. Select the Calculate Due Date Based On and select the appropriate dropdown 
option to base the document dues on other task completions. 
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9. Click OK to close the dialog. 

10. Click Add to Checklist to add the selected document to the Loan Checklist. 

Note: Click Remove from Checklist to remove a selected item from the Loan Checklist. 

11. Repeat Steps 1 – 10 for other list items. 

Note: Select a blank field to enter a user-defined item. 

Document Requests Status 

The Document Requests section is a list of various items required from the Borrower to 
process the loan. 

Documents are added to the Document Request List when one of the following occurs:  

• A document is electronically sent to the Borrower WebCaster account from the 
document repository requiring a signature. 

• A loan condition is added to the Banker Conditions screen and then select the Show 
in Track Conditions Screen checkbox on the Edit Condition dialog is selected. 

Note: Selecting the Show in Track Conditions Screen checkbox does not record the loan 
condition in the Document Requests list when editing a previously saved loan condition. 
The checkbox must be selected at the time of creation to be saved in the Document 
Requests list. 

Check Document Status 

Point connects directly to WebCaster to check for uploads and documents viewed by the 
Borrower. Point updates the Document Requests list and document repository accordingly 
after selecting Send/Retrieve when a document is not selected from the list. 

The WebCaster dialog displays with the Document Description and the Notes to Borrower 
sections are disabled. Enter login information and click Send/Retrieve to initiate the 
connection to WebCaster to check for uploads and viewed documents. 

Send Document Requests 

Use the following steps to send a document request to a Borrower WebCaster account. 
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1. Select the document to send. 

 

Figure 335: Document Requests 

2. Click Send/Retrieve. 

3. Enter a due date in the Date field on the Send/Retrieve dialog. 

 

Figure 336: Send/Retrieve Dialog 

4. Enter instructions or comments for the Borrower in the Notes to Borrower field. 

Note: The Comments are added to the Conversation Log in the Point Borrower file. 

5. Complete the WebCaster Administration Login Information section if prompted. 

6. Select the Save Password checkbox to save the login information for future logins. 

7. Click the Send/Retrieve button. 

Note: A Status dialog displays with the document descriptions, the action taken, and if the 
transmission was successful when the transaction is complete. 
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Edit Document Requests 

Use the following steps to edit a document request. 

1. Select the document in the Document Requests list. (See Figure 335.) 

2. Click Edit. 

3. Make appropriate changes to the request. 

 

Figure 337: Edit Document Requests 

4. Click OK to save. 

Add Document Request 

Use the following steps to add a new document request. 

1. Double-click an empty row in Document Requests list. (See Figure 335.) 

2. Click Edit. 

3. Enter the document request details in the Edit Document Requests dialog. (See 
Figure 337.) 

4. Click OK to save. 
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Track Conditions 

The Conditions screen itemizes the various conditions of the loan. The fields are populated 
with conditions from the Banker Conditions screen identified by selecting the Show in Track 
checkbox when the condition is added. Use Track Conditions to track loan processing and 
underwriting conditions for which the originator and processor are responsible. 

1. Select Conditions from the Track menu. 

2. Select a Condition to edit. 

 

Figure 338: Track Conditions 

3. Click Edit. 

4. Update the Collected Date or Submitted Date on the Edit Condition dialog if 
applicable. 

 

Figure 339: Edit Conditions Dialog 
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5. Select the condition to edit click the Edit button. 

6. Click OK on the Edit Conditions dialog. 

Registration & Rate Lock 

The Registration & Rate Lock screen provides a resource for locking loans with a wholesale 
lender or the Calyx secondary marketing department. Fields are populated with Borrower 
Information screen data, Underwriting screen, and requested Credit Reports. 

The originator uses Registration & Rate Lock screen for the following: 

• Negotiating the primary market rate and price with the Borrower 

• Registering and locking the loan with either a wholesale lender or their secondary 
marketing department 

• Recording the confirmation of the lock request from either the wholesale lender or 
the secondary marketing department 

Note: The screen option is available only to users who have access to financial information. 
The menu option is disabled when access is not granted. 

Initial Information 

Complete the Initial Information applicable fields. 

1. Select Registration & Rate Lock from the Track menu. 
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2. Select the Business Channel. 

 

Figure 340: Track Registration & Rate Lock 

3. Enter the Company/Broker. 

4. Select the Originator. 

5. Select the Processor. 

6. Select the Underwriting Decision if applicable. 

7. Select the Decision Date if applicable. 

8. Enter the Estimated Close Date. 

9. Verify the Borrower Information. 

10. Verify Loan and Lien information. 

11. Enter the number of stories in the dwelling if a Condominium Property is selected 
from the Property Type dropdown. 
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General Information 

Use the following steps to complete the General Information section non-populated fields. 

1. Enter the Sales Price. 

 

Figure 341: General Information 

2. Enter the Appraised Value. 

3. Enter the Loan Amount. 

4. Enter the Initial HELOC Draw if applicable. 

5. Enter the Max Loan Amount if applicable. 

6. Enter the Term/Due. 

7. Enter the Max LTV/CLTV. 

8. Enter the Interest Only Months. 

9. Select the Doc Type. 

10. Select the Credit Grade. 

11. Enter the Top and Bottom Maximum Percentage if applicable. 
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ARM and Mortgage Insurance 

The ARM Information is populated from the Truth-in-Lending screen Rate Adjustments 
section. Use the following steps to complete the non-populated ARM Information when 
completing an ARM loan. Complete the Mortgage Insurance fields when the Borrower 
must carry the insurance. 

1. Enter the Margin percent. 

 

Figure 342: ARM and Mortgage Insurance 

2. Enter the 1st Cap Percent. 

3. Enter the Period Cap Percent. 

4. Enter the Life Cap Percent. 

5. Enter the publicly published number used to alter the adjustable loan rate in the 
Index Value field, if applicable. 

6. Enter the Adjustment Period 1st Months. 

7. Enter the Adjustment Period Periodic Months. 

8. Select the Index Type. 

9. Enter the Alternate Index Percent. 

10. Select the Mortgage Insurance Type. 

11. Select the Mortgage Insurance Premium Type. 

12. Enter the Mortgage Insurance Coverage Percent. 

13. Enter the Mortgage Insurance Name. 

Note: The Upfront MIP, FF fields are populated with the values from the PMI/MIP/FF/USDA 
dialog. 
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Registration & Lock Request 

Use the following steps to complete the Registration & Lock Request section. 

Note: The fields are not available when Lock is selected in the Request Type section. 

1. Enter the Registration Date. 

 

Figure 343: Registration & Lock Request 

Note: The field is automatically populated with the current date when the Register 
checkbox in the Request Type section is selected. 

2. Enter the date and time of the lock request in the Lock Date/Time fields. 

3. Enter the term of the lock in the Lock Term field. 

4. Enter the number of days the lock is extended in the Lock Extension field. 

5. Select the Lock Type. 

6. Complete the Interest Rate field, if applicable. 

Note: The date the rate was changed is automatically populated in the date field 

7. Select the 1st Time Home Buyer checkbox if applicable. 

8. Select the Escrows waived checkbox if the lender is allowing the Borrower to pay 
certain escrow items directly to the payees. 

9. Select the Prepayment Penalty checkbox if the selected loan program has a 
prepayment penalty. 

10. Enter the number of years the prepayment penalty is in effect and select the 
Prepay Type from the dropdown. 

  



   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
334 

Pricing from Rate Sheet 

Use the following steps to complete the Pricing from Rate Sheet section. 

Note: Price adjustments are calculated as positive values. Precede a value it with a minus 
sign (-) to deduct the amount from the total. 

1. Enter the Base Rate from the rate sheet in the Base Price field. (See Figure 343.) 

2. Select up to two additional rate adjustments from the dropdowns. 

3. Enter the Adjustment Percent in the % field. 

4. Complete the Pricing from Rate Sheet section. 

Interest Rate Sheet and Request Type 

Use the following steps to complete the remaining Registration & Rate Lock fields. 

1. Enter the base price from the rate sheet in the Base Price field. (See Figure 343.) 

2. Select Additional Loan Price Adjustments from the dropdowns. 

3. Enter the Adjustment Percent in the % field. 

4. Select the Pricing based on Loan Amount w/MIP, FF checkbox to calculate the 
Net Adjust Lock Price based on the total loan amount rather than the base loan 
amount. 

5. Select the Register checkbox to enable the Create Registration Request button to 
register the loan. 

6. Click the Create Registration Request button to generate the request. 

7. Select the Float or Lock checkbox to indicate the rate is not locked. 

8. Select the Lock checkbox to enable the Create Lock Request button to lock the 
rate. 

9. Click Create Lock Request to generate the request. 

Track Verifications 

The Track Verification screens are automatically populated when the Verification screens 
are populated. Use verification tracking to manage the receipt of verification documents 
sent for a loan file. 

1. Select Verifications from the Track menu. 
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2. Select one of the following verifications to track: 

• VOB: Verification of Benefits 

• VOD: Verification of Deposit 

• VOE: Verification of Employment 

• VOL: Verification of Loan 

• VOM/R: Verification of Mortgage/Rent 

3. Enter the date Received when the verification is returned. 

Note: Items are automatically updated in the Loan Checklist when updated on the tracking 
screen. 

Track Title 

Use the Track Title screen to track the title conditions that must be cleared from the title 
report before the loan can close. 

1. Select Title from the Track menu. 

2. Enter the Preliminary Title Date. 

Note: Click on the Calendar icon inside the field of open an interactive calendar that is used 
to select the desired date. 

 

Figure 344: Track Title 

3. Enter the Assessor’s Parcel Number. 
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4. If needed, enter Secondary Assessor’s Parcel number. 

5. Enter the Signed Purchase Agreement date. 

6. Enter Vesting. 

7. Select the Land Trust. 

8. Enter the Escrow Closing date. 

9. Enter the Inspection Ended date. 

10. Enter the Title Report Remarks if applicable. 

11. Enter the conditions required before the title insurance can be issued in the Title 
Conditions section. 

12. Enter the Title Report Required Endorsement if applicable. 

13. Enter Long Legal Description. 

Track HMDA 

The HMDA Reporting screens contain most of the information required to be reported to the 
CFPB to comply with the Home Mortgage Disclosure Act. 

Note: The HMDA Report does not include loan with a missing relevant date causing 
reporting will be inaccurate. 

Use the field Locks to prevent updates to the field. Unlock fields to enable editing. 

HMDA Reporting (2017) 

The HMDA Reporting (2017) screen is used for tracking the required data for the year 2017. 
The data must be complete based on the data points. 

Loan Information 

Use the following steps to complete the Loan Information fields. 

1. Select HMDA from the Track menu. 

2. Select HMDA Reporting (2017). 
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3. Select the Final HMDA Loan Application Register (LAR) if applicable. 

 

Figure 345: HMDA (2017) Reporting 

4. Complete the Application Date. 

5. Enter the Closed Date. 

6. Select the Exclude from HMDA report checkbox to prevent the loan from being 
included in the HMDA Report. 

7. Select the Report the Purposed of this loan as Home Improvement if applicable. 

8. Select Report as a HOEPA loan if applicable. 

9. Select the appropriate Preapproval option from the dropdown. 

10. Select the appropriate Occupancy option if applicable. 

11. Select the appropriate Annual Income option if applicable. 

12. Select the Rate Spread. 

Property Information 

Use the following steps to complete the Property Information. 

Note: Use the provided links to access Point Help to retrieve the codes. 

1. Click Geocoding Lookup to retrieve the property Geocode. (See Figure 345.) 

2. Enter the MSA/MD Code. 

3. Enter the County Code. 

4. Enter the State Code. 

5. Enter the Census Tract. 

6. Select the Lien Status. 

7. Select the Property Type. 
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Origination Information 

Use the following steps to complete the Origination Information. 

1. Select the Type of Purchaser. 

2. Select Action Taken. 

3. Enter Action Date. 

Denial and Counter Offer Tracking Information 

Use the following steps to complete the Reason for Denial and Denial/Counter Offer 
Tracking Information. 

1. Select the appropriate Reason for Denial #1. 

2. Select the appropriate Reason for Denial #2. 

3. Select the appropriate Reason for Denial #3. 

4. Select the This loan denied checkbox and enter the Denied on information if 
applicable. 

5. Select the Credit denial form completed checkbox and enter the Mailed on 
information if applicable. 

6. Select the Counter offer made checkbox and enter the Made on information if 
applicable. 

Government Monitoring Section 

Use the following steps to complete the Government Monitoring Section. 

1. Select the appropriate Borrower checkboxes. 

2. Select the appropriate Co-Borrower/Co-application option from the dropdown. 

3. Select the appropriate Co-Borrower/Co-application checkboxes. 

4. Select the appropriate This app taken by checkbox. 

5. Click Save to save the reporting selections. 

HMDA Reporting 

Use the HMDA Reporting screen for non-2017 year loan applications. 

Loan Information 

Use the following steps to complete the initial loan information. 
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1. Select HMDA from the Track menu. 

2. Select HMDA Reporting. 

3. Enter the Application Date. 

 

Figure 346: HMDA Reporting  

4. Enter the loan Closed Date. 

5. Select the Exclude loan from HMDA report checkbox to omit the loan from the 
HMDA Report. 

6. Select Finalize HMDA data and lock screen if applicable. 

7. Verify the Lender Case Number. 

8. Enter Legal Entity Identifier (LEI). 

9. Enter Universal Loan Identifier (ULI). 

10. Enter Non Universal Loan Identifier (NULI). 

Denial Reasons and Application Channel 

Use the following steps to complete the Reason(s) for Denial and Application Channel 
Information. 

1. Select the Disclosed using Notice of Action Taken checkbox if applicable. (See 
Figure 346.) 

2. Select Denial # 1 reason from the dropdown. 

3. Select Denial # 2 reason from the dropdown. 

4. Select Denial # 3 reason from the dropdown. 

5. Select Denial # 4 reason from the dropdown. 

6. Select the appropriate Application Channel options. 

Note: A selection is required. Select Not Applicable when appropriate. 
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Organization and Additional Loan/Property Information 

Use the following steps to complete the Organization Information. 

1. Select the Type of Purchaser. 

 

Figure 347: Organization & Loan/Property Information 

2. Select the Action Taken. 

3. Select the Action Date. 

4. Select the Primarily for a business or commercial option. 

Note: A selection is required. Select Not Applicable when appropriate. 

5. Select the appropriate Additional Loan and Property Information options. 

Note: Selection are required. Select Not Applicable when appropriate. 

6. Verify the populated Subject Property fields. 

7. Click Geocoding Lookup to access the Codes if required. 
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Loan Summary and Automated Underwriting 

Use the following steps to complete the Loan Summary and Automated Underwriting 
information. 

1. Review the populated Loan Summary fields. 

 

Figure 348: Loan Summary & Automated Underwriting 

Note: Click a Lock to unlock a field to edit if required. 

2. Select the appropriate Reverse Mortgage option. 

3. Select the Automated Underwriting is not applicable for this loan checkbox if 
applicable. 

4. Select the appropriate Fannie Mae checkbox(es). 

5. Select the appropriate Freddie Mac options. 

6. Review displayed Underwriting Results. 

7. Update the Underwriting Results when appropriate. 

8. Select the Loan Costs Total Points and Fees option. 

9. Complete the Borrower Demographic Information. 

10. Complete the Co-Borrower Demographic Information when appropriate. 
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Track Mortgage Call Report 

The Mortgage Call Report (MCR) screen allows the user to enter loan origination required for 
the Nationwide Mortgage Licensing System (NMLS). The user can generate NMLS Call 
Reports through the Report & Marketing screen. 

 
Figure 349: Mortgage Call Report 

Enter origination information into the Track: Mortgage Call Report. 

1. Choose a Business Channel from the dropdown menu. 

2. Enter the Application Date. 

3. Select an option from the Servicing Has Been dropdown menu. 

4. If applicable, click on the Exclude from NMLS Report checkbox. 

5. Click on the Report as a HOEPA loan checkbox. 

Origination Information 

For the Origination Information section: 
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1. Select the Type of Purchaser from the dropdown menu. 

 
Figure 350: Origination Information 

2. Select the Action Taken from the dropdown menu. 

3. Select an Action Date by clicking on the Calendar icon. 

Qualified Mortgage 

The Qualified Mortgage section is auto-populated by selecting the QM button at the bottom 
of the screen. Use the dropdown to select the QM Report Status. 

 
Figure 351: Qualified Mortgage 

Subject Property 

Enter property information about the borrower. 

1. Enter the Street address. 

 
Figure 352: Subject Property 
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2. If needed, enter the type of unit from the dropdown menu. 

3. Enter the unit Number. 

4. Enter the Subject Property’s City, State, and Zip code. 

5. Enter the Property Type. 

Loan Information 

Enter the loan information for the subject property. 

1. To adjust the Loan Purpose, select the Lock icon and choose the desired options. 

 
Figure 353: Loan Information (MCR) 

2. Select the desired Lien Position. 

3. Select the desired Loan Type. 

4. Select the desired Occupancy. 

Loan Originator Information 

The Loan Originator Information section allows the user to enter information about the 
originator. Select the Originator from the dropdown menu. 

 
Figure 354: Loan Originator Information 

Track RegulatorConnect 

The Regulator Connect screen contains information specific to RegulatorConnect or the 
Nationwide Mortgage Licensing System (NMLS) Mortgage Call Report. 



   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
345 

  



   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
346 

Loan Information 

Use the following steps to complete the Loan Information. 

1. Select RegulatorConnect from the Track menu. 

2. Select the Exclude loan from RegulatorConnect report checkbox to exclude the 
open loan from the report. 

 

Figure 355: Regulator Connect Loan Information 

3. Enter the Application Received By Originator Date. 

4. Enter the Application Received By Creditor Date. 

5. Select the Documentation Type. 

6. Select the Negative Amortization Program Type. 

7. Enter the Option ARM Minimum Rate. 

8. Enter the Seller Paid Points and Fees. 

9. Enter the Undiscounted Interest Rate. 

10. Select the Portfolio Loan Refinance checkbox if the loan will not be sold into the 
secondary market. 

11. Select the Construction Loan Interest Estimation Type. 

12. Select the Bridge Loan checkbox if applicable. 
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13. Select the Home Improvement Loan checkbox if applicable. 

Property Information & HELOC 

Use the following steps to complete the Property Information and HELOC fields. 

1. Select the Property Type. (See Figure 355.) 

2. Select the appropriate Homestead Property option. 

3. Select the HELOC checkbox if applicable. 

4. Enter the HELOC Disclosure Date. 

5. Enter the Minimum Draw Amount. 

6. Enter the Draw Period. 

7. Enter the Repayment Period. 

8. Enter the Initial Rate. 

9. Enter the APR if applicable. 

10. Enter the Annual Fee. 

11. Enter the Early Termination Fee. 

12. Enter the Draw Fee. 

QM & Per Diem Interest e-Exam 

Use the following steps to complete the QM and Per Diem Interest e-Exam fields. 

1. Select the Ability to Repay Method option. 

 

Figure 356: QM and Per Diem Interest e-Exam fields 

2. Select the Is Insured FHA QM. 

3. Select the GSE or Federal Agency Eligible option. 

4. Select the Income/Assets Accurate and Verified option. 

5. Select the Debt/Liability Accurate and Verified option. 

6. Select the Per Diem Round To option. 



   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
348 

7. Select the Document Source option. 

8. Select the Additional Interest Days option. 

Tolerance & NMLS Mortgage Call Report 

1. Enter the Curative Date for Tolerance. 

 

Figure 357: Tolerance and NMLS Mortgage Call Report 

2. Select the NMLS Mortgage Call Report Prime checkbox if applicable. 

3. Select the NMLS Mortgage Call Report FAS 140 Sale Treatment checkbox if 
applicable. 

Prepayment Penalty & Closing Info 

Use the following steps to complete the Prepayment Penalty and Closing Info fields. 

1. Complete Prepayment Penalty fields if applicable. 

 

Figure 358: Prepayment Penalty and Closing Info 

2. Select the Closing Info Disbursement Date. 

3. Select the Closing Info Docs Signed Date. 
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Loan Estimate & Closing Disclosure 

Use the following steps to complete the Loan Estimate and Closing Disclosure fields 

1. Select the Initial Loan Estimate Date. 

 

Figure 359: Loan Estimate & Closing Disclosure 

2. Select the Revised Loan Estimate Date. 

3. Enter the LE Sequence Number. 

4. Select the Revised Receipt Date. 

5. Select the Revised Delivery Method. 

6. Select the Waive 7 Day Waiting Period option. 

7. Select the Consummation Date. 

8. Select the Initial Closing Disclosure Date. 

9. Select the Revised Closing Disclosure Date. 

10. Enter the CD Sequence Number. 

11. Select the Initial Receipt Date. 

12. Select the Initial Delivery Method. 

13. Select the Revised Receipt Date. 

14. Select the Revised Delivery Method. 
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Post Consummation & MI/Funding Fee 

Use the following steps to complete the Post Consummation and MI and Funding Fee 
fields. 

1. Select the Redisclosure Date. 

 

Figure 360: Post Consummation and MI and Funding Fee 

2. Select the Knowledge of Event Date. 

3. Select the Reimbursement Date. 

4. Enter the Reimbursement Amount. 

5. Select the Redisclosure Reason. 

6. Select the Changed Circumstance Date. 

7. Select the Reason for Redisclosure. 

8. Select the Disclosure Section Type. 

9. Select the Service Provider Source. 

10. Select the MI Cash Paid By. 

Non Specific Lender Credit & Reverse Mortgage 

Use the following steps to complete the Non Specific Lender Credit and Reverse Mortgage 
fields. 

1. Enter the Lender Credits amount. 

 

Figure 361: Non Specific Lender Credit & Reverse Mortgage 
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2. Select the Changed Circumstance Date. 

3. Select the Reason for Redisclosure. 

4. Enter the Revision Number. 

5. Select the Reverse Mortgage. 

6. Enter the Age of Youngest Borrower if applicable. 

7. Enter the Initial Advance amount. 

8. Update the Appraised Value if applicable. 

Agent List 

The Agent screen contains a log of contacts in the pipeline for the various lenders, brokers, 
and agencies involved in the loan. 

Note: Information entered in the Company Information dialog from the Utilities menu 
automatically populates and disables the fields in the Broker or Lender section, depending 
on option selected. (See Company Information for details.) 

Table 9: Agency List Contacts 

Originator Listing Agent Mortgage Insurance 

Lender Selling Agent Flood Insurance 

Broker Buyer’s Attorney School Property Tax 

Real Estate Broker (Buyer) Seller’s Attorney Regulatory Agency 

Real Estate 

Broker (Seller) 
Appraiser Assignor 

Closing Agent Surveyor Beneficiary 

Title Insurance Company Builder Assignee 

Buyer’s Agent Property Tax Trustee 

Seller Hazard Insurance Servicer 

Note: Five additional sections are included to add user-defined agents. 

1. Select Agent List from the Track menu. 
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2. Enter the information for the agents applicable to the loan. 

 

Figure 362: Track Agent List 

3. Use the Cardex database to populate agent information if possible.  

4. Enter remaining information manually. 

Branch/Team 

The Branch/Team screen tracks branch and team information. 

The customized dropdown lists set up from the Utilities Dropdown Lists menu provides 
some Branch and Team information. (See Dropdown Lists.) 

Use the following steps to complete the non-populated fields. 

1. Select Branch/Team from the Track menu. 
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2. Select the Division. 

 

Figure 363: Track Branch/Team 

3. Select the Region. 

4. Select the Originator. 

5. Select or enter the Originator Title. 

6. Enter the Originator Phone. 

7. Enter the Originator Fax. 

8. Enter the Originator Cell. 

9. Enter the Originator Email. 

10. Enter the Originator ID. 

11. Select the Originator Team. 

12. Repeat Steps 4 – 11 for the Processor. 

13. Repeat Steps 4 – 11 for the Underwriter. 

14. Select the branch name from the Branch dropdown. 

15. Repeat Steps 4 – 11 for the Doc Prep. 

16. Repeat Steps 4 – 11 for the Closer/Funder. 

17. Repeat Steps 4 – 11 for the Shipper. 
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Trust Account 

Use the Trust Account screen to record financial information. 

Note: The Trust Account screen is available only to users with access to financial 
information. PointCentral users are granted read, write, or no access to select Tracking 
screens as part of the data folder security settings. 

The Trust Account can contain up to 16 transactions. 

1. Select Trust Account from the Track menu. 

2. Enter a description of the payment in the Description field. 

 

Figure 364: Trust Account Tracking 

3. Enter the date the payment was sent or received in the Date field. 

4. Enter the information in either the Funds Paid Out or Funds Received section. 

Note: Do not enter the information in both sections. 

5. Enter Comments in the field below the Funds Paid Out/Funds Received. 

Note: Point calculates the Totals of the funds paid, the funds received, and the account 
balance. The Balance is included in the Borrower Status Report and WebCaster Status 
Report. 
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Loan Profit/Loss 

The Loan Profit/Loss screen calculates the profits and losses realized on a loan. The screen 
is available only to users who have access to financial information. The menu option is 
disabled for users with proper credentials. 

Note: Loan profit/loss tracking is not available in prospect files. 

Loan Information 

Use the following steps to complete the Loan Information. 

1. Select Loan Profit/Loss from the Track menu. 

2. Select the Originator. 

 

Figure 365: Loan Profit/Loss Tracking 

3. Select the Branch. 

4. Enter the Primary Referral Source. 

5. Enter a Secondary Referral Source if applicable. 

6. Enter a Lead ID, if applicable. 

Note: The Referral Sources and Lead ID information are populated from the Contact 
Information dialog. (See Borrower Information Screen Buttons for details.) 

7. Select the Business Channel. 
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Commission Splits & Deductions 

The Commission Splits and Deduction sections record commission payments and 
deductions to various individuals involved in the transaction. The first 4 field groups 
calculate the loan originator commission. 

1. Enter the percentage of the Loan Amount Percentage applied to commission. 

 

Figure 366: Commission Splits & Deductions 

2. Enter the Revenue Percentage applied to commission. 

3. Enter the Margin (from Rate Lock) applied to commission. 

4. Select an Override option to determine how the override commission is calculated. 

5. Complete the remaining Override fields. 

6. Enter a value for additional commissions in the Additional Flat Compensation 
field. 

7. Select a Deduction from the dropdown. 

8. Select the option from the dropdown list to determine how the deduction is 
calculated. 

9. Enter the Percentage of the deduction to be taken if applicable. 

Note: Enter the amount if Flat Amount is selected from the dropdown. 

10. Repeat Steps 7 – 9 for additional Deductions. 

Other Splits 

Select other splits to be applied to commissions. 



   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
357 

1. Select the individual to receive the commission from the Other Splits dropdown. 

 

Figure 367: Other Splits 

2. Select the option from the dropdown list to determine how the commission is 
calculated. 

3. Enter the percentage applied to commission in the percentage field if applicable. 

Note: Enter the amount if Flat Amount is selected from the dropdown. 

4. Repeat Steps 1 – 1 for additional Other Splits. 

5. Enter the Commission Paid Date. 

Banked Loan 

Complete the Banked Loan section when the loan was originated by a bank. The Banked 
Loan section records the revenue generated from the loan. 

Most of the fields are calculated fields and are automatically populated. Complete 
remaining fields manually, as applicable. Enter additional fees in the blank fields. 

Brokered Loan 

Complete the Brokered Loan section when the loan was originated by a Broker. The 
Brokered Loan section records the revenue generated from the loan. 

Most of the fields are calculated fields and are automatically populated. Complete 
remaining fields manually, as applicable. Enter any additional fees in the blank fields. 

Enter the amount paid by the broker to the lender in the Lender Charge field. The value can 
be a percentage or dollar amount. 

Note: Enter the amount as a negative number by using a minus sign (–) when compensation 
from the lender is expected. 
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Add Notes 

Use the following steps to complete the Notes section and add and view notes. 

1. Click Add Item. 

 

Figure 368: Add Notes 

2. Enter Item Comments. 

 

Figure 369: Item Comments 

3. Click OK to close the dialog. 
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Chapter 10: BANKER MENU 
Point provides a set of screens assist bankers with managing mortgage banking activities 
that occur after the loan is closed and funded. 

Many of the Banker screens share information that is entered at various times during the 
loan process. Each user maintains different information, and if the information is shared, it is 
populated in other areas of the loan file. 

Access to Banker screens is controlled by setting the security level for these screens in 
Point Administrator or Point Central, depending on the configuration. 

Secondary Marketing 

Register and Lock Loans for Sale 

The Secondary Marketing screen is used to register and lock loans for sale. Record the lock 
data for loans to be funded internally and sold to investors on the screen. 

Disabled fields are populated when the user for the role completes them (such as: the fields 
in the Underwriting Decision section are completed by the underwriter on the Underwriting 
screen.) 

Loan Information 

Complete the non-populated Loan Information fields. 

1. Select Secondary Marketing from the Banker menu. 

2. Select the Business Channel. 

 

Figure 370: Secondary Marketing Loan 
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3. Enter the Company/Broker. 

4. Select the checkbox to unlock the MERS # field and enter the MERS Number to 
manually override the automatically generated value. 

Note: The MERS # is automatically generated if Auto MIN Generation is enabled. 

Rate Lock & Current Loan 

The fields in the Rate Lock Confirmation section correspond to the Registration and Lock 
Request section on the Registration & Rate Lock Tracking screen. The fields pertaining to the 
rate lock are disabled and cannot be modified if the rate was already locked on the 
Registration & Rate Lock Tracking screen. (See Registration & Rate Lock for details.) 

Use the following steps to enter the Rate Lock details and Current Loan Information fields 
if not populated from the Registration & Rate Lock Tracking screen. 

1. Select the Registered Date. 

 

Figure 371: Rate Lock & Current Loan 

2. Select the Lock Date/Time. 

3. Enter the Lock Term. 

4. Enter the Lock Extension. 

5. Select the Pricing Exception Granted checkbox if applicable. 

6. Select the Escrows Waived checkbox to waive any escrow requirements. 

7. Select the HELOC YSP Based on Initial HELOC Draw Amt checkbox if the yield 
spread premium is based on the initial HELOC draw amount. 

8. Select the Lock Confirmed checkbox when the lock is confirmed. 

Note: The following occurs when the Lock Confirmed checkbox is selected: the Create 
Lock Confirmation button is enabled and the HELOC YSP Based on Initial HELOC Draw 
Amt checkbox and the Rate Lock Pricing fields become disabled to prevent additional 
changes. The Lock Confirmed Date field is automatically populated with the current date. 
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9. Select Yes or No on the message that displays to copy the locked rate to the note 
rate if the Required Net Adjusted Rate field in the Rate Lock Pricing section 
contains a value when the Locked Confirmed checkbox is selected.  

10. Click the Create Lock Confirmation button to generate the Lock Confirmation. 

11. Enter a file name if the File Name field is not populated. 

Note: A file name is required to email or save the Lock Confirmation PDF. (See Email Options 
for details.) 

12. Complete the Product ID field if required. 

13. Click the Loan Program Details button to access the Program & Rate Lock Details 
dialog. 

 

Figure 372: Program & Rate Lock Details Dialog 

14. Select the tab corresponding to the information to view or edit and make the 
necessary changes. 

15. Update the Loan Amount field if required. 

16. Enter the initial draw amount in the Initial HELOC Draw field if the loan is for a 
home equity line. 

17. Update the Interest Rate if applicable. 
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Gain/Loss Information 

Complete the Gain/Loss information as appropriate. 

 

Figure 373: Secondary Marketing Gain/Loss 

Rate Lock Pricing 

Note: The Rate Lock Pricing section is disabled after the Lock Confirmed checkbox is 
selected to confirm the lock. 

1. Enter the base rate in the Base Rate field. 

2. Select up to two additional Base Rate Adjustments from the dropdowns. 

3. Enter the adjustment Percentage in the % field. 

Note: Point calculates the Required Net Adjusted Rate Percentage. 

Buy Price 

Refer to Figure 373 for field locations while completing the Buy Price section. 

1. Enter the Base Price. 



   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
363 

2. Select up to 10 additional Buy Price Adjustments from the dropdowns. 

3. Enter the adjustment Percentage in the % field. 

Note: Point calculates the Net Buy Price. 

4. Enter the Branch/Originator Margin. 

Commitment Pricing 

Refer to Figure 373 for field locations while completing the Commitment Pricing section. 

1. Enter the Base Rate. 

2. Select up to two additional Base Rate Adjustments from the dropdowns.  

Note: Point calculates the Required Net Adjusted Rate field. 

3. Enter the adjustment Percentage in the % field. 

Sell Price 

Refer to Figure 373 for field locations while completing the Sell Price section. 

1. Enter the Base Rate. 

2. Enter the Service Release Premium rate adjustment. 

3. Enter the Overage/Rebate adjustment. 

4. Select up to eight additional Sell Price Adjustments from the dropdowns. 

5. Enter the adjustment percent in the % field. 

Note: Point calculates the Net Sell Price. 

6. Select the Pricing based on Loan Amount w/MIP, FF checkbox to calculate the 
Net Buy Price based on the total loan amount rather than the base loan amount. 

Note: Point calculates the Gain/Loss on Sale fields based on the adjustments entered. 

Commitment & Investor Information 

Use the following steps to complete the Commitment & Investor fields. 

1. Select the Registered Date. 

2. Enter the Commitment Date/Time. 

3. Enter the Commitment Term. 

4. Enter the Commitment Extension. 

Note: The Commitment Exp Date field is populated based on the values in the 
Commitment Term and Commitment Extension fields. 
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5. Select the Desired Ship Date. 

6. Select the and Delivery Due Date. 

7. Select the Investor. 

Note: Populate the dropdown list by creating investor profiles in the company defaults 
utility. (See Investors for details.) 

8. Enter the Investor Loan No. 

9. Enter the Commitment No. 

10.  Enter the Investor Program. 

11. Select the Commitment Type. 

12. Enter the Rate Sheet Ref # fields. 

Final Gain/Loss Information 

Use the following steps to complete the Final Gain/Loss Information. 

1. Enter the date when the loan is sold to the investor. 

2. Enter the date when the wired purchase funds are received from the investor in the 
Wire Received Date field. 

3. Enter the Principal Amount Purchased. 

Final Sale Pricing 

Use the following steps to complete the Final Sale Pricing fields. 

1. Enter the Base Sell Price. 

2. Enter the Service Release Premium. 

3. Enter the Overage/Rebate. 

4. Enter the Sell Adjustments percentages. 

5. Enter the additional values in the % and $ fields if applicable. 

Note: Point calculates the Final Net Sell Price, Net Sell Price, Execution Variance, and the 
Final Gain/Loss on Sale. 

6. Enter Notes if applicable. 

7. Click Save. 

Underwriting 

The Underwriting screen is used to track the underwriting status of a loan. 
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Loan Information 

The top portion of Underwriting screen contains general loan and Borrower information. 
Most fields are prepopulated with information entered in other screens. 

1. Select Underwriting from the Banker menu. 

2. Enter the Lender Case Number. 

 

Figure 374: Underwriting Loan Information 

3. Select the Business Channel. 

4. Enter the Company/Broker. 

5. Select the Estimated Close Date. 

6. Selected the Registered Date. 

Property & General Information 

Use the following steps to complete the missing Property and General Information. 

1. Select the Property Type. 

 

Figure 375: Property & General Information 

2. Enter the Number of Units. 
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3. Enter the Condo information when selecting Condominium from the Property 
Type dropdown. 

4. Enter the Initial HELOC Draw if the loan is for a home equity line of credit. 

5. Enter the Max Loan Limit. 

6. Select the 1st Time Home Buyer checkbox if applicable. 

7. Select the Escrows waived checkbox if the lender is allowing the Borrower to pay 
certain escrow items directly to the payees. 

8. Select the Prepayment Penalty checkbox if the selected loan program has a 
prepayment penalty. 

9. Enter the number of years the prepayment penalty is in effect if applicable. 

10. Select the Prepay Type from the dropdown if applicable. 

11. Enter the Max LTV/CLTV.  

Note: The LTV/CLTV and HCLTV fields are populated from information entered in other 
screens. 

12. Select the Doc Type. 

13. Enter the Credit Grade if applicable. 

14. Enter the Maximum Levels allowed on the rate sheet to ensure the loan 
parameters meet the rate lock requirements. 

Note: The Combined fields are automatically populated with the combined debt-to income 
ratios of the Borrower and Co-Borrowers. 

Program/Lock Details 

Edit the Program/Lock Details on the Program/Lock Details dialog. 

1. Click Program/Lock Details. (See Figure 372.) 

2.  Select the ARM tab to review and edit.  

Note: The Rate Lock tab fields are non-editable. 

3. Select the Buydown tab to review and edit. 

4. Select the Prepay/Other Features tab to review and edit. 

5. Click OK to save edits. 

Loan Program/Investor/Flood Certification 

Use the following steps to complete the Loan Program, Investor Information, and Flood 
Certification sections if not populated. 
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1. Enter the Product ID. 

 

Figure 376: Loan Program/Investor/Flood Certification 

2. Enter Loan Program. 

3. Enter Term/Due if not populated. 

4. Enter the Interest Only Months. 

5. Select the Investor. 

6. Enter Investor Loan No. 

7. Enter Investor Program. 

8. Enter Flood Certification Company Name. 

9. Select the Certification Type. 

10. Enter Flood Zone. 

11. Select the Certification Type. 

12. Select the Subject Property is in a Flood Zone checkbox if applicable. 

Underwriting Decision 

Use the following steps to complete the Underwriting Decision section. 

1. Select the appropriate Underwriting Decision. 

 

Figure 377:Underwriting Decision 
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2. Select a link to continue: 

• Approved 

• Suspended 

• Denied 

• Cancelled 

Approved 

Complete the following fields after approving the loan. (See Figure 377.) 

1. Enter the approved Maximum Interest Rate. 

2. Enter the Approved Exp Date. 

3. Select the Max Ap. 

4. Select the Manual Underwriting checkbox if manual underwriting was performed. 

5. Select the Underwritten to Investor Guidelines checkbox if the loan conforms to 
the investor guidelines. 

6. Select the Loan Exception Granted checkbox if an exception was made to the 
program guidelines that might be subject to added conditions or pricing add-ons. 

7. Enter an Exception Description when selecting the Loan Exception Granted 
checkbox. 

8. Complete the Notes section if applicable. 

Suspended 

Complete the following fields after suspending the loan. 

1. Enter the Suspense information. 

 

Figure 378: Underwriting Suspense/Denial 

2. Click Create Suspense/Denial Notice. 
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3. See Print Options for printing and email details. 

4. Enter Notes if applicable. 

Denied 

Use the following steps after denying the loan. 

1. Select up to three Denial Reasons. 

 

Figure 379: Denial Reasons 

2. See Print Options for printing and email details. 

3. Enter Notes if applicable. 

Cancelled 

No further action is required when Cancelled is selected. 

Automated Underwriting 

Use the following steps to complete the Automated Underwriting section.  

The applicable DO or DU checkbox is automatically selected when the AUS findings are 
downloaded from Fannie Mae. 

1. Select the DO or DU interface used for Fannie Mae UCD purposes. 

 

Figure 380: Automated Underwriting 

2. Enter or select the type of AUS if not Fannie Mae or Freddie Mac. 

3. Enter the AUS Run Date. 

4. Select the appropriate AUS Recommendation. 
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5. Enter the AUS Case Number.  

Note: Up to four automated underwriting decisions are allowed. 

6. Select the Include in UCD checkbox to include the findings. 

Underwriting Screen Buttons 

The following Underwriting screen buttons are available for additional functionality. 

Conditions 

The Conditions button opens the Conditions screen used to track loan conditions. (See 
Conditions for details.) 

Appraisal 

The Appraisal button opens the Appraisal Information dialog used to record information 
about the property appraisal. 

1. Click the Appraisal button. 

 

Figure 381: Appraisal Information Dialog 

2. Enter the company information for the Original Appraiser. 

3. Select the Valuation Type from the dropdown. 

4. Complete the Appraised Value. 

5. Complete the Estimated Cost New. 

6. Complete the Appraisal Expires. 

7. Enter the company information for the Reviewal Appraisal. 
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8. Select the Valuation Type from the dropdown. 

9. Enter the Reviewed Value. 

Note: The Value Variance is calculated and the Review Result field is automatically 
populated with the result. 

10. Click OK to exit the dialog. 

Insurance 

The Insurance button opens the Insurance dialog with information about the mortgage, 
hazard, and flood insurance for the property. 

Mortgage Insurance 

Use the following steps to complete the Mortgage Insurance (MI) tab. 

1. Select/enter the Mortgage Insurance Company. 

 

Figure 382: Mortgage Insurance Tab 

2. Select the MI Type. 

3. Select the MI Premium Type. 

4. Enter the MI Case Number. 

5. Select the Termination Date. 

6. Select the Required MI Coverage Percentage. 

7. Select the Upfront MIP/FF Percentage. 

8. Enter the Upfront MIP/FF Amount. 

9. Enter the MIP Refund Amount. 
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Hazard Insurance 

Use the following steps to complete the Hazard Insurance tab. 

1. Select/enter the Insurance Company Name. 

 

Figure 383: Hazard Insurance Tab 

2. Enter the Insurance Agent. 

3. Enter the Insurance Phone. 

4. Ener the Insurance Policy Number. 

5. Select the Effective Date. 

6. Select the Paid To Date. 

7. Enter the Coverage Amount. 

8. Enter the Extended Replacement Percentage. 

9. Enter the Guaranteed Replacement Amount. 

10. Enter the Premium Amount. 

11. Enter the Deductible Amount. 
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Flood Insurance 

Use the following steps to complete the Flood Insurance tab. 

1. Select/enter the Insurance Company Name. 

 

Figure 384: Flood Insurance Tab 

2. Enter the Insurance Agent. 

3. Enter the Insurance Phone. 

4. Enter the Insurance Policy Number. 

5. Select the Effective Date. 

6. Select the Paid To Date. 

7. Enter the Coverage Amount. 

8. Enter the Extended Replacement Percentage. 

9. Enter the Guaranteed Replacement Amount. 

10. Enter the Premium Amount. 

11. Enter the Deductible Amount. 

Escrow & Title 

The Escrow & Title button opens the Escrow & Title Information dialog containing the 
escrow, title, and wire information. 
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Escrow/Closing Agent 

Use the following steps to complete the Escrow/Closing Agent tab. 

1. Select the Type. 

 

Figure 385: Escrow/Closing Agent Tab 

2. Select/enter the Company. 

3. Enter the Company Contact. 

4. Enter the Company Contact Information. 

5. Enter the Reference Number. 

6. Enter the Credit To. 

7. Select/enter the Bank Name. 

8. Enter the Bank Address information. 

9. Enter the Bank ABA Number. 

10. Enter the Bank Account Number. 

11. Enter the Bank Reference Number. 

12. Enter the Bank Contact. 

13. Enter the Further information. 

14. Enter the Further Account Number. 
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Title 

Use the following steps to complete the Title tab. 

1. Select/enter the Title Company. 

 

Figure 386: Title Tab 

2. Enter the Company Contact. 

3. Enter the Contact Phone/Fax. 

4. Enter the Company E-Mail. 

5. Enter the Company Address. 

6. Enter the Order Number. 

7. Enter the Preliminary Date. 

8. Enter the Assessor Parcel Number. 

9. Enter the Tax Year & Message. 

10. Enter Approved information. 

11. Enter ALTA Endorsements. 

12. Enter Long Legal Description. 

Conditions 

Use the Conditions screen to track required loan conditions prior to loan approval. The top 
portion of this screen contains general loan and underwriting information. Most of these 
fields are populated with information entered in other screens. 
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Loan Information 

Use the following steps to complete the conditions initial information. 

1. Select Conditions from the Banker menu. 

2. Select the Business Channel. 

 

Figure 387: Conditions Loan Information 

3. Enter the Company/Broker. 

4. Enter the Product ID. 

5. Enter the Loan Program. 

6. Enter missing Reference Dates. 

7. Click the Program/Lock Details button to access the Program & Rate Lock Details 
dialog. (See Program/Lock Details for additional information.) 

8. Click Create Loan Approval Notice to generate a loan approval notice. 

Note: The Create Loan Approval Notice button is enabled only when the underwriting 
decision is Approved and loan contains at least one condition. 

9. See Print Options for printing and email details. 

10. Click Create Funding Conditions Notice button to generate a Funding Conditions 
Notice. 

Note: The Create Funding Conditions Notice button is enabled only when the Docs Back 
Date field is populated with a date. 
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Loan Conditions Table Loan Conditions Table 

Use the following section to update the Loan Conditions table. 

Add Condition 

Use the following steps to add a condition to the Loan Conditions table. 

1. Click Add to manually add conditions into the Loan Conditions section. 

 

Figure 388: Add Loan Conditions 

Note: Click Add Defaults to add the default conditions. Click Add Conditions from Pick-List 
to select the conditions from an existing pick-list. 

2. Select the Condition Type. 

 

Figure 389: Edit Conditions Dialog 

3. Enter the condition Description. 

4. Select the Document Category. 

5. Select the MISMO Document Type. 
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6. Select the Show in Track > Conditions Screen checkbox to include the condition in 
the list of conditions on the Conditions screen. 

7. Select the Show in Mtg Loan Commitment Screen checkbox to include the 
condition on the Mortgage Loan Commitment screen. 

8. Click Save & Close to save the condition. 

Note: Click Save & New to add another condition. 

Edit Condition 

Use the following steps to edit an existing loan condition. Perform the steps to change a 
condition or update the Received Date when the condition is met. 

Note: Selecting the Show in Track > Conditions screen checkbox does not record the loan 
condition in the Document Requests table if editing a previously saved loan condition. 

1. Highlight the condition to edit. 

 

Figure 390: Edit Loan Condition 

2. Make required updates to the condition in the Edit Conditions dialog. (See Figure 
389.) 

Condition Buttons 

The following buttons additional functionality. 

Appraisal 

The Appraisal button opens the Appraisal Information dialog to record information about 
the property appraisal. (See Appraisal for details.) 

Insurance 

The Insurance button opens the Insurance dialog containing information about the 
mortgage, hazard, and flood insurance for the property. (See Insurance for details.) 
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Escrow & Title 

The Escrow & Title button opens the Escrow & Title Information dialog containing the 
escrow, title, and wire information. (See Escrow & Title for details.) 

Fees & Impounds 

Use the Fees & Impounds screen to document the final fees and impounds for closing the 
loan. These fees are itemized on the Create Funding Figures Worksheet the funder/closer 
sends to the document provider used to generate the HUD-1. The net wire amount the 
warehouse lender is to send is also calculated on this screen. 

Note: The Fees & Impounds screen is available only to users who have access to financial 
information. Access to financial information is specified for Point users in Point Administrator.  

Initial Fields 

Use the following steps to complete the Initial Fields. 

1. Select Fees & Impounds from the Banker menu. 

2. Select the Business Channel. 

 

Figure 391: Initial Fields 

3. Enter Company/Broker. 

4. Select the Doc Preparer. 

5. Select the Funder. 

6. Click Copy from Fees Worksheet to copy the information to the Fees table. 
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7. Select the checkboxes corresponding to each fee to include in the list. 

 

Figure 392: Copy from Fees Worksheet Dialog  

Note: Click Select All to select all the fees in the list. 

Add Fees from Pick-List 

Click Add Defaults to add the default fees to the list. 

Note: See Fee Types to add a fee to the default set of fees. 

1. Click Add Fees From Pick-List. 

 

Figure 393: Fees Table 
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2. Select the Fees from Fees Pick-List dialog. 

 

Figure 394: Fees Pick List 

3. Click OK. 

Manually Add Fees 

Use the following steps to manually add fees. 

1. Click Add. (See Figure 393.) 

2. Select the HUD Line Number from the dropdown or enter the line number 
manually. 

 

Figure 395: Edit Fee Dialog 

3. Select the Fee Name. 
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4. Select Paid To. 

5. Click Borrower button. 

6. Complete the Fee Distribution Worksheet dialog. (See Figure 132.) 

7. Click OK to close the Fee Distribution Worksheet dialog. 

8. Enter the Points. 

9. Enter the Additional Amount. 

10. Enter the Fee Amount. 

11. Enter the Paid Amount. 

12. Enter Total Due if applicable. 

13. Check the APR Fee checkbox if applicable. 

14. Enter the GL Code. 

15. Select the Fee Type. 

16. Select Section 32 checkbox if applicable. 

17. Select Net From Wire checkbox if applicable. 

18. Complete the Fee Worksheet Linked Information. 

19. Click Save & Close. 

Note: Click Save & New to add another fee. 

Edit Fees 

Use the following steps to edit fees. 

1. Select the Fee to edit. (See Figure 393.) 

2. Click Edit. 

3. Update the information in the Edit Fee dialog. (See Figure 395.) 

4. Click Save & Close. 

Insert Fees 

Use the following steps to insert a fee at a selected table location. 

1. Select the table location to insert the fee. (See Figure 393.) 

2. Click Insert. 

3. Use the steps in Manually Add Fees to insert fee. 
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Delete Fees 

Use the following steps to delete fees. 

1. Select the fee to delete. (See Figure 393.) 

2. Click Delete. 

Add Impounds from Pick-List 

Use the following steps to add Impounds to the table. 

1. Click Add Impounds From Pick-List. 

 

Figure 396: Impounds Table 

2. Select the Impounds to add. 

 

Figure 397 : Impounds Pick-List 

3. Click OK. 
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Manually Add Impounds 

Use the following steps to manually add impounds to the table. 

1. Click Add. (See Figure 396.) 

2. Select the HUD Line Number or enter the number manually. 

 

Figure 398: Edit Impound Dialog 

3. Select the Impound Name. 

4. Click the Borrower button. 
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5. Complete the Impound Distribution Worksheet dialog. 

 

Figure 399: Impound Distribution Worksheet 

6. Click OK on the Impound Distribution Worksheet dialog. 

7. Select the APR Fee checkbox if applicable. 

8. Select the Disbursement Frequency. 

9. Enter the Annual Amount. 

10. Enter the number of months that will be collected at the close of escrow as a 
cushion in the Number of Months field. 

Note: The Monthly Amount and Amount Collected fields are calculated accordingly. 

11. Select the Paid at Closing checkbox to specify the fees in the Disb. 1 column were 
paid at closing and are excluded from the Aggregate Escrow Account dialog when 
the Calculate Aggregate button is clicked. 

12. Select the date when the first payment is due from the Disbursement 1 calendar in 
the Due Dates row. 

13. Select the month and date when the payment is considered late from the 
Disbursement 1 calendar in the Late Dates row. 

14. Continue the process for the subsequent disbursements for the disbursement 
frequency selected. 

15. Complete the Fee Worksheet Linked Information fields. 

16. Click Save & Close. 

Note: Click Save & New to add another impound. 
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Edit Impounds 

Use the steps in Edit Fees as a guide for editing impounds. 

Insert Impounds 

Use the steps in Insert Fees as a guide for inserting impounds. 

Delete Impounds 

Use the steps in Delete Fees as a guide for deleting impounds. 

PMI/MMI Impounds 

The mortgage information in this section corresponds to the mortgage insurance 
information on the Truth-In-Lending screen and in the PMI/ MIP/FF/USDA Insurance 
dialog. 

1. Select the mortgage insurance rate for the initial period from the PMI/MIP/VA/ 
USDA dropdown. 

 

Figure 400: PMI/MMI Impounds 

Note: Click the Lock to enter the Monthly Amount when not basing the rate on a 
Percentage. 

2. Enter the number of months the initial rate is effective in the Months field. 

Note: The amount is calculated and automatically populated in the Proposed Monthly 
Housing Expenses section on page 2 of the Loan Application, the Mortgage Insurance field 
on the Truth-in-Lending Disclosure, and the Up-Front Mortgage Insurance/USDA 
Guarantee Fee field on the GFE. 
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3. Select the renewal rate from the PMI Renewal 1 dropdown if applicable. 

4. Select the renewal rate from the PMI Renewal 2, dropdown if applicable. 

Note: The values for the PMI dropdowns are defined in the dropdown list utility. 

5. Enter the number of months the renewal rates are effective in the Months fields. 

6. Select the payment frequency from the Disbursement Frequency dropdown list. 

7. Select the Disbursement Date. 

Note: The Payable To field is populated according to the loan type selection.  

8. Select the Premium Paid By option. 

9. Select the Include PMI/MMI in Aggregate Calculation checkbox if applicable. 

10. Select the Months Cushion option to indicate the reserves. 

Note: The Total T & I Cushion and Total T & I Collected fields calculate automatically. 

11. Click the Calculate Aggregate button calculate the Aggregate Escrow 
Adjustment and view the Aggregate Escrow Account Schedule. 

 Note: The first payment date must be entered before calculating the aggregate escrow 
account. 

12. Click the Compare GFE and Closing Fees button to view the GFE and Closing Fees 
Comparison. 

APR Comparison & Higher Mortgages 

Use the following steps to complete the APR Comparison and Higher Priced Mortgage 
Loans sections. 

1. Select the Disclosed Date. 

 

Figure 401: APR Comparison & Higher Mortgages 
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2. Select the Re-disclosed Date. 

3. Enter the Disclosed APR Percentage. 

4. Enter the Re-disclosed APR Percentage. 

5. Select the Disclosed Method. 

6. Select the Re-disclosed Method. 

7. Select the date the APOR became effective. 

8. Enter the average Prime Offer Rate Percentage. 

9. Click Calculate to calculate the difference between the final APR and the last 
disclosed APR. 

Note: Values changed on this screen update the linked screens automatically. 

Funding Figures 

Use the following steps to complete the Funding Figures and Monthly Payment sections. 

1. Click Program/Lock Details to access the Program & Rate Lock Details dialog. 
(See Figure 372.) 

 

Figure 402: Funding Figures 

2. Select the tab corresponding to the information to view or edit. 

3. Make the necessary changes. 

4. Click OK to close the dialog. 

5. Select the Prepaid Interest from Date. 

6. Select the Prepaid Interest to Date fields. 
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Note: The Odd Days field is calculated based on the dates entered. 

7. Select the number of calendar days required by the lender from the dropdown if 
the Calendar Days Basis field is not populated from the company default selection 
with the correct value. 

8. Select the appropriate Paid By option. 

9. Select the Exclude checkboxes for the Loan Amount, Upfront MIP, FF, Total 
Prepaid Interest, MIP Refund, and SRP fields to exclude from calculations if 
applicable. 

10. Enter the Broker Yield Spread Premium YSP field. 

11. Press the Tab key. 

12. Enter the amount of the first draw at closing in the Initial HELOC Draw Amount 
field if the loan is a home equity line 

13. Press the Tab to calculate the Wire Amount. 

14. Select the HELOC YSP Based on Initial HELOC Draw Amt checkbox if the YSP is 
based on the initial HELOC draw amount. 

Note: The Broker YSP and Wire Amount fields adjusted automatically when the checkbox 
is selected. 

15. Click the Create Funding Figures Worksheet button to generate the worksheet. 

16. Enter a required file name if the File Name field is not populated. 

17. Select Email or Print from the Output Option dropdown list and choose to 
password protect if necessary. (See Print Options for more information.) 

Closing Documents 

The Banker Closing Documents screens are typically used by the loser/funder to enter 
information relevant to lenders when they order closing documents. 

Basic Loan Information 

The Basic Loan Information screen contains general information about the loan and 
important dates.  

Investor Information 

The top portion and other sections of the screen contain data provided is for informational 
purposes from other screens and cannot be edited. 

1. Select Closing Documents from the Banker menu. 
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2. Select Basic Loan Information. 

3. Review and edit the populated information if applicable. 

 

Figure 403: Basic Loan Investor Information 

4. Select the Business Channel. 

5. Enter the Company/Broker. 

6. Enter the MERS Purchaser Org ID for the lender or investor purchasing the loan. 

7. Select the Investor Address as Return to on Assignment checkbox to print an 
assignment from the lender or broker to MERS. 

Note: The MERS information and MERS ID number does not print on documents other than 
the assignment when the option is selected. 

8. Select the Endorsement on Note from Lender to Investor checkbox to print an 
endorsement on the note from the lender to the investor. 

9. Select the Assignment to MERS only checkbox to add investor address to the 
assignment as the return address for the recorded instrument. 

10. Select the Investor to blank on Assignment checkbox to print an assignment from 
the investor to blank. 

11. Select the Has no MERS ID # checkbox when the investor who purchases the loan 
is not a MERS subscriber. 

Note: This action prints an assignment from MERS to blank. 
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Add Sellers 

Use the following steps to add sellers to the Sellers table. 

1. Click Add. 

 

Figure 404: Sellers Table 

2. Select the Seller is a Trust or Corporation checkbox if the seller is a trust or 
corporation. 

 

Figure 405: Edit Seller Dialog 

3. Complete the seller Name fields. 

4. Enter the name of the Company or Trust if applicable. 

5. Select the Relationship on Title. 

6. Complete the seller Address fields. 

7. Complete the seller Contact fields. 
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8. Click Save & Close. 

Note: Click Save & New to enter additional sellers on the title. 

Edit Sellers 

Use the following steps to add sellers on the Sellers table. 

1. Highlight the Seller to edit. (See Figure 404.) 

2. Click Edit. 

3. Update the Edit Seller dialog. (See Figure 405.) 

4. Click Save & Close. 

Insert Sellers 

Use the following steps to add sellers at a selected table location. 

1. Select the table location to insert the seller. (See Figure 404.) 

2. Click Insert. 

3. Use the steps in Add Sellers to add the seller to the table. 

Delete Sellers 

Use the following steps to delete sellers from the Sellers table. 

1. Select the seller to delete. (See Figure 404.) 

2. Click Delete. 

Date Fields 

Complete the Dates section with the completion dates for each event. 

Rate Lock & Amortization Type 

Use the following steps to complete the Rate Lock sections. 
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1. Click the Program/Lock Details button to update information on the Programs & 
Rate Lock Details dialog. (See Program/Lock Details for details.) 

 

Figure 406: Rate Lock & Amortization Type 

2. Complete the Amortization Type fields if the loan is an ARM loan. 

3. Enter the amount the Borrower is approved to receive as a draw against the 
HELOC in the Initial HELOC Draw field if the loan is a HELOC. 

4. Select the Loss Mitigation Loan checkbox if the refinance is a subject of a loss 
mitigation effort. 

5. Enter the amount of the Hope for Homeowners Junior Lien on the second 
mortgage if applicable. 

Request Closing Documents 

Use the following steps to order closing documents. 

1. Proceed to Document Processing if the Product Name and Product Code fields 
are already populated with the required products. 

 

Figure 407: Request Closing Documents 

2. Enter the Doc Provider. 
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3. Click Select Product button to select the product name, code, and document 
investor on the Select Product dialog. (See Figure 306.) 

4. Enter Special Instructions when appropriate. 

5. Click View Documents to view the returned closing documents. 

6. Click View Analysist to view the loan analysis after receiving the closing 
documents. 

7. Enter Special Instructions when appropriate. 

8. Click Request Documents. 

Note: The View Documents and View Analysis buttons are available after receiving the 
closing documents. 

Document Processing 

Use the following steps to complete the Doc Processing section. 

1. Select the entity for which the documents are being requested from the Docs In 
Name Of dropdown. 

 

Figure 408: Document Processing 

2. Select where the documents are being from the Docs Sent To dropdown. 

3. Select the document transmission method from Method Docs Sent dropdown. 

4. Select the Mail Away checkbox if the closing documents were mailed for 
signatures rather than signed in person. 

5. Select the Doc Preparer. 

6. Enter Doc Preparer Phone. 

7. Enter Doc Preparer E-mail. 

8. Enter the location where the documents were executed in the Address fields. 
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Closer/Funder 

Use the following steps to complete the Closer/Funder section. 

1. Select the Closer/Funder Name. 

 

Figure 409: Closer/Funder 

2. Enter the Closer/Funder E-mail. 

3. Enter the Closer/Funder Phone. 

4. Enter the Closer/Funder Fax. 

5. Enter the hours of business in the Open for Business field. 

6. Enter the non-business hours in the Closed for Business field. 

Note Pay To 

Use the following steps to complete the Note Pay To fields. 

1. Enter the Name. 

 

Figure 410: Note Pay To 

2. Enter the Address information. 

3. Enter Notes if applicable. 

Basic Loan Information Buttons 

The following buttons additional functionality. 
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Appraisal 

The Appraisal button opens the Appraisal Information dialog to record information about 
the property appraisal. (See Appraisal for details.) 

Insurance 

The Insurance button opens the Insurance dialog containing information about the 
mortgage, hazard, and flood insurance for the property. (See Insurance for details.) 

Escrow & Title 

The Escrow & Title button opens the Escrow & Title Information dialog containing the 
escrow, title, and wire information. (See Escrow & Title for details.) 

Payoffs 

The Payoffs button to open the Payoffs dialog. The dialog contains information about liens 
and other liabilities to be paid at the close of escrow. The Payoffs dialog corresponds to the 
Lien Payoffs and Other Payoffs tabs in the Title/Escrow Request dialog. 

HUD-1 

Use the HUD-1 button to open the HUD-1 screen used itemize charges by the lender to the 
Borrower and the seller for purchase transactions. (See HUD-1 Settlement Statement for 
details.) 

Banker Borrower 

The Banker Borrower screen contains general information about the Borrower. Many fields 
are populated from the Borrower Information screen. Update the populated fields as 
required. 

1. Select Borrower from the Banker menu.  

2. Select Borrower. 
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3. Select the Borrower Relationship on Title. 

 

Figure 411: Banker Borrower Screen 

4. Select the Borrower Not Obligated checkbox if applicable. 

5. Select the Borrower Co-Signer Only checkbox if applicable. 

6. Select the appropriate Borrower VA Home Loan checkbox. 

7. Select the Co-Borrower Relationship on Title. 

8. Select the Co-Borrower Not Obligated checkbox if applicable. 

9. Select the Co-Borrower Co-Signer Only checkbox if applicable. 

10. Enter the Credit Report Date. 

Note: Request a credit report if the fields are not populated. (See Credit Reports for details.) 

11. Select the Borrower FACTA checkbox if the Credit Report contains an inquiry that 
negatively impacts the credit score. 

12. Enter the inquiry date in the Borrower Date field. 

13. Repeat Steps 11 – 12 for the Co-Borrower. 

14. Enter the Credit Reference Number. 

15. Enter how the final deed is to be recorded in the Complete Final Vesting On Deed 
of Trust/Mortgage field. 
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16. Add missing any Borrower aliases in the Borrower Aliases table. (See Add 
Borrower Aliases.) 

17. Enter the Borrower Power of Attorney Name. 

18. Select the Borrower Power of Attorney Signing Capacity. 

19. Repeat Steps 17 – 18 for the Co-Borrower. 

20. Enter Notes if applicable. 

Closing Instructions 

The Closing Instructions screen provides closing instructions. 

Title Company/Settlement Agent Instructions 

Complete the instructions for the Title Company and/or Settlement Agent. 

1. Select Closing Documents from the Banker menu. 

2. Select Closing Instructions. 

3. Select the Waive Title Policy checkbox if a title policy is not required for the 
transaction. 

 

Figure 412: Title Company/Settlement Agent 

4. Select the Include Title Policy Agreement checkbox to include the agreement 
between the Borrower and the title company to enable the title company to 
correct document errors. 

5. Select the appropriate Schedule A checkboxes to indicate the information is 
included for Schedule A. 

6. Complete the additional instructions field below the checkboxes. 

7. Select the appropriate Schedule B checkboxes to indicate the information is 
included for Schedule B. 

8. Complete the additional instructions field below the checkboxes. 
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9. Select the appropriate Schedule C checkboxes to indicate the information is 
included for Schedule C. 

10. Select the Tax Return Type from the dropdown if requesting Form 4506. 

11. Enter the period ending dates for the request. 

Conditions & Forms 

Selected Conditions checkboxes indicate the condition has been met and forms are 
included. 

1. Select the checkboxes for the Conditions met. 

 

Figure 413: Conditions & Forms 

2. Enter Hold Harmless details if applicable. 

3. Select the checkboxes for included forms. 

4. Enter the Paid in Full Receipts Description. 

5. Enter the Proof of Sales Description. 

6. Enter Contract Corrections if applicable. 

Title/Escrow Information 

Use the following steps to complete the Title/Escrow Instruction fields. Many fields in this 
section are also in the Title & Escrow Information dialog. Changes made to the Title/Escrow 
Instruction fields update the Title & Escrow Information dialog. 
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1. Update the Assessor’s Parcel No if required. 

 

Figure 414: Title/Escrow Information 

2. Enter the Tax Year. 

3. Select the appropriate Message. 

4. Enter the Approved description. 

5. Enter the ALTA Endorsements. 

6. Enter the Long Legal Description. 

7. Update the Order Number if required. 

8. Select the Preliminary Date. 

9. Select the Table Funded Transaction checkbox and enter the Issue Funding 
Number if this is a table funded transaction. 
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Title/Escrow Company 

Enter the title company and escrow company details if not populated. Leave the Escrow 
Company fields blank if the company uses is both title and escrow. 

1. Enter the Title Company Name. 

 

Figure 415: Title/Escrow Company 

2. Enter the Title Company Contact. 

3. Enter the Title Company Address information. 

4. Enter the Title Company Contact Information. 

5. Select the Lender Affiliate checkbox if the title company is affiliated in any way 
with the lender. 

6. Select the Wire Disbursements checkbox if the loan proceeds will be in the form 
of a wire transfer. 

7. Enter the Notary State if different from the title state.  

8. Enter the Notary County if different from the title county. 

9. Complete the Escrow Company fields if required. 

Wire To 

Use the following steps to complete the Wire To section if not populated. 

1. Enter the amount to be disbursed in the Wire/Check Amount field. 

 

Figure 416: Wire To Information 
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2. Enter the Credit To individual. 

3. Enter the Bank Name. 

4. Enter the Bank City/State. 

5. Enter the Bank ABA Number. 

6. Enter the Account Number. 

7. Enter the Reference Number. 

8. Enter the Bank Contact. 

9. Enter the Bank Further if applicable. 

10. Enter the Further Account Number if applicable. 

11. Enter Notes is applicable. 

Construction Loans/Contractors 

Complete the Banker Construction screen to provide closing instructions for construction 
loans. 

Construction Loan Terms 

Use the following steps to complete the Construction Loan Terms. 

1. Select Closing Documents from the Banker menu. 

2. Select Construction. 

3. Enter the Advance Amount. 

 

Figure 417: Banker Construction 

Note: The Advance Amount is applicable only for conventional one-time close loans. 

4. Enter the interest rate to be charged during the construction phase of the loan in 
the Interim Rate field. 
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5. Enter the total paid outside of closing in the Alterations, Improvements, Repairs 
POC field. 

6. Enter the contingency amount paid outside of closing in the Contingency Reserve 
POC field. 

7. Select the Five Draw Schedule checkbox if the disbursement is on a five-draw 
schedule. 

Escrow Account 

Complete the Construction Escrow Account details. 

1. Select the individual to receive the escrow holdback funds from the Payable To 
dropdown. (See Figure 417.) 

2. Select the individual to receive the interest earned on the escrow account for the 
loan from the Interest Payable To dropdown. 

3. Select the version Agreement to print. 

4. Enter the name of the entity holding the funds in the Funds Held By field. 

5. Enter the amount of escrow funds to be held back in the Total Holdback Amount 
field. 

6. Enter the amount of the holdback paid by the Borrower in the Amount Buyer Paid 
field. 

FHA 203k Rehabilitation 

1. Enter the FHA 203(k) Total Escrow Holdback. (See Figure 417.) 

2. Enter the FHA 203(k) Rehab Escrow Rate. 

Add Builders/Contractors 

Use the following steps to add builders/contractors to the table. 

1. Click Add. 

 

Figure 418: Add Builders/Contractors 
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2. Select the Construction Type on the Edit Builder/Contractor dialog. 

 

Figure 419: Edit Builder/Contractor Dialog 

3. Select the Operates as DBA checkbox if the builder is operating under an assumed 
name. 

4. Select the Builder is owner of property checkbox when the builder owns the 
property. 

5. Select the builder Entity Type. 

6. Enter the Builder Name. 

7. Enter the Partner Name if applicable. 

8. Enter the builder Address. 

9. Enter the builder Contact Information. 

10. Enter the builder License Number. 

11. Enter the builder License State. 

12. Enter the names of persons authorized to sign on behalf of the builder and their 
titles in the Authorized Signature 1 and 2 and Title 1 and 2 fields. 

13. Complete the Mechanic’s Lien Information section. 

14. Select the Require Survey on Completion checkbox if a survey is required upon 
completion of construction. 

15. Select the For-Swimming Pool checkbox if the mechanics lien is for construction 
of a swimming pool. 

16. Click Save & Close. 

Note: Click Save & New to added additional builders/contractors. 
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Edit Builders/Contractors 

Use the following steps to edit a listed builder/contractor. 

1. Select the Builder/Contractor to edit. (See Figure 418.) 

2. Click Edit. 

3. Update the information on the Edit Builder/Contractor dialog. (See Figure 419.) 

4. Click Save & Close. 

Insert Builders/Contractors 

Use the following steps to insert a builder/contractor at the selected table location. 

1. Select the table location. (See Figure 418.) 

2. Click Insert. 

3. Follow the steps in Add Builders/Contractors. 

Delete Builders/Contractors 

Use the following steps to delete a listed builder/contractor. 

1. Select the Builder/Contractor to edit. (See Figure 418.) 

2. Click Delete. 

HUD-1 Settlement Statement 

Use the HUD-1 and HUD-1A screens to itemize all charges by the lender to the following 
recipients to be paid by the Borrower and seller: 

• Borrower 

• Seller 

• Sales commissions 

• Other settlement charges 

Use the HUD-1 screen pages for purchase transactions, including: 

• A summary of both the Borrower and seller transactions. 

• An itemized list of the fees and impounds. 

• A summary of the fees and impounds. 

Note: Charges that are not part of the settlement are included on the HUD-1 and marked as 
paid outside of closing. 
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HUD-1 Page 1 

1. Select HUD-1 Settlement Statement from the Banker menu. 

2. Select Page 1 from the HUD-1 Settlement Statement menu. 

Note: Sections B through I are automatically populated with information entered in other 
screens. 

3. Review J. Summary of Borrower’s Transaction populated fields. 

 

Figure 420: Banker HUD 1 Page 1 

4. Enter Deposit or Earnest Money on Line 201 if applicable. 

5. Complete K. Summary of Seller’s Transaction populated fields. 

6. Enter Adjustments For Items Unpaid By details on Lines 501 – 515 if applicable. 

7. Click Save. 

8. Click Pg 2. 
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HUD-1 Page 2 

1. Enter the Division of Commission on lines 701 and 702. 

 

Figure 421: Banker HUD 1 Page 2 

2. Enter the amount paid by the Borrower and the seller on line 703. 

3. Enter additional payments and the amount the Borrower and seller are paying on 
line 704. 

4. Click Copy from Fees Worksheet. 
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5. Select the checkboxes for the fees on the Copy From Fees Worksheet dialog to add 
to the screen. 

 

Figure 422: Copy from Fees Worksheet Dialog 

6. Click Yes when complete. 

7. Click Copy From Fees & Impounds. 

8. Select the checkboxes for the fees on the Copy From Fees & Impounds dialog to 
add to the screen. 

 

Figure 423: Copy from Fees & Impounds Dialog 

9. Click Yes when complete. 

10. Click Save. 

11. Click Pg 3. 
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HUD-1 Page 3 

The top portion of page three contains a summary of all Borrower paid fees and a fee 
comparison from the HUD-1 and Good Faith Estimate. 

1. Complete the non-populated fields. 

 

Figure 424: Banker HUD 1 Page 3 

2. Click Save. 

HUD-1 Buttons 

The HUD-1 buttons provide additional functionality. 

HUD-1A 

Use the HUD-1A button to open the HUD-1A screen to itemize charges by the lender to the 
Borrower for refinance transactions. (See HUD-1A Settlement Statement for details.) 

Closing 

Use the Closing button to open the Basic Loan Information screen used by the 
closer/funder to order closing documents. (See Basic Loan Information for details.) 

HUD-1A Settlement Statement 

Use the HUD-1A for refinance transactions. 
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Use the HUD-1A screen contains two pages for the following: 

• An itemized list of the fees and impounds 

• A summary the fees and impounds 

1. Select HUD-1A Settlement Statement from the Banker menu. 

2. Select Page 1 from the HUD-1A Settlement Statement menu. 

3. Complete the non-populated fields on Page 1. 

 

Figure 425: Banker HUD-1A Page 1 

4. Click Save. 

5. Click Pg 2. 
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6. Complete the non-populated fields on Page 2. 

 

Figure 426: Banker HUD-1A Page 2 

7. Click Save. 

HUD-1A Buttons 

The HUD-1A buttons provide additional functionality. 

HUD-1 

Use the HUD-1 button to open the HUD-1 screen. (See HUD-1 Settlement Statement for 
details.) 

Closing 

Use the Closing button to open the Basic Loan Information screen used by the 
closer/funder to order closing documents. (See Basic Loan Information for details.) 

Loan Program Information 

The Loan Program Information screen provides information about the mortgage rate and 
other features. Most information is populated if the Truth-In-Lending or ARM Disclosure 
(Initial) screens are already completed. 
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Adjustable Rate Mortgage 

Use the following steps to complete the ARM fields when appropriate. 

Note: Associated screens re-populate with the information updated here. 

1. Select Loan Program Information from the Banker menu. 

2. Select the index the rate is from the ARM Index Type dropdown. 

 

Figure 427: ARM Information 

3. Select the ARM Plan #. 

4. Enter the Index Value. 

5. Enter the Margin. 

6. Enter the Initial Cap. 

7. Enter the Periodic Cap. 

8. Enter the Life Cap. 

9. Enter the Floor Percentage. 

10. Select the Convertible Mortgage checkbox if the mortgage is convertible to a 
fixed rate mortgage. 

11. Enter the Conversion Fee percentage and fee the Dollar Amount. 

12. Enter the Additional Percentage of the fee if the loan term is longer than 15 years. 

13. Enter the Additional Percentage of the fee if the loan term is shorter than 15 years. 

14. Enter the Payment Initial Cap information. 

15. Enter the Payment Period Cap information. 
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16. Select the Potential Negative Amortization Type. 

Mortgage Insurance 

Review the Mortgage Insurance section and update if required. (See Figure 427.) 

1. Select the MI Company. 

2. Enter the Certificate Number. 

3. Select the Coverage Renewal Percentage. 

4. Enter the MIP Refund. 

5. Enter the Coverage Percentage. 

6. Enter the Termination Date. 

7. Select the Duration Type. 

8. Select the Refundable Type. 

9. Select the Renewal Calculation. 

10. Select the Premium Paid By. 

11. Enter the Premium Tax information. 

12. Select the Premium Tax Type. 

Prepayment Penalty 

Complete the non-populated Prepayment Penalty fields. 

1. Select the Prepayment Penalty checkbox if there is a prepayment penalty. 

 

Figure 428: Prepayment Penalty 

2. Select the Penalty Type. 

3. Enter the Penalty Code. 

4. Enter the Penalty Rate. 

5. Enter the and Penalty Amount. 
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6. Enter the penalty phase Duration. 

7. Enter the date when the prepayment penalty term ends in the Prepay Cutoff Date 
field. 

8. Enter the dollar amount of the penalty if the loan is paid off the day following 
closing in the Penalty Amount field. 

Note: The Penalty Amount if paid off day after closing is required for the state high cost 
points and fees test for conventional loans. 

Other Program Features 

Use the following steps to complete the Other Program Features section. 

1. Select the Repayment Type. 

 

Figure 429: Program Features & Buydown 

2. Verify Loan Maturity date. 

3. Select the day of the month the loan payment is to be remitted. 

4. Enter the Late Charge Amount and the minimum and maximum that can be 
charged in the Min. and Max. fields 

5. Select the Eligible for Timely Payment Rewards checkbox if the Borrower is 
eligible for rewards with on-time payments. 

6. Enter the percentage the interest rate is reduced in the Reduction Percentage 
field. 

7. Enter the Interest Only Term. 

8. Select the Assumable option applicable to the loan. 

9. Enter the rate the Borrower would receive without pay discount points in the 
Undiscounted Rate field 
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10. Select the PMI High Risk checkbox if the loan is a high risk according to FNMA, 
FHLMC, or other investor guidelines. 

11. Select the Type from the dropdown. 

Temporary Buy Down 

Use the following steps to complete the Temporary Buy section. (See Figure 429.) 

1. Select the Buydown Temporary Subsidy checkbox if the loan has a temporary 
buydown or subsidy agreement. 

2. Select the third-party source of the subsidy or buydown from the Contributor 
dropdown list. 

3. Enter the amount of the subsidy in the Subsidy Amount field. 

4. Enter the number of months the third-party will subsidize the loan in the Subsidy 
Months field. 

5. Enter the Original Buydown Amt. 

6. Enter the Final Buydown Rate. 

7. Select the Buydown Type from the dropdown menu. 

8. Complete the Term (mths) field. 

Property Information 

The Property Information screen summarizes details about the property. 

Subject  

Use the following steps to complete the property details. 

1. Select Closing Documents from the Banker menu. 

2. Select Property Information. 
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3. Verify the populated Property Address. 

 

Figure 430: Banker Loan Subject Property 

4. Select the City Type. 

5. Select the Free and Clear checkbox if there are no existing liens against the 
property and the Borrower owns the property free and clear. 

6. Select the Record in City checkbox to record the property in the city rather than 
the county. 

7. Select the Property Type. 

8. Enter the Gross Living Area size. 

9. Enter the Bedroom Count. 

10.  Select the 1 to 4 Family unit or a Community Land Trust checkbox appropriately. 

11. Select the appropriate Property Owned By option. 

12. Select the Building Status. 

Project Classification 

Use the following steps to complete the Project Classification information. 

1. Select the Freddie Mac and Fannie Mae Project Classification and PUD type. (See 
Figure 430.) 

2. Select the Recording Jurisdiction. 
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3. Enter the Judicial District Name. 

4. Enter the Judicial Division Name. 

5. Enter the Recording Description. 

6. Enter the Unincorporated Area Name if applicable. 

7. Enter the Recorded Document Book information. 

8. Enter the Legal Description Block Number. 

PUD and Projects 

Use the following steps to complete the PUD and Projects fields if the property is a 
Planned Unit Development (PUD). 

1. Select the Planned Unit Development checkbox. 

 

Figure 431: PUD and Projects 

2. Enter the PUD Declaration Description. 

3. Enter the Project Name. 

4. Enter the Project Total Shares. 

5. Enter the Appointed Attorney name. 

6. Enter the Project Shares Certification Number. 

7. Enter the Project Shares Certification Name. 

8. Enter the number of Parking Spaces. 
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9. Enter the HOA Tax ID/EIN Number. 

Manufactured Home 

Use the following steps to complete the Manufactured Home fields if the property is a 
manufactured home. (See Figure 431.) 

1. Select the Manufactured Home checkbox. 

2. Enter the Manufactured Year. 

3. Enter the Manufacturer Name. 

4. Enter the Model. 

5. Enter the Serial Number. 

6. Select the Condition. 

7. Select the Width Type. 

8. Enter the Length (Feet). 

9. Enter the Width (Feet). 

Leasehold 

Use the following steps to complete the Leasehold fields if the property is a leasehold 
estate. (See Figure 431.) 

1. Enter the Lessee Name. 

2. Enter Lessor Name. 

3. Enter the Recording Description. 

4. Enter Original Lease Date. 
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Appraisal and Valuation 

Use the following steps to complete the Appraisal and Valuation section. 

1. Enter the Estimated Property Value. 

 

Figure 432: Appraisal and Valuation 

2. Verify the Appraised Value if an appraisal was completed and the Appraisal 
Information dialog\ was completed. (See Underwriting for details.) 

Note: Enter the appraised value if not present. 

3. Select the method used to appraise the value from the Valuation Method for LPA 
dropdown. 

4. Select the appropriate Estimate of Value Should option. 

5. Select the appropriate the Appraisal Type. 

6. Select the appropriate type of Fannie Mae, Freddie Mac, or VA appraisal ordered. 

Flood Hazard Determination 

Complete the Flood Hazard Determination fields if the property is in or partially in a flood 
zone. 
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1. Select the applicable checkbox. 

 

Figure 433: Flood Hazard Determination 

2. Enter the Flood Determination Date. 

3. Enter the Flood Certification Number. 

4. Enter the Flood Zone. 

5. Enter the Participation Status. 

6. Select the Certification Type. 

7. Enter the NFIP Community Number. 

8. Enter the NFIP Community Name. 

9. Enter the NFIP Map Number. 

10. Enter the NFIP Map Panel Effective/Revised Date. 

State Specific Information 

The State Specific Information screen provides information specific in the state where the 
property is being sold. 

Note: Not all the fields apply in all states. Refer to state and local real estate regulations for 
more information about which fields are required. 

State High Cost 

Use the following steps to complete the State High Cost fields when required by the state. 

1. Enter the total amount of fees the lender corporate policy determines are required 
for state high cost testing purposes in the Required Total Fees field. 

 

Figure 434: Banker State High Cost 
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2. Enter the Excluded Premiums. 

3. Enter the Excluded Attorney Fees. 

4. Enter the Excluded Lender Affiliate Fees. 

5. Enter the Excluded Total Fees. 

6. Enter the Points Paid on Prior Loan. 

7. Enter the Excluded Prepay Penalty. 

8. Enter the HELOC Draw Admin Fee. 

9. Select the High Cost Loan checkbox if loan is considered a high cost loan. 

10. Select the Providence Fail checkbox if a condition is present that will result in the 
test failing. 

11. Select the Texas (AB) Home Equity checkbox if the loan is a Texas (A6) home 
equity loan and the property resides in Texas. 

12. Select the Originated by Exempt Agency checkbox if agency may be exempt 
from the state high cost test according to state specific conditions. 

13. Select the Renewal and Extension of Liens Against Homestead checkbox if the 
note is in renewal and extension. 

14. Select the Purchase Money Transaction checkbox if I the transaction is made with 
a payment of money or the equivalent of collateral. 

15. Select the Owelly of Partition checkbox if a co-owner is buying the interests of 
another co-owner using 100% of the interests as collateral to acquire the property. 

16. Select the FNMA Rehabilitation checkbox if the lender is closing the loan using 
FNMA Rehabilitation documents. 

Add Lien Renewals & Extensions 

Use the following fields to add information about renewals and lien extensions. 

1. Click Add. 

 

Figure 435: Lien Renewals & Extension 
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2. Select the Lien Type. 

 

Figure 436: Edit Renewal & Extension of Lien Dialog 

3. Select Note Date. 

4. Enter Note Amount. 

5. Enter Note Rate. 

6. Enter Payable To. 

7. Enter Executed By. 

8. Enter Trustee Name. 

9. Enter Recording Information. 

10. Enter Additional Recording Information if required. 

11. Select the Contemporaneously checkbox if applicable. 

12. Select the For Swimming Pool checkbox if applicable. 

13. Click Save & Close. 

Note: Click Save & New to add another renewal or extension. 

Edit Lien Renewals & Extensions 

Use the following steps to edit a listed renewal or extension. 

1. Select the item to edit. (See Figure 435.) 

2.  Click Edit. 

3. Update the information on the Edit Renewal & Extension of Lien dialog. (See Figure 
436.) 

4. Click Save & Close. 
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Insert Lien Renewals & Extensions 

Use the following steps to insert a renewal or extension at a selected table location. 

1. Select the table location. 

2. Click Insert. 

3. Use the steps in Add Lien Renewals & Extensions to enter the information. 

Delete Lien Renewals & Extensions 

Use the following steps to delete a listed renewal or extension. 

1. Select the item to delete. (See Figure 435.) 

2.  Click Delete. 

Trust 

The Trust screen contains information about the trust. 

Trust Details 

Use the following steps to enter the trust details. 

1. Select Closing Documents from the Banker menu. 

2. Select Trust. 

3. Enter Primary Trust Name. 

 

Figure 437: Banker Trust Details 

4. Select trust Type. 

5. Select the Non-Person checkbox if the trust is not a person. 

6. Enter the trust Number. 

7. Select the trust Established Date. 
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8. Select the State where the trust is located. 

9. Repeat Steps 3 – 5 for the Secondary Trust. 

Add Trustee/Settlor/Beneficiary 

Use the following steps to add trustees. 

1. Click the Trustee Add button. 

 

Figure 438: Add Trustee 

2. Enter the Trustee Name. 

 

Figure 439: Edit Trustee Dialog 

3. Select Trustee Type. 

4. Enter Trustee Address. 

5. Select the Associated Trust option. 

6. Select the Non-Person checkbox if applicable. 

7. Click Save & Close. 

Note: Click Save & New to add another Trustee. 

8. Repeat Steps 1 – 7 for Settlor/Grantor. 

9. Repeat Steps 1 – 7 for Beneficiary. 
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Edit Trustee/Settlor/Beneficiary 

Use the following steps to edit a listed trustee. 

1. Select the trustee to edit. (See Figure 438.) 

2.  Click Edit. 

3. Update the information on the Edit Trustee dialog. (See Figure 439.) 

4. Click Save & Close. 

5. Repeat Steps 1 – 4 to edit a Settlor/Grantor. 

6. Repeat Steps 1 – 4 to edit a Beneficiary. 

Insert Trustee/Settlor/Beneficiary 

Use the following steps to insert a trustee at a selected table location. 

1. Select the table location. 

2. Click Insert. 

3. Use the steps in Add Trustee/Settlor/Beneficiary to enter the information. 

4. Repeat Steps 1 – 3 to insert a Settlor/Grantor. 

5. Repeat Steps 1 – 3 to insert a Beneficiary. 

Delete Trustee/Settlor/Beneficiary 

Use the following steps to delete a listed Trustee. 

1. Select the item to delete. (See Figure 438.) 

2.  Click Delete. 

3. Repeat Steps 1 – 2 to delete a Settlor/Grantor. 

4. Repeat Steps 1 – 2 to delete a Beneficiary. 

Warehouse & Purchase Advice 

The Warehouse & Purchase Advice screen tracks the warehouse lender funding the loan and 
tracks the investor purchase advice. The screen records the date and amount of the 
repayment of the warehouse advance from the proceeds of the loan sale. The screen tracks 
the warehouse costs of funded loans between the warehouse advance date and the 
warehouse repayment date. 

Note: Many fields are populated from other Point screens. 



   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
426 

Loan Information 

Use the following steps to complete the Warehouse Lender fields. 

1. Select Warehouse & Purchase Advice from the Banker menu. 

2. Review the populated fields. 

3. Select the MERS # checkbox and enter the MERS # manually to override the 
automatically generated value. 

 

Figure 440: Warehouse Lender Loan Information 

4. Enter the Worksheet No if not populated. 

5. Select the Estimated Close Date. 

Warehouse Lender 

The Warehouse Lender list is set up in Company Defaults on the Utilities menu. (See 
Warehouse Lenders for details.) 

1. Select the Warehouse Lender to populate the lender fields. 

 

Figure 441: Banker Warehouse & Purchase 
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2. Enter the warehouse lender-assigned number that identifies the advance amount 
in the Warehouse Lender Loan No field. 

3. Update other fields as required. 

Warehouse Advance 

Use the following steps to complete the Warehouse Advance fields. 

1. Select the Advance Type. 

 

Figure 442: Warehouse Advance 

2. Enter the Advance Fee. 

3. Enter the Advance Amount +. 

Advance Rate Calculation 

The Advance Rate Calculation fields are populated if the warehouse lender has a profile 
set up in the company defaults utility. Use the following steps when calculating a Variable 
Rate if the profile is not complete. 

Note: Select Use Fixed Rate to use the fixed rate. 

1. Select the Use Variable Rate checkbox. 

 

Figure 443: Advance Rate Calculation 
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2. Select the Index Type. 

3. Enter the Index Value Percentage. 

4. Enter the Days on Line. 

Remaining Fields 

1. Complete the Dates fields if not populated. 

 

Figure 444: Dates 

2. Enter the Principal Amount Purchased in the Warehouse Repayment section. 

 

Figure 445: Principal Amount Purchased 

3. Select the Days in a Year in the Fixed Warehouse Expense section. 

 

Figure 446: Days in a Year 

4. Enter Notes if applicable. 

Warehouse & Purchase Advice Buttons 

The Warehouse & Purchase Advice buttons provide additional functionality. 
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Appraisal 

The Appraisal button opens the Appraisal Information dialog to record information about 
the property appraisal. (See Appraisal for details.) 

Insurance 

The Insurance button opens the Insurance dialog containing information about the 
mortgage, hazard, and flood insurance for the property. (See Insurance for details.) 

Escrow & Title 

The Escrow & Title button opens the Escrow & Title Information dialog containing the 
escrow, title, and wire information. (See Escrow & Title for details.) 

Banker Shipping 

Use the Shipping screen to record closed loan data and status of the shipment of the loan to 
the investor. 

Note: Many of the fields in the Shipping screen are populated from data entered in other 
screens. Fields disabled cannot be edited. 

The Shipper list is set up in Company Defaults on the Utilities menu. 

Shipper 

1. Select Shipping from the Banker menu. 

2. Select the Lock to unlock the field and enter the MERS # manually if required. 

 

Figure 447: Shipper Information 

3. Select the Shipper coordinating the shipment. 

Note: The Phone & Fax and E-mail fields are automatically populated if this information was 
included in the dropdown list set up in the dropdown list utility. 

4. Select the Shipping Method. 
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5.  Enter the Tracking Number. 

Mailing Address 

Select the Copy From Subject Property button to use the property mailing address. 

Select the Copy From Present Address button to use the Borrower present address. 

Manually enter the address information when not selecting a button. 

 

Figure 448: Mailing Address 

Shipping Dates 

Complete the Shipping Dates. 

1. Select the Desired Ship Date. 

 

Figure 449: Shipping Dates 

2. Select the File Received Date. 

3. Select the Shipped Date. 

4. Select the Suspended by Investor Date. 

5. Select the Suspension Cleared Date. 

6. Select the Last Payment Received Date. 

7. Select the Purchased Date. 

8. Select the Transfer Date. 
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Monthly Payment Received 

Use the following steps to track payments received after loan close. 

1. Enter the Initial Interest Received if not populated. 

 

Figure 450: Monthly Payment Received 

2. Enter Initial MI Balance. 

3. Enter Initial Impound Balance. 

4. Enter Original Buydown Balance. 

5. Enter the number of payments in the No. Payments Delinquent field if applicable.  

6. Select the Capitalized checkbox to indicate the interest, escrow disbursements, 
late payments, and fees charged are added to the unpaid principal balance. 

Add Payment 

Use the followings steps to add a received payment. 

1. Click Add. (See Figure 450.) 
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2. Enter the Payment Number. 

 

Figure 451: Edit Payment Dialog 

3.  Enter Paid Date. 

4. Enter the Principal. 

5. Enter the Interest. 

6. Enter the Impounds 

7. Enter the MI 

8. Enter the Buydown. 

9. Click Save & Close. 

Note: Click Save & New to add another payment. 

Edit Payment 

Use the following steps to edit a listed payment. 

1. Select the payment to edit. (See Figure 450.) 

2. Update the payment details on the Edit Payment dialog. (See Figure 451.) 

3. Click Save & Close. 

Insert Payment 

Use the following steps to insert a payment at a selected table location. 

1. Select the table location. (See Figure 450.) 

2. Click Insert. 

3. Use the steps in Add Payment to add the payment. 
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Delete Payment 

Use the following steps to delete a listed payment. 

1. Select the payment to delete. (See Figure 450.) 

2. Click Delete. 

Shipping & Servicing Transfer Information 

Use the following steps to complete the Shipping & Servicing Transfer Information 
section.  

Investor Information 

The Investor fields are automatically populated after selecting the Investor if this 
information was included in the dropdown list set up in the dropdown list utility. 

Note: See Investors for details. 

1. Select the Investor. 

 

Figure 452: Investor Information 

2. Enter the Investor Loan Number. 

3. Enter the Investor Commitment Information. 

4. Complete the blank Investor fields. 

5. Enter Investor Notes if applicable. 

File & Note Delivery Information 

The File Delivery and Note Delivery Information sections are automatically populated with 
the default information for the investor selected in the Investor Information section. Enter 
missing information as required. 

Note: See Investors for details. 
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1. Complete the blank fields the File Delivery Information section. 

 

Figure 453: File & Note Delivery Information 

2. Complete the blank fields in the Note Delivery Information section. 

Servicing & Investor Loss Payee 

The Servicing and Investor Loss Payee Information fields are automatically populated with 
the default information for the investor selected in the Investor Information section. Enter 
any missing information as required. 

Note: See Investors for details. 

1. Complete the blank fields the Servicing Information section. 

 

Figure 454: Servicing & Investor Loss Payee Information 

2. Complete the blank fields in the Investor Loss Payee Information section. 

Uniform Loan Delivery Dataset 

The Uniform Loan Delivery Dataset section of the Shipping screen is part of the data set of 
elements used to meet the loan delivery requirements for electronically submitting loans to 
Fannie Mae and Freddie Mac. 

Note: The fields are automatically populated if the Uniform Collateral Data Protocol Setup 
dialog in the Utilities menu is completed. (See Uniform Collateral Data Portal Setup for 
details.) 
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1. Select the appropriate AU System. 

 

Figure 455: Banker Shipping Uniform Dataset 

2. Select the Fannie Mae Decision. 

3. Select the Freddie Mac Decision. 

4. Enter a Doc File Identifier number. 

5. If needed, check on the Enote checkbox. 

6. Enter the Payee ID. 

7. Enter the Fannie Seller No. (Number) if applicable. 

8. Enter the Freddie Seller No. (Number) if applicable. 

9. Select the Lock to enable the Loan Number field and enter a new number if 
applicable. 
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10. Click on the Select a Program button to choose a Freddie Mac program. Up to five 
programs can be selected. 

 
Figure 456: Freddie Mac Programs 

11. Click OK. 

12. Enter the HFA Identifier. 

13. Enter additional information in the Loan Comments field. 

14. Click the Export to Fannie Mae, Export to Freddie Mac, or Export Combined File 
button to generate an XML file. 

15. Manually upload the file to Fannie Mae, Freddie Mac, or a third-party vendor. 

Borrower Section 

The fields in this section are not required for all loans. The fields required are dependent on 
the status of the loan and the type of loan being processed. 
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1. Select the method used to specify the loan-level credit score across all Borrowers 
from the Credit Score Selection dropdown list. 

 

Figure 457: Borrower Section 

2. Select the impairment from the Credit Impairment dropdown if a characteristic of 
the credit score impairs the effectiveness as an indicator of their credit risk. 

3. Select the type of counseling or education program attended by one or more of 
the Borrowers from the Counseling Confirmation dropdown. 

4. Select the Borrower homeownership program in which Borrower participated in as 
a requirement of a special mortgage program from the Counseling Type 
dropdown. 

5. Select the entity type of the Borrower from the Legal Entity Type dropdown. 

6. Enter how many payments the Borrowers could make with their cash reserves in 
the No. Months of Payments from Reserves, all Borrowers field. 

7. Enter the credit score representative of the overall credit risk of the loan in the 
Loan Level Credit Score field. 

8. Select the type of counseling the Borrower received from the Counseling Type 
dropdown. 

9. Enter the total number of mortgages held by all Borrowers in the No. of Mortgages 
Properties, all Borrowers field. 

Down Payment, Closing Costs, Other Funds 

Use the following sections to complete the Down Payment, Closing Costs, and Other 
funds Collected At Closing information. 
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Down Payment 

The values for each down payment source specified on the Loan Application is listed. 

Note: Freddie Mac and ULDD do not support five down payment sources. Contact Freddie 
Mac for specific information about their requirements for submitting multiple down 
payments. 

1. Select the fund type corresponding to the value for each down payment amount 
from the Type dropdown. 

 

Figure 458: Types & Sources 

2. Select the source of the down payment corresponding to each amount from the 
Source dropdown lists. 

Closing Costs and Other Funds Collected at Closing 

1. Specify the type of funds being used to pay the closing costs from the Type 
dropdown. (See Figure 458.) 

2. Enter the amount of the closing cost in the Amount field. 

3. Select the Other Funds Type. 

4. Enter the Other Funds Amount. 
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Investor Product/Program 

Use the following steps to complete the Investor section. 

1. Enter the Investor Product ID. 

 

Figure 459: Investor Product/Program 

2. Enter any Investor-defined ID Feature Codes. 

3. Select the Collateral Program associated with the loan from the dropdown. 

4. Select the method used to calculate the funds due to the investor from the 
Remittance Type dropdown. 

5. Select the appropriate Buyup/Buydown option. 

6. Enter the percentage of ownership by the investor in the Ownership field. 

Property Sections 

Use the following steps to complete the property sections. 

1. Select the Attachment Type. 

 

Figure 460: Property Sections 



   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
440 

2. Select the Structure Type. 

3. Select the construction method used for the dwelling from the Construction 
Method dropdown. 

4. Select the Appraisal Date. 

5. Select the method used to appraise the value of the property from the Valuation 
Type dropdown. 

6. Select AVM Type. 

7. Select the Has Flood Insurance checkbox if applicable. 

8. Select the Shared Equity checkbox if applicable. 

9. Enter the 2-4 Unit Properties information if applicable. 

10. Select the condominium/co-op Design Type if applicable. 

11. Select the condominium/co-op Attachment Type if applicable. 

12. Enter the condominium/co-op Project Name if applicable. 

13. Select the condominium/co-op Project Status if applicable. 

14. Select the condominium/co-op Project Class if applicable. 

15. Enter the condominium/co-op Units Total if applicable. 

16. Enter the condominium/co-op Units Sold if applicable. 

Loan Program 

Use the following steps to complete the Loan Program section. 

1. Select the method used to calculate the interest on the loan from the Calculation 
Type dropdown menu. 

 

Figure 461: Loan Program 

2. Select the Refinance Program if applicable. 

3. Select the Original Investor Type. 

4. Enter the Buyup/Buydown Basis Points. 
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5. Enter the Lender Paid MI%. 

6. Select the appropriate Calculation Period. 

7. Enter the Principal Curtailment. 

8. Enter the Original Investor Loan Number. 

9. Select the Fannie Home Improvement Product. 

10. Select the No MI Reason. 

11. Select the Balloon Reset checkbox if applicable. 

12. Select the Corporate Relocation checkbox if applicable. 

Construction Loans 

Use the following steps to complete the Construction section if required. 

1. Select the Feature Type for construction loans. 

 

Figure 462: Construction/ARM/Simple Interest/Related Loans 

2. Select the First Payment Due for construction loans. 

3. Select the Closing Type for construction loans. 

4. Select the Index Source Type for ARM loans. 

ARM Loans 

Use the following steps to complete the ARM section if required. 
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1. Select the type and source of the index to be used to determine the interest rate at 
each adjustment from the Index/Source Type dropdown list. (See Figure 462.) 

2. Select the First Adjustment Date for ARM loans. 

3. Select the Next Adjustment Date for ARM loans. 

4. Enter the Current Rate for ARM loans. 

5. Select the Conversion Status for ARM loans. 

6. Select the Second Adjustment Date for ARM loans. 

7. Enter the Lookback Period for ARM loans. 

8. Enter Current Period for ARM loans. 

9. Select the Conversion Type for ARM loans. 

Simple Interest 

Use the following steps to complete the Single Interest section if applicable. 

1. Select the Interest Accrual for single interest loans. (See Figure 462.) 

2. Select the Calculation Base for single interest loans. 

3. Select the Days in Year for single interest loans. 

4. Enter the Effective Months for single interest loans. 

5. Select the Accrual Start Date for single interest loans. 

6. Enter the Accrued Interest for single interest loans. 

7. Enter the Billing Cycle Days for single interest loans. 

Related Loan 

Use the following steps to complete the Related Loan section if applicable. 

1. Select the Loan Type for related loans. (See Figure 462.) 

2. Enter the Note Amount for related loans. 

3. Select the Amortization Type for related loans. 

4. Select the Principal Balance for related loans. 

5. Select the First Payment Date for related loans. 

6. Select the Note Date for related loans. 

7. Enter the Due Months for related loans. 

8. Select the Balloon checkbox if applicable for related loans. 

9. Select the Affordable Second checkbox if applicable for related loans. 
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10. Select the HELOC checkbox if applicable. 

11. Enter the HELOC Maximum Balance if applicable. 

12. Enter the HELOC Current Balance if applicable. 

File Room 

Use the following steps to complete the File Room section. 

1. Select the Sent to Storage Date. 

 

Figure 463: File Room 

2. Enter the Storage Company. 

3. Enter the Location/Shelf #. 

4. Select the Requested Date. 

5. Enter the Requested By. 

6. Select the Delivery Date. 

7. Enter Notes if applicable. 

8. Click Save. 

Shipping Buttons 

The Shipping buttons provide additional functionality. 

Appraisal 

The Appraisal button opens the Appraisal Information dialog to record information about 
the property appraisal. (See Appraisal for details.) 

Insurance 

The Insurance button opens the Insurance dialog containing information about the 
mortgage, hazard, and flood insurance for the property. (See Insurance for details.) 
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Escrow & Title 

The Escrow & Title button opens the Escrow & Title Information dialog containing the 
escrow, title, and wire information. (See Escrow & Title for details.) 

Suspense Items 

The Suspense Items button opens the Suspense Items dialog containing items that suspend 
the loan until received. 

 

Figure 464: Suspense Items Dialog 

Trailing Documents 

Shippers use the Trailing Documents screen to record and track the documents required by 
the investor. 

Investor Details 

The Investor and Investor Loan No. fields are automatically populated from the Investor 
Information entered on the Secondary Marketing or Underwriting screen. The Closing Date 
field is populated when the loan status is changed to closed. 

1. Select Trailing Documents from the Banker menu. 

Note: Enter the Investor if not populated. 

2. Enter the Investor Loan Number. 

 

Figure 465: Investor/Shipper 
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3. Enter the Purchased Date. 

4. Enter the Trailing Documents Sent date. 

Note: The Shipper, Phone & Fax, and Email fields are populated from information entered 
on the Banker Shipping screen. 

Trailing Documents 

Use the following sections to add documents to the Trailing Documents table. 

Auto-Populate Documents 

Click Auto-Populate to populate the table with the Default Trailing Documents List created 
from the Utilities menu. 

 

Figure 466: Trailing Documents Table 

Add Trailing Documents 

Use the following steps to manually add documents to the Trailing Documents table. 

1. Click Add. (See Figure 466.) 
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2. Select the Document on the Edit Trailing Document dialog. 

 

Figure 467: Edit Trailing Document Dialog 

3. Enter Requested Date. 

4. Enter party the document is Requested From. 

Note: Use the Cardex Lookup button to select the party form the Cardex Database. 

5. Enter the document referenced number in the Ref No field. 

6. Enter the document Received Date. 

7. Select Shipped By. 

8. Enter Tracking Number. 

9. Select the Sent to Investor Date. 

10. Enter the investor Shipping and Tracking information. 

11. Enter the Late Fee details if applicable. 

12. Click Save & Close. 

Note: Click Save & New to add another document. 

Edit Documents 

Use the following steps to edit a document on the Trailing Documents table. 

1. Select the trailing document to edit. (See Figure 466.) 

2. Click Edit. 
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3. Edit the document properties using the Edit Trailing Document dialog. (See Figure 
467.) 

4. Click Save & Close. 

Insert Documents 

Use the following steps to insert a document in a specific location on the Trailing 
Documents table. 

1. Select the table location to insert the document. 

2. Click Insert. 

3. Use the steps in Add Trailing Documents to add the document to the Trailing 
Documents table. 

Delete Documents 

Use the following steps to delete a document from the Trailing Documents table. 

1. Select the document to delete. (See Figure 466.) 

2. Click Delete. 

Insurance Documents 

Complete the non-populated Insurance fields. 

1. Select the Due Date. 

 

Figure 468: Insurance Documents 

2. Select the Up-Front MIP/PMI Paid Date. 

3. Select the VA Funding Fee Paid Date. 

4. Select the Sent Date. 

5. Select the Suspended Date. 
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6. Select the Accepted Date. 

7. Select the Insured Date. 

8. Select the Recap Received Date. 

9. Enter the Agency Case Number. 

10. Enter the Previous Case Number if applicable. 

11. Select the Submission Type. 

12. Select the Insurance Status. 

13. Enter the HUD Authorization Code. 

14. Enter the VA Office Code. 

Package Tracking 

The Tracking section is used to track the loan package when it is shipped to a government 
agency for an FHA or VA loan. 

1. Select the Package Sent Date. 

 

Figure 469: Package Tracking 

2. Select the Package Rejected Date if applicable. 

3. Select the Package Resent Date if applicable. 

4. Select the Sent Method. 

5. Enter the Tracking Number. 

6. Select the Resent Method if applicable. 

7. Enter the Resent Tracking Number. 

Trailing Documents Buttons 

The Trailing Documents buttons provide additional functionality. 
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Appraisal 

The Appraisal button opens the Appraisal Information dialog to record information about 
the property appraisal. (See Appraisal for details.) 

Insurance 

The Insurance button opens the Insurance dialog containing information about the 
mortgage, hazard, and flood insurance for the property. (See Insurance for details.) 

Escrow & Title 

The Escrow & Title button opens the Escrow & Title Information dialog containing the 
escrow, title, and wire information. (See Escrow & Title for details.) 

Recording 

Use the Recording screen to document the loan information used to record the transaction 
with the county. 

Registration 

Use the following steps to complete the Registration fields. 

1. Select Recording from the Banker menu. 

2. Select the Registration Date. 

 

Figure 470: Recording Registration 

3. Select the Registered with MERS checkbox if applicable. 

4. Select the Originated with MERS checkbox if applicable. 

5. Select the Recording Status. 

6. Use the MERS MIN Lock to override the populated number if required. 
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7. Enter the Servicer ID. 

8. Enter the Subservicer if applicable. 

9. Enter the Subservice ID if applicable. 

Transfer of Rights 

Use the following steps to complete the Transfer of Rights section. 

1. Select the Transfer Type. 

 

Figure 471: Transfer of Rights 

2. Select the Recording Rights. 

3. Enter Document Custodian. 

4. Enter Document Custodian ID. 

5. Select the Effective Transfer Date. 

6. Enter the Purchased Date. 

7. Enter the Bene Transfer Date. 

Deactivation 

Use the following steps to complete the Deactivation section. 

1. Select the Deactivation Type. 

 

Figure 472: Deactivation 

2. Select the Liquidation Date. 
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3. Enter the New Subservicer if applicable. 

4. Enter the New Subservicer ID if applicable. 

Assignee & Assignor 

Use the following steps to complete the Assignee and Assignor sections. 

1. Enter the Assignee Name. 

 

Figure 473: Assignee & Assignor 

2. Enter the Assignee Address details. 

3. Enter the Assignor Name. 

4. Enter the Assignor Address details. 

Recordable Documents & Riders 

Use the following steps to complete the Recordable Documents and Riders sections. 

1. Select the Document Type. 

 

Figure 474: Recordable Documents & Riders 
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2. Enter the Requested By Name. 

3. Enter the Witness Name. 

4. Select the Associated Recording Date. 

5. Enter the Page Number. 

6. Enter the Instrument. 

7. Enter the Book Number. 

8. Enter the Lender’s PO Box on Recordable Document. 

9. Select the Real Property Improvements Not Covered checkbox is appropriate. 

10. Select the Acknowledgement of Cash Advance Against Non-Homestead 
Property checkbox if applicable. 

11. Enter the Assumption. 

12. Enter the Attorney Fee Percentage. 

13. Enter the Trustee Fee Percentage. 

14. Select the appropriate State of Texas checkbox(es). 

15. Select the applicable Riders checkbox(es). 

Prepared By & Returned To 

Use the following steps to complete the remaining Prepared By and Returned To fields. 

1. Enter the Prepared By Name. 

 

Figure 475: Prepared By & Returned To 

2. Enter the Prepared By Address details. 

3. Enter the Return To Name. 

4. Enter the Return To Title. 

5. Enter the Return to Address. 
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Notary Information & Commissioned In 

Use the following steps to complete the Notary Information and Commissioned In fields. 

1. Select the Notary Appearance Date. 

 

Figure 476: Notary & Commission Information 

2. Enter the Notary Name. 

3. Enter the Notary Title. 

4. Enter the Notary State. 

5. Enter the Notary County. 

6. Enter the List of Notary Names. 

7. Enter the Commissioned in State. 

8. Enter the Commissioned in County. 

9. Select the Commissioned in Expiration Date. 

10. Enter Notes if applicable. 
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Chapter 11: LENDERS MENU 
Lenders partnered with Calyx provide access to their services from Point. 

MarketPlace Lenders 

Use the Marketplace interface to complete transactions with prospective lenders. The 
interface processes transactions and communicates with the lender back-end services 
when requests are submitted to a participating lender. 

Note:  Registration as a broker with a lender is and enabling the lender in the Point utility is 
required prior to using the MarketPlace. 

Wholesale Marketplace benefits include: 

• Better pricing through automation 

• Fully adjusted live rate sheets displayed in seconds 

• Automated underwriting decisions in minutes 

• Instant online locks 

Note: Verify lender approval status and the territory a lender covers before using the 
Market interface. 

Use the following steps to access the Lenders listed in MarketPlace. 

1. Select MarketPlace from the Lenders menu. 

2. Click the Lender Logo to access the Lender website. 

 

Figure 477: MarketPlace Lenders 
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3. Use the Lender website Login to access lender-specific submittal instructions. 

MarketPlace Pricing Engine 

Use the Pricing Engine to run pricing scenarios with multiple MarketPlace lenders. 

1. Click Run Pricing Engine on the MarketPlace screen. 

2. Complete the Required Fields. 

 

Figure 478: MarketPlace Pricing Engine 

3. Select the Search By option. 

4. Select the Lock option. 

5. Click Run Scenario. 

6. Review the Lender pricing results on the Results tab. 

 

Figure 479: MarketPlace Pricing Results 

7. Select a Lender to view Product Details. 
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Pricing Settings 

Broker Specific price results are captured on the Pricing Settings screen. 

1. Click Pricing Settings. (See Figure 479.) 

2. Adjust to the Compensation % fields to overwrite the override the Compensation 
% in the Scenario screen. 

 

Figure 480: Pricing Settings Dialog 

3. Click Save. 

4. Re-run the Scenario to see the results. 

Other Lenders 

Other lenders are available on the Lenders menu that are not listed in the MarketPlace. 
Select a listed Lender to access the website for submittal instructions. 
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Chapter 12: SERVICES MENU 
Use the Services menu to order documents and services from providers for the loan file 
using the Point interface options. 

Note: See Interfaces Menu for ordering services directly from vendor websites. 

Fannie Mae Services 

Fannie Mae Services include: 

• Fannie Mae DO/DU 

• Addendum 

• Government 

• View Documents: Available after receiving Fannie Mae documentation (See View 
Documents for details.) 

Fannie Mae DO/DU 

Use the following steps to request Fannie Mae Desktop Originator (DO)/Desktop 
Underwriter (DU) services. 

1. Select Fannie Mae from the Services menu. 

2. Select Fannie Mae DO/DU. 
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3. Select the Transaction Request Type. 

 

Figure 481: Fannie Mae Request Dialog 

4. Select the Submission Type. 

5. Select the Credit Company. 

6. Enter the Casefile ID #. 

7. If using Fannie Mae credentials, select the Fannie Mae Credit Credentials 
checkbox. 

8. Enter the User ID and Password. 

9. Click Submit. 
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Fannie Mae Addendum 

Use the following sections to complete the Fannie Mae Addendum. 

Note: Fields may be populated depending on the loan options selected on other screens. 

Property Information 

Use the following steps to complete the property information. 

1. Select Fannie Mae from the Services menu. 

2. Select Addendum. 

3. Select the DU Policy. 

  

Figure 482: Fannie Mae Addendum 

4. Select the Report as a HOEPA loan checkbox if applicable. 

5. Select the Product Description. 

6. Enter the Credit Report ID (ULDD). 

7. Select the applicable Late Payment option. 

8. Enter the Estimated Appraisal. 
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9. Enter the Appraisal ID. 

10. Enter the Property Data ID. 

11. Select the Manufactured Home option if applicable. 

12. Select the Width Type if applicable. 

13. Select the Construction Method if applicable. 

14. Select the Owner of First Mtg if applicable. 

15. Complete the Refinance field if the loan is a refinance. 

16. Select the applicable Project checkbox. 

17. Enter the Project Manager ID. 

18. Select the Project Design if applicable. 

19. Select the Attachment Type if applicable. 

Loan Details 

Use the following steps to complete the loan details. 

1. Select the appropriate ARM Parameters options for an ARM loan. 

 

Figure 483: Loan Details 

2. Select the appropriate Buydown Parameters if applicable. 

3. Complete the Community Lending section if applicable. 
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4. Use the Geocoding Lookup button to verify the address matches. 

Add Automated Service Providers 

Use the following steps to add AUS for Borrower and Co-Borrower. 

1. Click the Borrower Add button. 

 

Figure 484: Automated Service Providers Tables 

2. Select the Verification Type on the Edit DU Validation Order Number dialog. 

 

Figure 485: Edit DU Validation Order Number 

3. Select the Service Provider. 

4. Enter the Reference. 

5. Enter the Reissue Key if applicable. 

6. Click Save & Close. 

Note: Click Save & New to add another provider. 

7. Repeat Steps 1 – 6 for the Co-Borrower if applicable. 

Edit Automated Service Providers 

Use the following steps to edit a listed automated service provider. 
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1. Select the service provider to edit. (See Figure 484.) 

2. Click Edit. 

3. Update the information on the Edit DU Validation Order Number dialog. (See Figure 
485.) 

4. Click Save & Close. 

Delete Automated Service Providers 

Use the following steps to delete a listed service provider. 

1. Select the service provider to delete. (See Figure 484.) 

2. Click Delete. 

Fannie Mae Government 

Use the following steps to complete the Fannie Mae Government screen for FHA or VA 
loans. 

1. Select Fannie Mae from the Services menu. 

2. Select Government. 

3. Enter the Borrower’s Credit Alert Verification Reporting System (CAIVR) Number. 

 

Figure 486: Fannie Mae Government 

4. Enter the Co-Borrower’s CAIVR number. 
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5. Enter Number of Owned Properties. 

6. Select the Section of the Act for an FHA loan. 

7. Enter MIP Refund for an FHA loan. 

8. Enter the FHA Lender ID for an FHA loan. 

9. Enter the FHA Sponsor for an FHA loan. 

10. Select This loan is a sponsored organization checkbox if applicable. 

11. Enter the Borrower Income details for a VA loan. 

12. Enter the Co-Borrower Income details for a VA loan if applicable. 

13. Enter the Entitlement Amount for a VA loan. 

14. Enter the Monthly Maintenance for a VA loan. 

15. Enter the Monthly Utilities for a VA loan. 

16. Select the Borrower/Co-Borrower are Married checkbox if applicable. 

Freddie Mac Services 

Freddie Mac Services include: 

• Loan Product Advisor 

• Addendum 

• View Documents: Available after receiving Freddie Mac documentation (See View 
Documents for details.) 

Loan Product Advisor 

Use the following steps to request Freddie Mac Loan Product Advisor services. 

1. Select Freddie Mac from the Services menu. 

2. Select Loan Product Advisor. 
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3. Select the Transaction Request Type. 

 

Figure 487: Loan Product Advisor Dialog 

4. Select the Credit Company. 

5. Enter the Casefile #. 

6. Enter the Loan ID. 

7. Enter the Check Status ID. 

8. Click Submit. 

Addendum 

Use the following steps to complete the Freddie Mac Addendum. 

Note: Fields may be populated depending on the loan options selected on other screens. 

1. Select Freddie Mac from the Services menu. 

2. Select Loan Product Advisor. 
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3. Enter the Lender Registration Number. 

 

Figure 488: Fa 

4. Enter the Lender Branch Number. 

5. Enter the Agency Number. 

6. Enter the Interviewer Signed Date. 

7. Select the Case State. 

8. Select the Submitting Role. 

9. Select the Credit Agency for ULDD. 

10. Select the Merged Credit to ULDD if applicable. 

11. Select the applicable Late Payment option. 

Property Information 

Use the following steps to complete the Property Details. 

1. Enter Appraisal Value. 

 

Figure 489: Property Information 

2. Enter Appraisal ID. 

3. Select the appropriate Manufactured Home option. 

4. Select the Width Type. 

5. Select the Construction Method. 

6. Select the Construction status. 
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Loan Details 

Use the following steps to complete the loan details. 

1. Select the appropriate Refinance options for a refinance loan. 

2. If refinancing, click on the Program Identifier dropdown and select the appropriate 
option. 

 

Figure 490: Loan Information 

3. Select the appropriate Project options for a project loan. 

4. Select the appropriate ARM Parameters for an ARM loan. 

5. Complete the appropriate Buydown Parameters. 

Transaction Details 

Use the following steps to complete the Transaction Details. 

1. Enter the Sales Concessions Amount. 

 

Figure 491: Transaction Details 
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2. Enter the Down Payment Percentage. 

3. Enter the Down Payment Amount. 

4. Click on the Select an Offering button. 

5. Select the desired offerings. 

 
Figure 492: Offering Identifier 

6. Click Ok. 
The selected offerings will populate the Offering Identifier table. 

7. Select the Type of Funds. 

8. Select the Source of Funds. 

9. Enter the Funds Amount. 

10. Repeat Steps 7 – 9 for additional funds. 

FHA/VA 

Use the following steps to complete the FHA/VA fields if applicable. 

1. Enter the Lender Identifier. 

 

Figure 493: FHA/VA Fields 

2. Enter the Sponsor Identifier. 

3. Enter the VA Residual Income Amount. 

4. Enter the Discount Pts Financed Amount. 

5. Enter the Borrower Paid CC Amount. 
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Add Automated Validation Service Providers 

Use the following steps to complete the Automated Validation Service Providers table. 

1. Click the Borrower Add button. 

 

Figure 494: Add Service Providers 

2. Select the Service Provider on the Edit LPA Validation Order Number dialog. 

 

Figure 495: Edit LPA Validation Order Number Dialog 

3. Enter the Reference Number. 

4. Click Save & Close. 

Note: Click Save & New to add another provider. 

5. Repeat Steps 1 – 4 for Co-Borrower if applicable. 

Edit Automated Validation Service Providers 

Use the following steps to edit a listed automated validation service provider. 

1. Select the service provider to edit. (See Figure 494.) 

2. Click Edit. 

3. Update the information on the Edit LPA Validation Order Number dialog. (See Figure 
495.) 

4. Click Save & Close. 
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Delete Automated Validation Service Providers 

Use the following steps to delete a listed automated validation service provider. 

1. Select the service provider to delete. (See Figure 494.) 

2. Click Delete. 

AVM Reports 

AVM Services include the following options. 

Request AVM 

View AVM: Available after receiving the AVM report. (See View Documents for 
details.) 

Populate AVM Results 

Note: See Automated Underwriting under Interfaces to request automated underwriting 
from vendor websites. 

Request AVM 

Use the following steps to request an AVM Report. 

1. Select AVM Reports from the Services menu. 

2. Select Request AVM. 

3. Select the AVM Provider. 

 

Figure 496: AVM Request 

4. Select the appropriate Request Type radio button. 
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5. Verify the Loan Information. 

6. Enter the Legal Description. 

7. Enter the Last Prior Sale details. 

8. Click Submit. 

Populate AVM Results 

Populate selected data from the AVM Report to the Loan Application. 

1. Select AVM Reports from the Services menu. 

2. Select Populate Results. 

 

Figure 497: AVM Populate Results dialog 

3. Select the Item checkbox next to the AVM result to populate to the loan file. 

4. Click Populate. 

Note: Click Do not Populate to return to the loan file without populating the AVM data. 

Closing Documents 

The services for ordering closing documents are like other services except for the following: 

• An investor and product must be selected prior to requesting documents 

• Request dialog does not require loan information 

Note: The loan information required for the request is retrieved from the screens in Point 

• Information not part of the loan file in Point may be required by some providers 

• An interface is available to submit vendor-specific data for providers requiring the 
information 
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• Viewing of loan data analysis is available to determine if the loan is compliant if the 
analyze feature is configured on the system 

Note: Use the Closing Docs under Interfaces option for submitting closing documents 
directly to vendor websites. 

Select Investors & Products 

Select the investors and the product prior to ordering closing documents. 

Note: Update the Select Product dialog regularly to verify the product selection is still 
available. An error occurs during request submittal if the selected product was 
discontinued. 

1. Select Closing Documents from the Services menu. 

2. Choose Select a Product. 

3. Click Update Products on the Select Product dialog to update a provider list with 
the investors and products they currently offer. (See Figure 306.) 

Note: The Select Product dialog is empty the first time this screen is accessed. 

4. Select a provider from the Documents Provider dropdown list on the Investors and 
Products Login dialog. 

 

Figure 498: Investors and Products Login Dialog 

Note: Use the provider telephone number and web page links for additional information or 
to create or update an account. 

5. Enter the required Login Information. 

6. Click Submit. 
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7. Click the Save Password checkbox to save the password. 

Note: The Select Product dialog re-displays with the selected providers investors and 
products listed. The top of the screen indicates when the last update was made and 
displays the name of the current provider. 

8. Click the + sign next to the investor name to expand the product list and enable the 
Select Product button. 

9. Select the product to order. 

10. Click Select Product. 

Request Closing Documents 

Use the following steps to request closing documents after selecting the investor and 
products. 

1. Click Request Documents to process the request for the documents from the 
selected investor. 

 

Figure 499: Closing Documents Request Dialog 

2. Select the Document Provider. 

3. Select the Document Package Type. 

4. Select the appropriate Request Type radio button. 
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5. Click Submit. 

Note: Click View Documents to view and print after the documents are requested. (See 
View Documents for details.) 

View Loan Data Analysis 

The loan analysis is generated after the documents or disclosures are requested. 

• Loan data is reviewed and analyzed to verify compliance when the request is 
made 

• Non-compliant items are listed in the Audit Feedback dialog 

• Analysis is completed automatically and displayed after the document 
request is complete when the feature is configured for the installation 

1. Select Closing Documents from the Services menu. 

2. Select View Analysis. 

3. Select the Audit tabs to review the analysis. 

 

Figure 500: Closing Documents Audit Feedback 

Note: The Audit Feedback dialog displays data invalid, missing, or compliance warnings. 
Additional tabs may be available depending on the vendor. 

4. Proceed to Correct File Errors to correct audit findings. 

Correct File Errors 

Use the following steps for correcting loan file errors and resubmitting the file. 

1. Select the Audit Results tab. 

2. Double-click the error to navigate to the screen and the field that caused the error. 

3. Correct the error on the loan screen. 
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4. Select the checkbox next to the item on the Audit Feedback dialog. 

5. Continue with the remaining items in the Audit Results tab. 

Note: The Vendor Specific Data tabs contain fields not included in Point but required by the 
selected document provider. Field names are retained when subsequent loans use the 
same vendor and the required missing fields are recorded in the Vendor Specific Data 
screen. 

6. Enter the missing data in the Content field or select an option provided from the 
dropdown. 

7. Click Remove Fields and reply Yes to the confirmation prompt to clear the data from 
the Vendor Specific Data fields. 

Note: The data is removed from the corresponding fields and the Vendor Specific Data tab 
is removed from the Audit Feedback dialog. 

8. Click Order Docs on the Audit Feedback dialog to resubmit the request after all errors 
are corrected. 

9. Click Close to the close the dialog without completing the request. 

Note: The View/Print Documents dialog displays when the Audit Feedback dialog was 
displayed as the result of a request for closing documents or when documents are 
returned. 

Compliance Services 

The Compliance service includes the following: 

• Requesting compliance services. 

• View Documents that were requested. 

• View Analysis on compliance. 

Requesting compliance services requires the user to enter login information to submit a 
compliance request. 

  



   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
475 

Compliance Request 

Use the following steps to request a compliance provider. 

 
Figure 501: Compliance Request 

1. Click on the Compliance Provider dropdown menu and select a desired option. 

2. Select a Document Package Type. 

3. Select a Request Type. 

Note: If the Retrieve Request Type option was chosen, enter the Order Reference Number 
to retrieve the document. 

4. Click on the Submit button. 

5. Enter Login information and select Ok. 

View Documents (Compliance) 

Select View Document to view any document that was requested from the Compliance 
Request dialog. This option requires at least one compliance request to be submitted for 
this option to be available. 

View Analysis (Compliance) 

See View Loan Data Analysis for information on this similar topic. 

1. Select View Analysis. 

2. Select the Audit Results tab to review the results of the analysis. 
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Credit Reports 

Credit Report Services include: 

Request Credit 

View Credit: Available after receiving the credit report (See View Documents for 
details.) 

Populate Liabilities 

See Enable/Disable Services to customize the list of providers offering credit reports. 

Note: See Credit Reporting to request credit reports from vendor websites. 

Request Credit 

Use the following steps to request credit reports. 

1. Select Credit Reports from the Services menu. 

2. Select Request Credit. 

3. Select the Credit Agency from the dropdown. 

 

Figure 502: Credit Report Request Dialog 

Note: The vendor telephone number and web page links are provided to contact vendor for 
additional information or to create or update an account. 
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4. Select the Report Type to order. 

5. Select the appropriate Report Type checkbox(es). 

6. Select the Credit Report radio button(s) for the reports to order. 

Note: The Order Reference Number field is automatically populated with the reference 
number of the original request order previously placed through the Services menu. 

7. Complete the Requested By section, if available. 

8. Select the Copy credit report liabilities to this 1003 checkbox to copy the report 
information to the loan after receipt. 

9. Complete the loan information for the request. 

Note: Some information is prepopulated from the loan application. Manually enter 
additional information based on the request type. 

10. Click Submit. 

11. Enter your user ID and password on the Vendor Login dialog. 

 

Figure 503: Vendor Login Dialog 

12. Click Save Password to save the password for future logins. 

13. Click OK. 

Note: Documents requested through Calyx Services are automatically stored in the 
document repository when it is received from the provider 

Populate Liabilities 

Use the Populate Liabilities option to populate selected data from the Credit Report to the 
Loan Application. 

1. Select Credit Reports from the Services menu. 

2. Select Populate Results. 

3. Select liabilities to ignore from the Liabilities to be Imported list. 

4. Click Ignore to move the selected liabilities to the Liabilities to be Ignored. 
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5. Select the Liabilities to be Ignored to add to the Import list. 

6. Click Import to add the liabilities to the Liabilities to be Imported list 

7. Select the liabilities to import on the Populate Liabilities dialog. 

 

Figure 504: Populate Liabilities Dialog 

8. Click Ignore $0 Balance to prevent importing $0 balance liabilities. 

9. Click Ignore Closed to prevent importing closed liabilities.  

10. Click Populate. 

Note: Click Do not Populate to return to the loan file without populating the AVM data. 

Flood Certification 

Flood Certification Services include: 

• Request Flood 

• View Flood: Available after receiving the credit report (See View Documents for 
details.) 

Use the following steps to request flood certification. 

1. Select Flood Certification from the Services menu. 

2. Select Request Flood. 
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3. Select the Flood Provider. 

 

Figure 505: Flood Certification Request 

Note: The vendor telephone number and web page links are provided to contact vendor for 
additional information or to create or update an account. 

4. Select the Report Type. 

5. Select the Request Type. 

6. Select the Copy Flood Hazard Information to this loan checkbox to copy the flood 
information to the loan upon receipt. 

7. Enter the Legal Description. 

8. Enter the Assessor’s Parcel. 

9. Click Submit. 

10. Complete the Vendor Login dialog if displayed. 

Initial Disclosures 

Initial Disclosures options mirror the Closing Documents options. The screens vary slightly 
but the processes are the same. See Closing Documents for details. 
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Title/Escrow 

Title/Escrow Services include: 

• Request Title/Escrow 

• View Flood: Available after receiving the Title/Escrow document (See View 
Documents for details.) 

Note: See Title/Escrow on the Interface menu to request the documents from vendor 
websites. 

Use the following steps to request the title/escrow. 

1. Select Title/Escrow from the Services menu. 

2. Select Request Title/Escrow. 

3. Select the Title/Escrow Company. 

 

Figure 506: Title/Escrow Request Dialog 

4. Select the Order Type. 

5. Select the appropriate Order Type radio button. 

6. Enter the Order Reference Number if applicable. 
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7. Enter the Requested By details. 

8. Complete the appropriate Tabs. 

9. Click Submit. 

10. Complete the Vendor Login dialog if displayed. 

11. Use the View Title/Escrow option to view the title/escrow after submittal. 

12. Click on the Submit button to complete the order. 

First American Title 

The Title/Escrow Request dialog was specifically created for First American Title. This 
screen allows the user to order a Title or an Escrow. 

 
Figure 507: First American Title 

5. Click on the Title/Escrow Company drop-down menu and select First American 
Title. 

6. Enter the Company ID. 

7. Select either Order Title or Escrow. 

8. Click on the Order Type drop-down menu and select an option. 

9. Enter an Order Reference Number. 

10. Add any additional information. 

11. Click the Submit button at the bottom of the screen 
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Order Status 

Retrieve: Clicking the Retrieve button generates a request for getting previous results. The 
Order Status table will store a description when the title company sends the user back a 
document. In an instance, this document is unavailable in the loan. Then the user can select 
the document in the table and re-downloaded the document by clicking the Retrieve 
button.  

View Status: The View Status button exists to view the full description of each successful 
response stored in the Order Status table. 

View Documents: The View Documents button is unavailable by default (grayed out). When 
enabled, the user can view the documents that returned from the interface. 

Verifications 

Verification Services include: 

Request Verifications 

View Report: Available after receiving the verification document (See View Documents for 
details.) 

• Populate Employment (1003): Available after receiving the verification document 

Note: See Verification Services to request the verifications from vendor websites. 

Request Verifications 

1. Select Verifications from the Services menu. 

2. Select Request Verifications 
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3. Select the Verification Services Provider. 

 

Figure 508: Request Verification Dialog 

4. Select the appropriate Order radio button. 

5. Enter the Primary Borrower Order Reference Number if applicable. 

6. Enter the Co-Borrower Order Reference Number if applicable. 

7. Enter Additional Instructions, Comments if applicable. 

8. Select the Pay by credit card checkbox if applicable. 

9. Click Enter Credit Card to enter card information. 

10. Select the appropriate Request Type. 

11. Select the applicable Verification Types. 

12. Select the Authorization method. 

13. Click Submit. 

14. Complete the Vendor Login dialog if displayed. 
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Populate Employment 

Use the following steps to populate employment after receiving the report. 

1. Select Verifications from the Services menu. 

2. Select Populate Results. 

3. Select the Employment Records to populate. 

 

Figure 509: Populate Employment Dialog 

Note: Click Add All to move all employment records. 

4. Click Add to move the records to the Employment Records to Populate list. 

5. Click Populate. 

Correct Service Request Submission Errors 

Request information is verified during transmission after the service request is submitted. A 
dialog displays containing a list of fields with errors if required data is invalid or is missing 
from the request. 

Use the following steps to correct fields containing invalid or missing data. 

1. Double-click the field name to go to the field that caused the error. 

2. Add or correct the data as needed to correct the error. 

3. Click Refresh to remove the corrected fields from the list. 

4. Click Refresh to close the dialog and return to the request dialog after all fields are 
corrected. 
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5. Click Submit to resubmit the request. 

Check Pending Request Status 

Documents are automatically stored in the Document Repository when the request for a 
service is successful. The ordered and received dates are automatically updated in the loan 
checklist and third-party documents if those date fields are empty. 

Retrieve the status of pending title, escrow, or flood request after opening the loan file. 

1. Open the loan file with a pending request. 

Note: Pending Orders dialog displays if a response was received from the provider. The 
orders with a response from the provider are listed in the dialog. 

2. Select the checkboxes for the services to view. 

3. Click OK. 

Note: Click Cancel to go directly to the loan file. 

4. Enter login information for the selected provider. 

5. Click OK to display the view report dialog. 

Note: Clicking Cancel opens the next provider login dialog. The loan file displays if another 
provider is not selected. 

6. Click View to open the report. 

Note: Click Close to proceed to the next vendor. 

View Documents 

Retrieve documents from the Document Repository to view and print.  

1. Select the View option for the ordered Service Document to review. 

2. Remove the unwanted documents from the list by unchecking the boxes. 

3. Select document(s) to view and click View/Print to display a PDF file of the selected 
file(s). 

4. Click Print to print the file. 

5. Click the Save icon to save the PDF file to a secured location of choice. 

6. Click Close when finished with the file. 
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Chapter 13: INTERFACES MENU 
Use the Interfaces menu to order products and services from vendors who have integrated 
their software to work with Point to exchange data without having to exit the application. 

LoanScoreCard 

LoanScorecard is the integration of LoanScorecard.com and Point. 

Note: A credit report is required before the FHA TOTAL Scorecard can be generated. 

LoanScoreCard Access 

Use the following steps to access LoanScoreCard. 

1. Open the appropriate borrower or prospect file. 

2. Select LoanScoreCard from the Interfaces menu. 

3. Enter the Login credentials. 

  

Figure 510: Loan Scorecard 

4. Click Log In to access the Point Automated Underwriting — FHA TOTAL Scorecard 
screen. 

LoanScorecard QM Findings 

A QM interface communicates with LoanScorecard to evaluate the loan and return a report. 
The interface is accessible from the QM button which is located at the bottom of the 
workspace on the following screens: 

• Borrower Information 

• Fees Worksheet 
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• Good Faith Estimate 

• Loan Application (pages 1 through 5) 

• Transmittal Summary 

• Truth-in-Lending 

Generate QM Report 

The Current Status on the Point Information Bar updates with the QM Finding, Date and 
Time when a report is generated. 

Use the following steps to generate a QM Report. 

1. Open a screen containing the QM button. 

1. Click the QM button. 

Note: The Point browser window displays briefly the first time a report is generated. 

 

Figure 511: Loan Scorecard QM findings 

2. Scroll down the report to view the following: 

• QM assessment 

• Points and fees analysis 

• Income information 

• Loan information, etc. 

3. Click the Run QM button to update the report data. 

4. Click the Print button to print the report. 

5. Click the Close button to return to the Point loan. 
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Uniform Collateral Data Portal 

The Uniform Collateral Data Portal (UCDP) is used to electronically submit appraisal data 
(UAD and non-UAD XML) files to Fannie Mae and Freddie Mac. The following XML files are 
supported: 

• MISMO 2.6 GSE 

• ACI 

• AI Ready 

The appraisal XML file to submit to the Government Sponsored Enterprise (GSE) must be 
stored in the Document Repository to access from the UCDP screen. 

The following table shows the UAD XML and non-UAD XML supported forms. 

Table 10: Supported XML Forms 

UAD XML Non-UAD XML 

1004/70 1004C/70B 
1073/465 1025/72 
1075/466 2090 
2055/2055 2095 

The portal is accessible only in borrower files from the Interfaces menu and the Shortcut 
menu. 

Set up seller identification and login information in the Point utilities prior to use to avoid 
entering the data each time you submit an appraisal for a new loan file to Fannie Mae or 
Freddie Mac in the Uniform Collateral Data Portal. The information is permanently stored 
and retained for future use. (See Uniform Collateral Data Portal Setup for details.) 

UCDP Submission 

Use the following steps to submit an appraisal to Fannie Mae and Freddie Mac through 
UCDP. 

1. Open the borrower file. 

2. Select Uniform Collateral Data Portal from the Interfaces menu. 
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3. Select a Form Type from the dropdown. (See Table 10: Supported XML Forms for 
supported forms.) 

 

Figure 512: UCDP Screen 

4. Click the Select button. 

5. Select the appraisal XML file from the Document Management File List. (See Figure 
299.) 

6. Click Select to display the document in the Uniform Collateral Data Portal screen 
Appraisal 1 field is populated with the appraisal name. 

7. Repeat Steps 3 – 6 for up to two additional appraisals, if applicable. 

8. Click the corresponding Remove button and click the OK button in response to the 
confirmation prompt to remove an appraisal. 

Note: Appraisal 1 must be replaced another appraisal after the submission is completed to 
remove. 

9. Enter the Loan Number if not populated. 

Note: Use the Lock to change a listed Loan Number if required. 

10. Select the Fannie Mae Add to Submission checkbox if applicable and complete the 
Fannie Mae fields. 

11. Select the Freddie Mac Add to Submission checkbox if applicable and complete the 
Freddie Mac fields. 
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12. Click Submit. 

Note: Submit additional appraisals to the same investor after the original submission or 
submit the appraisals to a new investor at any time. An investor cannot be removed from 
the submission after an appraisal is submitted. 

13. Click OK in response to the UCDP Submission Results dialog. 

View Hard Stops 

The View Hard Stops dialog displays if a hard stop occurs. The View Hard Stops dialog 
contains the errors that occurred during the submission of the appraisal. 

The Override Status and Override Decision columns are populated with APPROVED and 
the Override request accepted if the submittal is successful. 

Some overrides are performed automatically and approved during submission. 

The Override Allowed column states Automatic when an automatic override occurs. 

The Override Decision column states Override automatically approved. 

The Override Allowed field states Yes when a manual override is allowed. 

The Override Status column is blank when a manual override is required. 

The Override Allowed field states No when an override is not allowed. 

Note: The must be corrected and the file re-submitted when the Override Allowed field 
states No. 

Review each message and determine whether a manual override is allowed. 

Use the following steps to perform a manual override. 

1. Select the Error. 

2. Click Create Override to open the Edit Override dialog. 

3. Select a Reason Code for the override from the dropdown. 

4. Enter a Comment for Reason Code Other. 

5. Click OK. 

6. Repeat for remaining manual overrides. 

7. Click Submit to resubmit. 

8. Click OK on the UCDP Direct Integration Login dialog. 

9. Click OK on the and UCDP Submission Results dialog. 

10. Click Close. 



   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
491 

Uniform Closing DataSet (UCD) 

Use the Uniform Closing Dataset (UCD) screen to export the Closing Disclosures stored in 
the Point Document Repository to UCD XML format for submission to Fannie Mae and 
Freddie Mac. 

Only the following document types are allowed: 

• Closing Disclosure: Standard 
• Closing Disclosure: Alternative 
• Closing Disclosure: Borrower only 
• Closing Disclosure: Seller only 

1. Select Uniform Closing Dataset (UCD) from the Interfaces menu. 

2. Enter the Fannie Mae or Freddie Mac UCD Case Number. 

 

Figure 513: Uniform Closing (UCD) 

Note: The UCD case number is automatically included in the report when using the Fannie 
Mae or Freddie Mac AUS in Point and selecting the corresponding Include in UCD 
checkbox in the Automated Underwriting section on the Banker Underwriting screen. 

3. Click the Add button to open the Document Repository. (See Figure 299.) 

4. Select the document to export to UCD XML. 

Note: There is potential risk the data will not export to the UCD XML format correctly if the 
Closing Disclosure being exported was not generated by Point. 

5. Click the Select button. 

6. Repeat Steps 3 – 5 for another document to the export. 

7. Click the Export button for the XML type to export. 

8. Navigate to the directory to store the XML file. 

9. Click Save. 

Note: Select a document and click Delete to remove from the Export Closing Disclosure 
table. 
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WebCaster 

WebCaster is a subscription-based website creation program used to promote and conduct 
mortgage business on the internet. The following options are available with a Calyx 
WebCaster subscription: 

• Transfer loan information from Point to WebCaster. 

• Submit online loan applications. 

• Access loan status reports. 

Note: See Zip/WebCaster Preferences for WebCaster setup. 

WebCaster Administrator Login 

Use the Administrator Login option to access WebCaster options not available to typical 
users. 

1. Select WebCaster from the Interfaces menu. 

2. Select WebCaster Administrator Login. 

 

Figure 514: WebCaster Administrator Login 

3. Enter Log In Credentials. 

4. Click Log In. 
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Update Loan Status 

WebCaster sends emails to borrowers stating the loan status has been updated and is now 
available when WebCaster is configured for the option. Borrowers can log into the site and 
view the loan application status. 

Use the following steps to update WebCaster loan statuses. 

1. Select the Borrower file. 

2. Select WebCaster from the Interfaces menu. 

3. Select Update Loan Status. 

4. Enter the Borrower Email Address field. 

 

Figure 515: WebCaster Loan Status Update 

Note: The email address is used as the Borrower user ID to log into the website. 

5. Enter Notes to Borrower. 

6. Complete the Administration Login information. 

7. Click the Save Password checkbox to save log in information for future use. 

Note: WebCaster Administration Login information is setup using the WebCaster 
Preferences on the Utilities menu. See Zip/WebCaster Preferences for WebCaster setup. 

8. Select the Resend All Status Fields checkbox to send an updated status of all fields if 
applicable. 

9. Click Update. 
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WebCaster View Loan Status 

Use the following steps to view loan status. 

1. Select the Borrower file. 

2. Select WebCaster from the Interfaces menu. 

3. Select View Loan Status. 

4. Log in to the WebCaster website. 

Other Interfaces 

Use the following interface selections to provide vendor online portal access for the 
selected service. 

• Appraisals 

• Automated Underwriting 

• Bundled Services 

• Compliance 

• Credit Reporting 

• Closing Docs 

• Disclosure Fees 

• Fraud Detection 

• Homeowners Insurance 

• Mortgage Insurance 

• Product and Pricing 

• Title/Escrow 

• Verification Services 

• Additional Services 

Install Interfaces and Exchange Data 

Contact the vendor to set up an account prior to access. The vendor provides the 
information required to access the interface. 

Note: The example shows the Appraisals Interfaces option. Other options use the same 
steps provided below. 

1. Open a prospect or borrower file. 

2.  Select the service from the Interfaces menu. 
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3. Select the vendor to use. 

 

Figure 516: Appraisals Interfaces 

4. Select a link to continue: 

Vendor Website 

Point Interface 

Vendor Website 

Periodic Internet updates occur automatically to update the list of interfaces available in 
Point. Data that must be returned to Point is received automatically. Refer to vendor 
documentation for more information. A message may display indicating an update occurred 
for the vendor when a file is opened. 

1. Click More Information to open the vendor website. 

2. Click the Launch button to access the vendors website. 

3. Follow the instructions provided by the vendor to order services or work with data. 
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Point Interface 

1. Click OK to open the Point interface with the vendor. 

 

Figure 517: Point Vendor Interface 

2. Click the Launch button to access the vendor interface. 

3. The Loan ID field is populated with the vendor identification number for the loan 
when the vendor returns data. 

4. Click Clear or Edit to delete or edit the Loan ID. 

5. Enter the new loan ID in the Loan ID field. 

6. Click OK. 

View Interface Transaction History Log 

The log contains a list of transactions and the date and time they occurred. 

1. Select Interface Transaction Log from the Interfaces menu. 

2. Click OK to close the log. 
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Chapter 14: UTILITIES MENU 
The Utilities menu contains options for customizing Point to meet specific business needs. 
Use the Utilities menu to configure dropdown lists, company defaults, screen settings and 
colors, and interfaces. Features can be setup and modified after installation and throughout 
the Point user lifecycle. 

Show Tasks 

Use Show Tasks to view the task list for the selected loan application. 

1. Select Show Tasks from the Utilities menu. 

2. Select the Task option from the Search dropdown. 

 

Figure 518: Show Tasks Dialog 

3. Select a task. 

4. Click Open Task to update the details on the Task Details dialog. (See Figure 12.) 

5. Click Delete to delete the selected task. 

6. Click Print to print the selected task. 

Cardex Database 

Create the Cardex database of people and companies interacted with during loan. The 
Cardex database populates Cardex-enabled fields automatically. Enter contact information 
into the database manually or transfer information from a completed form. 

Access Cardex through the Utilities menu or by clicking the Cardex icon. 



   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
498 

Create Categories List 

Create a Categories dropdown list to assign categories to new or imported contacts. 
Categories may include: 

• Appraisers 

• Hazard Insurance 

• Investors 

• Lenders 

• Mortgage Insurance 

• Notary 

• Realtors 

• Referrals 

• Title Companies 

1. Click Edit Categories on the Cardex Database dialog. 

 

Figure 519: Edit Cardex Categories 

2. Click Add on the Dropdown List: Cardex Category dialog. 

 

Figure 520: Dropdown List Cardex Category 

3. Enter the Category Name in the Add Selection dialog. (See Figure 293.) 

4. Click OK. 
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5. Repeat Steps 2 – 4 to build the Category List. 

6. Click OK on the Dropdown List: Cardex Category dialog when the list is complete. 

Edit Categories List 

Use the following steps to edit the Categories List. 

1. Select the category to edit. (See Figure 520.) 

2. Rename the category on the Add Selection dialog. (See Figure 293.) 

3. Click OK on the Add Selection dialog. 

4. Click OK on the Dropdown List: Cardex Category dialog. 

Delete Category 

Use the following steps to delete Cardex category. 

1. Select the category to delete. (See Figure 520.) 

2. Click Delete. 

3. Click OK on the Dropdown List: Cardex Category dialog. 

Import Contacts 

Imported lists must be in one of the following formats: 

• Existing Cardex list 

• Comma delimited file 

• Outlook contacts List 

Use the following steps import an existing contact list or comma delimited file. 

1. Select Import from the Cardex Database dialog File menu. 

 

Figure 521: Import Contact List 
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2. Select the Other Cardex File or Comma Delimited File radio button for the File 
Type being imported. 

 

Figure 522: Import Dialog 

3. Click Next. 

4. Click the Browse button on the Import Source dialog. 

 

Figure 523: Import Source Dialog 

5. Browse to and select to the file. 
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6. Complete the Custom Import dialog fields. 

 

Figure 524: Custom Import Dialog 

7. Click Next. 

8. Map the fields on the Import Table Mapping dialog. 

 

Figure 525: Import Table Mapping Dialog 

9. Click Finish when import is complete. 

  



   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
502 

Import Outlook Contacts 

Use the following steps to import Outlook contacts. 

1. Select Import from the Cardex Database dialog File menu. (See Figure 521.) 

2. Select the Outlook Contacts radio button on the Import dialog. (See Figure 522.) 

3. Click Next. 

4. Select the appropriate Address Book on the Outlook Address Books dialog. 

 

Figure 526: Outlook Address Books Dialog 

5. Click Next. 

6. Map the fields on the Import Table Mapping dialog. (See Figure 525.) 

7. Click Finish when import is complete. 

Add New Contact 

Use the following steps to manually add contacts. 

1. Click New on the Cardex Database dialog. 

 

Figure 527: New Cardex File 
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2. Complete the Contact Information. 

 

Figure 528: Cardex Record Dialog 

3. Enter the Address Information. 

4. Enter contact details in the Notes field if required. 

5. Select the appropriate Category from the dropdown. 

Note: Click Category to create a new category. (See Edit Categories List for details.) 

6. Enter the contact License # if applicable. 

7. Click Save & Close. 

Note: Click Save & New to add another contact. 
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Contact Search and Print 

Use the following steps to locate a Cardex contact and optionally print contact information. 

1. Use the Search bar in the Cardex Database dialog to locate a contact in the list. 

 

Figure 529: Print Contact 

2. Highlight the contact. 

3. Click Print. 

4. Select the appropriate radio button. 

 

Figure 530: Print Contact Dialog 

5. Click Print. 
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Edit Contact 

Use the following steps to edit a contact in Cardex. 

1. Double-click a contact in the Contact List. 

 

Figure 531: Edit Contact 

Note: Click Delete after selecting the contact to delete.  

2. Update the Cardex Record dialog. (See Figure 528.) 

3. Click Save & Close. 

Delete Contact 

Use the following steps to Delete a contact. 

1. Select the contact to delete. (See Figure 531.) 

2. Click Delete. 

Display Ratios 

Select Display Ratios from the Utilities menu from any borrower screen to view updated 
ratios. 

 

Figure 532: Ratios Dialog 
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Conversation Log 

Use the Conversation Log to track communication about the in-progress loan. 

Add Conversation 

Use the following steps to add conversations to the log. 

1. Select Conversation Log from the Utilities menu. 

2. Click Add. 

 

Figure 533: Conversation Log 

3. Enter conversation notes on the Add Item dialog. 

 

Figure 534: Add Item Dialog 

4. Click OK. 
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Open Conversation 

Use the following steps to open a listed conversation. 

1. Select the conversation to open. (See Figure 533.) 

2. Click Open. 

3. View and/or update the conversation on the View Update Item dialog. 

 

Figure 535: View/Update Item Dialog 

4. Click OK. 

Delete Conversation 

Use the following steps to delete a conversation. 

1. Select the conversation to delete. (See Figure 533.) 

2. Click Delete. 

Clear All Conversations 

Use the following steps to clear all conversations. 

1. Click Clear All. (See Figure 502.) 

2. Click OK on the Clear All Items prompt. 

Audit Trail 

Audit Trail functions are available only at sites running PointCentral and must be enabled in 
PointCentral to be available for use. 

The audit trail function tracks changes to and actions taken in loan files. The audit trail 
begins after the loan file is saved for the first time and captures only the differences since 
the previous save. 
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The audit trail log remains with the loan file when it is moved or copied to another data 
folder unless selecting Copy only 1003 data to start a new loan including the Co-borrowers 
option in the following dialogs when copying an existing loan file: 

• Copy Borrower 

• Copy Prospect 

Logged Actions 

The following document-related actions are logged: 

• When documents, reports, or services are ordered through the Services interface 

• When a document is added to the document repository 

• When a document is deleted from the document repository 

• When a document is emailed from the document repository 

• When a document is printed from the document repository 

• When a document in the document repository is edited 

• When a document is sent to or received from the borrower by using the integration 
with WebCaster or Zip 

• When document request and collection activity occur 

Unlogged Actions 

Changes to the following information are not logged in the audit trail: 

• Liabilities 

• Real Estate Owned 

• Former employers 

• Verifications in the Verifs menu 

• Service Providers List screen 

Log Entries 

Field Changes Entries 

Log entries for field changes show the following: 

• Date changes are made. 

• Individual making the change. 

• Field name and ID that changed. 

• Previous field value. 
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• New field value 

• Fields updated because of a recalculation or an interface change 

Document Changed Entries 

Log entries for document changes show the following: 

• Document name 

• Date changes are made 

• Individual making the change 

• Action taken in the document repository, such as: 

• Added 

• Edited 

• Deleted 

• Emailed 

• Printed 

• Saved 

Access Loan File Audit Trail 

Use the following steps to access the Loan File Audit Trail. 

1. Open a prospect or borrower file. 

2. Select Audit Trail from the Utilities menu. 

3. Click a column heading to sort the records in ascending order. 

4. Click a column heading again to sort in descending order.  

Note: The Previous Value and Current Value columns are not sortable. 

5. Click and drag column lines to increase or decrease the column width. 

Log Entries Search 

The following searches are enabled in the audit log: 

• Field name 

• Field ID 

• User 

• Change date 

• Document name 

• Action 
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• Action date 

1. Open a prospect or borrower file. 

2. Select Audit Trail from the Utilities menu. 

3. Select the Fields or Documents tab to determine where to search. 

4. Select what to search from the Search By dropdown. 

5. Enter the search criteria in the Search field. 

6. Enter the date range when searching by Date. 

Print Audit Trail Log 

1. Open a prospect or borrower file. 

2. Select Audit Trail from the Utilities menu. 

3. Perform a search to filter information before printing the log. 

4. Click the Print button to open the Audit Trail Print Preview dialog. 

5. Click the Print icon to open the Print dialog. 

6. Select the print parameters. 

7. Click OK to print the log. 

Company Default Information 

The Company Defaults options set the default company information. The entered 
information is stored in a unique data folder and transferred to other data folders are 
required. 

The Company Defaults menu is available only to users who have access to secured areas. 
Secured area access is specified for Point users in Point Administrator. Point Central users 
are granted access to company defaults as part of the Data Folder security settings. 

Company Information 

Use the Company Information dialog to define company information to include on printed 
forms. 

Note: Update the Company Information when changes occur that impact printed forms. 

1. Select Company Defaults from the Utilities menu. 

2. Select Company Info. 
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3. Select the Broker or Lender checkbox as appropriate. 

 

Figure 536: Company Information Dialog 

4. Enter the Company Name and Address. 

5. Enter Time Zone. 

6. Enter Telephone Number. 

7. Enter Fax #. 

8. Enter the company NMLS Number. 

9. Enter the company Federal Tax ID Number. 

10. Enter the Legal Entity Identifier. 

Note: The Legal Entity ID field is available when the Lender checkbox is selected. 

11. Select the Manually enter company information on forms checkbox to require 
manually company information entry on screens instead of auto populating forms. 

Note: The company information is auto populated on the Agent screen when this option is 
not selected. The contact information fields are disabled and cannot be changed. 

12. Select the checkboxes for the items to include on printed forms. 

Note: The Loan Originator must be selected from the dropdown list on the Borrower or 
Prospect Information screen for the loan originator information to print. 

13. Select the State checkboxes where the company is licensed to do business. 

14. Enter the company License # for each state selected. 
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15. Click OK to save updates and close the dialog. 

Processing Center 

Use the Processing Center dialog to define processing information to include on printed 
forms when the processing center is different than the loan origination company. 

1. Select Company Defaults from the Utilities menu. 

2. Select Processing Center. 

3. Complete Steps 3 – 15 in Company Information using the Processing Center details. 

Days Per Year 

Use the Days Per Year option to specify the days per year used during automatic 
calculations. 

1. Select Company Defaults from the Utilities menu. 

2. Select Days Per Year. 

 

Figure 537: Days Per Year Dialog 

3. Select the appropriate radio button. 

4. Enter the number of days when selecting Other. 

5. Click OK to save updates and close the dialog. 

ECOA Address 

Enter the ECOA address for the governing federal agency administering ECOA compliance. 
The entered information populates the address on the ECOA Submission form. 

1. Select Company Defaults from the Utilities menu. 
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2. Select ECOA Address. 

 

Figure 538: ECOA Address Dialog 

3. Enter the ECOA Address. 

4. Click OK to save updates and close the dialog. 

CA Fair Lending Address 

Enter the California (CA) Fair Lending Address option to enter the address to send the CA Fair 
Lending notice. The entered information populates the address on the CA Fair Lending 
notice. 

1. Select Company Defaults from the Utilities menu. 

2. Select CA Fair Lending Address. 

 

Figure 539: CA Fair Lending Address Dialog 

3. Enter the CA Fair Lending Address. 

4. Click OK to save updates and close the dialog. 
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Denial Letter Address 

Use the Denial Letter Address option to specify the address of the federal agency 
administering Regulation B of ECOA compliance. The entered information populates the 
address on the Notice of Action Taken form. 

1. Select Company Defaults from the Utilities menu. 

2. Select Denial Letter Address. 

 

Figure 540: Credit Denial Address Information 

3. Enter Administering Federal Agency Address. 

4. Click OK to save updates and close the dialog. 

Servicing Disclosure Information 

Use the Servicing Disclosure Info option to enter default settings for the Servicing 
Disclosure Statement. 

1. Select Company Defaults from the Utilities menu. 

2. Select Servicing Disclosure Info. 

 

Figure 541: Servicing Disclosure Statement Info 

3. Select the options to include in the disclosure statement. 

4. Click OK to save updates and close the dialog. 
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Marketing Letterhead 

Use the Marketing Letterhead option to select the company letterhead to use on printed 
forms. 

1. Select Company Defaults from the Utilities menu. 

2. Select Marketing Letterhead. 

 

Figure 542: Marketing Letterhead Setting Dialog 

3. Click Browse to browse to and select the letterhead image. 

4. Select the Auto Fit checkbox to auto fit the letterhead to the print form. 

5. Use the Move and Zoom options to set the letterhead placement. 

Note: The Move and Zoom options are not available when Auto Fit is selected. 

6. Click OK to save updates and close the dialog. 

Right to Receive Appraisal 

Use the Right to Receive Appraisal option to print an appraisal statement on the Right to 
Receive Appraisal form or in Section IX on the loan application. 

1. Select Company Defaults from the Utilities menu. 

2. Select Right to Receive Appraisal. 

 

Figure 543: Right to Receive Appraisal Dialog 
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3. Select the Print “Right to Receive Appraisal” statement in section IX on the loan 
application checkbox to include the statement on the printed loan application. 

4. Select the appropriate Time Limit checkbox. 

5. Enter the written notice timeframe when the second checkbox is selected. 

6. Click OK to save updates and close the dialog. 

FHA Consumer Choice Disclosure 

Use the FHA Consumer Choice Disclosure Notice dialog to populate the information to 
include on the FHA Consumer Choice Disclosure Notice. 

1. Select Company Defaults from the Utilities menu. 

2. Select FHA Consumer Choice Disclosure. 

 

Figure 544: FHA Consumer Choice Disclosure 

3. Complete the fields appropriately. 

4. Click OK to save updates and close the dialog. 

GFE/TIL Disclosure 

Use the Good Faith Estimate (GFE)/Truth-in-Lending (TIL) option to complete the GFE/TIL 
information on forms. 

1. Select Company Defaults from the Utilities menu. 

2. Select GFE/TIL Disclosure. 
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3. Select the Always print the current date on all disclosures checkbox to include 
the current date on printed disclosures. 

 

Figure 545: Disclosure Settings Dialog 

4. Select the applicable TIL Consummation Date checkbox. 

Add Changed Circumstances 

Use the following steps to add changed circumstances to the table. 

1. Click Add. (See Figure 545.) 

2. Enter the circumstance option in the Add Selection dialog field. (See Figure 293.) 

3. Click OK. 

4. Repeat Steps 4 – 6 to add additional circumstance options. 

Edit Changed Circumstance 

Use the following steps to edit a listed changed circumstance. 

1. Select the changed circumstance to edit. (See Figure 545.) 

2. Click Edit. 

3. Update the information on the Add Selection dialog. (See Figure 293.) 

Delete Changed Circumstance 

Use the following steps to delete a listed changed circumstance. 
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1. Select the changed circumstance to delete. (See Figure 545.) 

2. Click Delete. 

Reset Defaults 

Click the Reset To Defaults button to restore the default settings installed with Point. 

Service Provider List Disclosure 

The Service Provider List Disclaimer is displayed on the printed Service Providers List. 

1. Select Company Defaults from the Utilities menu. 

2. Select Service Provider List Disclosure. 

 

Figure 546: Service Provider List Disclaimer 

3. Uncheck the Use Calyx Default checkbox to enter a company disclaimer. 

4. Enter the disclaimer to display on the Service Provider List. 

5. Click OK. 

Privacy Policy Disclosure Form Settings 

Use the Privacy Policy Disclosure option to determine the privacy statements included on 
the Privacy Policy Disclosure form, including: 

• Type of information the company collects 

• How information is used for marketing purposes 

• Borrowers opt-out options circumstances when Borrower personal information is 
collected with whom information is shared 

The following sections provide guidance on completing the tabs that correspond to the 
Privacy Policy Disclosure form fields. 

What Box 

Use the What Box tab to select the information the Loan Originator collects and shares. 
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1. Select Company Defaults from the Utilities menu. 

2. Select Privacy Policy Disclosure. 

 

Figure 547: Privacy Policy Disclosure What Box 

3. Select an Available Option to include in the disclosure. 

4. Click Add. 

5. Repeat Steps 3 – 4 to include up to five options. 

6. Use the Move Up and Move Down buttons to change to order the options appear 
on the disclosure. 

7. Highlight an option in the Selected Options list to remove. 

8. Proceed to Reasons We Can Share. 

Reasons We Can Share 

Use the Reasons We Can Share tab to specify the reasons for sharing Borrower personal 
information. 

1. Select the Reasons We can Share tab. 

2. Select the appropriate Does Share radio button for each option. 

3. Select the appropriate Limit Sharing radio button for each Yes. 

Note: Limit Sharing selections are disabled when the Borrower uses both Phone and 
Website opt-out options. 

4. Proceed to Opt-Out Options. 
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Opt-Out Options 

Use the Opt-Out Options tab to specify the reasons a Borrower can select for preventing 
information sharing. 

1. Select the Opt-Out Options tab. 

 

Figure 548: Privacy Policy Disclosure Opt-Out 

2. Select the Phone checkbox and provide the appropriate phone number for the 
Borrower to call to opt-out of information sharing. 

3. Select the Website checkbox and provide the appropriate website URL for the 
Borrower to use online opt-out. 

4. Enter the number of days the Borrower may use to complete the Opt-Out steps in 
Please Note field. 

5. Select the Mail checkbox and enter the company information for the Borrower to 
contact to opt-out of information sharing. 

6. Select the Joint Accountholder checkbox to choose a single opt-out for joint 
Borrowers. 

7. Select the appropriate Opt-Out Choices checkboxes. 

8. Proceed to Questions/Who We Are. 
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Questions/Who We Are 

Use the Questions/Who We Are tab to provide the company contact information to display 
in the Questions section. 

1. Select the Questions/Who We Are tab. 

 

Figure 549: Questions/Who We Are Options 

2. Select the Phone checkbox and enter a telephone number that customers should 
use to call with questions about the privacy notice. 

3. Select the Website checkbox and enter the website the customers should use to 
find answers to questions about the privacy notice. 

4. Enter information in the Who is providing this notice field to populate the Who is 
providing this notice information on the printed form. 

5. Select the Extend List checkbox and enter additional text when more than four 
lines is required. 

Note: The text if Extend List field is printed at the end of the disclosure. The text is printed 
in the Other Important Info section when the Extend List checkbox is not selected. 

6. Proceed to What We Do Section. 

What We Do Section 

Complete the What We Do Section about collecting and managing personal data. 
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1. Select What We Do Section tab. 

 

Figure 550: What We Do Section Options 

2. Enter the description of the security steps used to protect Borrower information in 
the How We Protect Personal Info field. 

Note: The field allows 30 words maximum. 

3. Select a How We Collect Personal Info Available Option. 

4. Click Add to move the selected option to the Selected Options list. 

5. Repeat Steps 3 – 4 for up to five options. 

6. Highlight and click Remove to move an option from the Selected Options list. 

7. Select the Optional checkboxes if applicable. 

8. Select the Limit Sharing checkbox to display specific state laws on the privacy 
policy. 

9. Select the Limit Sharing – Jointly options if applicable. 

10. Proceed to Definitions. 
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Definitions 

Complete the Definitions tab to define affiliate and joint marketing information to display on 
the privacy policy. 

1. Select the Definitions tab.  

 

Figure 551: Definition Options 

2. Select the appropriate Affiliates Information checkbox. 

3. Complete the Shares with our affiliates fields when selecting the checkbox. 

4. Select the appropriate Nonaffiliate Information checkbox. 

5. Complete the Nonaffiliates we share with can include field when selecting the 
checkbox. 

6. Select the appropriate Joint Marketing checkbox. 

7. Complete the Our joint marketing partners include field when selecting the 
checkbox. 

8. Proceed to Other Important Info. 

Other Important Info 

Complete the Other Important Info tab with other information to include on the privacy 
form. 

1. Select the Other Important Info tab. 
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2. Select the Show General Information Box checkbox. 

3. Enter important information to include on the form. 

4. Select the Extend To Third Page checkbox to extend additional information to a 
third page of the privacy form. 

5. Click OK on the Privacy Policy Disclosure dialog to save all changes. 

Print Loan Application Addendum 

The Loan Application Addendum is used for collecting Borrower demographic information. 
Select an option from the dropdown to print the Loan Application Addendum with the loan 
application. 

1. Select Company Defaults from the Utilities men. 

2. Select Loan Application Addendum. 

 

Figure 552: Loan Application Addendum 

3. Select the dropdown menu and select one of the options (All Loans, Disable, FHA). 

4. Click OK to save. 

Freddie Mac LPA System-to-System 

Set up the direct connection to the Freddie Mac Loan Product Advisor (LPA) to 
communicate directly with the LPA system. 

Note: A Freddie Mac account must be created and configured through the Freddie Mac 
System-to-System website before communication is enables.  

LPA Account Sign Up 

Log into the Freddie Mac System-to-System website to request the LPA system access. 

1. Click the following link to access the System-to-System Access Registration Form: 

System-to-System Access Registration Form - Freddie Mac 

http://www.freddiemac.com/singlefamily/crownpeak/S2Ssignup.html
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2. Locate the sign-up link. 

 

Figure 553: Freddie Mac LPA Sign Up 

3. Follow the on-screen prompts to complete the registration and retrieve a User ID 
and Password. 

Set Up Point LPA Connection 

Set up the Point LPA connection after ensuring the information in the following table is 
available. 

Table 11: LPA Setup Required Information 

Required Information  Description 

Company Level User ID The Freddie Mac user ID and password assigned to 
the company for authenticating through the interface. 

Company Level Authentication 
Password 

Enter the Freddie Mac assigned password for the 
Freddie Mac (S2S) system. Information is received 
from the System-to-System Access Registration 
Form - Freddie Mac during system up. 

See LPA Account Sign Up. 

Seller Servicer Number A Freddie Mac-assigned number indicating a 
company is approved to do business directly with 
Freddie Mac. 

Third Party Originator (TPO) 
Number 

A Freddie Mac-assigned Third-Party Originator 
number for accessing LPA directly. 

Non-Originating Third Party 
(NOTP) Number 

A Freddie Mac-assigned number for non-originating 
third parties and Mortgage Service Providers access 
LPA directly. 

LPA password A Freddie Mac-assigned number for non-originating 
third parties and Mortgage Service Providers access 
LPA directly. 

1. Select Company Defaults from the Utilities menu. 

http://www.freddiemac.com/singlefamily/crownpeak/S2Ssignup.html
http://www.freddiemac.com/singlefamily/crownpeak/S2Ssignup.html
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2. Select Freddie Mac LPA System-to-System. 

3. Complete the Setup fields. 

 

Figure 554: Freddie Mac Loan Product Advisor 

4. Click OK to save the information. 

Condition Types 

The Condition Types populate the Loan Conditions table on the Banker Conditions screen 
when the Add Defaults button or Add Conditions from Pick-List button is selected. (See 
Conditions.) 

Add Conditions 

Use the following steps to add conditions on the Condition Types dialog. 

1. Select Company Defaults from the Utilities menu. 

2. Select Condition Types. 
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3. Click Add. 

 

Figure 555: Condition Types Dialog 

4. Enter a unique condition identifier in the Condition # field. 

 

Figure 556: Conditions Setup Dialog 

5. Select the appropriate Condition Type from the dropdown list. 

6. Enter a condition description in the open field. 

7. Select the appropriate Document Category from the dropdown list. 

8. Select the appropriate Document Type from dropdown list. 

Note: Default Document Category and Document Type lists are provided. (See Document 
Categories and Types for details on modifying the options.) 
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9. Select the Default Condition for All New Loans checkbox to include the condition 
in the Default List for loans. 

Note: Conditions Pick-List Filter Settings, Loan Purpose, and Loan options are not 
available when selecting the Default Conditions checkbox. 

10. Select the Show in Track > Conditions Screen checkbox to include the condition 
on the Track Conditions screen. (See Track Conditions for details.) 

11. Select the Mark as Inactive checkbox to exclude the condition from the Default 
Conditions that populate the Banker Conditions screen when the Loan Originator 
selects specific conditions. (See Conditions for details.) 

12. Select the Show in Mtg Loan Commitment Screen checkbox to include the 
condition on the Mortgage Loan Commitment screen. (See Mortgage Loan 
Commitment for details.) 

13. Select the appropriate Filter option(s) to set the lien types for which the condition 
is available. 

14. Select the appropriate Loan Purpose option(s) to set the loan purpose for which 
the condition is available. 

15. Select the appropriate Loan Type option(s) to set the loan types for which the 
condition is available. 

16. Click OK on the Condition Setup dialog save the condition. (See Figure 556.) 

17. Repeat Steps 1 – 16 for other conditions. 

18. Click OK on the Condition Types dialog when finished creating the Default 
Condition Types. (See Figure 555.) 

Sort Condition Types 

Sort the condition types to determine the order in which the conditions appear on Banker 
Conditions screen Loan Conditions table. 

1. Click a column heading on the Condition Types dialog to sort the list in ascending 
order by that column. (See Figure 555.) 

2. Click OK to save the changes. 

Edit Conditions 

Use the following steps to edit a listed condition. 

1. Select the Condition to edit. (See Figure 555.) 

2. Click Edit. 

3. Make the appropriate changes on the Condition Setup dialog. (See Figure 556.) 
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4. Click OK on the Condition Setup dialog. 

5. Click OK on the Condition Types dialog. 

Delete Condition 

Use the following steps to delete a listed condition. 

1. Select the Condition to delete. (See Figure 555.) 

2. Click Delete. 

Fee Types 

The Fee Types populate the Fees table on the Banker Fees & Impounds screen when the 
Add Defaults button or Add Fees from Pick-List button is selected. (See Fees & Impounds 
for details.) 

Add Fees 

Use the following steps to add fees to the Fee Types dialog. 

1. Select Company Defaults from the Utilities menu. 

2. Select Fee Types. 

3. Click Add on the Fees Types dialog. 

 

Figure 557: Fee Types Dialog 
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4. Select the HUD Line # from the dropdown on the Fees Setup dialog. 

 

Figure 558: Fees Setup Dialog 

5. Select the Fee Description from the dropdown. 

6. Select the Paid To party from the dropdown. 

7. Select the Paid By party from the dropdown. 

8. Enter the Fee Amount. 

9. Select the APR Affecting Fee checkbox if the fee is included in the Annual 
Percentage Rate (APR). 

10. Enter the General Ledger (GL) Code. 

11. Select the Fee Type from the GL dropdown. 

12. Select the Default Fee for All Loans checkbox to include the condition in the 
Default List for all loans. 

Note: Fees Pick-List Filter Settings, Loan Purpose, and Loan options are not available 
when selecting the Default Fee For All Loans checkbox. 

13. Select the Section 32 Fee checkbox when the fee is a Section 32 fee. 

14. Select the Net From Wire checkbox when the fee is not included with the amount 
to be wired 

15. Select the appropriate Filter option(s) to set the lien types for which the fee is 
applicable. 
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16. Select the appropriate Loan Purpose option(s) to set the loan purpose for which 
the fee is available. 

17. Select the appropriate Loan Type option(s) to set the loan types for which the fee 
is available. 

18. Click OK to save the Fee Type. 

19. Repeat Steps 1 – 15 for other condition. 

20. Click OK on the Fee Types dialog when finished creating the Default Fee Types. 
(See Figure 557.) 

Sort Fee Types 

Sort the condition types to determine the order in which the conditions appear on Banker 
Fees & Impounds screen Fees table. 

1. Click a column heading to sort the list in ascending order by that column. (See 
Figure 557.) 

2. Click OK to save the changes. 

Edit Fees 

Use the following steps to edit listed fees. 

1. Select the Fee to edit. (See Figure 557.) 

2. Click Edit. 

3. Make the appropriate changes on the Fees Setup dialog. (See Figure 558.) 

4. Click OK on the Fees Setup dialog. 

5. Click OK on the Fee Types dialog. 

Delete Fees 

Use the following steps to delete a listed fee. 

1. Select the Fee to delete. (See Figure 557.) 

2. Click Delete. 

Impound Types 

The Impound Types populate Tax and Insurance Impounds table on the Banker > Fees & 
Impounds screen. (See Fees & Impounds for details.) 
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Add Impounds 

Use the steps to add impounds to the Impounds Types dialog. 

1. Select Company Defaults from the Utilities menu. 

2. Select Impound Types. 

3. Click Add on the Impounds Types dialog. 

 

Figure 559: Impound Types Dialog 

4. Select the State from the dropdown list on the Impounds Setup dialog. 

 

Figure 560: Impounds Setup Dialog 
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5. Check the State checkbox if applicable. 

Note: The Count & City/Town dropdowns are only available when certain states are 
selected. 

6. Select the County from the dropdown when required. 

7. Enter the City/Town when required. 

8. Enter the Tax Collector Name. 

9. Select the Impound Description. 

10. Select the Disbursement Frequency. 

11. Select the Paid By party. 

12. Select the HUD Line #. 

13. Complete the Disbursement Dates fields. 

14. Select the Mark as Inactive checkbox to keep the impound from the Defaults List. 

15. Click OK on the Impounds Setup dialog. 

16. Repeat Steps 1 – 12 for additional impounds. 

17.  Click OK on the Impounds Types dialog when finished creating the Default 
Impound Types. (See Figure 559.) 

Sort Impound Types 

Sort the impound types to determine the order in which the conditions appear on Banker 
Fees & Impounds screen Tax and Insurance Impounds table. 

1. Click a column heading to sort the list in ascending order by that column. (See 
Figure 559.) 

2. Click OK to save the changes. 

Edit Impounds 

Use the following steps to edit a listed impound. 

1. Select the impound to edit. (See Figure 559.) 

2. Click Edit. 

3. Make the appropriate changes on the Impound Setup dialog. (See Figure 558.) 

4. Click OK on the Impound Setup dialog. 

5. Click OK on the Impound Types dialog. 
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Delete Impounds 

Use the following steps to delete a listed impound. 

1. Select the impound to delete. (See Figure 559.) 

2. Click Delete. 

Escrow Account Payments 

Use the Initial Escrow Account Setup dialog to calculate the escrow payments. The following 
calculations can be defined: 

• Three user-defined 

• Escrow for taxes 

• Hazard insurance 

• Mortgage insurance 

• Flood insurance 

• School taxes 

1. Click Company Defaults from the Utilities menu. 

2. Select Escrow Account. 

 

Figure 561: Initial Escrow Account Setup 

3. Select the cell corresponding to the month the payment is due and enter the 
number of months to be paid at that time for each payment type. 

4. Enter the number of months the Borrower must pay in the Cushion row if Borrower 
must pay some fees in advance to provide a reserve. 

5. Select the Exclude checkbox at the bottom of the Disbursement column to 
exclude a fee from the aggregate accounting. 
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6. Click OK. 

Docs Due In 

Use the Docs Due In option to set the default for the number of days after a due date a 
document is considered late. 

1. Select Company Defaults from the Utilities menu. 

2. Select Docs Due In. 

 

Figure 562: Docs Due In Dialog 

3. Enter the number of days after a document is requested before it is considered 
late. 

4. Click OK. 

Document Categories and Types 

Point provides default document categories and document types. Create new categories 
and types or modify existing to meet company requirements. 

Note: Refer to eLoan Document Management for additional information about document 
management, categories, and document types. 

Add Document Categories 

Use the following steps to new document categories. 

1. Select Company Defaults from the Utilities menu. 
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2. Select Document Categories/Types. 

 

Figure 563: Document Categories Dialog 

3. Click Add on the Document Categories dialog. 

4. Enter the new category name in the Category Name field. 

 

Figure 564: Document Types Dialog 

Note: Proceed to Add Document Types before clicking OK to add document types to the 
new category. 
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5. Click the X to close the Document Types dialog. 

6. Click OK on the Document Categories dialog. 

Edit Document Categories 

Use the following steps to rename an existing document category. (See Add Document 
Types to add document types to a category.) 

1. Select the category to edit. (See Figure 563.) 

2. Click Edit. 

3. Rename the category on the Document Types dialog. (See Figure 564.) 

4. Click the X to close the Document Types dialog. 

5. Click OK on the Document Categories dialog. 

Delete Document Categories 

Use the following steps to delete an existing document category. 

1. Select the category to delete. (See Figure 563.) 

2. Click Delete. 

3. Click Yes on the Delete Category prompt. 

4. Click OK on the Document Categories dialog. 

Add Document Types 

Use the following steps to add document types to document categories. Document types 
can only be included in one document category.  

1. Select the Document Category containing Document Type. (See Figure 563.) 

2. Click Edit. 

3. Click Edit on the Document Types dialog. (See Figure 564.) 

4. Enter the document Type Name on the Document Type dialog. 

 

Figure 565: Document Type Dialog 

5. Click OK. 
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6. Click the X to close the Document Types dialog. 

7. Click OK on the Document Categories dialog. 

Edit Document Types 

Use the following steps to edit existing document types. 

1. Select the Document Category containing Document Type to edit. (See Figure 
563.) 

2. Click Edit. 

3. Update the Category Name. 

4. Click OK. 

5. Click the X to close the Document Types dialog. 

6. Click OK on the Document Categories dialog. 

Delete Document Type 

Use the following steps to delete an existing category. 

1. Select the Document Category containing the Document Type to delete. (See 
Figure 563.) 

2. Click Delete. 

3. Click Yes on the Delete Category Confirmation. 

4. Click OK on the Document Categories dialog. 

5. Click the X to close the Document Types dialog. 

6. Click OK on the Document Categories dialog. 

Reset Default Document Categories 

Click the Reset to Defaults button on the Document Categories dialog to return the 
document categories and document types to the original settings received when Point was 
installed. 

Stacking Orders 

The Stacking Orders option specifies the document printing sequence in the Document 
Repository. Create the stacking order to avoid scrolling through the Document List to 
locate the required form. 

Note: Refer to eLoan Document Management for additional information about document 
management, categories, and document types. 
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New Stacking Orders 

Use the following steps to create a new stacking order. 

1. Select Company Defaults from the Utilities menu. 

2. Select Stacking Orders. 

3. Click New on the Stacking Orders dialog. 

 

Figure 566: Stacking Orders Dialog 

4. Enter the Stacking Name. 

 

Figure 567: Stacking Order Dialog 

5. Enter details in the Notes field. 
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6. Select a document from the Available Document Types list. 

7. Click Add. 

8. Repeat Steps 6 – 7 for remaining documents to add to the stack. 

9. Click OK on the Stacking Order dialog when complete. 

10. Click OK on the Stacking Orders dialog. 

Edit Stacking Orders 

Edit an existing document stack to change document order or to add/delete documents. 

1. Select the Stack to edit. (See Figure 566.) 

2. Click Edit. 

3. Rename the Stack if applicable. 

4. Add or remove Notes if applicable. 

5. Use the Add/Remove arrows to add or remove stacked documents from the 
Stacking Order. 

6. Use the Move Up/Down arrows to shift the document Stacking Order. 

7. Click OK on the Stacking Order dialog when complete. 

8. Click OK on the Stacking Orders dialog. 

Copy Stacking Orders 

Use the following steps to copy an existing document stack. 

1. Select the Stack to copy. (See Figure 566.) 

2. Click Copy. 

3. Use the steps in Edit Stacking Orders to edit the new stack. 

4. Click OK on the Stacking Order dialog when complete. 

5. Click OK on the Stacking Orders dialog. 

Delete Stacking Orders 

Use the following steps to delete an existing document stack. 

1. Select the Stack to delete. (See Figure 566.) 

2. Click Delete. 



   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
541 

Package Types 

Document packages are used to send loan documents to resources during the loan 
process. A default package list is provided. Package types are used to identify the package 
in which a document belongs. 

Note: Refer to eLoan Document Management for additional information about document 
management and packages. 

Add Package Types 

Use the following steps add a package type. 

1. Select Company Defaults from the Utilities menu. 

2. Select Package Types. 

 

Figure 568: Package Types Dialog 

3. Click Add. 

4. Enter the package Type Name. 

 

Figure 569: Package Type Dialog 

5.  Click OK on the Package Type dialog. 

6. Click OK on the Package Types dialog. 
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Edit Package Types 

Use the following steps to edit an existing package type. 

1. Select the package type to edit. (See Figure 568.) 

2. Use the Move Up/Down buttons to sort the packages order. 

3. Click Edit. 

4. Update the package Type Name. (See Figure 569.) 

5. Click OK on the Package Type dialog. 

6. Click OK on the Package Types dialog. 

Delete Package Types 

Use the followings steps to delete an existing package type. 

1. Select the package type to delete. (See Figure 568.) 

2. Click Delete. 

Reset Default Package Type 

Click the Reset to Defaults button on the Package Types dialog to return the types to the 
original settings received when Point was installed. 

Set Automatic Document Storage 

Use the Automatic Document Storage to enable automated storage for documents 
received from: 

• Lenders 

• Services 

• Interface 

1. Select Company Defaults from the Utilities menu. 

2. Select Automatic Document Storage. 

3. Clear the checkbox to disable automatic document storage. 

  

Figure 570: Automatic Document Storage 
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4. Verify the checkbox is selected to enable the automatic document storage. 

Warehouse Lenders 

Use the Warehouse Lenders option to enter lender information. The information populates 
the corresponding fields in the Banker Warehouse & Purchase Advice screen when the 
lender is selected from the Warehouse Lender dropdown. See Warehouse & Purchase 
Advice for details. 

Note: The Warehouse & Purchase Advice screen is used to track warehouse line aging and 
loan purchase by investors. 

Add Warehouse Lenders 

Use the following steps to add Warehouse Lenders to the list. 

1. Select Company Defaults from the Utilities menu. 

2. Select Warehouse Lenders. 

 

Figure 571: Warehouse Lenders Dialog 
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3. Click Add. 

 

Figure 572: Warehouse Lender Setup Dialog 

4. Enter the Lender Information. 

5. Enter Warehouse Lender Restrictions notes. 

6. Select the Mark as Inactive checkbox to retain the warehouse lender information 
but exclude the lender from the dropdown list on the Warehouse & Purchase 
Advice screen. (See Warehouse & Purchase Advice for details.) 

7. Select the appropriate Advance Rate checkbox. 

8. Select the Index Type from the dropdown when selecting the Use Variable Rate 
checkbox. 

9. Enter the Days on Line and Margin percentages when selecting the Use Variable 
Rate checkbox. 

Note: Days on Line and Margin percentages are not available when selecting the Use Fixed 
Rate checkbox. 

10. Enter the unique 9-digit warehouse lender routing number assigned by the 
American Banker Association in the ABA No field. 
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11. Enter the name of the financial services entity receiving the warehouse advance 
from the warehouse lender in the Credit to Name field. 

12. Enter the lender account number where the warehouse advance wired funds are 
deposited in the Account No field. 

13. Enter the name of the individual to notify when the warehouse lender funds 
deposited in the bank account in the To Attention of field. 

14. Enter the name of the individual authorized to sign on the lender account in the 
Authorized Signer field. 

15. Click OK on the Warehouse Lender Setup dialog. 

16. Click OK on the Warehouse Lenders dialog. 

Edit Warehouse Lenders 

Use the following steps to edit an existing warehouse lender. 

1. Select the warehouse lender to edit. (See Figure 571.) 

2. Click Edit. 

3. Make the appropriate changes in the Warehouse Lender Setup dialog. (See Figure 
572.) 

4. Click OK on the Warehouse Lender Setup dialog. 

5. Click OK on the Warehouse Lenders dialog. 

Delete Warehouse Lenders 

Use the following steps to delete an existing warehouse lender. 

1. Select the warehouse lender to delete. (See Figure 571.) 

2. Click Delete. 

3. Click OK on the Warehouse Lenders dialog. 

Investors 

Use the Investors option to add detailed information about investors that purchase closed 
loans. The investor information automatically populates in the Banker Shipping screen when 
an investor is selected on the Secondary Marketing, Underwriting, or Banker Shipping 
screens to avoid repetitive data entry. 

Add Investors 

Use the following steps to add investors. 
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1. Select Company Defaults from the Utilities menu. 

2. Select Investors. 

 

Figure 573: Investors Dialog 

3. Click Add. 

4. Enter the Investor Information on the Investor Setup dialog. 

  

Figure 574: Investor Setup Dialog 
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5. Select the Mark as Inactive checkbox to exclude the investor from the dropdown 
list on other screens. 

6. Enter loan File Delivery Information. 

7. Enter Note Delivery Information when different from File Delivery Information. 

8. Enter the servicer details in the Servicing Information section. 

9. Enter the Investor Loss Payee Information section. 

10. Click OK to close the Investor Setup dialog. 

11. Click OK to close the Investors dialog. 

Edit Investors 

Use the following steps to edit investor information. 

1. Select the investor to edit. (See Figure 573.) 

2. Click Edit. 

3. Make required changes in the Investor Setup dialog. 

4. Click OK to close the Investor Setup dialog. 

5. Click OK to close the Investors dialog. 

Delete Investors 

Use the following steps to delete an investor. 

1. Select the investor to delete. (See Figure 573.) 

2. Click Delete. 

3. Click OK to close the Investors dialog. 

Create Default Trailing Documents List 

The Trailing Documents option populates Trailing Documents on the Banker Trailing 
Documents screen. Establish a standard set of trailing documents for loan types added to 
the Trailing Documents list by clicking the Auto-Populate button in the Trailing Documents 
screen. 

Note: The auto-populate settings are predefined for each default trailing document. Use 
the Edit button in the Banker Trailing Documents screen to change the settings. 
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Add Trailing Documents 

Use the following steps to add Trailing Documents to the list created during the Point 
installation. 

1. Select Company Defaults from the Utilities menu. 

2. Select Trailing Documents. 

 

Figure 575: Trailing Documents Dialog 

3. Click Add. 

4. Enter the Trailing Document name. 

 

Figure 576: Trailing Document Setup Dialog 

5. Select the loan types that will include or exclude this document in the Default 
Trailing Documents list on the Banker Trailing Documents screen. (See Trailing 
Documents for details.) 

Note: Select the Select All checkbox to choose all loan types. 
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6. Click OK on the Trailing Document Setup dialog. 

7. Click OK on the Trailing Documents dialog. 

Edit Trailing Documents 

Use the following steps to edit trailing document loan types. 

1. Select the document to edit. (See Figure 575.) 

2. Click Edit. 

3. Make appropriate changes on the Trailing Document Setup dialog. (See Figure 
576.) 

4. Click OK on the Trailing Document Setup dialog. 

5. Click OK on the Trailing Documents dialog. 

Delete Trailing Documents 

Use the following steps to delete a listed trailing document. 

1. Select the document to delete. (See Figure 575.) 

2. Click Delete. 

3. Click OK on the Trailing Documents dialog. 

Dropdown Lists 

Use the Dropdown List options to create default dropdown lists to select from when 
completing the loan application. 

The following table contains the dropdown lists that can be set up in Point. 

Table 12: Available Dropdown Lists 

Originator Processor Underwriter 

Doc Prep Closer/Funder Shipper 

Adjustment Type Manner Title 

Branch Region Division 

Team Registration Doc Taxes 

Hazard Insurance Mortgage Insurance City Tax 

State Tax User-defined Cardex Category 
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Use the following steps to: 

• Add items to selected list 

• Edit items on the selected list 

• Delete items on the selected list 

Add List Items 

1. Select Dropdown Lists from the Utilities menu. 

2. Select the list to add items. 

 

Figure 577: List Dialog 

Note: The above graphic displays the Originator List option. 

3. Click Add on the List dialog. (See Figure 577.) 
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4. Complete the fields in the sub-dialog. 

 

Figure 578: Originator Information Dialog 

Note: The sub-dialog varies depending on the selected dropdown list. 

5. Click OK on the sub-dialog. 

6. Click OK on the List dialog 

Edit List Items 

Use the following steps to edit the selected list. 

1. Select the list item to edit. (See Figure 577.) 

2. Click Edit.  

3. Click OK on the sub-dialog. 

4. Click OK on the List dialog. 

Delete List Item 

Use the following steps to delete an item from the selected list. 

1. Select the list item to delete. (See Figure 577.) 

2. Click Delete.  

3. Click OK on the List dialog. 
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Create Escrow and Title Tables 

Use the Escrow tables and Title tables options to create tables for standard escrow and 
title fees. The tables are accessed by clicking the Table button in the Title Charges section 
on the Fees Worksheet. See Fees Worksheet for details. 

Escrow Tables 

Create Escrow Table 

Use the following steps to create Escrow tables. 

1. Select Escrow Tables from the Utilities menu. 

2. Select Purchase. 

Note: Select Refinance to create an Escrow Refinance table. 

 

Figure 579: Escrow Purchase Dialog 

3. Click the Add. 
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4. Enter a Table Name to override the default table name. 

 

Figure 580: Table Dialog 

Note: Tables are numbered automatically when they are created. 

5. Select one of the following fee calculations from the Based On dropdown list: 

• Sales Price: Fees are calculated based on the property sale price 

• Loan Amount: Fees are calculated based on the loan amount 

• Appraisal Val: Fees are calculated based on the property appraised value 

6. Select the Round Up or Round Down radio button. 

7. Enter a value in the To nearest $ field. 

8. Enter the offset amount in the Offset field o offset the amount by a specific value. 

Add Fee Range 

The fees are calculated cumulatively (the base fee from each previous tier is added to the 
total fees). Subtract the previous tier base fee from the base fee of the tier currently being 
added to determine the amount to enter in the Base field when entering multiple-tiered 
fees. 

Example: Enter $250 in the Base field if the base fee for the first tier of a fee structure is 
$250 for a sales price of up to $250,000. Subtract the first-tier base fee ($250) from the 
second-tier base fee ($500) and enter the result ($250) in the Base field if the second-tier 
base fee is $500 for a sales price between $250,001 and $500,000. 
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1. Click Add on the Table dialog. (See Figure 580.) 

 

Figure 581: Add Range Dialog 

2. Enter the maximum tier amount for selected Based On option in the Up to field. 

3. Enter the base fee for the tier in the Base field. 

4. Enter the fee percentage for the tier in the Factor field. 

Note: The fee percentage must be entered in decimal format. 

5. Click OK after the fee tier is entered. 

6. Repeat Steps 2 – 5 for additional tiers. 

7. Click OK on the Table dialog when the fee tiers are complete. 

The completed fee table looks like the following figure based on the example: 

 

Figure 582: Fee Table 

Note: The escrow fee value is not calculated when a sales, loan, or appraisal amount not 
defined in one of the tiers is entered in the loan application. 
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Edit Escrow Table 

Use the following steps to edit a Purchase or Refinance Escrow table. 

1. Select Escrow Tables from the Utilities menu. 

2. Select Purchase. 

3. Select the table to edit. 

 

Figure 583: Escrow: Refinance Dialog 

4. Click Edit. 

5. Make appropriate changes on the Table dialog. 

 

Figure 584: Edit Refinance Table 

6. Click Add to add another fee tier. 

Note: Select a fee tier and click Delete to remove the tier. 
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7. Click OK. 

8. Click Set as Default on the to make the selected table the default. 

9. Click OK to save. 

Note: Click Delete to delete the highlighted table. 

Title Tables 

Three Title table types are available: 

• Lender’s Policy Purchase 

• Lender’s Policy Refinance 

• Owner’s Policy 

1. Select Title Tables from the Utilities menu. 

2. Select the Title table type to create or modify. 

3. Use the steps in Create Escrow Table to create the Title tables. 

Enable/Disable Lenders 

Use the following steps to enable and disable direct connection from Point to lender 
interfaces. 

1. Select Enable/Disable Lenders from the Utilities menu. 

2. Select the Enable lender interfaces checkbox to allow the connection between 
Point and lender interfaces. 

 

Figure 585: Lenders in Point Dialog 
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3. Select the Lenders checkboxes to enable the connection. 

Note: Click Select All to enable connections to all listed lenders. Click Deselect All to clear 
all checkboxes. 

4. Click OK to save. 

Enable/Disable Services 

Use the following steps to enable and disable provider services. The following services are 
available in Point: 

• AVM: Automated Valuation Model 

• Credit 

• Documents 

• Flood 

• Title 

1. Select Enable/Disable Services from the Utilities menu. 

2. Select the Service to enable/disable providers. 

 

Figure 586: AVM in Services Dialog 

Note: Services dialogs vary, but the steps for enabling/disabling are the same. 
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3. Select the Providers checkboxes to enable the service. 

Note: Click Select All to select all providers. Click Deselect All to clear all checkboxes. 

4. Click OK to save. 

5. Repeat Steps 3 – 5 for all services. 

Enable/Disable Interface Venders 

Use the following steps to enable and disable Point to vendor interfaces. 

1. Select Enable/Disable Interface Vendors from the Utilities menu. 

2. Select the appropriate Interface Category from the dropdown. 

 

Figure 587: Enable/Disable Interface Vendors 

3. Select the appropriate Interface options checkbox(es). 

Note: Click Select All to select all options. Click Deselect All to clear all checkboxes. 

4. Repeat Steps 3 – 4 for required services. 

5. Click OK to save. 
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Fannie Mae Connectivity 

Use the following steps to select the Fannie Mae Connectivity options. 

1. Select Fannie Mae Connectivity from the Utilities menu. 

2. Select the appropriate Connect to radio button. 

 

Figure 588: Fannie Mae Connectivity Dialog 

3. Select the appropriate DO/DU checkboxes. 

4. Select the Do not check for underwriting errors checkbox to skip checking for 
underwriting errors. 

5. Enter the Fannie Mae User ID. 

6. Enter the Fannie Mae Password. 

7. Enter the Fannie Mae Institution ID. 

8. Click OK to save. 

Fannie Mae EarlyCheck Connectivity 

Use the following steps to select the Fannie Me EarlyCheck Connectivity options. 

1. Select Fannie Mae EarlyCheck Connectivity from the Utilities menu. 
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2. Enter the Fannie Mae EarlyCheck User ID. 

 

Figure 589: Fannie Mae EarlyCheck Dialog 

3. Enter the Fannie Mae EarlyCheck Password. 

4. Enter the Fannie Mae EarlyCheck Institution ID. 

5. Click OK to save. 

HMDA Loan App Register Information 

Use the following steps to enter the HMDA Loan Application Register Information. 

1. Select HMDA Loan App Registration Information from the Utilities menu. 
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2. Enter Company Information. 

 

Figure 590: HMDA Loan App Registration 

3. Enter Contact Person Information. 

4. Enter the Activity Year to report. 

5. Select the Exempt checkbox if applicable. 

6. Select Use Non Universal Loan Identifier checkbox if applicable. 

7. Click OK to save. 

TMS Connection 

Use the TMS Connection Setup options to set up the Transaction Management Server 
(TMS) connection for sending and receiving information to and from third party vendors. 

Note: The TMS connection is a proxy server. 

1. Select TMS Connection Setup from the Utilities menu. 
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2. Select the Use a Proxy Server checkbox to enable the dialog fields. 

 

Figure 591: TMS Connection Dialog 

3. Enter the IP Address and Port. 

4. Enter the proxy server User ID. 

5. Enter the proxy server Password. 

6. Enter the proxy server Domain. 

7. Click OK to save. 

Uniform Collateral Data Portal Setup 

Use the following steps to select the Uniform Collateral Data Portal (UCDP) options. 

1. Select Uniform Collateral Data Portal from the Utilities menu. 
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2. Enter Fannie Seller No. (Fannie Seller Number). 

 

Figure 592: UCDP Dialog 

3. Enter the Freddie Seller No. 

4. Enter the Business Unit #. 

5. Enter the User ID. 

6. Enter the Password. 

7. Click OK to save. 

Zip/WebCaster Preferences 

Use the following steps to set up the Zip and WebCaster preferences. The selected 
preferences indicate how Point interacts with the selected online application. 

Note: Only one option may be selected. 

Zip Preferences 

Use the following steps when selecting ZIP. 

1. Select Zip/WebCaster Preferences from the Utilities menu. 
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2. Select the Zip radio button. 

 

Figure 593: Zip Preferences 

3. Complete the Administration Login Information. 

4. Select the appropriate Notification Instructions. 

5. Enter the frequency at which Point should check for loan applications. 

6. Select the appropriate Loan Application Download Instructions checkbox to set 
the notification frequency. 

7. Select the appropriate Default Destination Folder. 

8. Select the Default Naming Option. 

9. Select the Default File Type. 

10. Select the Proxy Server checkbox to use a proxy server. 

11. Enter the Proxy Server details. 

12. Click OK to save. 

WebCaster Preferences 

1. Select Zip/WebCaster Preferences from the Utilities menu. 
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2. Select the WebCaster radio button. 

 

Figure 594: Zip Preferences 

3. Enter the WebCaster Administration Login Information. 

4. Select the appropriate Notification Instructions. 

5. Enter the frequency at which Point should check for loan applications. 

6. Select the appropriate Default Destination Folder. 

7. Select the Default Naming Option. 

8. Select the Default File Type. 

9. Select the Proxy Server checkbox to use a proxy server. 

10. Enter the Proxy Server details. 

11. Select the Display menus for loan status update if applicable. 

12. Enter the Loan Status Password. 

13. Enter the Loan Application Login details. 

14. Click OK. 
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Mobile Access 

Use the Mobile Access utility to enable Point for mobile. The setup may be completed 
individually by each user on a personal computer, or by the Point Administrator on a single 
computer functioning as the mobile server for an entire group. 

Note: This option is disabled for Point Central users. 

The following are required before mobile access can be enabled in Point and the mobile 
featured used: 

• Obtain Point mobile login credentials. 

• Mobile user account must be created in MyCalyx. 

• New users receive a unique activation ID which identifies the user as a mobile user. 

• Connection ID has been received and identifies the computer where the connection 
is enabled. 

• Computer to be used as a server is enabled. 

• Borrower auto file naming is required for Point mobile users to save new loan files 
from their mobile devices. 

The following information displays in the Defined Users List on the Mobile Access 
Configuration dialog when a user activates the mobile device: 

• Point username for each device displays in the User Name column. 

• Activation key associated with the user mobile device displays in the Device column. 

Note: See Auto File Naming for setting the auto file naming. 

  



   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
567 

1. Select Mobile Access from the Utilities menu. 

 

Figure 595: Mobile Access Configuration 

2. Select the Enable Point for Mobile Access checkbox. 

3. Change the default lock expiration time if applicable. 

Note: The lock expiration time is the amount of time the file remains idle checked out 
before locking user access. 

4. Click Email Connection ID to email the Connection ID. 

Note: The ID is required to access Point from a mobile device for the first time. An outgoing 
email message with the Connection ID in the body is opened in the default email 
application. 

5. Enter the Email Addresses of the recipients using the computer as their mobile 
server. 

6. Click to Send to send the email. 

7. Click OK to activate the cloud connectivity. 

Search/Display Settings 

Use the following steps to select how search results are displayed when searches are 
performed on the Navigation panel. 
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Access Search/Display Settings/Pipeline 

The following options are available from the Search/Display Settings/Pipeline Options 
dialog: 

• Search Loan Settings 

• Auto Display Options 

• Extended Search Options 

• Pipelines 

1. Select Search Display Settings from the Utilities menu. 

2. Select the appropriate link to continue. 

 

Figure 596: Search/Display Settings/Pipeline 

• Search Loan Settings 

• Auto Display Options 

• Extended Search Options 

• Pipelines 

Search Loan Settings 

Use the Search Loan Settings tab to select fields included in the search results and the 
order in which the fields are listed on the Loan Search Results screen. 

1. Access the Search/Display Settings/Pipeline Options dialog. (See Access 
Search/Display Settings/Pipeline.) 

2. Select the Search Loans Settings tab. (See Figure 596.) 

3. Select a field from the Show these fields in this order list. 
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4. Click Remove to make the field unsearchable. 

5. Repeat Steps 3 – 4 for additional fields to make unsearchable. 

6. Use the Move Up/Down buttons to change the Search Results display order. 

7. Click Use Defaults to return the search results to the installed default settings. 

8. Proceed to Auto Display Options. 

Note: Click OK to save and close the dialog when completed with the Search/Display 
Settings/Pipeline options. 

Auto Display Options 

Use the following steps to set the Auto Display options. 

Note: Performance may be impacted when the refresh options are enabled and using Point 
Central. Disable the Refresh option on Point clients to avoid response time problems. 

1. Access the Search/Display Settings/Pipeline Options dialog. (See Access 
Search/Display Settings/Pipeline.) 

2. Select the Search Auto Display Options tab. 

 

Figure 597: Auto Display Options Tab 

3. Select the Never or Always refresh for latest results radio buttons appropriately. 

4. Select Off or Search for all records appropriately in the Cardex Default Search 
section. 

5. Proceed to Extended Search Options. 

Note: Click OK to save and close the dialog when completed with the Search/Display 
Settings/Pipeline options. 
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Extended Search Options 

Use the following steps for selected extended Search options. 

1. Access the Search/Display Settings/Pipeline Options dialog. (See Access 
Search/Display Settings/Pipeline.) 

2. Select the Extended Search Options tab. 

3. Select the data folders where the search is performed. 

4. Click Select All to select all data folders. 

5. Click Deselect All to remove all folders. 

6. Proceed to Pipelines. 

Note: Click OK to save and close the dialog when completed with the Search/Display 
Settings/Pipeline options. 

Pipelines 

Folders selected on the Pipelines tab are removed from the Extended Search Options tab. 
The options are reinstated in the Extended Search Options tab if pipeline indexing is 
removed. 

Use the following steps to define the data folders included in the pipeline indexing.  

1. Access the Search/Display Settings/Pipeline Options dialog. (See Access 
Search/Display Settings/Pipeline.) 
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2. Select the Pipelines tab. 

 

Figure 598: Pipelines Tab 

3. Select the Data Folders checkboxes to include in the pipeline indexing. 

4. Click Select All to select all data folders. 

5. Click Deselect All to remove all folders. 

Custom Screen Settings 

Use the Custom Screen Settings option to create company-specific fields not included in 
Point. It is possible to create up to four customized screens that can contain up to 25 fields 
of information on each screen. 

1. Select Custom Screen Settings from the Utilities menus. 
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2. Select the Custom Screen to be created or edited from the dropdown. 

  

Figure 599: Custom Screen Settings Dialog 

3. Enter a Screen Name. 

4. Select Field 1 from the list. 

5. Enter a Field Name. 

6. Select the Field Type from the dropdown. 

 
Figure 600: Field Type 

Note: Select Disabled from the dropdown list to create a title for the form or a section 
heading that does not have a data entry field. 

7. Select Dropdown List and enter the list items in the Dropdown field to create a 
dropdown list. 

8. Repeat the steps above for any additional fields to include in the screen. 
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9. Click OK. 

Note: Open a prospect or Borrower file and select Custom Screens from the Forms menu 
to access custom screens. 

Customize Shortcut Toolbar 

Use the following steps to customize the Shortcut toolbar. 

1. Select Customize Shortcut Toolbar from the Utilities menu. 

2. Select the File Type for toolbar arrangement from the dropdown. 

 

Figure 601: Setup Shortcut Bar Dialog 

3. Select the Form to move. 

4. Click the List Layout buttons to move the form to the appropriate list location. 

5. Select the Smart List checkbox to place the most-recently accessed forms at the 
top of the list. 

6. Select the Show Scrollbar checkbox to include a scroll bar in the list. 

7. Click Sort List checkbox to sort the list alphabetically. 

8. Click Load Default to restore the original default settings. 

9. Click OK to save. 
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Screen Colors 

Use the Screen Colors options to customize the Point interface with different colors. 

1. Select Screen Colors from the Utilities menu. 

2. Click Title to select the title color from the Palette. 

 

Figure 602: Screen Colors Dialog 

3. Click Label to select the label color from the Palette. 

4. Click the Selected Fld/Btn/Box to select the color for selected fields, buttons, 
and checkboxes. 

5. Click Selected Fld Data to select the color for selected field data. 

6. Click Use Default Colors to restore to the original default colors. 

7. Enter title for the selected options in the Label 1 field. 

8. Repeat Steps 3 – 6 to set up another set up colors. 

9. Enter title for the selected options in the Label 2 field. 

10. Select the appropriate Radio Box button. 

11. Select the appropriate Checkbox. 

12. Click OK. 

Web Browser 

Use the Web Browser option to select the default web browser for Point. 

1. Select Web Browser from the Utilities menu. 
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2. Click Browse to navigate to the web browser executable file. 

 

Figure 603: Find a Web Browser Dialog 

3. Select the file. 

4. Click OK. 

Auto File Naming 

Use the Auto File Naming option to enable automatic file naming and specifies the 
parameters Point uses when the option is enabled. Auto File Naming must be enabled to 
import batch files into Point. 

Borrower auto file naming is required for Point mobile users to save new loan files from 
mobile devices. 

Note: Assigning automatic names to files prevents the accidental overwriting of filenames. 
Different parameters can be specified for Borrower and prospect files. 

1. Select Auto File Naming from the Utilities menu. 

2. Select Prospect to set auto naming for prospect files. 

 

Figure 604: Borrower Auto File Naming Dialog 

3. Select the Enable Auto File Naming checkbox. 

4. Select the Use Prefix checkbox. 

5. Enter a numeric prefix of up to 10 characters. 
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6. Select the corresponding checkbox for Year, Month, and Day to use the date or 
partial date in the file name. 

7. Select 1-digit, 2-digit, or 4-digit to specify the format for the year and month. 

8. Select the number of digits to append to the file name from the Counter dropdown 
list to enable Auto File Naming to function properly. 

Note: The file name cannot exceed ten characters to generate automatic Mortgage 
Electronics Registration (MERS) Mortgage Identification Number (MIN) Numbers for the file. 
See Auto MIN Generation for details. 

9. Click OK. 

Auto Save 

The Auto Save option saves the currently opened file when: 

• A change is made. 

• Switching between screens. 

• Prior to printing. 

Note: Enabling this feature removes the ability to abandon changes to the file made in error. 

1. Select Auto Save from the Utilities menu. 

2. Select Yes to enable Auto Save. 

 

Figure 605: Auto Save Dialog 

3. Click OK.  

Auto MIN Generation 

Use the Auto MIN Generation option to automatically generate the MIN. 

1. Select Auto MIN Generation from the Utilities menu. 
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2. Select the Automatically generate MIN checkbox. 

 

Figure 606: MERS Mortgage ID Setting 

3. Enter the 7-digit Organizational Identification Number. 

4. Click OK. 

Zip Code Options 

Use the Zip Code options to enable auto-filling of City and State fields based on the 
entered Zip Code. 

1. Select Zip Code Options from the Utilities menu. 

2. Select the Automatically fill checkbox to enable the auto fill option. 

 

Figure 607: Zip Code Options Dialog 

3. Select the Use All Cap checkbox if applicable. 

4. Click OK. 



   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
578 

Enable Field Pop Up Help 

The field Pop Up Help displays when F1 is pressed when the cursor is placed in a field. 

Select Enable Field Pop Up Help from the Utilities menu to turn the option on and off. 

Display Field ID 

Field IDs are used to: 

• Import and export data 

• Create custom forms 

• Create report templates 

Point includes a Microsoft Excel file containing a comprehensive list of field IDs and the 
screens where they are, in addition to using the Utilities functions to identify field IDs. 

Note: The Field ID Directory spreadsheet is stored in the C:/WINPOINT directory with the 
file name FieldID.xls. 

Select the Display Field ID from the Utilities menu to display field IDs when the cursor 
hovers over the field. 

Load Field ID 

Use the following steps to load the field IDs into the fields of an empty Borrower or 
prospect file. 

1. Select Load Field ID from the Utilities menu. 

2. Close and reopen the Borrower file after saving any necessary changes to return to 
the field values. 
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Chapter 15: LOAN SCENARIOS 
The following sections discuss some specific loan scenarios. 

Select a link to continue: 

Subordinate Financing 

Construction Loans 

Investment Loans 

Subordinate Financing 

The following information assists with proper calculations when processing a loan with a 
second mortgage. Information includes processing the following types of second 
mortgages: 

• Primary homes. 

• New first mortgages with new or existing second mortgages. 

• Second or equity line mortgages on investment or second home properties. 

Standalone Second Mortgage 

A standalone second mortgage is a second mortgage not used for the specific purpose of 
buying a property. 

1. Open a borrower file. 

2. Click Primary as the property type and Second Mtg to indicate the second lien 
position from the Loan Summary section on the Borrower Information screen. 

 

Figure 608: Borrower Information Loan Summary 

3. Complete the following fields: 

• Appr Val 
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• Loan Amt 

• Note Rate 

• Term/Due 

4. Leave the Sales Price field blank. 

5. Click the Sub Financing button to enter the existing first mortgage balance in the 
Subordinate Financing Information dialog. 

 
Figure 609: Subordinate Financing Information 

6. For the 4b. Other New Mortgage Loans section, click on the Add button to add new 
3rd and 4th mortgage loans (if applicable). 

Note: Adding loans to the 4b. Other New Mortgage Loans will populate the same 4b. table in 
Loan Application-section 4. 

7. Click OK. 

8. Click HE & Oblig 

9. Enter the first mortgage payments. 

Note: The amount of the second is already populated in the Other Fin field. Both amounts 
populate throughout the screens in Point. 

Create New from Existing Mortgage 

1. Open a borrower file. 
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2. Click Primary as the property type and First Mtg from the Loan Summary section 
on the Borrower Information screen. 

3. Select Cash-Out Refi or No Cash-Out Refi as the purpose of the loan. (See Figure 
608.) 

4. Click the Sub Financing button at the bottom of the workspace. 

5. Click the 2nd Mtg button.  

6. Enter the information about the second mortgage and click OK. 

7. Click the Sub Financing button. 

8. Select the appropriate Create Second Mortgage File option. 

9. Enter the 2nd Mtg Amount. 

 

Figure 610: Create & Link to New Second Mtg 

Note: Select Link to Existing Second Mortgage from the menu to link to an existing file. 

6. Unselect the Use Auto File Naming checkbox and name the file if applicable. 

7. Click Save on the Create and Link to New Second Mortgage dialog. 

8. Click Yes on the Second Mortgage File Created Successfully dialog to immediately 
open the file. 

9. Click OK on the Sub Financing dialog to close. 

Investment or Second Home 2nd Mortgage 

Use the following steps to create a second mortgage for an investment property or second 
home. 
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1. Open a borrower file and click Investment as the property type and Second Mtg 
as the lien position from the Borrower Information screen. (See Figure 608.) 

2. Enter the applicable values for the property in the Gross Rent and Occ Rate fields 
the property type. 

3. Complete the following fields: 

• Appr Val 

• Loan Amt 

• Note Rate 

4. Complete the Expenses section. 

5. Enter the first mortgage payment in the First Mtg field. 

Note: The amount of the second is already populated in the Other Fin field. Both values are 
also populated in other screens containing these fields 

6. Click the following buttons to calculate the fees: 

• HazIns 

• Taxes 

• Mtg Ins 

7. Enter the Homeowner Association dues. 

8. Enter any other expenses in the Other field. 

9. Click the Sub Financing button to open the Subordinate Financing Information 
dialog. 

10. Enter the amount of the first mortgage. 

11. Enter other mortgage payments in the Other Financing Information section. 

12. Click OK. 

13. Enter the present mortgage payment for the borrower primary residence and 
additional costs in the Present Monthly Housing Expense section of the Loan 
Application. 

Create Concurrent Purchase Loans 

The first loan is usually for 80% of the value of the home, the second loan is for 10%, and the 
remaining 10% is the buyer’s down payment when using a first and second loan for a 
purchase. 

The down payment includes the second mortgage loan amount combined with the down 
payment. It does not show on the Loan Application. The monthly payment calculates in the 
HE & Oblig field and transfers to the Proposed Monthly Housing Expenses section on page 
2 of the Loan Application. 
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Create First Loan 

1. Create a new prospect or borrower file. 

Note: This example uses a 20% down payment and the LTV and the CLTV fields both show 
80%. 

2. Enter the Borrower and Co-Borrower information. 

3. Select the following In the Loan Type section: 

• Conventional 

• Primary as the property type 

• First Mtg as the lien position 

4. Enter information for the first mortgage in the following fields: 

• Sales Price 

• Appr Value 

• Loan Amt 

• Note Rate 

• Term/Due fields 

5. Click the Sub Financing button to open the Subordinate Financing Information 
dialog. 

Note: The New First Mortgage field is not enabled if the open file is the first lien file. The 
Closing Costs from New Second Mortgage field is enabled. The Closing Costs from New 
Second Mortgage field is automatically populated when the new second mortgage is 
created and the closing costs are entered to match the following fields: 

• Cash From/To Bor in the Cash-to-Close screen. 

• Total Estimated Funds to Close field on the Fees Worksheet 

6. Click the 2nd Mtg button to open the Second Mortgage Payment dialog. (See Figure 
610.) 

7. Complete the following fields for the second mortgage: 

• Loan Amount 

• Note Rate 

• Qual Rate 

• Term/Due 

• Interest Only 

8. Click OK (assuming Appraisal Value and Sale Price are the same). 
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Note: The amount automatically populates the Other Fin field in the Monthly Income and 
Combined Housing Expense Information section on the Loan Application. The value in the 
LTV field is still 80%, but the value in the CLTV field is now 90%. 

9. Open page 2 of the Loan Application and complete the following information: 

• Click HazIns to enter the hazard insurance rate in the Hazard Insurance dialog or 
check the lock box to enter a custom value 

• Click Taxes to enter any tax rates for the property or check the Lock to enter a 
custom value 

• Click Mtg Ins to enter the mortgage insurance information for the subject 
property and click OK in the Mortgage Insurance dialog or check the Lock to 
enter a custom value 

10. Open the Fees Worksheet and enter the fees for the First Loan. 

11. Open the Cash-to-Close screen and complete the following information: 

• Verify field J. Subordinate Financing contains the second mortgage loan amount 
• Enter any other fees and credits in the line l fields 

12. Save the file. 

Create Second Loan 

1. Select Subordinate Financing from the File menu. 

2. Select Create New Second Mortgage. 

3. Enter a file name If Auto File Naming is not enabled. 

4. Click Save. 

5. Click Yes to open the second mortgage file. 

6. Verify the following information on the Borrower Information screen. 

Table 13: 2nd Loan Concurrent Purchase Loans 

Field Value 

Lien Pos Second 

Sales Price Same sales price included on the first 
mortgage file 

Down Pmt 90% 

This down payment percentage is not included 
on the Loan Application screen. 
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Field Value 

Appr Value Same appraised value included in the first 
mortgage file. 

Loan Amt Second mortgage amount (10% of the sales 
price). 

Note Rate Rate for the second mortgage. 

Term/Due The Term/Due. 

Mth Pmt Second mortgage monthly payment. 

7. Open page 2 of the Loan Application and verify the values in the Proposed 
Monthly Housing Expenses, including the First Mtg, Other Fin, HazIns, Taxes and 
other fee fields match the values in the first mortgage file. 

8. Open the Cash-to-Close screen and verify the following information: 

Table 14: Page 4 Concurrent Purchase Loans 

Field Value 

Purchase Price (a) Same as the 1st mortgage file 

Subordinate financing (j) Blank 

For Sub Financing Only section 

(This section applies only to the closing costs from the new first mortgage) 

New First Mortgage First mortgage loan amount. 

Closing Costs from New First Mortgage Sum of costs from the first mortgage. 

The sum in the Closing Cost box is the 
total of prepaids, closing costs, 
I/MIP/Funding Fee, Discount, minus 
Closing Cost paid by Seller and PMI/MI 
financed. 

Loan Amt, excl. fee financed (m) Second mortgage amount. 

Loan Amount (o) The total second mortgage amount (m 
+ n). 

Cash from/to Bor (p) Funds the borrower will pay or receive. 
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9. Open the Fees Worksheet and enter any fees for the second loan. 

10. Open the Cash-to-Close screen and enter any other fees on line l. 

11. Save the file. 

Create Concurrent Investment Loan 

Use the sample information provided to complete a concurrent loan for an investment 
property. 

Note: The closing costs for the first loan transfer to the Closing Costs from New First 
Mortgage field on the Fees Worksheet for the second loan.  

Create First Loan 

1. Create a new prospect or borrower file and complete the following information in 
the Borrower Information screen in the Loan Type section: 

• Select Conventional. 
• Select Investment as the property type. 
• Select First Mtg as the lien position. 

2. Enter the Gross Rent. 

3. Enter Occ Rate. 

4. Enter the first mortgage information in the following fields: 

• Sales Price 

• Appr Value 

• Loan Amt 

• Interest Rate 

• Term/Due 

5. Enter 20% in the Down pmt field. 

Note: The LTV and the CLTV fields should both contain 80%. 

6. Click the Sub Financing button to open the Subordinate Financing Information 
dialog. 

7. Enter 10% of the sales price in the 2nd Mortgage field. 

8. Click OK. 

Note: The amount automatically populates the Other Fin field in the Monthly Income and 
Combined House Expense Information section on page 2 of the Loan Application. The 
value in the LTV field is still 80%, but the value in the CLTV field is 90%. 

9. Open page 2 of the Loan Application. 
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10. Click the Other Fin button in the Monthly Income and Combined House Expense 
Information section to open the Second Mortgage Payment dialog. 

11. Enter the Note Rate, Qual Rate, and Term/Due for the second mortgage. 

12. Click OK 

13. Complete the hazard insurance, taxes, and mortgage insurance information. 

Note: The amount in the Total Housing Exp field represents the Principal, Interest, Tax and 
Insurance (PITI) of the subject property. The amount in the Net Rental Income field equals 
the Gross Rent amount times the Occ Rate, minus the PITI. The Net Rental field displays 
the net rental income. The Net Rental Income populates the 1008 Transmittal Summary if 
the Net Rental Income amount is positive. The Net Rental Income amount populates the 
1008 Transmittal Summary’s Neg Cash Flow box if negative. 

14. Open the Cash-to-Close screen and verify that the Subordinate Financing field 
(labeled J) contains the second mortgage loan amount. 

15. Open the Fees Worksheet and enter the fees for the first loan. 

16. Open an complete the Cash-to-Close screen. 

17. Do NOT check Closing Costs Paid by Seller in the second mortgage file. 

Create Second Loan 

1. Select File > Subordinate Financing > Create New Second Mortgage from any 
screen in the first loan file. 

2. Enter a file name if Auto File Naming is not enabled. 

3. Click Save. 

4. Click Yes to open the second mortgage file. 

Note: A new file is opened that contains the information for the concurrent second 
mortgage. The navigation panel contains two buttons to toggle back and forth between the 
two linked loans. 
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5. Verify the following information on the Borrower Information screen. 

Table 15: Concurrent Purchase Investment 

Field Value 

Purchase Price (a) Same as the 1st mortgage file 

Subordinate financing (j) Blank 

For Sub Financing Only section 

New First Mortgage First mortgage loan amount 

Closing Costs from New First 

Mortgage 

Sum of costs from the first mortgage. 

The sum in the Closing Cost box equals 
prepaids, plus closing cost, plus 
PMI/MIP/Funding Fee, plus Discount, 
minus Closing Cost paid by Seller and 
PMI/MI financed. 

Loan Amt, excl. fee financed 

(m) 

Second mortgage amount 

Loan Amount (o) The total second mortgage amount (m + n). 

6. Open page 2 of the Loan Application and verify the Proposed Monthly Housing 
Expenses, including the First Mtg, Other Fin, HazIns, Taxes and other fee fields, 
match the values in the first mortgage file. 

7. Verify information in the Cash-to-Close screen. 

Construction Loans 

Three types of construction loans are supported in Point: 

• Construction 
• Construction-to-permanent 
• Construction with Required Reserve 

Construction loans do not include a payment schedule on the printed Truth-in-Lending 
Disclosure form based on the terms entered. 

The loans state “Repayment: One payment of principal of [the entire loan amount] on 
[the end of the amortization period specified]”. 

Refer to Subpart E (Special Rules for Certain Home Mortgage Transactions) on the Reg. Z 
for additional information. 
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The Truth-In-Lending Disclosure reflects the construction loan terms completing the Loan 
Application. 

Create Construction Loan 

Complete the Loan Application as other loans. The following exceptions apply to all 
construction loans. 

1. Select either the Construction or Construction – Permanent checkbox on the 
Borrower Information screen. 

2. Complete the following fields for the loan: 

• Sales Price 

• Appr Value 

• Loan Amt 

• Note Rate 

• Term/Due 

Note: The transaction and the associated fields in the loan file are -processed as a purchase 
if a value is entered in the Land field in the Cash-to-Close screen. The loan is processed as 
a non-purchase loan if 0 is entered or the field is left empty. 

3. Select the Customize checkbox on the Truth-In -Lending Disclosure to indicate 
draws in the payment schedule and enter the information there. 

4. Click the Calculate button again. 

5. Open page 1 of the Loan Application and complete the If Construction Loan 
section. 

6. Enter the Estimated Construction Duration, in months, in the Period field. 

7. Enter the interest rate and required reserves In the Int Rate and Req Rsv fields if 
the values are known. 

8. Complete the Yr Aqd (year acquired), Original Cost, Existing Lien, Lot Value (a), and 
Impvmts (b) (Improvements) fields. 

Note: The Total (a+b) is calculated with these figures 

9. Select the Include MI during the Construction Period checkbox to include 
mortgage insurance in the construction phase of the payment schedule 

10. Select the Include Escrow during the Construction Period checkbox to include 
the calculated escrow amount in the construction phase of the payment schedule 

11. Open the Fees Worksheet and enter the loan fees. 

12. Open the Truth-In-Lending screen and complete the Date Prepared and the 1st 
Pmt Date fields. 
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13. Click Calculate. 

Construction-to-Permanent Loan 

Complete the Loan Application as other loans. The following exceptions apply for 
construction-to-permanent loans 

1. Open page 1 of the Loan Application. 

2. Enter the loan term in months after the construction is complete in the Term mths 
field in the Type of Mortgage and Terms of Loan section. 

Example: Enter 360 for a 30 -year term. Do not include the construction period as part of 
the term. 

3. Select the Construction–Permanent checkbox in the Purpose of Loan section. 

4. Enter the estimated construction duration, in months, in the Period field in the If 
Construction Loan section. 

5. Enter the amount of the reserve in the Req Rsv field if the loan requires a reserve. 

Note: Leave the field blank if a reserve is not required. 

Construction Loan Required Reserves 

Complete the Loan Application as other loans. The following exceptions apply for 
construction loans requiring reserves. 

Note: Required reserves increase the APR calculation. 

1. Open page 1 of the Loan Application. 

2. enter the loan term in months after the construction is complete in the Term mths 
field in the Type of Mortgage and Terms of Loan section. 

Example: Enter 360 for a 30 -year term. Do not include the construction period as part of 
the term. 

3. Select the Construction checkbox in the Purpose of Loan section. 

4. Enter the estimated construction duration, in months, in the Period field If 
Construction Loan section. 

5. Enter the amount of the required reserve in the Req Rsv field. 

Investment Loans 

Use the following steps to complete a loan for investment property: 

1. Create a new borrower fil. 
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2. Complete the Borrower Information screen as normal with the following 
exceptions: 

3. Select Investment in the Purpose of Loan section. 

4. Enter the applicable values for the property in the Gross Rent and Occ Rate fields. 

5. Complete the Sales Price, Loan Amt, Note Rate, and Term/Due fields. 

6. Complete the Appr Value field if the loan is a refinance and leave the Sales Price 
field blank. 

Note: The Net Rent amount transfers to the Pos Cash Flow (Subj Property) field or Neg 
Cash Flow (Subj Prop) in the Underwriting section in the Transmittal Summary (1008). 

7. Open page 2 of the Loan Application and complete the following information in the 
Monthly Income and Combined Housing Expense Information section: 

Note: The amount in the Total field for the Housing Expenses represents the Principal, 
Interest, Tax and Insurance (PITI) of the subject property. The amount in the Net Rent field 
equals the Gross Rent field times the Occ Rate field minus the PITI. The Net Rent field 
shows the positive cash flow or negative cash flow for the subject property. 

8. Complete the Gross Monthly Income section for the borrower and the coborrower 
but exclude the Net Rent field. 

Note: Net Rent is populated from the Schedule of Real Estate Owned section on page 3 if 
net rent is a positive amount. 

9. Enter the housing expenses for the borrower owner-occupied residence in the 
Present column in the Monthly Housing Expenses section regardless of the loan 
type. 

Note: Point calculates the proposed monthly payment 

10. Complete the HazIns, Taxes, and MtgIns fields. 

11. Open page 3 of the Loan Application and complete the following information in the 
Liabilities section: 

• Enter an M in the R/L(I)/M field to calculate the amount as a negative value 
• Mark that an existing mortgage on the investment property is being paid off if 

applicable 
• Indicate second homes and land loans as liabilities (L) 

12. Complete the following information on page 3 of the Loan Application in the 
Schedule of Real Estate Owned section: 

• The subject property must be listed first if the loan is for a refinance, 
• Enter an occupancy rate (typically 75%) in the Investment Property Occupancy 

Rate field to automatically calculate the net rent for additional rental properties 

13. Select the Subject Property. 
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14. Click Edit. 

15. Select the property and enter an R in the S/PS/R field to indicate the property is a 
rental. 

16. Enter the primary residence and any additional real estate. 

17. Leave the S/PS/R field blank for these properties. 

Note: Investment properties are calculated into the ratios by using the amount in the Net 
Rent field in the Schedule of Real Estate Owned section on page 3 of the Loan Application. 

18. Open the Transmittal Summary (1008) and verify the following information: 

• The Proposed Monthly Payment column should reflect the borrower primary 
residence (owner-occupied) regardless of the loan type 

• The amount automatically populates the 1008 from the Present Monthly 
Housing Expenses section on page 2 of the Loan Application 

• The rental income is populated in the Pos Cash Flow (Subj Prop) field if the 
subject property net rent is positive 

• The negative value populates the Neg Cash Flow (Subj Prop) field if the net 
rent is negative 

Note: The calculation comes from the fields accessed by clicking the Investment button on 
a Borrower Information or Prospect Information screen 

19. Open the Transmittal Summary (1008) in each co-borrower file and click the Other 
Obligations Lock to enable the fields If non-married co-borrowers are sharing the 
loan. 

20. Delete the information in the Neg Cash Flow (Subj Prop) field. 

Note: The Other Prop field contains the total negative net rents from the REO section of the 
Loan Application. The All Other Pmts field contains a total of all liabilities, except 
mortgages, from the Liabilities section of the Loan Application. The Total Payments field 
contains the total monthly payments, including any negative cash flow on rental properties. 
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Chapter 16: FILE MENU 
The following table provides the available Point File menu options. Select a link for 
additional details. Not all options are available after opening a loan file. 

Table 16: File Menu Options 

File New Menu Open: Opens the 
Loans tab on the 
Navigation Panel. 

Open File Copy Loan 
Files 

  

Move Loan 
Files 

Rename: Select to 
rename the open 
loan file. 

Delete Close: Click 
to close the 
open loan 
file. 

Save: Click to 
save the open 
loan file. 

Save As: See Save 
Documents to New 
Location 

Subordinate 
Financing 

Print: See 
Print Options 

Print Preview Print Setup Paper Sources Print Offset  

Email Options Store Files Import From Export To 

Rebuild List Change Name  Login Change 
Password 

File New Menu 

The following options are available from the New menu. 

Open File 

The option opens the Manual File Open dialog to browse to a loan file. 

Note: Select the Keep Open checkbox on an open loan file to open a second file without 
closing the open file. 

1. Select Open File from the File menu. 
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2. Browse to the file to open. 

 

Figure 611: Manual File Open 

3. Select the file to open. 

4. Click Open. 

Copy Loan Files 

External loan files must be moved or copied into Point system. Lists do not have to be 
rebuilt when files are copied or moved. 

Note: See to move Point files between Point folders. 

1. Select Copy from the File menu. 

2. Select Prospect from Specified Location to copy a prospect file. 

Note: Select Borrower from a Specified Location to copy a borrower file. 
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3. Click Browse to navigate to the location of the data folder to move. 

 

Figure 612: Copy Borrower and Prospect Dialog 

4. Select the destination Data Folder. 

5. Select the appropriate As A radio button. 

6. Select the appropriate Filename radio button. 

7. Click OK to complete the process. 

Move Loan Files 

Use the Move option to move loan files between locations without leaving a copy in the 
original location. 

Note: The steps are the same as Copy Loan Files. 

Print Options 

Review print settings and set the parameters based on printing requirements prior to 
printing forms. 

Print Setup 

Print requests are automatically routed to the default printer. Use the following steps to set 
or change the default printer. 

1. Open a prospect or borrower file. 
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2. Select Print Setup from the File menu. 

3. Select the Default Printer from the dropdown. 

 

Figure 613: Print Setup 

4. Enter required default parameters. 

5. Click Properties to change the paper orientation, duplex settings, or tray selection. 

6. Click OK when finished in the Print Setup dialog. 

Paper Sources 

Use the Paper Sources option to select the printer paper options and locations. 

1. Open a prospect or borrower file. 

2. Select Paper Sources from the File menu. 

3. Select the Paper Tray assignment for each paper type using the corresponding 
dropdown. 

 

Figure 614: Paper Sources Dialog 
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4. Select the appropriate checkboxes. 

5. Click OK to finish. 

Print Offset 

Use the Print Offset option to adjust the form position on the paper if the margins or 
alignment on a form are uneven when the form is printed. 

Note: Adjust the offset only if you encounter difficulties with the print alignment. 

1. Open a prospect or borrower file. 

2. Select Print Offset from the File menu. 

3. Enter the number of inches to offset the printed area in the Shift Right or Shift 
Down fields. 

 

Figure 615: Print Offset Dialog 

4. Enter the amount in decimal format to set the offset by an increment of an inch. 

5. Click OK. 

Print Forms 

Use the Borrower Forms dialog to print and preview Point forms and screens. Forms that do 
not require input are also available to print from the Borrower Forms dialog. 

Note: Use the Print icon on the toolbar as an option to Print from the File menu. 

1. Open a prospect or borrower file. 
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2. Select Print from the File menu. 

 

Figure 616: Borrower Forms Dialog 

3. Click the Updated Forms button to view the forms recently updated. 

4. Select the forms from the Tabs to place the forms in the Forms Selected list. 

Note: Select Loan Application - All from the forms list to print the entire Loan Application. 
continuation sheets are printed after the last page of the Loan Application. One continuation 
sheet contains 22 REOs if the Loan Application contains more than four employers, six 
liabilities, or 20 Real Estate Owned (REO) items. 

5. Select Print from the Output Option dropdown. 

6. Select Print Preview to review the forms before printing. 

7. Click the Font button to customize form fonts. 

8. Select the Form with data from the Print Option dropdown. 

9. Click the Print button and select the print settings in the Print Setup dialog. (See 
Figure 613.) 

10. Click OK. 

11. Click Close to close the Borrower Forms dialog. 
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Print Envelopes 

Select the Print Envelope options from the Borrower Forms dialog. 

1. Open a prospect or borrower file. 

2. Select Print from the File menu. 

3. Click the Envelopes tab. (See Figure 616.) 

4. Select the appropriate envelope option(s). 

Note: The verification options correspond to the institutions entered in the Verifications 
forms. 

5. Click Print. 

6. Select the number of copies to print on the Print Setup dialog. (See Figure 613.) 

7. Click OK. 

Create Print Groups 

The Print Groups tab on the Borrower Forms dialog contains the list of personalized print 
groups and shared print groups.  

1. Open a prospect or borrower file. 

2. Select Print from the File menu. 

3. Click the Print Groups tab. (See Figure 616.) 

4. Click Create Group. 
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5. Enter the Print Group Name. 

 

Figure 617: Print Groups Dialog 

6. Select the Share this print group checkbox to share the group with other users. 

7. Select the forms to include in the group. 

8. Click OK to save the group. 

9. Select the group to print from the Print Groups tab in the Borrower Forms dialog 
to print the form group. 

Print Preview 

Use the Print Preview option to view a print form prior to printing. 

1. Select Print Preview from the File menu. 

2. Select the forms to preview. (See Figure 616.) 

3. Click Print Preview. 
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Email Options 

The following sections provide Point email options. 

Email Data Files 

Use the Point Data File option to email entire loan files to other Point users as email 
attachments. 

1. Select E-mail from the File menu. 

2. Select Point Data File. 

3. Enter the password in the Password Protected field. 

 

Figure 618: Email Point Data File Dialog 

4. Click Send To. 

Note: Click Save As PCF to convert the file to a Point Compressed File (PCF) before 
emailing. 

5. Complete the email and send as usual. 

Email Forms 

Use the Borrower Forms dialog to create PDF documents of the selected forms to attach to 
an email.  

1. Select E-mail from the File menu. 

2. Select Forms. 

3. Select the Forms tab on the Borrower Forms dialog. (See Figure 616.) 

4. Select the forms the recipient. 

Note: Select forms for one recipient at a time. A single PDF file is generated containing all 
selected forms. 
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5. Click Send. 

 

Figure 619: Set PDF Password Dialog 

6. Select either Protect with Password to password protect the file. 

7. Enter the Password. 

8. Click OK. 

9. Complete the email and send as usual. 

Download Email Point Compressed File 

Process pcf files prior to downloading and viewing. 

1. Open the with the pcf file attached. 

2. Double-click the attachment in the email to open the pcf file. 

3. Enter the assigned password to access the Point Compressed File Processor dialog 
if prompted. 

Note: A login dialog is displayed when using Point Central or secured data folders. 
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4. Select the Data Folder. 

 

Figure 620: Point Compressed File Processor 

5. Select the appropriate As a radio button. 

6. Select the appropriate filename: 

• Preserve: Retain the original file name. 
• Auto Filename: Use the automatic file naming convention specified for the 

selected data folder. 
• Manual Naming: Enter a name of choice in the Rename File dialog, which is 

displayed when copy is clicked.  

7. Click Copy. 

8. Click OK in the PCF Copy Results dialog. 

9. Click Close. 

Store Files 

Use the following steps to create and save PDF documents of selected forms. 

1. Select Store from the File menu. 

2. Click the Forms tab on the Borrower Forms dialog. (See Figure 616.) 

3. Select the forms to include in the PDF file in the forms list 

4. Select Save as PDF File from the Output Option dropdown. 

5. Click Save As. 

6. Select the password protection option on the Set PDF Password dialog. (See Figure 
619.) 

7. Navigate to the location to save the file. 
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8. Enter a file name. 

9. Click Save. 

Import From 

Point provides data import options from the File menu. 

Other App Using Import Template 

ASCII data can be imported into new and existing loan files. 

Use the following steps to import data using a predefined import template. 

An import template with mappings to the fields is required to import the data. See Template 
Management for template creation details. 

1. Convert the import file to an ASCII delimited file (.txt) before initiating the import. 

2. Open or create the loan file to receive the imported data. 

5. Select Import From on the File menu. 

6. Select Other App (using import template). 

7. Use the Choose a Data Import Template To Use dialog to browse to and open the 
appropriate import template. 

8. Select a template. 

9. Click Open. 

10. Enter the full file name and path in the File Name field (or locate and select the file) on 
the Specify an Input Data File dialog. 

Note: The import is automatically initiated when clicking Open if an input data file (the file 
containing the data to be imported) was specified in the selected template. 

11. Click OK to import that data. 

Borrower Master File 

Apply master file templates to a new loan file during creation or import the master file 
template into an existing loan file. 

See Template Management for template creation details. 

1. Open a new or existing prospect or borrower file. 

2. Select Import From on the File menu. 

3. Select Borrower Master File. 
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4. Use the Import Data from Borrower Master File dialog to browse to and open the 
appropriate import template. 

5. Click OK to import that data. 

Fannie Mae DO/DU 

Only Fannie Mae version 3.0 and 3.2 files (.fnm files) may be imported. A template is not 
required to convert the files because the field mappings are built into Point. 

Note: The social security numbers must match when importing Fannie Mae data into an 
existing prospect or borrower file. 

1. Select Import From on the File menu. 

2. Select Fannie Mae DO/DU. 

3. Use the Import 1003 data from Fannie Mae DO/DU dialog to browse to the file. 

4. Select the file. 

5. Click Open to initiate the import process. 

Fannie Mae 3.4 MISMO 

Importing a Fannie Mae 3.4 file into the Loan Application is possible. Some data components 
from a Fannie Mae 3.4 file will not import into the New Loan Application due to the 
introduction of new fields and methods for capturing the information on the 1003 (such as: 
Employment and Income). 

1. Open a New blank loan. 

 

Figure 621: Fannie 3.4 MISMO 

2. Select Import From on the File menu. 

3. Select Fannie Mae 3.4 MISMO. 
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4. Browse to the Fannie Mae 3.4 XML file. 

5. Complete the import. 

6. Re-enter the information into the following screens: 

• Borrower Information screen: Monthly Housing Expenses fields 

• Loan Application Section 1 screen: Citizenship, Employment, and Income 
fields 

• Loan Application Section 2 -3 screen: Assets, Liabilities, and Owned 
Properties fields 

• Lender Loan Information Pg 2 screen: Closing Costs and Credits fields 

Note: Use the following link for additional information: 
https://customers.calyxsoftware.com/aspx/HomeCustomer 

Export To 

Point provides some data export options from the File menu, including: 

Other App Using Export Template 

Fannie Mae 3.0 DO/DU 

Fannie Mae 3.2 DO/DU 

Fannie Mae 3.4 MISMO 

Uniform Loan Data Delivery 

Other App Using Export Template 

An Export Template is required to complete the following steps. (See Template 
Management for template details.) 

1. Open the prospect, borrower, or co-borrower file containing the information to 
export. 

2. Select Export to from the File menu. 

3. Select Other App (Using Export Template). 

4. Use the Choose a Data Export Template dialog to browse to the template folder. 

5. Select the appropriate template. 

6. Click Open. 

7. Enter the full file name and path or locate the file in the Output Data File dialog. 

Note: The export automatically initiates when clicking Open if an output data file was setup 
in the selected template. 

https://customers.calyxsoftware.com/aspx/HomeCustomer
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8. Click Save to initiate the export process. 

Fannie Mae 3.0 DO/DU 

Use the Fannie Mae 3.0 DO/DU option to export Classic Loans in the Fannie Mae 3.0 file 
format. 

Note: See Fannie Mae 3.4 MISMO for exporting loan in the New Format. 

1. Verify the Classic Loan Application is complete. 

2. Verify the Fannie Mae Addendum screen is complete. 

3. Verify the Fannie Mae Government screen is complete. (Fannie Mae Government.) 

4. Select Export To from the File menu. 

5. Select Fannie Mae 3.0 DO/DU. 

6. Use the Export 1003 Data to Fannie Mae DO/DU dialog to browse to the file 
location. 

7. Click Save. 

Fannie Mae 3.2 DO/DU 

Use the Fannie Mae 3.2 DO/DU option to export Classic Loans in the Fannie Mae 3.2 file 
format. 

Use the steps in Fannie Mae 3.2 DO/DU to export the file selecting Fannie Mae 3.2 DO/DU 
Export To option. 

Fannie Mae 3.4 MISMO 

Use the Fannie Mae 3.4 MISMO option to export New Loan types in the Fannie Mae 3.4 
MISMO format. 

1. Verify the New Loan Application is complete. 

2. Verify the Fannie Mae Addendum screen is complete. (See Fannie Mae Addendum.) 

3. Verify the Fannie Mae Government screen is complete. (See Fannie Mae 
Government.) 

4. Select Export To from the File menu. 

5. Select Fannie Mae 3.4 MISMO. 

6. Use the Export 1003 Data to Fannie Mae 3.4 MISMO dialog to browse to the file 
location. 

7. Click Save. 
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Uniform Loan Data Delivery 

The Uniform Loan Delivery Dataset (ULDD) is a data format governing loan data delivery. 
ULDD improve loan quality referred to as the Uniform Mortgage Data Program (UMDP). 
Fannie Mae and Freddie Mac require the ULDD for single-family loan deliveries. 

Point is set up to create the ULDD files required by Fannie Mae and Freddie Mac. Point also 
creates a combined ULDD file that is accepted by both Fannie Mae and Freddie Mac. Use 
the following steps to export to Fannie Mae or Freddie Mac ULDD files. 

1. Select Export To from the File menu. 

2. Select one of the following: 

• Fannie Mae ULDD 

• Freddie Mac ULDD 

• Combined ULDD 

3. Use the Save As dialog to browse to the location to store the ULDD file. 

4. Name the file. 

5. Click Save. 

Note: Use the Uniform Loan Delivery Dataset file to the Fannie Mae or Freddie Mac when 
required. 

Rebuild List 

Use the following steps to rebuild the index after changes. 

Note:  Loan files must be closed for the option to be available. 

1. Select Rebuild List from the File menu. 

2. Select the Data Folder in which the list is stored. 

 

Figure 622: Rebuild List 

3. Select the Loan List(s) to include in the rebuild. 

4. Select the Tasks checkbox to include tasks in the rebuild. 
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5. Click Start. 

Change Name 

Use the Change Name option to change the logged in user name without losing the 
associated loan files. 

Note:  Loan files must be closed for the option to be available. 

1. Select Change Name from the File menu. 

2. Enter the user First and Last Name. 

 

Figure 623: Set Name Dialog 

3. Click OK. 

4. Restart Point if required. 

Login 

Use the Login option to log into Point if applicable. 

1. Select Login from the File menu. 

2. Enter user credentials to log in. 

Change Password 

Use the Change Password option to change the user password when company security 
requires passwords to access Point. 

1. Select Change Password from the File menu. 

2. Follow the prompts to change the user password. 

3. Restart Point if required. 
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Chapter 17: DATA MANAGEMENT 
Use the Point Administrator tool to manage the following: 

• Create data folders 

• Copy data folders 

• Establish data folder access rights for users 

• Change the directory where templates are stored 

• PointCentral settings 

Access Point Administrator 

Use the following steps to access the Point Administrator 

1. Close Point. 

2. Select the Windows Start menu. 

3. Select All Programs. 

4. Select Point Administrator. 

 

Figure 624: Point Administrator Dialog 

Manage Data Folders 

Use the Data Folder function for the following: 
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• Create new data folders 
• Connect existing data folders 
• Disconnect existing data folders 
• Manage folder owners 
• Modify folder properties 
• Change the order in which the folders are listed in the dropdown lists 

Note: Do not store more than 1500 files in a single data folder. Storing more files causes 
slower performance during searches. 

Setup Data Folders 

The following sections discuss setting up the Point Data folders. 

Set Primary Data Ownership 

Set initial ownership of the Primary Data folder to ensure more data security and file 
control. Click Setup Data Folders on the Point Administrator dialog. 

Note: The Owned column in the Data Folder Manager dialog displays a check mark if a 
data folder has an owner. 

1. Select the Primary Data Folder. 

 

Figure 625: Data Folder Manager Dialog 

2. Click Modify Properties. 

3. Enter the Password on the Folder Supervisor Login dialog. 
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4. Click OK. 

5. Re-enter the password in the Password Verification dialog. 

6. Click Close. 

Create New Data Folder 

Create new data folders to manage the loan files and organize your workflow. 

1. Open the Data Folder Manager dialog. (See Figure 625.) 

2. Click Create New. 

3. Enter the Supervisor password in the Password field on the Verify Password 
prompt. 

4. Click OK. 

5. Re-enter the password if prompted. 

6. Enter the Directory Name in the Field 1. 

 

Figure 626: Create New Data Folder Dialog 

Note: Use the Browse button to browse to the folder storage location. 

7. Enter Folder Name in Field 2. 

8. Select a folder from the Copy From dropdown to copy the folder settings. 

9. Select the Include User Security Settings checkbox to include the security 
settings. 

10. Click Create. 

11. Proceed to Modify Data Folder Properties to set up the folder properties. 
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Modify Data Folder Properties 

Use the following steps to modify data folder properties. 

1. Select the data folder to modify from the Data Folder Manager dialog. (See Figure 
625.) 

2. Click Modify Properties. 

3. Enter a Data Folder Name if applicable. 

 

Figure 627: Modify Data Folder Properties 

Note: Do not change the Data Folder Name if data has already been saved to the folder. 

4. Select the Security Enabled Yes radio button to require a user password to modify 
folder contents. 

5. Select the Available to User Yes radio button to make the available to users on the 
network. 

6. Click OK. 

Connect Existing Data Folders 

Use the following steps to connect an external data folder to the Point data folder. 

1. Access the Data Folder Manager dialog. (See Figure 625.) 

2. Click Connect Existing. 
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3. Click Browse to navigate to the folder to connect. 

 

Figure 628: Connect to Existing Folder Dialog 

4. Click OK to add the data folder to the Data Folder Manager dialog. 

Disconnect Data Folders 

Use the following steps to remove a data folder from Point. Disconnection from Point does 
not delete the folder from the original location. 

1. Access the Data Folder Manager dialog. (See Figure 625.) 

2. Select the data folder to disconnect. 

3. Click Disconnect. 

4. Click Yes on the Disconnect Confirmation dialog. 

Reorder Data Folders 

It is possible to arrange the order of folders in the data folder dropdown lists by changing 
the order in the Data Folder Manager. 

1. Access the Data Folder Manager dialog. (See Figure 624.) 

2. Select a data folder. 

3. Use the Move arrows to reposition the folder in the list. 

Copy Folder Settings 

Use the following steps to copy folder settings between data folders. 

1. Access the Point Administrator dialog. (See Figure 624.) 

2. Click Copy Folder Settings. 
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3. Select the folder to copy From. 

 

Figure 629: Copy Data Folder Settings 

4. Select the folder to copy To. 

5. Click Copy. 

Manage Users 

Use the following sections to set up and manage data folder users. The user name must 
match exactly as it was created in the Processor or Originator dropdown list using the 
dropdown list utility. 

Add Users 

Use the following steps to add new data folder users. 

1. Access the Point Administrator dialog. (See Figure 624.) 

2. Click Setup Users. 
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3. Click New User. 

 

Figure 630: User Manager Dialog 

4. Enter the user Full Name on the Modify User Properties dialog. 

 

Figure 631: Modify User Properties Dialog 

5. Enter User ID. 

6. Enter user Password. 

7. Select the appropriate Access Mode radio button. 

8. Select the appropriate Access Rights radio button. 

9. Select the Access to Financial Information Screens checkbox to enable access to 
financial screens. 
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10. Select the Access to Secured Area checkbox to enable access to Point secured 
folders. (See Table 17: Point Secure Areas for the Point secure areas.) 

11. Click OK to add the user to the User Manager dialog. 

12. Proceed to 

Modify Users 

Use following steps to modify data folder user access. 

1. Access the User Manager dialog. (See Figure 630.) 

2. Select the user to modify. 

3. Click Modify User. 

4. Make appropriate changes on the Modify User Properties dialog. 

5. Click OK. 

Delete Users 

Use the following steps to delete a data folder user from Point. 

1. Access the User Manager dialog. (See Figure 630.) 

2. Select the user to delete. 

3. Click Delete. 

4. Click OK. 

Table 17: Point Secure Areas 

Point Component Secured Area 

Point Screens • • Loan program templates 

• • Closing cost scenario templates 

• • Prospect master templates 

• • Borrower master templates  

• • Data import templates 

• • Data export templates 

• • Custom forms 

Utilities • • Company Defaults 

• • Dropdown Lists 

• • Escrow tables 

• • Title tables 

• • Custom Screen settings 

• • Enable/Disable Vendors 

• • Auto File Naming 
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Point Component Secured Area 

Secure access is required to move, copy, and delete loan files. 

Secure access is required to delete or print the conversation log entries. 

Secure access is required to edit Credit Score fields. 

Copy User Settings 

Copy user settings from folder to folder to prevent repeating the setup process for each 
folder a user can access. 

1. Access the Point Administrator dialog. (See Figure 624.) 

2. Click Copy Users. 

3. Enter the Supervisor password if prompted. 

4. Select the Data Folder to copy the settings From. 

 

Figure 632: Copy User Settings Dialog 

5. Select the Data Folder to copy the setting To. 

6. Click Copy All Users to copy all users. 

7. Click Yes to confirm the copy in the Copy User Settings Confirmation dialog. 

Outcome: The Copy User Settings dialog is displayed with a message the users were copied 
successfully and click Close. 

Modify Data Folder Users 

You can modify a user’s ID password, and access rights at any time. 

1. Access the User Manager dialog. (See Figure 630.) 
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2. Click Setup Users. 

3. Enter Password on the Folder Supervisor Login dialog. 

4. Click OK. 

5. Click the User to modify. 

6. Click Modify User. 

7. Make the necessary changes and click OK. 

Remove Data Folder Access 

Use the following steps to remove user access to a data folder. 

1. Access the User Manager dialog. (See Figure 630.) 

2. Select the data folder. 

3. Select the user to modify. 

4. Click Delete User. 

5. Click Yes on the Delete User Confirmation. 

Change Template Location 

The default template directory is c:\PNTTEMPL. Use the following steps to change the 
template directory. 

1. Access the Point Administrator dialog. (See Figure 624.) 

2. Click Change Template Directory. 

3. Click Browse to navigate to the new template location. 

4. Click OK. 

Point Data Server 

PointCentral is the centralized data server that provides access to organization loan files, 
templates, reports, and Cardex. The Point files are accessible from any location. Generate 
management reports that include information from different offices and provide a 
consolidated view of the entire organization loan pipeline. 

Configure Client Connection 

Use the Point Data Server Settings dialog to configure the client to connect to the 
PointCentral server. 
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1. Access the Point Administrator dialog. (See Figure 624.) 

2. Click Settings. 

3. Select the Enable Point Data Server checkbox. 

 

Figure 633: Point Data Server Settings 

4. Enter the PointCentral URL. 

5. Enter the PointCentral Security Key. 

6. Click Test Connection to verify the parameters are correct and network 
connectivity to the PointCentral server is functioning. 

7. Click OK to save the configuration. 

Combined Field IDs 

Point includes the most common fields in the Field Name dropdown on the Reports 
Template screen. The Field ID column is automatically populated with the field ID when the 
field name is selected. Enter the field name and ID manually when not available from the 
dropdown. 

Individual user controls, such as checkboxes and radio buttons, are each assigned unique 
field IDs. Field IDs for groups of controls are established running macros that extract the 
selected option and insert it into the report. 

Field IDs with macros were also created to extract information from a single screen 
containing multiple fields for the same information. 

To include this type of data in the report, you must use the ID assigned to that group of 
fields or controls rather than the unique ID for the selected field or option. 
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Data Import 

Text Files Batch Import 

Use batch importing to import multiple files from a single txt file. The loan files must be 
contained in a single ASCII delimited text file before import. 

The Auto File Naming Utility must be enabled to import batch files. (See Auto File Naming 
for details.) 

An import template is required to import txt files. (See Template Management for details.) 

1. Click the Templates tab. (See Figure 13.) 

2. Select the Data Import radio button. 

3. Select the import template to use. 

4. Click Open. 

5. Select <custom ASCII format> from the Import Format dropdown. 

6. Click the Advanced button to open the Advanced Import Format Settings dialog. 

 

Figure 634: Advanced Import Format Settings 

7. Select the Field Separator: 

• Tab: Uses a tab as the field delimiter 

• Comma Uses a comma as the field delimiter 

8. Select the Text Qualifier to indicate the text contained within the qualifier 
characters is imported as one value: 

• None: No text qualifier is used 

• Double quotation mark: Uses double quotation marks as the text qualifier 
(Text contained within double quotation marks is considered one value) 
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• (single quotation mark): Uses single quotation marks as the text qualifier 
(Text contained within single quotation marks is considered one value) 

9. Select the Field Name Header in First Row checkbox if the file to be imported has 
column headers in the first row. 

10. Select the Update Existing Files checkbox to overwrite any existing files with the 
same name. 

11. Click Batch Import. 

Note: The Batch Data Import dialog is displayed if the Update Existing Files checkbox is not 
selected. 

12. Select Prospect or Borrower. 

13. Click OK. 

14. Navigate to the directory containing the txt file to import or enter the file name In 
the Specify an Input Data File dialog. 

15. Click Open to initiate the import process. 

Import Multiple Fannie Mae Files 

Use batch import to import multiple Fannie Mae files, including Fannie Mae . 

The Auto File Naming Utility must be enabled to import batch files. (See Auto File Naming 
for details.) 

1. Click the Templates tab. (See Figure 13.) 

2. Select Data Import. 

3. Select the import template to use. 

4. Click Open. 

5. Select the appropriate Fannie Mae file format from the Import Format dropdown. 

6. Click Batch Import. 

Note: Fannie Mae 3.4 MISMO XML files can be batch imported into Point. 

7. Click on the Browse button. 

8. Navigate to the directory containing the files to import. 

9. Enter the file name to import. 

Note: Use an asterisk (*) as a wild card and the file extension (*.fnm) to import all files in that 
directory with the fnm extension. 

10. Select the Loan Type. 

11. Click Start Import to import the files. 
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Import Fannie Mae 3.2 File 

The Fannie Mae 3.2 file captures data components from the Classic Loan Application (1003).  
The New Loan Application mandated for March 1, 2021 introduces new fields and methods 
that do not exist in Fannie Mae 3.2 classic files. 

Importing a Fannie Mae 3.2 file into the New Loan Application is possible. Some data 
components from a Fannie Mae 3.2 file do not import into the New Loan Application due to 
the introduction of new fields and methods for capturing the information on the 1003 (such 
as: Employment and Income). 

Use the following steps to import the Fannie Mae 3.2 file to a New Loan Application. 

1. Select the Loan tab. 

2. Click New. 

3. Select the New radio button on the Create New Loan File dialog. (See Figure 17.) 

4. Select Import From on the File menu. 

5. Select Fannie Mae DO/DU. 

6. Browse to the Fannie Mae 3.2 file. 

7. Complete the import. 

8. Update the following information when the import is complete: 

• Borrower Information Screen: Monthly Housing Expenses information 

• Loan Application Section 1: Citizenship, Employment, and Income information 

• Loan Application Section 2 – 3: Assets, Liabilities, and Owned Properties 
information 

• Lender Loan Information Pg 2: Closing Costs and Credits (such as: cash deposit 
on sales contract) 

Use the following link for additional information: 

https://customers.calyxsoftware.com/aspx/HomeCustomer 
  

https://customers.calyxsoftware.com/aspx/HomeCustomer
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Chapter 18: PIPELINE MANAGEMENT 
The pipeline provides a view of the latest status of active loans in a single screen. 

The pipeline setup is either Automated or Manual. The Pipeline screen is updated by clicking 
the Refresh button. 

Pipeline Descriptions 

Automated 

The Pipeline includes the loans with the most recent loan status that match the defined the 
criteria. Loans are automatically added to the Pipeline after meeting the defined criteria. 

Manual 

Manual setup includes selecting the loans to include in the Pipeline. 

Pipeline Change 

The following sections provide information for what occurs when the pipeline status 
changes. 

Manual to Automated 

• Pipeline displays only the loans that meet the automated selection criteria. 

• Loans in the Manual pipeline are preserved, but not displayed in the automated 
pipeline. 

• Manual pipeline loans are visible again when Manual is selected from the Pipeline 
Setup dialog. 

Automated to Manual 

• loans in the Automated pipeline are removed from the pipeline. 

• Loans with the specified criteria are displayed in the pipeline after switching back to 
automated. 

• The loans in the previous Manual pipeline are displayed. 
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Pipeline Setup 

The following sections provide details for setting up pipelines. 

Automated Pipeline Setup 

1. Select the Pipeline tab. (See Figure 10) 

2. Click Pipeline Setup. 

 

Figure 635: Pipeline Setup 

3. Select the Set Pipeline as Default View checkbox to set the Pipeline view as the 
default view. 

Note: Default views opens the Pipeline tab when Point is launched. 

4. Select the Automated radio button. 

5. Select the Data Folders containing the loan files to include in the pipeline. 

Note: Local folders are not displayed for PointCentral users. 

6. Select the Statuses to include the pipeline. 

7. Select Other Status to include all loans with a custom status set in the Track Status 
screen. 

8. Select Loan Originator/Processors to provide pipeline access. 

9. Click OK. 

Manual Pipeline Setup 

1. Select the Pipeline tab. (See Figure 10.) 
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2. Click Pipeline Setup. (See Figure 635.) 

3. Select the Set Pipeline as Default View checkbox to set the Pipeline view as the 
default view. 

4. Select the Manual radio button. 

5. Click OK on the Proceed with caution to rebuild the index dialog to acknowledge the 
message if the dialog opens. 

Note: Rebuilding the index prevents Point users who have not updated to version 8.0 (or 
later) from accessing the data folders indexed. 

6. Click the Loans tab. 

7. Perform a search to locate the loan files to include in the pipeline. 

8. Select the files to add to the pipeline. 

9. Click Add to Pipeline. 

10. Click YES in the Add to Pipeline dialog. 

11. Click OK to close the confirmation dialog. 

12. Select the Pipeline tab to view the loans in the pipeline. 

Remove Loans from Pipeline 

Only loans in a manually created pipeline can be removed. 

1. Select the Pipeline tab. (See Figure 10.) 

2. Select the files to remove from the pipeline. 

3. Click Remove from Pipeline. 

4. Click Yes on the Remove from Pipeline dialog to confirm the removal. 
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Chapter 19: TASK MANAGEMENT 
The Task Manager is accessible from the Tasks tab in the Navigation panel. Use tasks to 
document actions required to process loans. A permanent record of the task is kept with the 
loan file. 

Create Tasks 

Tasks are created from the Tasks tab or while in a loan file. Both methods require 
association to a loan file. 

Use the following steps to create tasks. 

1. Select the Tasks tab. (See Figure 11.) 

2. Click New to access the Create New Task dialog. 

 

Figure 636: Create New Task Dialog 

Note: Access the Create New Task dialog from an open loan file by clicking the New Task 
icon or selecting Show Tasks from the Utilities menu and clicking the New button. 

3. Enter a brief task description (60 characters or less) in the Subject field. 

4. Select Created by. 

5. Select the person responsible for completing the task from the Assign To 
dropdown. 

Note: The Created by and Assign To fields automatically populate from the originator and 
processor lists established in the dropdown list utility in an unsecured environment. 
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6. Select the task Due Date. 

7. Select the Task Priority. 

8. Enter Comments if applicable. 

9. Click Browse to locate the loan file to associate with the task. 

Note: Skip Step 9 when creating the task from an open loan file. 

10. Select the Remind Me options to enter reminder criteria. 

11. Click to Save the task. 

Task Reminders 

The Reminders dialog displays as a task reminder according to the Remind Me options set 
during task creation. 

The Reminders dialog remains open until all reminders are dismissed. 

 

Figure 637: Manage Task Reminders 

The following options are available for managing tasks: 

• Dismiss: Removes the selected reminder from the dialog and clears the reminder 
from the Task Details dialog for the selected task. The Reminders dialog closes after 
dismissing the last reminder. 

• Dismiss All: Closes the Reminders dialog and clears the reminders from the Task 
Details dialog for all tasks in Reminders dialog. 

• Open Task: Opens the Task Details dialog. Edit the reminder or any task data as 
needed. Click Close to return to the Reminders dialog. 

• Open Loan: Opens the loan associated with the selected task. 

Search Tasks 

Use the Search function to locate tasks. 
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Basic Search 

A basic task search locates open or overdue tasks in the selected data folder or all data 
folders. 

1. Select the Tasks tab. (See Figure 11.) 

2. Select the appropriate Search For from the dropdown. 

Note: The current folder is determined by the folder selected in the Data Folder dropdown 
on the Loans tab. Change the Loans tab selection in the Data Folder dropdown. 

3. Select All Folders or Current Folder from the in-dropdown list and click Search. 

Advanced Search 

Use the Advanced Search function to define more specific search criteria to further refine 
the search. 

1. Select the Tasks tab. (See Figure 11.) 

2. Click the Advanced Search button. 

3. Select the Data Folders checkboxes to search. 

 

Figure 638: Advanced Task Search Dialog 

4. Select the Assigned To checkboxes next to the names of the agents whose tasks 
are being searched. 
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5. Select the Statuses to search. 

6. Select the Priorities to search. 

7. Enter the Date Ranges. 

8. Enter Borrower Information. 

9. Enter Sorting Information. 

10. Click Search. 

Edit Tasks 

Use the following steps to edit a task. 

1. Select the Tasks tab. (See Figure 11.) 

2. Select the task to edit. 

3. Click Open to open the Task Details dialog. 

4. Edit task details appropriately. 

 

Figure 639: Task Details Dialog 

5. Click Save to close the dialog and save the changes. 
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Close Tasks 

Close tasks from the Task Details dialog or Task List. 

Note: See Edit Tasks for closing tasks from the Details dialog. 

1. Select the Tasks tab. (See Figure 11.) 

2. Check the Closed checkbox in the second column of the Task List. 

 

Figure 640: Close Task 

3. Click OK on the Close Confirmation dialog. 

Delete Tasks 

Verify the intend to delete before clicking Delete. Point does not have a recycle bin. 

Navigation Panel Delete 

1. Select the Tasks tab. (See Figure 11.) 

2. Select the task to delete. 

3. Click Delete. 

4. Click OK on the Delete Confirmation. 

Borrower File Delete 

1. Select Show Tasks from the Utilities menu. (See Figure 518.) 

2. Select the task to delete and click the Delete button. 

3. Click OK to confirm the deletion. 

Print Tasks 

Use the following steps to print tasks. 
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1. Select the Tasks tab. (See Figure 11.) 

2. Select the tasks(s) to print. 

3. Click Print. 

4. Select the appropriate Tasks to Print radio button. 

 

Figure 641: Print Tasks Dialog 

5. Select the appropriate Output radio button.  

6. Click Print: 

7. Select the required print options on the Print dialog is displayed. 
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Chapter 20: REPORTS MANAGEMENT 
The report functions are accessible from the Reports & Marketing tab. 

Use reports to manage day-to-day business events and clients. Use marketing documents 
to assist with loan marketing loans. 

Verify the time and date settings on the computer are correct. The following options 
indicate where the data is to be retrieved when the report is generated: 

Select All/Deselect All: Toggles between Select All or Deselect All when selecting data 
folders. Only the data folders to which you have access are displayed. 

Prospect/Borrower: Specifies the file type from which you generate the report. You can 
select both file types as well as co-borrowers. 

Point contains predefined report and marketing document templates to simplify business. 
Create custom templates that meet other specifications. 

Standard Reports 

The Report & Marketing template files are divided into Report files and Marketing 
documents. 

Report Templates 

Use the predefined reports included in Point for tracking and printing options. 

Table 18: Report Templates 

Address Labels Report Appraiser Report (Vendor) 

ARM Loans for Refinance Builder Report (Vendor) 

Business Analysis Summary (Banker with 
Excel) Business Summary Report (with Excel) 

Closed and Funded Report Contact Information Report 

Escrow Report (Vendor) Funded and Not Shipped (Banker with Excel) 

GFE Fee Report HMDA Report (2017) 

HMDA Report Last Contact Report 

Late Documents Report Lender Report 
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Lender Summary Report Loan Conditions Report 

Loan Originator 1st Mortgage Pipeline 
Report 

Loan Originator Report 

Loan Pipeline (with Excel) Loan Profit Summary (Banker with Excel) 

Loan Status (with Excel 2007) Loan Status and Pipeline (with Excel) 

Loan Status Report Loan Summary Report 

MDIA Compliance Report NMLS Call Report – Standard 

Pipeline Report Processor Pipeline Report 

Production Report Profit Report from Track Manager 

Property Address Report Rate Lock Report 

RegulatorConnect Report 
SecMktgExpiring Commitments (Banker with 
Excel) 

SecMktg New Lock Requests (Banker 
with Excel) 

Secondary Marketing Locked Pipeline 
(Banker) 

Title Report (Vendor) Trailing Documents 

Trust Account Report Underwriter Pipeline Report 

Warehouse Aging (Banker with Excel) Yield Spread Premium Report 

Generate Standard Reports 

Reports can contain a maximum of 500 rows. A message is displays indicating the report 
has exceeded the maximum number of rows allowed for a report if the report exceeds 500 
rows. 

Note: Report data can be manipulated after report generation depending on the output 
type. 

Use the standard report templates to generate a report. 
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1. Click the Reports & Marketing tab. 

 

Figure 642: Generate Results Screen 

2. Select the Data Folders where the data is to be obtained. 

3. Select the checkbox(es) for the file types to include in the report. 

4. Select the Reports radio button. 

5. Select the appropriate template from the dropdown. 

6. Use the Originator and Processor dropdown lists to filter the search results by a specific 
loan originator or loan processor. 

7. Select the Current Status option to include in the report. 

8. Select a Status Date option and set a Date Range to include in the report. 

9. Click Generate to generate and open the report in Report Viewer. 

10. Click the Open in Excel button to open the report in an Excel file. 

Note: The reports containing Excel in the title are generated in a Microsoft Excel 
spreadsheet. The reports display in the lower portion of the Generate Results screen. Click 
the report to open. 
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The following example shows the Loan Status and Pipeline (with Excel) report displayed in 
the Generate Results screen. 

  

Figure 643: Generate Results Screen 

Custom Reports 

Create custom report templates when required. 

Create Report Templates 

Use the following steps to create a new report template. 

1. Select the Templates tab. (See Figure 13.) 
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2. Select Reports & Marketing radio button. 

 

Figure 644: New Report Template 

3. Click New to open a blank template. 

  

Figure 645: Blank Report Template 

4. Proceed to Select Report Content. 

Copy Report Templates 

Use the following steps to copy an existing report template as a basis for the new template. 

1. Select the Templates tab. 

2. Select Reports & Marketing radio button. (See Figure 644.) 
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3. Select the report to copy. 

4. Click Copy. 

 

Figure 646: Copy Reports & Marketing Dialog 

5. Enter the Name for the copied report. 

6. Click OK. 

7. Select the new report. 

8. Click Copy. 

9. Double-click the new report to open. 

10. Proceed to Modify Custom Report. 

Select Report Content 

Use the following steps to identify report or marketing template content. 

1. Enter template name in the Report Title field. 

 

Figure 647: Select Report Content 

2. Enter the template Description. 
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3. Select the Field Name for the first data point to include in the report. 

Note: Enter the Field Name and Field ID manually when the field name is not available in 
the dropdown. 

4. Click Condition to add field conditions. 

 

Figure 648: Condition Builder Dialog 

5. Use the following table to assist with selecting field conditions in the Condition 
Builder dialog. 

Table 19: Field Condition Descriptions 

Condition Definition 

Equal to The value in the corresponding field matches the value 
specified in the Text Value 1 field. 

Not Equal to The value in the corresponding field does not match the 
value specified in the Text Value 1 field. 

Contains The value in the corresponding field contains the value 
specified in the Text Value 1 field. 

Begins with The value in the corresponding field begins with the value 
specified in the Text Value 1 field. 

Greater than The value in the corresponding field is greater than the 
value specified in the Text Value 1 field. 
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Condition Definition 

Greater than or equal 

To 

The value in the corresponding field is greater than or 
equal to the value specified in the Text Value 1 field. 

Less than The value in the corresponding field is less than the value 
specified in the Text Value 1 field. 

Less than or equal to The value in the corresponding field is less than or equal 
to the value specified in the Text Value 1 field.  

Between The value in the corresponding field is between the values 
specified in the Text Value 1 and Text Value 2 fields. 

Date conditions The following date conditions are available when a date 
field is selected: 

• • Today 

• • Last # days 

• • Next # days 

• • This month 

• • Last month 

• • Next month 

• • This year 

• • Last year 

Select an option and enter the appropriate value in the 
Text Value 1 field. 

6. Select the Include in the Additional Filter List on the Report Generation Screen 
checkbox if applicable. 

7. Click OK to close the dialog. 

8. Select the Include in the Addition Filter List on the Report Generation Screen 
checkbox to enable filtering for the corresponding field at the time the report is 
generated. 

Note: Selecting this option adds the field to the Additional Filters on the Generate Report 
screen where additional filter criteria can be specified. 

9. Select the Show column checkbox to display the field on the report. 

10. Select the appropriate Total option to display at the bottom of the corresponding 
column in the report if applicable. 

11. Select the appropriate Width option. 

12. Repeat steps 3 – 11 for additional fields. 
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Select Sort Options 

Use the Sort Options to specify the sequence in which the records are sorted in the 
resulting report. 

1. Select the first field to Sort by from the dropdown. 

 

Figure 649: Report Sort & Output Options 

2. Select the Ascending or Descend radio button. 

3. Select the Group By checkbox if applicable. 

4. Select the Page Break checkbox if applicable. 

5. Repeat Steps 1 – 4 for remaining fields. 

Select Output Options 

The report output options include: 

Display in Point Report Viewer 
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Display in Excel 

Use Results for Mail Merge 

Select a link to set up the report output. 

Display in Point Report Viewer 

A report that outputs a report in Point Report Viewer format enables the following actions 
after the report is generated: 

• Report formatting 
• Report saving 
• Reporting exporting to XML, Microsoft Excel, or ASCII format 

1. Select the Display Result in Point Report Viewer radio button. (See Figure 649.) 

1. Select the appropriate Permissions options. 

2. Select the Paper Size. 

3. Select the Page Orientation. 

4. Select the Display Row Numbers checkbox to display the row numbers in the 
report. 

5. Select Save from the File menu to save the template. 

Note: See Format Report Viewer Reports for additional information. 

Display in Excel 

Use the following steps to display the report in Excel. 

1. Select the Display Result in Excel radio button. (See Figure 649.) 

2. Select the appropriate Excel File option. 

3. Select the appropriate File from the File dropdown do replace. 

Note: Click New to create a new Excel file option. 

4. Select the Worksheet Export To option. 

5. Select the Worksheet Launch With option. 

6. Select Save from the File menu to save the template. 

Use Results for Mail Merge 

Use the following steps to use the report for mail merge marketing documents. 

1. Select the Use Result for Mail Merge Marketing Documents radio button. (See 
Figure 649.) 
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2. Click Add Link. 

3. Select the Document Type. 

 

Figure 650: Marketing Document and Options 

4. Complete the Match Fields options when selecting the Mailing Label radio button. 

5. Complete the Email Options when selecting the Email radio button. 

6. Select the Email/Customer Letter Content Document. 

Note: Click New to create a new content document. Select a content document and click 
Edit to edit an existing document. 

7. Select Save from the File menu to save the template. 

Modify Custom Reports 

Use the following steps to modify a custom report. 

1. Select a report from the list. (See Figure 644.) 

2. Make appropriate changes as described in the following sections: 

Select Report Content 
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Select Sort Options 

Select Output Options 

3. Select Save As from the File menu. 

4. Name the report. 

 

Figure 651: Report Save As 

5. Click Save. 

Note: Click Browse Other Location to change the directory to save the file. 

Format Report Output 

Use the following sections to manipulate report outputs to Point Report Viewer and Excel. 

Format Report Viewer Reports 

The following formatting options are available after the report is available in Point Report 
Viewer format. 

• Font 
• Row Colors 
• Grid Color 
• Auto Size Rows 
• Auto Size Columns 
• Headers and Footers 
•  

1. Open the report. 
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Figure 652: Format Report 

2. Select Format. 

3. Select the item to change. 

4. Modify the settings in the dialog. 

5. Click OK. 

Filter Report Viewer Reports 

A data filter is used to filter out key items in a long report. 

1. Select Filter from the Data menu. 

2. Select the column containing the data to filter from the Column Name dropdown on the 
Filter dialog. 

3. Define the Filter Conditions. 

4. Click OK to update the report. 

5. Repeat to add another filter level. 

6. Repeat the Steps 1 - 5 above until finished filtering data. 

Sort Report Viewer Reports 

The Sort function works much the same as a filter. 
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1. Select Sort from the Data menu. 

2. Use the steps in Filter Report Viewer Reports to assist with sorting the report. 

Subtotal Report Entries 

The Subtotal function calculates the total amount, the average amount, or the total number 
of entries in the corresponding column. 

1. Select Subtotal from the Data menu. 

2. Click in the Use Function field for the first field to calculate. 

3. Select the appropriate option. 

4. Repeat Steps 2 – 3 for remaining fields to calculate. 

5. Click OK when finished. 

Save Report Viewer Report 

1. Select Save from the File menu to save the report. 

2. Select Save As from the File menu to save the report with a new name. 

Export Report Viewer Report 

Point Report Viewer reports may be exported in the following formats: 

Export Reports to XML 

Export Reports to Custom ASCII 

Export Reports to Excel 

Export Reports to XML 

Use the following steps to export the results of a report in Point Report Viewer format to 
XML. 

1. Select Export from the Report File menu. 

2. Select XML. 

3. Use the Export Report dialog to browse to the destination. 

4. Name the file. 

5. Click Save. 
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Export Reports to Custom ASCII 

Use the following steps to export the results of a report in Point Report Viewer format to 
custom ASCII format. 

1. Select Export from the Report File menu. 

2. Select Custom ASCII. 

3. Select the appropriate options on the Export Customer ASCII dialog. 

4. Click Export. 

5. Use the Export Report dialog to browse to the destination. 

6. Name the file. 

7. Click Save. 

Export Reports to Excel 

Use the following steps to export the results of a report in Point Report Viewer format to 
Microsoft Excel. 

1. Select Export from the Report File menu. 

2. Select Excel. 

3. Use the Export Report dialog to browse to the destination. 

4. Name the file. 

5. Click Save. 

Format Excel Report Output 

Use the controls in the Generate Results screen to format the Excel report. 

Table 20: Generate Results Screen Controls 

Control Description 

Keep report results open 
checkbox 

Keeps the report open and available in the Reports & 
Marketing tab when switching to a different view 

Open Loan button Opens the loan file for the selected record 

Refresh button Refreshes the report to include loan data updated since 
the report was generated 

Sort button Sorts data by the selected option in the dropdown list 
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Control Description 

E-Mail To button Opens the default email application with the report 
attached as a Microsoft Excel spreadsheet 

Print button Opens the Print dialog to specify print options and print the 
report 

Open in Excel button Opens the report in a Microsoft Excel® spreadsheet 

View buttons Correspond to tabs at the bottom of the spreadsheet The 
following views are available depending on the 
spreadsheet: 

• Cost and Profit Summary: Displays an overview of warehouse 
costs, units, and any gains or losses 

• Dashboard: Displays all panels of the report in graphical format 

• Data: Displays a table containing the information specified by the 
individual report template 

• Detail Status: Displays a detailed table of the loans in the pipeline, 
alphabetically by filename 

• LO Summary: Displays a table of sales figures by originator 

• Monthly Trend: Displays a table of the loans by originator and 
monthly trend 

• Pipeline Status: Displays an overview of loans in the pipeline. 
Select a single originator or processor or view a cross-section of 
their work. View the loans by status or check all status types. 

• Yearly Trend: Displays a table of the loans by originator and yearly 
trend 

• Range Analysis: Displays the number of loans within certain FICO 
score ranges and the number of loans within specified LTV ranges 

• Warehouse Summary: Displays an overview of data for warehouse 
lenders, their branches, and averages of fees and costs 

HMDA Reports 

HMDA requires lending institutions to report public loan data for monitoring purposes. 

The 2017 and 2018 screens are not running archives of loan data for each year. The 2017 
tracking option reflects the CFPB’s 48 data points for 2017. The 2018 tracking option reflects 
the updated 110 data point for 2018. Generate a report to view current and previous year 
HMDA data. 

The HMDA Reporting (2018) screen is available from the Tracking menu in every prospect 
and borrower file. This screen contains most of the information the CFPB requires for HMDA 
reporting. 

The report can be generated after the HMDA Reporting (2018) screen is completed. 
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Note: The maximum number of characters allowed in a file name is 25. Point truncates any 
file names exceeding the limit. 

1. Select the Reports & Marketing tab. 

 

Figure 653: Generate HMDA Report 

2. Select Reports. 

3. Select Calyx Report – HMDA Report (2017) or Calyx Report – HMDA from the 
dropdown. 

4. Click Additional Filters if the filters are not displayed in the workspace. 

5. Select the data folder containing the applicable HMDA files in the Select Data Folder(s) 
section of the workspace. 

6. Select the appropriate Borrower checkbox(es). 

Note: All options are selected in the Current Status section by default. 

7. Select the Current Status All checkbox to deselect all options. 

8.  Locate and select the Closed checkbox. 

9. Click Generate. 

10. Select No on the Export HMDA prompt to run a test report. 

11. Review report for accuracy and adjust if required. 

12. Generate the report again. 
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13. Click Yes Export HMDA prompt to export the report. 

  

Figure 654: HMDA Loan App Register Info 

14. Enter the lender information in the following fields: 

• Respondent ID 

• Tax ID 

• Agency 

• Code fields 

15. Enter the lender details in the Respondent Information section. 

16. Enter the Parent Company Information if applicable. 

17. Enter the year of the report in the Activity Year field. 

18. Complete the Date and Time fields. 

19. Click OK. 

20. Use the Export Loan Application Register to HMDA Format dialog to browse to the secure 
location. 

21. Click Save. 

22. Click OK to Confirm Data Export confirmation. 
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Chapter 21: MARKETING MANAGEMENT 
Use Marketing tools for the following:  

• Store information about prospects and borrower. 

• Customize marketing documents. 

• Produce custom documents to assist prospects and borrowers in making mortgage 
decisions. 

Standard Marketing Documents 

The Marketing documents feature are like Report features. Use the predefined templates 
included in Point to send form letters and emails and print labels. 

Table 21: Predefined Marketing Templates 

Document Description 

Address Labels (Property 

Address) 

Generates address labels for the property 

address 

ARM Refinance 

Notification Email 

Generates emails to inform homeowners 

that new loan programs are available to 
save money 

ARM Refinance 

Notification Letter 

Generates letters to inform homeowners 

that new loan programs are available to 
save money 

Borrower Address Labels 

(Mailing Address) 

Generates address labels for borrower 

mailing addresses 

Borrower Interests Generates a list of borrowers interested in 

specific activities 

Co-Borrower Address 

Labels (Mailing Address) 

Generates address labels for the co-
borrower mailing addresses 

Post-Closing Letter Generates follow-up letters to send after a 

loan is closed 
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Address Labels 

Use the standard mailing label templates to generate mailing labels for a select group of 
clients or prospects. The labels output to a PDF document formatted for the size selected.  

Generate Labels 

Use the following steps to generate address labels. 

1. Click the Reports & Marketing tab. 

2. Select the appropriate Data Folders. 

 

Figure 655: Marketing Templates 

3. Select the appropriate File Types to include in the output. 

4. Select the Marketing radio button. 

5. Select the appropriate address label option from the dropdown. 

6. Click Additional Filters to display more options to refine the label criteria. 

7. Use the Originator and Processor dropdowns to filter the search results by a 
specific loan originator or loan processor. 

8. Select the Status to filter the labels by a loan status. 

9. Select a Status Date dropdown enter the date range to filter by dates. 

10. Click Generate. 
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11. Select the Label Type if the Label Options dialog displays. 

 

Figure 656: Label Options Dialog 

12. Click OK. 

View Labels 

The Point Report Viewer displays the address label list when generation is complete. 

1. Select the records/rows to delete. 

2. Click Delete Selected Rows. 

3. Select Yes on the Delete Confirmation dialog. 

4. Select the Label in the Mail Merge Document(s) field. 

5. Click Generate. 

6. Click Print on the Marketing Tools – Labels dialog. 

7. Use the Save As dialog to browse and save the labels. 

8. Double-click the saved file to review the labels. 

9. Use the PDF print option to print labels. 

Marketing Letters 

Use the standard marketing letter templates to generate letters for mass mailings to a 
select group of clients or prospects. The letters output to a PDF document. 
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Generate Letters 

Use the following steps to generate the letters. 

1. Select the appropriate Data Folders. (See Figure 655.) 

2. Select the File Types to include in the letter. 

3. Select the Marketing radio button. 

4. Select the appropriate letter template from the dropdown. 

5. Click Additional Filters to display more options to refine the letter criteria. 

6. Use the Originator and Processor dropdowns to filter the search results by a 
specific loan originator or loan processor. 

7. Select the Status to filter the labels by a loan status. 

8. Select a Status Date dropdown enter the date range to filter by dates. 

9. Click Generate. 

View Letters 

The Point Report Viewer displays the address label list when generation is complete. 

1. Select the records/rows to delete. 

2. Click Delete Selected Rows. 

3. Select Yes on the Delete Confirmation dialog. 

4. Select the Letter in the Mail Merge Document(s) field. 

5. Click Generate. 

6. Click Print on the Marketing Tools – Labels dialog. 

7. Use the Save As dialog to browse and save the labels. 

8. Double-click the saved file to review the labels. 

9. Use the PDF print option to print labels. 

Marketing Emails 

Use the standard marketing email templates to generate emails for mass mailings. 

Generate Emails 

Use the following steps to generate the letters. 
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1. Click the Reports & Marketing. 

2. Select the appropriate Data Folders. (See Figure 655.) 

3. Select the File Types to include in the letter. 

4. Select the Marketing radio button. 

5. Select the appropriate email template from the dropdown. 

6. Click Additional Filters to display more options to refine the letter criteria. 

7. Use the Originator and Processor dropdowns to filter the search results by a 
specific loan originator or loan processor. 

8. Select the Status to filter the labels by a loan status. 

9. Select a Status Date dropdown enter the date range to filter by dates. 

10. Click Generate. 

View Emails 

1. Select the records/rows to delete. 

2. Click Delete Selected Rows. 

3. Select Yes on the Delete Confirmation dialog. 

4. Select the Letter in the Mail Merge Document(s) field. 

5. Click Generate. 

6. Click Email on the Marketing Tools – Labels dialog to send the email. 

Note: Outlook returns a message if there was an issue with sending the emails. 

Custom Labels/Letters/Emails 

Custom forms are used to create templates for Marketing documents. Use the custom 
forms function to create forms in Microsoft Word 2000 (or later) that merge directly with 
Point data. The forms can also be printed from the Print menu. 

Create Custom Letters 

Use the following steps to create a customer letter. 

1. Click the Templates tab. (See Figure 13.) 
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2. Select Custom Forms/Letters/Email radio button. 

 

Figure 657: Templates Options 

3. Click New. 

4. Enter a letter Name on the New Customer Form dialog. 

5. Click OK. 

6. Select the first letter field from the Point Custom Form dialog. 

 

Figure 658: Point Custom Form Dialog 

7. Clicking Insert. 

8. Select Other Point Fields Not Listed Above… from the dropdown if the required field is 
not listed. 

9. Select the Show Point Field IDs checkbox. 

10. Enter the Point Field ID in the dialog. 

11. Click Insert. 
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12. Repeat Steps 6 – 11 for remaining fields. 

 

Figure 659: Point Custom Form Example 

13. Enter the form text and format using Microsoft Word formatting tools. 

14. Use the basic Microsoft Word functions to edit and format the form. 

15. Click the Point Customer Form dialog Save button. 

16.  Click the Point Customer Form dialog Close button. 

17. Click the Preview button on the List of Customer Forms to view the document. 

Create Custom Letters from Word 

Existing Microsoft Word documents can be imported into Point to use as custom forms. 

1. Select the Templates tab. (See Figure 13.) 

2.  Select Custom Forms/Letters/Email radio button. (See Figure 657.) 

3. Click the Import button. 

4. Read the Import Word Document message and click Yes. 

5. Use the Select Word File(s) dialog to browse to the document to import. 

6. Click Open. 

7. Select the document. 

8. Click Open. 

9. Edit the document to add any merge fields and replace the fields lost during the import. 
(See Create Custom Letters from Word for details.) 
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Create Custom Emails 

Use the following steps to create a custom email template. 

1. Select the Templates tab. (See Figure 13.) 

2.  Select Custom Forms/Letters/Email radio button. See Figure 657.) 

3. Double-click the customer letter to convert to an email. 

4. Print the letter. 

5. Close the Point Customer Form dialog. 

6. Select the Report & Marketing radio button on the Templates tab. 

7. Click New. (See Figure 657.) 

8. Enter Email into a Field name. 

9. Enter 122 in the Field ID. 

10. Enter the information from the printed form below the Email field. (See Select 
Report Content for details.) 

11. Select the Use Result for Mail Merge Marketing Documents radio button. 

12. Click Add Link. 

13. Select the Email radio button on the Marketing Document and Options dialog. (See 
Figure 650.) 

14. Enter the Email Subject. 

15. Select the Email address from the Email Address Field. 

16. Click OK to save. 

Print Custom Forms 

1. Open a prospect or borrower file. 

2. Select Print from the File menu. 

3. Select Custom Forms tab on the Borrower Forms dialog. (See Figure 616.) 

4. Select the form(s) to print. 

5. Click Print 

Add INK-it Signature Blocks 

1. Templates tab. (See Figure 13.) 
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2.  Select Custom Forms/Letters/Email radio button. See Figure 657.) 

3. Select the document. 

4. Click INK-it Signature Blocks to display the document in INK-it-Designer. 

5. Select the Select Signature Type. 

 

Figure 660: INK-it-Designer 

6. Select the signer from the Select Signer dropdown. 

7. Click the Insert icon to add the signature block. 

8. Click the Signature Block icon. 

9. Drag the Signature Block to the appropriate location. 

10. Resize as require. 

11. Repeat Steps 7 – 10 for additional signatures. 

12. Click Save. 

13. Select block and click the Trash icon to delete. 

Customize Marketing Documents 

The following forms on the Marketing menu can be customized to include company-
specific information using the buttons provided on the screen. 

• Amortization Schedule 

• Cash-to-Close 

• Loan Comparison 

• Rent vs. Own 

• Prequalification 

Note: The Company Information dialog must be completed o include the company 
information on a printed form. (See Company Information for dialog details.) 
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Chapter 22: TEMPLATE MANAGEMENT 
Use templates in Point to create boilerplate loan files and loan information to reuse multiple 
times. 

The following types of templates can be created: 

• Reports & Marketing 
• Loan program 
• Closing cost scenarios 
• Prospect and borrower files 
• Importing and exporting data 
• Forms, letters, and emails 

See Reports Management for custom reports. 

See Marketing Management for customer marketing document. 

Note: Do not change the file extension of templates. File names cannot contain any of the 
following characters: \ / : * ? “ < > . 

Loan Program Templates 

PointCentral users with Calyx Pricer enabled cannot use loan program templates. Click the 
Loan Program button to directly access to Calyx Pricer without populating a loan program 
template. 

Use loan programs templates to populate detailed loan information on the following 
screens: 

• Amortization 
• Debt Consolidation 
• CA MLDS, Non-Traditional 
• Fees Worksheet 
• Loan Comparison 
• Prequalification 
• Prospect Information/Borrower Information 
• Truth-in-Lending 

Populate screens with a loan program template by clicking the Loan Prog/Loan Prg button 
and selecting a loan program from the list of templates. 

1. Templates tab. (See Figure 13.) 

2.  Select Loan Program radio button. See Figure 657.) 

3. Select the appropriate loan program template. 

4. Click New. 



   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
661 

5. Name the template in the Loan Program Name field. 

Note: The name displays in the List of Loan Programs. 

 

Figure 661: Loan Program Template 

6. Complete the applicable fields. 

7. Select Save from the File menu when complete. 

8. Close the template. 

Closing Cost Scenario Templates 

Closing costs are calculated on the Fees Worksheet. Use a closing cost scenario template to 
avoid repeat data entry for regular loan costs. Closing cost scenario templates are useful for 
marketing loans to prospects. 

Access the templates by clicking the CC Scen/CC Scenario buttons after creating the 
templates. 

Closing cost scenarios are available in prospect and borrower files in the following screens: 

• Debt Consolidation 
• Fees Worksheet 
• Loan Comparison 
• Prequalification 
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• Prospect Information/Borrower Information 

Changes made to one screen populate the others. Point re-calculates all figures and ratios 
automatically. The template is immediately available to apply to Point files and populate the 
GFE or the MLDS after creation. 

1. Templates tab. (See Figure 13.) 

2.  Select Closing Cost Scenario radio button. See Figure 657.) 

3. Select the appropriate closing costs template. 

4. Click New. 

5. Enter the template name in the Closing Cost Scenario Name field. 

 

Figure 662: Closing Costs Template 

6. Complete the applicable fields. 

7. Select Save from the File menu when complete. 

8. Close the template. 

Master File Templates 

Use the master file templates to create a complete loan file containing information identical 
for different loans. 

Note Most information in the Prospect Information screen is general and varies from file to 
file. Leave most of the information blank in the prospect master file template. 

1. Templates tab. (See Figure 13.) 
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2.  Select a Master Template radio button. (See Figure 657.) 

3. Select the appropriate master borrower/prospect template. 

4. Click New. 

5. Complete the Borrower Information for the master template. 

 

Figure 663: Master Template 

6. Use the menu options and screen buttons to add forms and data to the master 
template. 

7. Click Save. 

8. Close the template. 

Master File Template Usage 

Import the Master File Template into an existing loan file. (See Import From for details.) 

Select the Master Template option on the Create New Loan File dialog to use the master 
template while creating a new loan. (See Create Loans for details.) 
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Edit Templates 

1. Click the Templates tab from the navigation panel. 

2. Click the appropriate Select a Template Category radio button. 

3. Select the template to modify. 

4. Click Open. 

5. Make the required changes. 

6. Click Save. 

7. Close the template. 

Delete Templates 

1. Click the Templates tab from the navigation panel. 

2. Click the appropriate Select a Template Category radio button. 

3. Select the template to delete. 

4. Click Delete. 

5. Click Yes on the Delete Confirmation dialog. 

Import Templates 

Create templates to import files from other applications.  

Note: It is not necessary to create a template to convert files from Fannie Mae format 3.2 
(.fnm). 

1. Templates tab. (See Figure 13.) 

2.  Select Data Import. See Figure 657.) 

3. Click New. 
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4. Select the Import Format from the dropdown. 

 

Figure 664: Data Import Template 

6. Click Advanced to open the Advanced Import Format Settings dialog to define the 
text delimiters to set up ASCII formats. 

Note: Skip to Step 9 for Fannie Mae import templates. 

 

Figure 665: Template Import Format Settings 

7. Select the Field Separator. 

8. Select the Text Qualifier. 



   Point User Guide 
 

©2023 Calyx Technology, Inc. All rights reserved. 
666 

9. Enter the complete path name of the file to be imported (such as: c:\pointexp.txt) in 
the Input Data File field. 

Note: Leave the field blank to specify a different file to import when the template is used. 

10. Select the Field Name Header in First Row checkbox if the file to be imported has 
column headers in the first row. 

11. Select the Update Existing Files checkbox to overwrite an existing file with the 
same name. 

Complete Data Import Table  

Complete the table to set the delimited text file fields for import. 

Note: Leave the Maps to Field ID and Brw/Co-Brw columns blank to exclude a column 
from the import. 

1. Enter the column heading in the file being imported if the Field Name Header in 
First Row checkbox is selected. 

 

Figure 666: Template Data Import Table 

2. Enter the column numbers if Field Name Header in First Row checkbox was not 
selected and the file uses numbers. 

3. Enter the field ID corresponding to the data in Point in the Maps to Field ID for each 
row. 

4. Use FIELD ID Excel file (FieldID.xls) to identify field IDs when defining templates. 

Note: The Excel file is in the WINPOINT folder. 

5. Enter a 0 for a prospect or borrower file in the Brw/Co-Brw column. 

6. Enter a 1 through 5 to correspond to a co-borrower associated with the loan file. 
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7. Click to Save the file. 

Note: Point saves all data import template files with the. imp extension. Do not change the 
extension or Point will not recognize the template. 

Re-Sequence Rows 

Change the template prior to import to match the row sequence to the data being imported. 

1. Templates tab. (See Figure 13.) 

2. Select Data Import. See Figure 657.) 

3. Select the template. 

4. Click Open. 

5. Select the row to move. 

6. Select Cut from the Edit menu. 

7. Select the row number to place the cut row. 

8. Select Paste from the Edit menu. 

Data Export Templates 

Point interfaces applications used by the following types of companies: 

• Credit 

• Document preparation 

• Other mortgage service companies 

Use export templates to export data from multiple files. 

Note: The File Export function exports data from one file at a time. (See Export To for 
details.) 

The data export function sends Point data to lenders that offer automated underwriting 
systems. Point includes a data export template (called sample) containing more than 70 of 
commonly used fields for data export. Use this template as the base for building new data 
export templates. 

A sample export template is provided with Point. You can use this template as a base for 
creating new templates. 

Note: The default name and path for the output data file is 
C:\WINPOINTWORK\pointexp.dat. 

1. Select the Templates tab. (See Figure 13.) 

2. Select Data Export. See Figure 657.) 
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3. Select the Sample file. 

4. Click Open. 

5. Select the Export Format. 

 

Figure 667: Data Export Template 

6. Select custom ASCII format if the application to export to is not available. 

Note: The default file path of the executable file is automatically populated in the 
Executable to Launch field if a Microsoft application is selected. 

7. Select the Advanced button when selecting custom ASCII format. 

8. Complete the Advanced Export Format Settings dialog fields. (See Figure 665.) 

9. Browse to and select the executable file for the selected application. 

Note: Verify the path in the Executable to Launch field is correct when selecting a 
Microsoft application. 

10. Click the Document to Link to Browse button and select the file. 

11. Click the Output Data File Browse and navigate to the file containing the data to 
export. 

12. Edit the table by removing fields or entering additional field information as 
applicable. 

13. Select Save As from the File menu. 

14. Enter a file name. 

15. Click Save. 
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Appendix A – QM Tables 

The following tables show the relationship between the Qualified Mortgage results and 
Point data when the report is run in Point. 

Table 22: Requested By 

QM Report Data Description Location 

Requested by Company information Classic Loan Application, page 4 

New URLA Loan Application, 
section 

NMLS # Company information Classic Loan Application, page 4 

New URLA Loan Application, 
section 

User Name Name of user logged into 
Point 

 

Borrower/Co-
Borrower 

Name fields Borrower Information screen 

Credit Score (nnn nnn 
nnn)* 

Credit scores are imported from the Borrower credit report if credit 
was run in Point. 

Note: The credit score for QM is retrieved from the actual report, 
can be entered manually 

Application Date Interview Date field Classic Loan Application, page 4 

New URLA Loan Application, 
section  

Lender Loan No Lender Case Number field Classic Loan Application, page 1 

New URLA Loan Application, 
section  

LSC Casefile ID Generated when QM report is 
run 

 

Subject Property Subject Property section Classic Loan Application, page 1 

New URLA Loan Application, 
section 

Subject Property Type Property Type field Classic Loan Application, page 1 
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QM Report Data Description Location 

New URLA Loan Application, 
section  

Subject Property 
Status 

Property will be checkboxes Classic Loan Application, page 1 

New URLA Loan Application, 
section  

Table 23: Requested Terms 

QM Report Data Description Location 

Base Loan Amt Loan Amount field Classic Loan Application, page 1 

New URLA Loan Application, 
section  

Note Loan Amt Loan Amount field + PMI, MIP 
financed field 

Classic Loan Application, pages 1 
and 4, respectively 

New URLA Loan Application, 
section 

LTV/CLTV Borrower Information 

Loan Application 

LTV USDA purchase loans: Note Loan Amt/lesser of Appraised Value 
and Sales Price fields 

USDA refinance loans: Loan Amt/Appraised Value 

Non-USDA purchase loans: Base Loan Amt/lesser of Appraised 
Value and Sales Price 

Non-USDA refinance loans: Base Loan Amt/Appraised Value 
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QM Report Data Description Location 

CLTV USDA purchase loans: Note Loan Amt + subject property real estate 
owned liability balance + Subordinate financing (line j) field/lesser 
of Appraised Value and Sales Price 

USDA refinance loans: 

Note Loan Amt + subject property real estate owned liability 
balance + Subordinate financing (line j) field/Appraised Value 

Non-USDA purchase loans 

Base Loan Amt + subject property real estate owned liability 

balance + Subordinate financing (line j) field/lesser of Appraised 
Value and Sales Price 

Non-USDA refinance loans: Base Loan Amt + subject property real 
estate owned liability balance + Subordinate financing (line j) 
field/Appraised Value 

Note Rate Note Rate field Loan Application, section 

Loan Type Amortization Type 
checkboxes 

Loan Application, section 

Type of Refi Refinance Type dropdown Fannie Mae > Government 

Applicable when: 

Loan Type = VA or FHA 

Purpose of Loan = Cash-Out Refi or No Cash-Out Refi 

Amort Term Term mths field Loan Application, section 

Maturity Term Due In mths field Loan Application, section 

Purpose Purpose of Loan checkboxes. Loan Application, section 

Purpose of Refi Purpose of Refinance 
dropdown list. 

Loan Application, section 

Lien Pos Property will be checkboxes. Loan Application, section 
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Table 24: QM Agreement 

QM Report Data Description Location 

This loan was 
evaluated against QM 
Type 

Determined based on the QM Requirements used to assess the 
loan 

QM Requirements 

The following points are checked to assess the loan, where applicable. Loan is non-QM if 
any test fails. 

Max Points & Fees 

QM types: General, 
Agency, 

Balloon, Small 
Creditor 

Summary of Points and Fees 
Cap section 

 

General QM DTI ≤ 43 

QM type: General 

Same DTI as in Monthly Payments and Ratios section 

Max Loan Amount 
Test 

QM types: General, 
Agency 

Loan limits for subject property county are compared to base loan 
amount. 

Note Loan Amount is used for conventional loans, Base Loan 
Amount is used for FHA loans.  

Loan term ≤ 30 years Amortization term (Term mths 
field) divided by 12 

Loan Application, section 

QM types: General, Agency, Small Creditor  

No Balloon Payments Amort Term (Term mths field) 
and Maturity Term (Due In 
mths field) must match 

Loan Application, section 

QM types: General, Agency, Small Creditor  

No Negative Amort Recast Pd/Stop field Amortization Schedule, 

QM types: General, Agency, Balloon, Small Creditor Payment Adjustments section 

No Interest-Only Interest Only During Initial Pmt 
Rate Period field = unselected 

If indicator is selected, loan 
will fail QM assessment 

Amortization Schedule, Payment 

Adjustments section 
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QM Report Data Description Location 

QM types: General, Agency, Balloon, Small Creditor  

Agency Eligible Recommendation type Banker > Underwriting 

QM type: Agency DO/DU has precedence over LP when both have the same result 

LP is used when LP has better result than DO/DU 

Result is Warning/Run AUS if agency is unknown 

Amort Type 

QM type: Balloon 

Amortization Type checkbox = 
Fixed Rate 

Loan Application, section 

Maturity Term 

QM type: Balloon 

Due in mths field must equal 
between 60 and 360 years 

Loan Application, section 

Liability Protection was based on  

Lock Date Registered Date field Registration & Rate Lock screen 

Amort Type Amortization Type 
checkboxes 

Loan Application, section 

Maturity Term Due In mths field. Loan Application, section 

APOR Fixed loan: Lock Date, Lien Position, and Maturity Term are used to 
determine APOR 

ARM loan: Lock Date, Lien Position, and 1st adj are used to 
determine APOR 

Note: APOR tables are updated on Mondays. APOR date and Lock Date differ if lock does 
not occur on a Monday. 

Lien Position Property will be checkboxes. Loan Application, section 

Safe Harbor Threshold Greater than APR = Safe harbor 

Less than APR = Rebuttable presumption 

HPML Threshold Greater than APR = Non- HPML 

Less than APR = HPML 
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Table 25: Points & Fess Analysis 

QM Report Data Description Location 

Total Loan Amount   

TIL Amount Financed Amount Financed field. Amount Financed field 

Fin QM Points and 
Fees 

Included fees with the 
Finance checkbox selected. 

Fees Worksheet 

Total Loan Amount Amount Financed field minus Fin QM Points and Fees. 

Points & Fees Cap   

Note Loan Amount Loan Amount + PMI, MIP 
financed (line n) fields. 

Classic Loan Application, page 1 
and 4, respectively 

New URLA Loan Application, 
section  

QM Points & Fees Cap If Interview Date field (loan application date) is before January 1, 
2015: 

If Note Loan amount ≥ $100,000, then 3% 

If $60,000 ≤ Note Loan Amount < $100,000, then $3,000 

If $20,000 ≤ Note Loan Amount < $60,000, then 5% 

If $12,500 ≤ Note Loan Amount < $20,000, then $1,000 

If Note Loan Amount < $12,500, then 8% 

If Interview Date field (loan application date) is on or after January 1, 
2015: 

If Note Loan amount ≥ $101,953, then 3% 

If $61,172 ≤ Note Loan Amount < $101,953, then $3,059 

If $20,391 ≤ Note Loan Amount < $61,172, then 5% 

If $12,744 ≤ Note Loan Amount < $20,391, then $1,020 

If Note Loan Amount < $12,744, then 8% 

Total Loan Amount Amount Financed field minus Fin QM Points and Fees 

Max QM Points & Fees QM Points & Fees Cap multiplied by Total Loan Amount (Amount 
Financed field) 

Total QM Points & 
Fees 

All fees listed in Included QM Points and fees below (total) 
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QM Report Data Description Location 

Points & Fees Cushion 

Points & Fees 
Exceeded By 

(when a negative 
value) 

The difference between Max QM Points & Fees and Total QM Points 
& Fees 

Discount Points 
Exclusion 

  

Starting Adjusted Rate Starting Adjusted Rate field. Fees Worksheet, block 2 

APOR Fixed loan: Lock Date and Lien Position used to determine 

APOR. 

ARM loan: Lock Date, Lien Position, and 1st adj are used to 
determine APOR. 

Percentage Above 
APOR 

Starting Adjusted Rate field 
minus APOR. 

 

 Allowable exclusion is 0, 1, or 2, depending on the result. 

Allowable Exclusion If 0 ≤ Percentage Above APOR ≤ 1, then exclude up to 2% and 
include above 2% 

If 1 < Percentage Above APOR ≤ 2, then exclude up to 1%and 
include above 1% 

If 2 > Percentage Above APOR, then include all 

Starting Adjusted Rate Starting Adjusted Rate field Fees Worksheet, block 2 

Note Rate Note Rate field Classic Loan Application, page 1 

New URLA Loan Application, 
section 

Interest Rate 
Reduction 

Starting Adjusted Rate minus 

Note Rate 

 

Discount Points 
Charged 

Loan Discount % field Fees Worksheet, block 2 

Discount/Rebate at 
Start Rate 

Discount/Rebate for Starting 
Rate field 

Fees Worksheet, block 2 
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QM Report Data Description Location 

Eligible Discount 
Points 

Discount Points Charged Minus Discount/Rebate at Start Rate 

0 when negative value 

Line 802 Included as a fee when Discount/Rebate at Start Rate is a positive 
value 

Required Points at Start Rate  

Table 26: Included/Excluded Points & Fees 

QM Report Data Description Location 

HUD# Point HUD numbers are 
hardcoded 

 

Prior Loan 
Prepayment Penalty 

Prepay Penalty Amount field State Specific Information 

Maximum 
Prepayment Penalty 

Loan Has Prepayment Penalty 
checkbox is selected. 

Good Faith Estimate 

Line 902 Refundable Type dropdown 

list: 

PMI/MIP/FF/USDA dialog 

Non-Refundable 
Upfront PMI 

Refundable Upfront 
PMI 

Applicable when: 

Loan Type = 
Conventional 

Not Refundable: all included 

Refundable with limits: up to 1.75% can be excluded 

Refundable: all excluded 

Fee Type Fees on Fees Worksheet 

Fees on blocks 1 through 8 are mapped, user-defined 

fees are listed as Other with the entry in parentheses 
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QM Report Data Description Location 

Paid to Paid To dropdown list 

Paid to does not map for blocks 9, 10, 11, shows as Other 

Fees Paid to Affiliate, X is indicated in Affiliate column and name 
printed, if entered 

Does not print Affiliate name for blocks 9, 10, 11 Fees in block 10 
are always paid to Lender 

PFC, POC, Fin Indicates fee type selection (PFC, POC, or FIN checkbox on Fees 
Worksheet) 

Paid By Indicates fee type selection (PFC, POC, or FIN checkbox on Fees 
Worksheet) 

Paid By Paid By dropdown list Fees Worksheet 

Table 27: Qual Rate/AUS Results 

QM Report Data Description Location 

QM Qual Rate When the report is a General QM, Small Creditor QM, or Balloon 
QM 

AUS Results When the report is an 
Agency QM or VA QM 

 

DU Fannie Mae DO/DU 
Recommendation field 

Banker > Underwriting 

LP Freddie Mac LP 
Recommendation field 

Banker > Underwriting 

Note rate Note Rate field Classic Loan Application, page 1 

New URLA Loan Application, 
section  

1st Adj Cap 1st Adj Cap % field Rate Adjustments Section, 

Amortization Schedule 

1st Adj Period 1st Change mths field Rate Adjustments Section, 

Amortization Schedule 
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QM Report Data Description Location 

Adj Cap Adj Cap % field Rate Adjustments Section, 

Amortization Schedule 

Adj Period Adj Period mths field Rate Adjustments Section, 

Amortization Schedule 

Life Adj Cap Life Cap % field Rate Adjustments Section, 

Amortization Schedule 

Index Index % field Rate Adjustments Section, 

Amortization Schedule 

Margin Margin % field Rate Adjustments Section, 

Amortization Schedule 

QM Qual Rate QM Qual Rate: The theoretical highest rate, after comparing all 
variables, in the first 5 years of the loan 

AUS AUS Qual Rate: Qual Rate 
field 

Amortization Schedule 

Monthly Payment Monthly Payment based on Qual Rate or QM Qual Rate 

Might differ from Point when loan is General QM, Small Creditor 
QM, or Balloon QM, DTI  

Table 28: Monthly Payments & Ratios 

QM Report Data Description Location 

First Mortgage P & I 

Monthly MIP 

HOA Fees 

Second Mortgage P 
& I 

Hazard Insurance 

Taxes & Special 
Assessments 

Other 

Values are mapped from the applicable Present or Proposed 
housing expense when the property is owner-occupied 
(Occupancy checkbox = Primary), 

Values in the Present column are used when the property is a 
second home or investment property (Occupancy checkbox = 
Secondary or Investment), 
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QM Report Data Description Location 

Primary Housing 
Expenses 

Value is calculated by adding the applicable combination of 
Present and Proposed housing expenses to the Monthly Payment 
amount when the property is owner-occupied (Occupancy 
checkbox = Primary) 

Present housing expenses are added to the Monthly Payment 
amount when the property is a second home or investment 
property (Occupancy checkbox = Secondary or Investment) 

Housing Ratio Primary Housing 
Expenses/Total Income 

Classic Loan Application, page 2 

New URLA Loan Application, 
section 

Total Fixed Payment Total of all liabilities, housing expenses, and other monthly 
expenses 

DTI Total Fixed Payment/Total 
income 

Classic Loan Application, page 2 

New URLA Loan Application, 
section 

Residual Income Total Fixed Payment 
deducted from Total income 

Classic Loan Application, page 2 

New URLA Loan Application, 
section 

Table 29: Funds Summary 

QM Report Data Description Location 

Cash from/to 
Borrower 

Calculated by QM Can match line P on: 

Classic Loan Application, page 4 

New URLA Loan Application, 
section 

Cash Out Cash to/from Borrower amount if negative value 

Amount of Gift Funds Assets Type dropdown list 

Checking & Savings 
Accounts 

Classic Loan Application, page 3 

New URLA Loan Application, 
section 

Total Closing Costs Est. Closing Costs field Classic Loan Application, page 4 

New URLA Loan Application, 
section 
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QM Report Data Description Location 

Required Funds Same value as Cash from/to 
Borrower 

Liabilities marked to be paid 
off (Will be paid off (*) 
checkbox) are deducted 
from Cash from/to Borrower 
value for Purchase loans 

Edit Liability dialog: 

Classic Loan Application, page 3 

New URLA Loan Application, 
section 

Available Funds Sum of all liquid assets Classic Loan Application, page 3 

New URLA Loan Application, 
section  

Reserves Available Funds minus 
Required Funds. 

 

Months Reserves Reserves divided by 
Proposed Monthly Housing 
Expenses. 

Classic Loan Application, page 2 

New URLA Loan Application, 
section  

Table 30: Loan Details 

QM Report Data Description Location 

Sales Price Purchase Price field Classic Loan Application, page 1 

New URLA Loan Application, 
section 

Appraised Value Appraisal Value field Borrower Information 

Improvements Impvmts (b) field Classic Loan Application, page 1 

New URLA Loan Application, 
section 

Fee Simple Fee Simple checkbox Classic Loan Application, page 1 

New URLA Loan Application, 
section 

Leasehold Leasehold checkbox Class Loan Application, page 1 

New URLA Loan Application, 
section 
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QM Report Data Description Location 

PMI, MIP, Funding 
Fee 

PMI, MIP financed field Classic Loan Application, page 4 

New URLA Loan Application, 
section 

Base Loan Amount Loan Amount field Classic Loan Application, page 1 

New URLA Loan Application, 
section 

Note Loan Amount Loan Amount field + PMI, 
MIP 

financed field 

Classic Loan Application, pages 1 
and 4, respectively 

New URLA Loan Application, 
section 

Subordinate 
Financing 

Subordinate financing field Classic Loan Application, page 4 

New URLA Loan Application, 
section 

Table 31: Income/Liabilities/Credit Scores/Assets 

QM Report Data Description Location 

Income Information Gross Monthly Income 
section 

Classic Loan Application, page 2 

New URLA Loan Application, 
section 

Liabilities Liabilities section Classic Loan Application, page 3 

New URLA Loan Application, 
section 

Note: Only the Primary Borrower name is listed for liabilities when only one 1003 is used 
for more than one Borrower. Use additional 1003s in Point to list individual Borrower 
liabilities separately. 

Mortgages to be Paid 
Off 

Will be paid off checkbox 
selected and Liability Type 
dropdown = Mortgage 

Edit Liability dialog: 

Classic Loan Application, page 3 

New URLA Loan Application, 
section 

Debts to be Paid Off Will be paid off checkbox. Classic Loan Application, page 3 

New URLA Loan Application, 
section 
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QM Report Data Description Location 

Debts to Remain Debts not marked as Will be 
paid off or Omitted 

Edit Liability dialog: 

Classic Loan Application, page 3 

New URLA Loan Application, 
section 

Debts Excluded Omitted checkbox selected Edit Liability dialog: 

Classic Loan Application, page 3 

New URLA Loan Application, 
section 

Credit Reports and 
Scores 

Must run credit report in Point to display credit information 

Incomes Gross Monthly Income 
section 

Classic Loan Application, page 2 

New URLA Loan Application, 
section 

Assets Savings & Checking 
Accounts 

Section 

Classic Loan Application, page 3 

New URLA Loan Application, 
section 

Note: Only the Primary Borrower name is listed for assets when only one 1003 is used for 
more than one Borrower. You must use additional 1003s in Point to list individual 
Borrower assets separately. 
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Appendix B – Loan Estimate Fields 

The following tables contain the location of the fields on the Loan Estimate not populated 
from the Fees Worksheet. 

Loan Estimate Section Fields 

Table 32: Loan Estimate Section Fields 

Loan Estimate Section/Field Mapped from Screen Mapped from 
Section/Field 

Applicants Names and Address Borrower Information Borrower/Co-Borrower 

Mailing Address 

Property Borrower Information Subject Property 

Sales Price Borrower Information Purchase Price 

Estimated Property 
Value/Appraised Value 

Borrower Information Appr. Value 

Loan Term Borrower Information Loan Summary, Term/Due 

Purpose Borrower Information Loan Summary 

Product Truth-In-Lending Summary of combination 

of fields  

Loan Type Borrower Information Loan Summary 

Rate Lock Registration and Rate 

Lock 

Rate Lock Period 

Loan Terms 

Table 33: Loan Terms Fields 

Loan Estimate Field Mapped from 
Screen 

Mapped from Section/Field 

Loan Amount Truth-In-Lending Summary of Loan 

Total Loan Amount 
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Loan Estimate Field Mapped from 
Screen 

Mapped from Section/Field 

Can this increase Truth-In-Lending Summary of Loan even if 
payments are made on time 

Goes, Can Go, as high as, 

Increases, Can Increase 

until 

Truth-In-Lending Payment Schedule 

Interest Rate Truth-In-Lending Summary of Loan 

Initial Interest Rate 

Can this increase? Truth-In-Lending Determined by various 

loan data and loan terms 

Adjusts every starting Adj Period 1st 
Change 

Truth-In-Lending Summary of Loan Variable Rate 
Feature checkbox 

Monthly P & I Truth-In-Lending Summary of Loan Monthly 
Payment 

Can this increase? Truth-In-Lending Payment Schedule, worst case 
scenario 

Adjusts every Adj Period 1st Change Truth-In-Lending Summary of Loan Initial Pmt Rate 
Period when Interest Only During 
Initial Pmt Rate Period checkbox 
selected 

Variable Rate Feature checkbox 

Prepayment Penalty Truth-In-Lending Prepayment 

Balloon Payment Truth-In-Lending Calculated 

You will have to pay $ at the end of Truth-In-Lending Payment Schedule 
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Projected Payments 

Table 34: Projected Payments Fields 

Loan Estimate Section/Field  Mapped from 
Screen 

Mapped from Section/Field 

Principal & Interest Truth-In-
Lending 

Payment Schedule 

Mortgage Insurance Truth-In-
Lending 

Payment Schedule 

Estimated Escrow Fees 
Worksheet 

Section G. Initial Escrow Payment at 
Closing items with the Escrowed checkbox 

This Estimate Includes Closing Costs 
Worksheet 

Section G. Initial Escrow Payment at 
Closing: 

Yes=At least one item in the category has 
the Escrowed checkbox selected 

No=None of the items in the category have 
the Escrowed checkbox selected 

Yes Some=Only applies to Other. 

Note: Some items have the Escrowed 
checkbox selected, and some do not 

Estimated Escrow Fees 
Worksheet 

Section G. Initial Escrow Payment at 
Closing items with the Escrowed checkbox 
selected 

Estimated Total Monthly 

Payment 

 Calculated field 

Estimated Taxes, 

Insurance, Fees Worksheet 

Closing Costs 
Worksheet 

Section G. Initial Escrow Payment at 
Closing Sum of fees containing a monthly 
amount for escrowed and non-escrowed 
fees, excluding mortgage insurance 
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Fees 

Table 35: Fees Fields 

 Loan Estimate Section/Field Mapped from Screen Mapped from Field 

Section I. Total Other Costs Loan Estimate The sum of sections E, F, 

G, and H 

Section J. Total Closing Costs 

Lender Credits 

Loan Estimate 

Payoffs and Adjustments 

The sum of all closing 

costs (A through H) Total 
Lender Credits (displayed 
as a negative value) 

Calculating Cash to Close 

Table 36: Calculating Cash to Close Fields 

Loan Estimate Section/Field Mapped from Screen Mapped from Field 

Standard Form   

Section J. Total Closing Costs Loan Estimate The sum of all closing costs 
(A through H) 

Standard Form   

Section J. Total Closing Costs Loan Estimate The sum of all closing costs 
(A through H) 

Closing Costs Financed Loan Estimate Calculated 

Down Payment/Funds from 
Borrower 

Fees Worksheet Calculated 

Deposit Payoffs & Adjustments Cash Deposit 

Funds for Borrower Loan Estimate Calculated 

Seller Credits Payoffs & Adjustments Total Seller Credits 

(displayed as a negative 

value) 

Adjustments and Other Credits Payoffs & Adjustments  
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Loan Estimate Section/Field Mapped from Screen Mapped from Field 

Estimated Cash to Close  Calculated 

Alternative Form 

Note: Not applicable for loans 
that have a seller. 

  

Loan Amount Borrower Information Loan Summary w/MIP, FF 

Estimated Total Payoffs and 
Payments 

Payoffs & Adjustments 

Payments 

 

Estimated Cash to Close  Calculated 

Estimated Closing Cost Financed  Calculated 

Adjustable Payment (AP) Table 

Table 37: AP Table Fields 

Loan Estimate Section/Field Mapped from Screen Mapped from Field 

Interest Only Payments? Truth-In-Lending Payment Adjustments 

Interest Only during Initial 

Pmt Rate Period 

Optional Payments? Truth-In-Lending Optional Payment 

Step Payments? Truth-In-Lending Graduated Payment Mtg 

Years 

Seasonal Payments?  N/A 

First Change/Amount Truth-In-Lending Payment Adjustments 

Initial Pmt Rate Period Mths 

Subsequent Changes Truth-In-Lending Payment Adjustments Adj 
Period 

Maximum Payment  Calculated 
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Adjustable Interest Rate (AIR) Table 

Table 38: AIR Table Fields 

Loan Estimate Section/Field Mapped from Screen Mapped from Field 

Index + Margin Truth-In-Lending Rate Adjustments 

Margin 

Index Type 

Step Rate (Increases in 

Interest Rate) 

Truth-In-Lending Buydown Mortgage 

First Change Truth-In-Lending Rate Adjustments 1st 

Change 

Subsequent Changes Truth-In-Lending Rate Adjustments 

Adj Period mths 

First Change Truth-In-Lending Rate Adjustments 1st Adj 
Cap 

Subsequent Changes Truth-In-Lending Rate Adjustments Adj Cap 

Initial Interest Rate Truth-In-Lending Higher value of: Loan 
Information, Note Rate 
Adjustments, Margin + Index 

Minimum Interest Truth-In-Lending Rate Adjustments Floor 

Maximum Interest Rate Truth-In-Lending Rate Adjustments Life Cap 
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Comparisons 

Table 39: Comparisons Fields 

Loan Estimate Section/Field Mapped from Screen Mapped from Field 

Loan Costs Truth-In-Lending 

Loan Estimate 

Sum of the first 60payments 
on the Payment Schedule, 
Section D. Total Loan Costs, 
and Section F. 

Prepaid Interest 

Principal Paid Truth-In-Lending Payment Schedule–
estimated principal paid in 
the first five year 

APR Truth-In-Lending Payment Schedule APR 

TIP Truth-In-Lending Payment Schedule TIP 

Other Considerations 

Table 40: Other Considerations 

Loan Estimate Section/Field Mapped from Screen Mapped from Field 

Assumptions Truth-In-Lending Assumption 

Late Payment If a payment is more 
than ___ days late You will be 
charged 

Truth-In-Lending Late Charge 

Servicing Truth-In-Lending Servicing 
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Appendix C- Closing Disclosure Field Mapping Tables 

Many fields on the Closing Discloser are populated from the corresponding field on the 
Closing Costs Worksheet. The following tables contain the location of the fields not 
populated from the Closing Costs Worksheet. 

Closing Information 

Table 41: Closing Information Fields 

Closing Disclosure 
Section/Field 

Mapped from Screen Mapped from Section/Field 

Settlement Agent Agent Closing Agent 

File # Agent Closing Agent Number 

Property Borrower Information Subject Property 

Sales Price Borrower Information Sales Price 

Appraised Value Borrower Information Appr Value 

Transaction Information 

Table 42: Transaction Information Fields 

Closing Disclosure 
Section/Field 

Mapped from Screen Mapped from Section/Field 

Applicants Names 
Address 

Loan Application, Page 1 
Borrower/Co-Borrower 

Mailing Address 

Seller 

Agent Banker–Basic Loan 

Information (for multiple 

sellers) 

Seller/Sellers 

Lender Agent Lender 
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Loan Information 

Table 43: Loan Information Fields 

Closing Disclosure 
Section/Field 

Mapped from Screen Mapped from Section/Field 

Loan Term Borrower Information Loan Summary, 

Term/Only Due 

Purpose Borrower Information Loan Summary 

Product Truth-In-Lending Summary of combination 

of fields  

Loan Type Loan Application, Page 1 Lender Case No 

Loan Terms 

Table 44: Loan Terms Fields 

Closing Disclosure 
Section/Field 

Mapped from Screen Mapped from Section/Field 

Loan Amount Truth-In-Lending Summary of Loan/Total Loan 
Amount 

Can this increase Truth-In-Lending Summary of Loan/Even if 

payments are made on time, can 
the Loan Balance rise? checkbox 

Goes, Can Go, as high as, 

Increases, Can Increase 
until 

Truth-In-Lending Payment Schedule 

Interest Rate Truth-In-Lending Summary of Loan/Initial Interest 
Rate 

Can this increase Truth-In-Lending Determined by various loan data 
and loan terms 
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Closing Disclosure 
Section/Field 

Mapped from Screen Mapped from Section/Field 

Adjusts every/ starting in/ 

Goes, Can go, as high as, in 
See AIR Table on page 2 
for details 

Truth-In-Lending Adj Period 1st Change 

Summary of Loan/Variable Rate 
Feature checkbox 

Monthly P & I Truth-In-Lending Summary of Loan/Monthly 

Payment 

Can this increase Truth-In-Lending Payment Schedule/ worst case 
scenario 

Adjusts every/ starting in 

Goes, Can go, as high as, in 
Includes only interest and 
not principal until 

See AIR Table on page 2 
for details 

Truth-In-Lending Adj Period, 1st Change Summary of 
Loan/Initial Pmt Rate Period when 
Interest Only During Initial 

Pmt Rate Period checkbox 

selected Variable Rate Feature 
checkbox 

Prepayment Penalty Truth-In-Lending Prepayment 

Balloon Payment  Calculated 

You will have to pay $ at 
the end of 

Truth-In-Lending Payment Schedule 

Projected Payments 

Table 45: Projected Payments Fields 

Closing Disclosure 
Section/Field 

Mapped from Screen Mapped from Section/Field 

Section/Field Screen Section/Field 

Principal & Interest Truth-In-Lending Payment Schedule 

Section/Field Screen Section/Field 

Principal & Interest Truth-In-Lending Payment Schedule 

Mortgage Insurance Truth-In-Lending Payment Schedule 
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Closing Disclosure 
Section/Field 

Mapped from Screen Mapped from Section/Field 

Estimated Total Monthly 

Payment 

Closing Costs Worksheet Sum of Principal & Interest, 
Mortgage Insurance, and 
Estimated Escrow 

Estimated Taxes, Insurance 
& Assessments 

Closing Costs Worksheet Section G. Initial Escrow Payment 
at Closing Sum of fees 
containing a monthly amount for 
escrowed and non-escrowed 
fees, excluding mortgage 
insurance 

This Estimate Includes Closing Costs Worksheet Section G. Initial Escrow Payment 
at Closing 

Yes: At least one item in the 
category has the Escrowed 
checkbox selected 

No: None of the items in the 
category have the Escrowed 
checkbox selected 

Yes: Some=Only applies to 

Other. Some items have the 
Escrowed checkbox 

selected, and some do not 

Costs at Closing 

Table 46: Costs at Closing Fields 

Closing Disclosure 
Section/Field 

Mapped from Screen Mapped from 
Section/Field 

Estimated Closing Costs Closing Disclosure, Page 2 Section J. Total Closing 
Costs 

Estimated Cash to Close Closing Disclosure, Page 3 Cash to Close, final column 
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Loan Costs 

Table 47: Loan Costs Fields 

Closing Disclosure 
Section/Field 

Mapped from Screen Mapped from Section/Field 

I. Total Other Costs Closing Disclosure Sum of sections E, F, G, and H 

J. Total Closing Costs Closing Disclosure Sum of all closing costs (A 
through H) 

Calculating Cash-to-Close 

Table 48: Calculating Cash-to-Close Fields 

Closing Disclosure 
Section/Field 

Mapped from Screen Mapped from Section/Field 

Closing Costs Paid Before 

Closing 

Closing Costs Worksheet Fees paid by Borrower with 
the POC checkbox selected 

Closing Costs Financed  The closing costs to be paid 
out of loan proceeds, 
determined by subtracting 
the estimated total amount of 
payments to third parties 
from the total loan amount. If 
a positive number, the value 
is disclosed as a negative 
number, unless it exceeds 
the total amount of losing 
costs disclosed, then, 0. 

Down Payment/Funds from 

Borrow 

 Loan Amount subtracted 
from Purchase Price or 
Principal (Total Loan Amount 
- Closing Costs Financed) 
subtracted from Debt (Sales 
Price + Payoffs and 
Payments), unless a negative 
value, then 0. 

Deposit Closing Costs Worksheet 

Closing Disclosure, Page 
3 

Total Estimated Funds 
Needed to Close Deposit 
(section L) 
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Closing Disclosure 
Section/Field 

Mapped from Screen Mapped from Section/Field 

Funds for Borrower  Principal (Total Loan Amount 
– Closing Costs Financed) 
subtracted from Debt (Sales 
Price + Payoffs and 
Payments), unless a positive 
value, then 0. 

Seller Credit Closing Costs Worksheet 

Closing Disclosure, Page 
3 

Total Estimated Funds 
Needed to Close Seller 
Credit (section L) 

Adjustments and Other 

Credits 

Closing Disclosure Summaries of Transaction, 
Sections K, L 

Cash to Close  Calculated 

Alternative Form*  Does not apply to loans that 
have a seller 

Closing Costs Paid Before 

Closing Costs Worksheet 

Fees paid by Borrower 

Closing Costs Paid Before 
Closing Costs, Worksheet 
Fees paid by Borrower 

Closing Costs Paid Before 
Closing Costs Worksheet 
Fees paid by Borrower 

Total Payoffs and 

Payments (K) Payoffs & 

payments Total Payoffs 

and 

Total Payoffs and 
Payments (K) Payoffs & 
payments Total Payoffs 
and 

Total Payoffs and Payments 
(K) Payoffs & payments Total 
Payoffs and 

Cash to Close Calculated Cash to Close Calculated Cash to Close Calculated 

Loan Disclosures 

Table 49: Loan Disclosures Fields 
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Closing Disclosure 
Section/Field 

Mapped from Screen Mapped from Section/Field 

Estimated Closing Costs Closing Disclosure, Page 
2 

Section J. Total Closing Costs 

Estimated Cash to Close Closing Disclosure, Page 
3 

Cash to Close, final column 

Adjustable Payment (AP) Table 

Table 50: Adjustment Payment (AP) Table 

Closing Disclosure 
Section/Field 

Mapped from Screen Mapped from Section/Field 

Interest Only Payments? Truth-In-Lending Payment Adjustments 
Interest Only during Initial 
Pmt Rate Period 

Optional Payments? Truth-In-Lending Optional Payments 

Closing Disclosure Mapped from  

Step Payments? Truth-In-Lending Graduated Payment Mtg 
Years 

Seasonal Payments?  N/A 

Monthly Principal and 

Interest 

  

First Change/Amount Truth-In-Lending Payment Adjustments/ Initial 
Pmt Rate Period mths 

Subsequent Changes Truth-In-Lending Payment Adjustments Adj 

Period 

Maximum Payment  Calculated 

Estimated Cash to Close; 
Estimated Closing Cost; Financed 

 Calculated 
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Adjustable Interest Rate (AIR) Table 

Table 51: Adjustment Interest Rate (AIR) Table 

Closing Disclosure Mapped from Screen Mapped from Section/Field 

Index + Margin Truth-In-Lending Rate Adjustments/Margin 
Index Type 

Interest Rate Adjustment Truth-In-Lending Buydown Mortgage 

(Step Rate)   

Initial Interest Rate Truth-In-Lending Higher value of: Loan 
Information, Note Rate/Rate 
Adjustments, Margin + Index 

Minimum Interest Truth-In-Lending Rate Adjustments/Floor 

Maximum Interest Rate Truth-In-Lending Rate Adjustments/Life Cap 

Change Frequency   

First Change Truth-In-Lending Rate Adjustments/ 1st 
Change 

Subsequent Changes Truth-In-Lending Rate Adjustments/ 

Adj Period __ mths 

First Change Truth-In-Lending Rate Adjustments/ 

1st Adj Cap 

Subsequent Changes Truth-In-Lending Rate Adjustments/ Adj Cap 
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Loan Calculations 

Table 52: Loan Calculations 

Closing Disclosure 
Section/Field 

Mapped from Screen Mapped from Section/Field 

Total of Payments  Calculated 

Finance Charge  Calculated 

Amount Financed  Calculated 

Annual Percentage Rate (APR)  Calculated 

Total Interest Percentage (TIP)  Calculated 

I conduct business as a Company 

Information 

I conduct business as a 
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Appendix D - Tool Bars and Hot Keys 

The following sections provide details for Point tool bars and hot keys used for navigation. 

Toolbar Icons 

The Point software integrates many of the standard Microsoft Windows operating system 
icons to complete the most common functions (such as: printing and saving). Point also has 
icons unique to the application. The following table provides descriptions for the unique 
Point icons. 

Table 53: Point Toolbar Icons 

Icon Name Function 

 

Document Opens new loan file 

 

Email Emails files or forms 

 

Ratios Displays top, bottom, Loan to Value 
(LTV), Combined Loan to Value 
(CLTV) ratios for loans 

 

Conversation Log Displays conversation logs for the 
selected loan 

 

Show Tasks Displays tasks associated with the 
selected loan 

 

Calculator Launches Microsoft Windows 
calculator 

 

Cardex Opens Cardex database 

 

New Task Creates new task 

 

Document Storage Opens Document Storage dialog 
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Icon Name Function 

 

Flag Displays vendor interface notification 
messages 

 

Help Launches Point Help 

Key Combinations 

Point uses conventional Windows operating system key combinations to accomplish 
various tasks.  

Activating Keys 

Use Activating keys to close, cancel, or activate a task. The following activating keys are 
available in Point: 

Table 54: Activating Keys 

Key Description 

Enter Activates the highlighted 
command. 

Esc Closes a dialog or cancels a 
command. 

Space bar Activates the highlighted 
button. 

Function Keys 

Function keys are the F keys located at the top of the keyboard. Use Function keys to 
access the following functions in Point. 

Table 55: Function Keys 

Key Description 

F1 Help 

F2 Loans tab 
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Key Description 

F3 Tasks tab 

F4 Reports tab 

F5 Templates tab 

Hot Keys 

Hot keys provide shortcuts for completing frequently used functions in Point. Press and 
hold down the Ctrl key and press the specified letter to activate the item. The following hot 
keys are used in Point. 

Table 56: Hot Keys 

Key Description 

Ctrl+C Edit > Copy 

Ctrl+D Edit > Paste Date 

Ctrl+G Current view (toggle between 
tabs) 

Ctrl+L Conversation log 

Ctrl+N File > New 

Ctrl+O File > Open 

Ctrl+P File > Print  

Ctrl+R Utilities > Cardex 

Ctrl+S File > Save 

Ctrl+T Display ratios 

Ctrl+U Launch Calculator 

Ctrl+V Edit > Paste  

Ctrl+W Show tasks 

Ctrl+X Edit > Cut 
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Key Description 

Ctrl+Z Edit > Undo 

Movement Keys 

Use movement keys to navigate quickly through Point when entering data. Use the 
following keys to navigate in Point. 

Table 57: Movement Keys 

Key Description 

Tab Moves forward one field. 

Shift+Tab Moves backward one field. 

Alt+Forward Arrow Moves forward one section. 

Alt+Backward Arrow Moves backward one section. 

Scrolling Keys 

Use scrolling keys (without using the mouse) to navigate the screen when it exceeds the 
window boundaries, Use the following keys to scroll in the Point screens. 

Table 58: Scrolling Keys 

Key Description 

Ctrl+Page Down Scrolls down one page 

Ctrl+Page Up Scrolls up one page 

Ctrl+Home Scrolls to top of form 

Ctrl+End Scrolls to bottom of form 

Ctrl+Forward Arrow Scrolls to the right. 

Ctrl+Backward Arrow Scrolls to the left 

Ctrl+Down Arrow Scrolls down one line 

Ctrl+Up Arrow Scrolls up one line 
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